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1 Working collaboratively within
a Tekla Structures model

To work collaboratively within a Tekla Structures model, you can select out of
the following different methods:

Tekla Model
Sharing
(page 10)

With Tekla Model Sharing a global team can work
efficiently within one model regardless of the team
location and time zones. The team members can work
both simultaneously and at different times. Each user has
a local version of the model on their computer. The model
data is shared and synchronized over the Internet, and
stored to a cloud-based Tekla Model Sharing service.

It is possible to work also offline. The Internet connection
is needed only when you want to share your model
changes.

Tekla Model Sharing requires a license.
Multi-user mode
(page 85)

Multi-user mode also allows several users to access the
same model simultaneously. Multi-user mode is suitable
for local teams with projects where the team members do
not necessarily have an Internet connection.

In the multi-user mode a server computer runs the multi-
user server, a file server computer contains the multi-user
master model and client computers run Tekla Structures.
The multi-user model consists of a single master model on
the file server computer and local views to the master
model, called working models, on each users' computer.
The model synchronization is done by saving the working
model to the master model.

Trimble
Connector
(page 114)

The Trimble Connector adds automatic file
synchronization to the Trimble Connect cloud. You can use
it to exchange files and information, such as reference
models and comments. Trimble Connector works with

Working collaboratively within a Tekla Structures
model
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various different products and file formats, so it allows
smooth collaboration within the whole project.

If you do not need to work simultaneously with other
users on the same model, or you only need to give others
viewing access to the model, you can also synchronize the
Tekla Structures model (or parts of it) to Trimble Connect.
This method is not suitable for different people making
changes in the same Tekla Structures model
simultaneously, because users can easily overwrite each
others' changes.

NOTE Tekla Model Sharing and the multi-user mode do not work together. When
you want to work collaboratively, you need to select which one of the
methods to use.

If your company takes part in external projects, or if more than one user
works with the same model at different locations, we recommend that you
use Tekla Model Sharing. With Tekla Model Sharing, the users in your
company can work with the same shared model, offline and with high
performance, and synchronize the changes with other team members even in
a low-speed network.

If you work in a local team and prefer not to use Internet while working on
your models, you can use the multi-user mode.

1.1 What is Tekla Model Sharing
Tekla Model Sharing enables efficient global collaborative modeling within one
Tekla Structures model. Tekla Model Sharing gives users the freedom to work
with the same model at the same time in different locations and time zones.

Working collaboratively within a Tekla Structures
model
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With Tekla Model Sharing you can work locally and share the model changes
globally. For example, one Tekla Model Sharing team of users can work in New
York, one in London and one in Bangkok. They all contribute to the same
model, working around the globe during their office hours in different time
zones while the model keeps building up all the time.

In Tekla Model Sharing each user has a local version of the model on their
computer or on a network drive, and the model data is shared and
synchronized over the Internet using a Microsoft Azure cloud sharing service.
When a model is shared, it is connected to the cloud-based sharing service.
You can check the status of the service at any time.

To easily share your model changes, write out them to the sharing service.
When you want to update your model with the changes made by other users,
read in the changes from the sharing service.

Even though the changes are shared over the Internet, you do not need to be
connected to the sharing service all the time. You need to be online only when
you want to write out or read in the changes. This enables offline work if your
Internet connection is not always available.

NOTE Tekla Model Sharing requires a single-user model.

A model cannot be simultaneously shared and used in multi-user mode
(page 92). If you want to start using multi-user mode as a means to share
your model instead of Tekla Model Sharing, you need to first exclude your
local version of the model from the sharing service and then convert
(page 45) it to a multi-user model.

The excluded model has no connection to the original shared model in the
sharing service. This means that if you exclude your local version of the model
from the sharing service and start to use the model in multi-user mode, you
cannot later merge the original shared model and the multi-user model.

Working collaboratively within a Tekla Structures
model
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Prerequisites for Tekla Model Sharing
Before you can start using Tekla Model Sharing and share your models, the
following prerequisites need to be met:

• Internet connection

You need to establish a connection to the Tekla Model Sharing service to
perform any model sharing actions.

• TCP port 443 (the default HTTPS) outbound must be open.

If an HTTP proxy is used, it must support HTTP 1.1.

• Trimble Identity

All sharing actions require authentication, and the authentication is done
with Trimble Identity username and password.

If you do not have a Trimble Identity, go to Tekla Online services and click
Log in.

• License

All sharing actions require a valid Tekla Model Sharing license. Tekla Model
Sharing licenses are tied to users' Trimble Identities. The organization's
administrator assigns and manages the licenses in the Tekla Online Admin
Tool.

• Tekla Structures

The users of the same shared model need to have the same Tekla
Structures version, and use the same latest service pack.

Tekla Model Sharing licenses
Tekla Model Sharing requires a valid Tekla Model Sharing license.

Tekla Model Sharing licenses are assigned and managed in the Tekla Online
Admin Tool. To obtain a Tekla Model Sharing license, contact your
organization's administrator. For details about model sharing licenses, see
Manage Trimble Identities and Tekla Online licenses.

Tekla Model Sharing uses enterprise-type licenses that are purchased as a
yearly subscription. The license use is limited to a maximum number of
concurrent users.

A license is reserved when a user starts read in or write out in a shared model.
Note that users can work on a shared model offline without reserving a
license. Licenses can be temporarily assigned outside of your organization to
any users. Having several shared models open on the same computer only
reserves one license.

If a user does not perform any operations that use the Tekla Model Sharing
service (such as write out your changes or read in changes made by other

Working collaboratively within a Tekla Structures
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users), their session closes in eight hours, and Tekla Structures releases the
Tekla Model Sharing license within three hours. We recommend that each user
shuts down Tekla Structures at the end of the day to close the session and
release the Tekla Model Sharing license sooner.

The configuration, type, and maintenance status of your Tekla Structures
license has no effect on your Tekla Model Sharing license. Keep track of the
number of licenses and users as well as your license expiration dates to
ensure continued service.

How Tekla Model Sharing uses the sharing service
When you start to share a model using Tekla Model Sharing, the model is
connected to the cloud-based sharing service.

• To send model changes to the sharing service, you need to write out
(page 28).

• To fetch other users' model changes from the sharing service, you need to
read in (page 28).

When you read in other users' changes, the updates to your local version of
the shared model are delivered to you as incremental packets. This means
that when you read in, the data that is fetched from the sharing service is
merged with the data on your computer. You need to read in all shared
changes before you can write out your own changes to the sharing service.

Note that there is no central model in the sharing service as such, only a
model instance that consists of a model baseline and incremental updates.
You cannot open the model in the sharing service or access any files.

The image below shows how the model data is stored to the sharing service.
Each user fetches the model data from the sharing service to their local
versions of the model when they read in. User authentication is based on
Trimble Identity.

Working collaboratively within a Tekla Structures
model
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NOTE You can install a separate Tekla Model Sharing Cache service
(page 58) that downloads and caches the model changes on behalf of
the Tekla Structures client workstations. The cache service speeds up
the workflow as users can fetch the changes to their local versions of
the model from the LAN instead of the Tekla Model Sharing sharing
service. The cache service is useful especially when there are at least
two Tekla Model Sharing users in the same office, and in regions
where the download speed may be limited.

1.2 Work with Tekla Model Sharing
This section explains the basic workflow in Tekla Model Sharing.

Tekla Model Sharing is available in all configurations of Tekla Structures. You
can find all the Tekla Model Sharing commands in File --> Sharing .

To start using Tekla Model Sharing, you need to have:

• Tekla Structures installed

• A personal Trimble Identity that is connected to an organization

Working collaboratively within a Tekla Structures
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• An internet connection to share and download changes

• A valid Tekla Model Sharing license

Tekla Model Sharing uses enterprise-type licenses that are purchased as a
yearly subscription. The company administrator assigns Tekla Model
Sharing licenses to the users with the Tekla Online Admin Tool.

How does Tekla Model Sharing work?

In short, the workflow in Tekla Model Sharing has the following phases:

1. Downloading the cache service

If needed, the person who plans to share a model downloads the Tekla
Model Sharing Cache service from Tekla Downloads.

The Tekla Model Sharing cache service downloads and caches the model
changes on behalf of the Tekla Structures client workstations.
Downloading the cache service speeds up working, as users can fetch the
changes to their local versions of the model from the LAN instead of the
Tekla Model Sharing sharing service.

2. Sharing the model to other users

The model owner shares a single-user model (page 18) and invites users
to join the model.

To share a model, open the single-user model that you want to share, or
create a new single-user model.

Before you can start sharing your models in Tekla Model Sharing, you
need to be logged in with your Trimble Identity in Tekla Structures. If you
are not logged in, the Trimble Identity sign in dialog box opens.

To start sharing the model, go to File --> Sharing --> Start sharing to
open the Start sharing dialog box. You can invite other users to join the
model and send an email invitation to them, or you can add users later.
When you start sharing, you become the Owner of the model.

When you start sharing the model, a model baseline is uploaded to the
sharing service. The baseline is a snapshot of the current state of the
model. A new baseline is typically created once a week. Joining the
baseline is beneficial for users who join the model when many changes
have already been made.

When a model is shared (page 10), it is connected to a cloud-based
sharing service. Each user of the model has a local version of the model
on their computer or on a network drive.

3. Joining the model

The invited users accept the invitations they have received.

You can either join a model someone has shared with you, or you can
start sharing your own model. The shared model has an Owner who can

Working collaboratively within a Tekla Structures
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invite other users to the model. The Owner can send an email notification
to the invited users.

You can also join a model you have been invited to without the email
notification. You will find all the shared models in which you are a user in
File --> Sharing --> Browse shared models . Just select the model from
the list, and click Join. The model is downloaded, and you can start
working with it.

4. Working on the model

The invited users can start working on the model offline.

You do not need to log in with your Trimble Identity every time you want
to work on a shared model. When you have joined the model, you can
work offline, provided that you are using the same Windows account as
you did when you joined the model.

5. Sharing and downloading changes

You need an internet connection to download other people's changes to
the model and share your own changes.

a. Downloading changes made by other users

To keep your model up to date, you need to the changes other users
have made to the model (page 27) from the sharing service. Only the
changed data is read in to the model.

To read in, you can either go to File --> Sharing --> Read in , or click

 on the Quick Access Toolbar.

The Read in icon shows the number of packets  that are available
to be read in. Each packet contains one or more changes made by
another user. After reading in all the packets, the changes are listed
in a table at the bottom of the screen.

The changes are color-coded:

• Red for deleted objects

• Yellow for modified objects

• Green for new objects

b. Sharing your changes to other users

When you have made changes to your local model, you can share
your changes to other users of the model by writing out the changes
to the sharing service.

Before you write out, you always need to read in (page 27) any
changes made by other users first. This is done to solve any
conflicting changes made by other users.

Working collaboratively within a Tekla Structures
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After you have read in, you will see a green arrow on the Write out

icon . You can now write out your changes.

When you write out, only the changes that you have made are sent to
the sharing service. These changes are then available for other users
to read in.

Typically, you want to read in other users' changes and write out your
changes a couple of times a day to keep everyone updated. Model
changes are collected to packets that are very fast to download and
upload.

6. Track the progress of the project

Users with the Owner role can create new starting points, or baselines,
(page 39) for the model. Baselines make the model faster and easier to
join for new users, and allow tracking the progress in the model.

Who can use the shared model?

With Tekla Model Sharing, you can add new users to your shared model
without limitations. Tekla Model Sharing has four roles that define what a user
can do in the shared model.

• When you share your model, you automatically get the Owner role. You
can invite more users and assign appropriate roles for them. In a typical
situation you may have one or two owners who can control everything in
the shared model. The users of a model and their roles are listed in File -->
Sharing --> Users . The Owner can change the roles if needed.

• Editor can perform all modeling and drawing tasks.

• Viewer role is targeted for those who just want to follow-up on the project.

• Project viewer is for those who use the model information and need to
update the fabrication status, for example.

The permissions of each role are shown in the table below:

 Owner Editor Viewer Project
viewer

Read in Yes Yes Yes Yes
Write out Yes Yes No Yes
Modify
objects and
drawings

Yes Yes No No

Modify UDAs Yes Yes No Yes
Invite/remove
users, change
roles,
baseline,

Yes No No No
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 Owner Editor Viewer Project
viewer

exclude from
sharing

Owner has all permissions, Editor has all permissions except model
administration, Viewer can only read in changes, and Project viewer can read
in and write out, but cannot modify objects or drawings, only the UDAs that do
not affect numbering.

In addition to the Owner, the company administrator can list all the shared
models of the organization and the users and their roles in the web-based
Management Console for Tekla Model Sharing. The administrator can change
the roles in Management Console without opening Tekla Structures.

Click the links below to find out more:

Share a model in Tekla Model Sharing (page 18)

Join a shared model in Tekla Model Sharing (page 23)

Share your model changes in Tekla Model Sharing (page 28)

Update the model with other users' changes (page 27)

Detect sharing changes and view the sharing history in Tekla Model Sharing
(page 31)

Set object locks, drawing locks, and privileges in Tekla Model Sharing
(page 35)

Create a baseline for a model in Tekla Model Sharing (page 39)

Collect model history in Tekla Model Sharing (page 40)

Tekla Model Sharing settings (page 42)

Exclude a model from the sharing service in Tekla Model Sharing (page 44)

Convert a shared model to a multi-user model in Tekla Model Sharing
(page 45)

Share a model in Tekla Model Sharing
When you start sharing your model in Tekla Model Sharing, you need to be
logged in with your Trimble Identity in Tekla Structures. If you are not logged
in, the Trimble Identity log in dialog box opens. You can invite other users to
the models that you share.

Working collaboratively within a Tekla Structures
model

18 Work with Tekla Model Sharing



Start sharing a model
When you start sharing a model in Tekla Model Sharing, you become the
Owner of the model.

Note that to start sharing a model, you need to belong to an organization as
an employee. If you have an external license, you cannot have model
ownership, so you cannot start sharing a model. For more information about
employees and external license users, see Manage Trimble Identities and
Tekla Online licenses.

1. Open a single-user model that you want to share.

2. On the File menu, click Sharing --> Start sharing. 

The Start sharing dialog box opens.

3. Select the service from the Service list. 

When you use Tekla Model Sharing for the first time and the on-premises
sharing service is enabled, you need to select the service from the Service
list. You can set up and use an on-premises service connection, or you can
use the Tekla service. Tekla Model Sharing on-premises server requires a
separate license and installation.

4. If needed, enter a Code and a Description for the model. 

• Code can be a site number, a project number, or an accounting
number, for example.

• Type a description according to your company conventions.

5. Invite other users to share your model by typing their email addresses to
the Invite users box and set their user role to either Editor, Owner,
Project viewer, or Viewer. 

You can add several users at one go. Separate the email addresses with
semicolons. Do not use spaces between the email addresses. If you add
several users at one go, they all get the same user role. The role can be
changed later.

6. Click the Add button to add the users to the model.

7. Select the Send e-mail notification to user. check box to send a
notification email to the invited users, and write a message to the users.

8. Click the Start button to start sharing your model. 

The model is saved and written out to the sharing service (page 10).

When you open the model the next time, you have two alternatives:

• In the Tekla Structures start screen when you open Tekla Structures:

1. Go to the Shared models tab and log in with yourTrimble Identity.

2. Click Continue to open the Shared models dialog box.
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3. Select the Show shared models on this computer check box to list
the models.

4. Click Join.

You can also open shared models on the Recent or All models tabs. Log in
with your Trimble Identity to read in and write out.

• In File --> Open --> Browse shared models .

Invite new users to a shared model
1. Open the shared model to which you want to invite new users.

2. On the File menu, click Sharing --> Users .

3. In the Users dialog box, type the email addresses of new users in the
Invite users box, and set their user roles to either Editor, Owner, Project
viewer, or Viewer. 

You can add several users at one go. Separate the email addresses with
semicolons. Do not use spaces between the email addresses.

If you add several users at one go, they all get the same user role. The
roles can be changed later.

4. Click the Add button to add the new users to the model.

5. If necessary, modify the user roles of the new users.

6. Select the Send e-mail notification to user. check box to send a
notification email to the invited users, and write a message to the users.

7. Click Save changes to invite the users.

Modify user roles in Tekla Model Sharing
User roles define a user's permissions to view and modify the shared model.
There are four different user roles in Tekla Model Sharing: Owner, Editor,
Project viewer, and Viewer. When you start sharing your model in Tekla
Model Sharing, you become the Owner of the model. The Owner can invite
other users to join in the model and give them one of the four roles.

The permissions of the four different user roles are described in the table
below:

Role Permissions
Owner Users with the Owner role can:

• Read in other users' changes and write out
their own changes to the sharing service

• Invite new users

• List other users and change their roles

• Remove users from the model
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Role Permissions
• Remove the model instance and all the model

related data from the sharing service

• Change the model code and description
properties

Several users can have the Owner role within one
model. The Owner who has started to share the
model can give the Owner role to any selected
user.

Editor Users with the Editor role can:

• Read in other users' changes and write out
their own changes to the sharing service

• Edit the model

• List other users
Project viewer Users with the Project viewer role can:

• Read in other users' changes and write out
their own changes to the sharing service

• View the model, but they cannot modify the
model objects

• List other users

Users with the Project viewer role cannot:

• Modify user-defined attributes that affect
numbering

• Insert and modify grids

• Import and update models that would create
beams and other objects

Note that when you open the model in the
Project viewer role, restarting Tekla Structures is
required.

The permissions of the Project viewer role in a
shared model correspond with the set of
functionalities available in the Project Viewer
configuration.

Viewer Users with the Viewer role can:

• Read in other users' changes

• View the model

Users with the Viewer role cannot:

• Write out any changes to the sharing service

• Modify the model objects
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Role Permissions
• Use the export commands

Note that when you open the model in the Viewer
role, restarting Tekla Structures is required.

Note that your permission to access the shared model is removed when you
detach the model from the sharing using one the following methods:

• Exclude the model from the sharing (page 44) using the Exclude from
sharing command

• Upgrade to the next Tekla Structures version

• Use the Save as command to save the model

A user with the Owner role can change the role of a user as follows:

1. Open the shared model whose user roles you want to modify.

2. On the File menu, click Sharing --> Users .

3. In the Users dialog box, select the user whose role you want to modify.

4. Click the arrow in the Role column, and select a new role for the user in
the list.

5. If you want to send an email notification to the user whose role has been
changed, select the Send e-mail notification to user. check box.

6. If needed, type a short message that you want to attach to the email
notification. 

If you include a message, all the invited users and the user whose role has
been changed receive the same message.

7. Click Save changes.

Remove users from a shared model
Users with the Owner role can remove unnecessary users from a shared
model.

1. On the File menu, click Sharing --> Users .

2. In the Users dialog box, select the user that you want to delete.

3. Click the  button to remove the user's permissions to access and
modify the model. 

If you clicked the  button accidentally, you can click the button again
to cancel removing the user's permissions.

4. Repeat steps 2 and 3 for all users that you want to remove from the
model.

5. Click Save changes to remove the users from the model.
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View information on users and sharing action
When you want to check the Tekla Model Sharing users and the basic sharing
actions on the model, or invite new users to the shared model, open the Users
dialog box in File --> Sharing --> Users.

Option Description
Name Name of the user.
E-mail Email address of the user.
Role Role of the user: Owner, Editor, Project viewer, or Viewer.

When you start to share a model, you become the Owner of
the model and you can set other users' roles. The roles can
be changed later, if needed.

Use the different roles to control the permissions of users
regarding the shared model.

Note that there can be more than one Owner within one
model.

Joined Indicates whether the invited user has joined the model.
Date Date when the user has joined the model.
By Person who invited the user or changed the user role the

last.
Last read in Date when the user last read in.
↓ Number with the arrow down indicates the total number of

update packets available in the sharing service.

The number next to the arrow indicates how many of the
packets the user has read in.

Last write
out

Date when the user last wrote out.

↑ Number with the arrow up indicates the total number of
update packets available in the sharing service.

The number next to the arrow indicates the number of the
last packet that the user has written out.
Remove the selected user's permissions to the model.

Only users with the Owner role can remove other users from
the sharing service.
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Join a shared model in Tekla Model Sharing
When someone using Tekla Model Sharing has invited you to join a shared
Tekla Structures model, you may receive an invitation email.

The email contains information about the model, the used environment, and
your user role. The user role defines your permissions in the model. You can
join a model at any stage of sharing, and as many times as you need.

Join a shared model
1. On the File menu, click Sharing --> Browse shared models.

2. In the Shared models dialog box, select the service from the Service list. 

When you use Tekla Model Sharing for the first time and the on-premises
sharing service is enabled, you need to select the service from the Service
list. You can set up and use an on-premises service connection, or you can
use the Tekla service. Tekla Model Sharing on-premises server requires a
separate license and installation.

3. In Save in, browse for the location where you want to save your local
version of the model. 

If you later want to join the same model again, you need to save a new
local version of the model on your computer. If you use the same name
for the model, the local versions of the model need to be saved in
different locations on your computer, because you cannot have two or
more models with the same name in the same folder.

4. From the Shared models list, select the model you have been invited to. 

You can find the name of the model in the invitation email.

5. Click the Join button. 

Working collaboratively within a Tekla Structures
model

24 Work with Tekla Model Sharing

https://teklastructures.support.tekla.com/not-version-specific/en/ms_installing_on_premises_sharing_service
https://teklastructures.support.tekla.com/not-version-specific/en/ms_installing_on_premises_sharing_service


When you join the model:

• Tekla Structures checks that the local version of the model does not
already exist in the selected folder. A warning message is displayed if
the selected folder already contains the model. In that case, you need
to browse for a different folder where to save the model.

• Tekla Structures checks the environment you are using and displays a
message if you are using a different environment than the shared
model. We recommend that all users within the same shared model
use the same environment.

The Available updates list opens.

6. From the list of available updates, select an update or a baseline
(page 39) that you want to join. 

You can join any baseline (a snapshot of the model state on a certain
date) or update, not only the latest. Selecting a baseline is beneficial if you
join the model when there many changes have already been made.
Joining a baseline instead of an update is also faster.

By joining an earlier baseline or update, you can go back in the model
history, and, for example, check the model state on a certain date.

7. Start working with the model and share your model changes (page 28). 

When you read in, only incremental update packets are fetched from the
sharing service.

Information on shared models in Tekla Model Sharing
When you want to join a shared model in Tekla Model Sharing, you select the
model to join in the Shared models dialog box, in File --> Sharing --> Browse
shared models.

Option Description
Service Sharing service that is being used.
Save in Location where the local version of the model is saved on

your computer.

If you want to save to another location, click the Browse
button.
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Option Description
Shared models

• Show also
hidden

• Show shared
models on
this computer

List of models that you have shared or that have been
shared with you.

• If you have hidden some models from the Shared
models list, select the Show also hidden check box to
see the full list of models that have been shared with
you, or that you have shared.

• Select the Show shared models on this computer
check box to see the models that you have locally
saved on your computer.

Click to hide the model from the Shared models list.

If you have many models on the list, it can be useful to
hide the models you are not actively working with.

Code Code of the model.

The code can be, for example, a site number, a project
number, or an accounting number.

Name Name of the model.
Description Description of the model.
Environment Environment of the model.
From Person who has invited you to the shared model, or has

changed your role the last.
Date Date when the sharing of the model was started.
Your role Your role and your access level to the model.

The options are: Owner, Editor, Project viewer, or
Viewer.

Only the Owner can change the roles of the other users.
If you are the Owner, you can edit the Code and the
Description of the model.
If you are the Owner, you can invite new users to the
model, or remove existing users.

If you are the Editor, you can see which users have been
invited or have joined the shared model.
If you are the Owner, you can remove the model from
the sharing service.

This discontinues the sharing, and the users who have
been working with the shared model cannot share
changes anymore.

Local copies of
selected model
on this computer

• Edited

When you select a model from the Shared models list,
the model information is displayed here.

• The date when the local version of the model has
been edited.
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Option Description
• Model

•

•

• The location of the local version of the model on your
computer.

• Click  to open the selected local version of the
model.

• Click  to remove the selected local version of the
model from your computer.

Update the model with other users' changes
To update your model with the changes made by other users, fetch the
changes from the sharing service by reading them in. You always need to read
in the most current changes to a model before you can write out your own
changes.

You can also use the (page 28) to automate read in, so that you can keep the
model updated with changes made by other users of the model.

1. On the File menu, click Sharing --> Read in , or click  on the Quick
Access Toolbar. 

If there are available packets to read in, the Read in icon shows a green
arrow and the number of packets .

If one of the users who shares the model has selected the Show available
updates when reading in the changes option in the Sharing settings
(page 42) dialog box, the Available updates list opens after you have
clicked the Read in icon.

The dialog box lists all the available packets. You can read in the changes
packet-by-packet, if you want to check the model changes in phases. If
you want to receive all the updates at once, you can select the latest
packet and all the previous packets are read in as well.

When you read in, the updates to the shared model are delivered as
incremental packets that only include the changed data. You need to read
in all shared changes before you can write out your own changes to the
sharing service again.

If you have selected the Show changes after read in option in the
Sharing settings (page 42) dialog box, a list of sharing changes opens at
the bottom pane after the selected packets are read in. The list shows the
changes according to how they affect the model. For more information on
sharing changes, see Detect sharing changes and view the sharing history
in Tekla Model Sharing (page 31).

2. Continue working with the model.
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NOTE If you encounter problems with sharing, check the sharing related log files in
the current model folder and in ..\Users\<user>\AppData\Local\Tekla
DataSharing for troubleshooting.

If Tekla Model Sharing detects changes that should not appear in the local
version of the model after read in, Tekla Structures displays a message and
the changes are recorded in the modelsharing.log. We recommend that
you contact your local support to solve the issue.

See also

Share your model changes in Tekla Model Sharing (page 28)

Detect sharing changes and view the sharing history in Tekla Model Sharing
(page 31)

Share your model changes in Tekla Model Sharing
After you have modified your local version of the shared model, you can share
your changes with other users who are working with the model. To share your
changes with other users, send your changes to the sharing service by writing
them out. To ensure that other users will not write out while you are making
changes in the model, you can reserve the next write out. You can also use the
Sharing automation tool to automate sharing your changes.

Write out
Before you write out your changes, you need to:

• Read in (page 27) the most current changes made to the model.

• Save the changes you have made into the model.

1. On the File menu, click Sharing --> Write out, or click  on the Quick
Access Toolbar. 

The Write out icon shows a green arrow  when there are no packets
that need to be read in before you can write out. You can write out
changes immediately.

The Write out icon shows a gray arrow  when there are packets that
need to be read in before you can write out changes.

When you write out, Tekla Structures saves the model, creates a packet of
the model changes, writes out the changes to the sharing service and
saves the model again.
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Only new or changed data is written out. If you attempt to write out your
changes, but some other user has shared some changes earlier and you
have not yet read in all the available updates, you are asked to read in
first. If there is no new data to be read in, Tekla Structures writes out your
changes to the sharing service immediately.

If one of the users who shares the model has selected the Enable write
out revision comment option in the Sharing settings (page 42) dialog
box, you can enter a code or a comment for the update that you are
writing out.

If you delete objects and share the deletion to the sharing service, the
deletion is shared with other users, and the deleted objects cannot be
recovered.

2. Continue working with the model. 

Note that if several users modify the same objects at the same time, the
model will contain the changes by the user who first wrote out the
changes.

Reserve the next write out
1. On the File menu, click Sharing --> Reserve next write out.

2. In the Reserve next write out dialog box, write a comment about why
you are reserving the next write out.

3. Click Reserve. 

When you have reserved the next write out, the Write out icon on the

Quick Access Toolbar shows a yellow arrow  for all users of the model.
Placing the mouse pointer on top of the icon shows who has reserved the
next write out and the comment written in the Reserve next write out
dialog box.

Other users cannot write out while you have the next write out reserved.
If another user has started writing out when you reserve the next write
out, the write out of the other user is canceled only if data transfer has
not started yet. The other user will get a notification if the write out is
canceled.

4. To write out the changes you have made, on the File menu, click Sharing
--> Write out. 

Note that you may need to read in (page 27) before you can write out.

5. In the Reserve next write out dialog box, enter a comment about the
changes that you have made.

6. Click Release. 
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When you have written out, the arrow in the Write out icon on the Quick

Access Toolbar changes to green again . Other users can now write
out normally.

You can also release your write out reservation without writing out. To do this,
on the File menu, click Sharing --> Release reservation without write out.
Note that if you do not write out or release the reservation within 24 hours,
Tekla Structures will automatically release the reservation. An administrator
can also release the write out reservation in Management Console for Tekla
Model Sharing at any time.

Share your model changes automatically
If you want to automate sharing your model changes, you can use the Sharing
automation tool from the Applications & components catalog.

The Sharing automation tool first reads in and then tries to write out the
changes until it succeeds. The tool is useful if there are many packets to read
in (page 27) and you want to make sure you get the write out done, or if you
want to have the packets read in when you arrive at the office.

You can also use the tool just to automate read in (page 27) to keep your local
model updated with changes made by other users of the model. You can
select the date and set the time for the read in.

1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Define the settings that you want to use: 

Option Description
Write out now until
successful

Select this option to write out your changes
immediately. Note that before writing out, the tool
reads in other users' changes.

Create baseline If you are the Owner of the shared model, you can
select this option to create a baseline (page 39)
when writing out.

Close Tekla Structures
after successful write
out

Select to close Tekla Structures after write out.

Closing Tekla Structures releases licenses and may
help with license management.

Code Enter the code of the model, for example.
Comment Enter a comment, if needed.
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Option Description
Delayed read in at Select the date and set the time at which you want

to read in. If you have not selected Write out now
until successful, the tool only reads in.

If you have selected Write out now until
successful, the tool first reads in and writes out,
and then starts waiting to read in at the set date
and time.

Using the tool to only read in can be useful if your
local model has changes that you do not wish to
share but you want to get changes from others.

3. Click OK to start to tool.

See also

What is shared in Tekla Model Sharing (page 46)

Detect sharing changes and view the sharing history in Tekla Model Sharing
(page 31)

Best practices in Tekla Model Sharing (page 58)

Detect sharing changes and view the sharing history in
Tekla Model Sharing
To see how the model has been changing and who has shared their model
changes, use the sharing change detection and sharing history to see what
kind of changes the model includes.

Detect changes
After you have either read in (page 28) the model changes from the sharing
service (page 10) or made changes in the local model, you can view the
changes that have been made in more detail. A list of changes is shown at the
bottom of the screen. The changes are visualized with colors both in the
Changes list and in the model.

To Do this
Open the changes
list

Do one of the following:

• On the Quick Access Toolbar, click the Show read in

changes icon .

• Click File --> Sharing --> Show read in changes.
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To Do this
• To automatically show the list after each read in,

select the Show changes after read in option in File
--> Sharing --> Sharing settings .

View changes in
the list

• Click the separate tabs to see the changes according
to how they affect the model.

The changes are divided to the following tabs: Physical
objects, Other objects, Drawings, Options, Attribute
definitions, Model folder files, and UDA changes.

The changes are visualized with colors in the list.

Deleted objects are listed in the Changes list but they
do not have any information available in the Name
column.

The UDA changes tab includes user-defined attributes
that have a definition included in the environment.db
file. Reference objects are detected as changed if there
are physical or material changes.

Tabs do not exist if there are no items on the tab. If the
tab content becomes empty because of filtering, the tab
is no longer shown.

View changes in
the model

• Select the Select objects in the model check box
and a row in the list to highlight the changed objects
in the model.

The changes are visualized with colors in the model.
Deleted objects are not visualized in the model.

• Added objects = green

• Modified objects = yellow

• Conflicting objects = orange

• Existing objects that have not been modified by
another user = gray
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To Do this
View changes in
drawings

You can list the different versions of the same drawing in
conflict situations, show their snapshots, and change the
current drawing version. You can also view a modified
drawing and its snapshot, or clone drawings from other
models.

When users modify the same drawing in their local
version of the model and one user writes out, the
Changes list will show a conflict in other users' local
version of the model when they read in.

To view the versions of a drawing, do the following:

1. Select the changed drawing on the Changes list.

2. Right-click the drawing.

3. On the context menu, select Open versions.

The Drawing versions dialog box opens.

In the Drawing versions dialog box, you can select a
drawing version, right-click and open the selected
version. You can save the drawing version and write out
to make the selected drawing version the current
version for all users.

Filter changes in
the list

On each tab, you can filter the changes in every column.

1. Hover the mouse pointer over the column.

2.
Click the filter icon  next to the column name.

3. Select how you want to filter the changes.

The name of the selected filter is shown at the bottom
left corner of the list.

If you right-click the filter icon , you can, for example,
sort the columns.

Edit the filter 1.
Right-click the filter icon .
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To Do this
2. In the context menu, select Filter Editor....

The Filter editor dialog box opens. You can edit the
selected filter as needed, or create a new filter.

Zoom to changed
objects in the
model

• Select the Zoom to selected check box, and click a
row in the list to zoom to the changed object in the
model.

Search for specific
changes

• Type a search word to the search box on the bottom
right corner of the list.

Move the Changes
list somewhere
else on the screen

You can:

• move the list around the screen

• drag the list to a second screen

• dock the list to the side pane or to the bottom of the
screen

The list has a button, , in the side pane. If you drag
the list to a second screen, click the button to return the
list to the main screen.

Add new columns
to the Changes list
or bring back
hidden columns

1. Right-click the column title.

2. On the context menu, select the column that you
want to add to the Changes list.

3. Hold down the left mouse button and drag the
column to the desired location.

4. Release the left mouse button.

View the sharing history
After you have read in and written out (page 28) model changes, you can check
the sharing history of the model. The Sharing history dialog box shows:

• All your read in and write out events

• The packets included in each read-in and write out event

• The changes that you have made to the model locally and have not yet
shared

You can check the sharing history event-by-event, and see how the model has
evolved by the changes made by other users.
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To Do this
Open the sharing
history

• On the File menu, click Sharing --> Sharing history .

Check the read in
and write out
events

• To see all your read in or write out events and their
date and time, click the Collapse all button.

Check the packet
information

• To see all the packets in each read in or write out
event, click the Expand all button.

The packet information shows:

• The packet number

• The user who wrote out the packet

• The packet upload date and time

• The code and comment of the update that is
included in the packet

If the comment is too long, it is not shown entirely.
View the model
changes included
in a single event

• Select the event and click the Show changes button.

A list of model changes is displayed at the bottom pane
of Tekla Structures.

View the local
model changes

To view the changes that you have made to the model
but have not yet written out:

• Select Local non-shared changes and click the
Show changes button.

A list of local model changes is displayed in the bottom
pane of Tekla Structures.

The Undo history  dialog box lists all the commands that you have run and
the modifications that you have done in your local version of the model. The
Undo history list is cleared when you read in or write out.

See also

What is shared in Tekla Model Sharing (page 46)

Best practices in Tekla Model Sharing (page 58)

Set object locks, drawing locks, and privileges in Tekla
Model Sharing
You can use object locks, drawing locks, and privileges to prevent other users
from accidentally modifying the shared model objects and the shared
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drawings, and to control other users' access to particular attributes, files, and
settings.

Set object locks
You can lock assemblies and cast units, and model objects to prevent
accidental modification and numbering of objects. This is useful when there
are multiple organizations working with the same shared model, and the
organizations want to prevent changes to the assemblies, cast units, and
model objects that they have created.

Organization lock means that assemblies, cast units and model objects are
locked so that users who are not employees of a particular organization
cannot modify them. The assemblies, cast units and model objects are marked
as locked For others in the Object locks dialog box (Manage > Locks). We
recommend that you use the Assemblies option for locking as this also
prevents the editing of objects in the assembly.

NOTE The organization information is based on the Windows user account, not on
the Trimble Identity.

We recommend that you use the XS_OBJECTLOCK_DEFAULT advanced option
to set the default lock status to ORGANIZATION so that assemblies, cast units
and model objects are automatically locked For others when they are created.

Set the default organization lock status

You can automatically set the default lock status for all new assemblies and
cast units when they are created. Use the XS_OBJECTLOCK_DEFAULT advanced
option to set the default lock status. The default lock status can be 
ORGANIZATION or NO. When you start to share the model, the default lock
status is set for all assemblies and cast units that do not have any lock status
yet.

To set the default organization lock status:

1. On the File menu, click Settings --> Advanced options --> Modeling
Properties.

2. Set the XS_OBJECTLOCK_DEFAULT advanced option to ORGANIZATION.

3. Click OK.

All new assemblies and cast units are locked for your organization, and
their lock status in the Object locks dialog box is For others. The users in
your organization can modify the objects in the assemblies and cast units.
Note that users who are not in your organization see the locked status as
For us.

Change the lock statuses

To change the lock statuses:
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1. On the Manage tab, click Locks.

The Object locks dialog box opens.

2. Select the objects in the model.

You can select the objects on the assembly and cast unit level, or on the
model object level. Use the Assemblies and All object types options, and
the Sub-objects check box to define the level of selection.

3. Click the Add objects button  to add the assemblies, cast units, or
the objects to the list.

Once the objects are on the list, you can check their Object type, Name
and Locked status.

4. To change the status of the locks, select the assemblies or objects in the
list or in the model, and a new lock value from the list at the bottom of the
dialog box, and click Set.

The lock status is changed.

How the object locks are set What is locked
Assembly is set to Organization (the
Locked status is For others) and the
objects in the assembly are set to No.

Assembly and the objects in the
assembly are locked for your
organization, and users in your
organization can modify the assembly
or the objects in the assembly.

Users in other organizations cannot
modify the assembly or the objects in
the assembly. Assembly and the
objects in the assembly are green in
the model.

Assembly is set to Yes and the objects
in the assembly are set to No.

Assembly and the objects in the
assembly are locked for all users, no
one can modify the object.

Assembly and the objects in the
assembly are red in the model. It is
not possible to delete, modify or
number the assembly or the object.

Assembly is set to No and the objects
in the assembly are set to No.

Assembly or the objects in the
assembly do not have any locks,
anyone can modify the objects.

Assembly and the objects in the
assembly are green in the model.

If you want to clear the list, click the Reset data button .
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You can use the following template fields in report templates to report the
lock statuses: ASSEMBLY.OBJECT_LOCKED, ASSEMBLY.OWNER_ORGANIZATION
and ASSEMBLY.LOCK_PERMISSION.

In addition, you can use the object representation to visualize the locks. When
you share the object representations, other members in the project can
visually check the lock statuses.

Set drawing locks
You can lock drawings to prevent accidental modifications and to reserve
drawings for editing. If a drawing is locked and the lock is shared, use a
snapshot instead.

1. Read in (page 28) all the model changes.

2. Open Document manager, enable direct editing , and click the Lock
column next to the drawing.

The Locked by column in the Document manager shows the user who
has locked the drawing.

3. Write out (page 28) to share the drawing lock information.

4. To edit the drawing, open the drawing locks.

5. Edit the drawing as needed.

6. Write out to share the updated drawings.

The drawing can also be unlocked, unless unlocking drawings has been limited
to only particular users in the privileges.inp file. If the drawing is unlocked
and a user writes out the changes they made, the changes made by the
original lock owner are overridden.

Set privileges
The user who has created the model, or anyone in the same organization, can
control certain access rights to the model using privileges (page 108). In
practice, the privileges of the model are controlled via the privileges.inp
file. All users can change the status of locks unless the access rights are limited
in the privileges.inp.

By modifying the privileges.inp file, you can control the access to:

• modify user-defined attributes (page 108)

• modify numbering settings (page 108)

• save standard files (page 108)

To change the access rights:

1. Close the model.
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2. Open the privileges.inp file in any text editor.

The privileges.inp file is usually found under the ..\ProgramData
\Trimble\Tekla Structures\<version>\environments
\<environment>\ folder. The exact file location may vary depending on
the folder structure of your environment files.

3. Change the desired settings and save the privileges.inp file to your
model folder.

4. Re-open the model.

5. Write out (page 28) to share the privileges information.

See also

Share a model in Tekla Model Sharing (page 18)

Create a baseline for a model in Tekla Model Sharing
If you are the Owner of a model in Tekla Model Sharing, and you want to keep
a record of the current progress in the model or you want to make the model
faster to join for a new user, you can create a new starting point for the model
in the sharing service. This new starting point is a baseline. Baseline is a
snapshot of the current state of the model. When you create a baseline, a full
model is created and uploaded to the sharing service. We recommend that the
Owner creates a new baseline when a new user has been invited to the
model. Existing users do not need to re-join the model after a new baseline
has been created.

1. On the File menu, click Sharing --> Create baseline .

2. Enter a code or a comment, if entering revision comments has been
enabled in the Sharing settings (page 42) dialog box. 

A full model is written out (page 28) to the sharing service. Files and
folders that have been excluded from the sharing are not included in the
baseline.

If you need to read in while you are creating the baseline, you need to
repeat the Create baseline command after you have read in other users'
changes.

If you make changes in the model before creating the baseline, an
incremental update packet is created before the baseline. This ensures
that no model data is lost and that the users of the shared model do not
need to join the model again.

3. If needed: Invite someone to join (page 23) the model. 

When the new user joins the model, the Available updates list opens.

The user can then select a baseline or an update to join. The Available
updates list shows all the baselines and the updates after the latest
baseline. You can select any baseline or update to join, not only the latest.
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By joining an earlier baseline or update you can go back in the model
history, and, for example, check the model state on a certain date.

Joining a baseline is beneficial for users who join the model when there
already are many changes made. Joining a baseline instead of an update
is also faster.

After joining a model, only incremental update packets are read in from
the sharing service (page 10).

TIP You can also create a baseline using the Sharing automation tool
(page 30) from the Applications & components catalog.

See also

Share a model in Tekla Model Sharing (page 18)

Collect model history in Tekla Model Sharing
In Tekla Model Sharing, you can collect model history information on the
actions made in a model. The model history of a shared model shows when
the model has been changed, how the model has changed, and who has made
the changes.

Collect model history in Tekla Model Sharing
To start collecting model history, do the following:

1. On the File menu, click Settings --> Advanced options --> Speed and
Accuracy .

2. Ensure that XS_COLLECT_MODEL_HISTORY is set to TRUE. 

Tekla Structures automatically sets XS_COLLECT_MODEL_HISTORY to TRUE
when a model is shared.

3. Set XS_CLEAR_MODEL_HISTORY to FALSE.

4. Click OK.

5. To view model history, do one of the following: 

• On the ribbon, click  and select an object in the model.

The model history is shown in the Inquire object dialog box.

If the Enable write out revision comment option has been selected
in the Sharing settings dialog box, the revision comments are
displayed as well.
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• Create a model history report.

a. On the Drawings & reports tab, click Reports.

b. Select a report template that shows the model history.

The name of the report template may vary in different
environments. In the Default environment, the report template is
called Q_Model_History_Report.

c. Click Create from all to create a report on all the objects in the
model, or select one or more objects in the model and click
Create from selected to create a report from the selected
objects.

Offline usage history is stored according to the Windows domain user account.
Note that in Tekla Model Sharing models, when you write out your changes to
the sharing service, the changes are stored using your Trimble Identity.

Clear model history in Tekla Model Sharing
Clearing the model history of a shared model can improve the performance of
a large shared model in Tekla Model Sharing and save disc space. Note that if
you clear the model history, the model history information can no longer be
used in the Tekla Structures user interface, reports, or Tekla Open API.

Before you clear model history, ensure that:

• The information stored in the model history is no longer needed.

• All users in the shared model have written out all their changes.

• You are the only user currently working on the shared model. We
recommend that you delete the model history at a quiet time, such as
during the weekend.

NOTE Do not delete the history.db file in order to clear the history of a
shared model. The history.db file is incrementally shared, and
deleting the file can cause errors in the shared model.

1. Open the shared model whose history you want to delete.

2. On the File menu, click Sharing --> Reserve next write out .

3. In the Reserve next write out dialog box, write a comment about why
you are reserving the next write out.

4. Click Reserve.

5. On the File menu, click Settings --> Advanced options --> Speed and
Accuracy .

6. In the Advanced Options dialog box, set the XS_CLEAR_MODEL_HISTORY
option to TRUE.

7. Click OK.
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8. Save the model.

9. Restart Tekla Structures.

10. Open the model folder and ensure that the size of the history.db file
has been reduced.

11. Write out (page 28) the baseline.

Other users should now join the new baseline (page 23) you have written out.

Tekla Model Sharing settings
To modify the basic Tekla Model Sharing settings, use the options in the
Sharing settings dialog box in File --> Sharing --> Sharing settings.

Option Description
Model folder file
sharing

Click the Exclude button to define files or folders
in the model folder that you do not want to share.

• Tekla Model Sharing
cache

• Name and Port

You can set up a separate Tekla Model Sharing
Cache service to be used with the Tekla Model
Sharing service. With the Tekla Model Sharing
Cache service, the model data is stored to the
sharing service and then cached inside a LAN. This
set-up is useful especially if there are several Tekla
Model Sharing users in the same location, or a
narrow bandwidth to the Internet. Using a cache
reduces the download effort.

The first user who reads in a packet from the
sharing service loads it to the cache, and the next
user gets the data faster from the cache inside the
LAN than from the sharing service through the
Internet. The cache is not used for packets that
are written out.

• Name is the name of the computer on which
the cache is installed.

To check the computer name, click Windows
Control Panel --> System and Security -->
System .

• Port is the cache service port number that you
have set when you installed the cache service.

The default value is 9998.

• Click the Set button to connect to the cache.
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Option Description
• Alternatively, you can set the advanced option

to ”name of the server”;”port” in a .ini
file. This advanced option is user-specific.

To reset the cache settings in the dialog box to
the ones defined in the .ini file, click the
Reset button. If any .ini file has the advanced
option defined, the settings appear in the
dialog box.

Show available updates
when joining the model

Select the check box to enable a list that shows all
the available baselines and updates (page 39)
when you join the model.

The Available updates list shows all the baselines
and the updates after the latest baseline. You can
select any of the available baselines or updates to
join, not only the latest. By joining an earlier
baseline or update you can go back in the model
history, and, for example, check the model state
on a certain date.

Alternatively, you can set the advanced option to 
TRUE in a .ini file to enable the showing of
updates. This advanced option is user-specific.

Show available updates
when reading in the
changes

Select the check box to enable a list that shows all
the available updates (page 28) when you read in
the model changes.

The Available updates list shows all the available
updates. You can select any of the available
updates to be read in, not only the latest. By
reading in an earlier update you can go back in the
model history, and, for example, check the model
state on a certain date.

Alternatively, you can set the advanced option to 
TRUE in a .ini file to enable the showing of
updates. This advanced option is user-specific.

• Show changes after
read in

• Only when conflicts
exist

Select the check box to enable a list that shows the
model changes (page 28) after you have read in. If
you select the Only when conflicts exist option,
the list is shown only when there are conflicts in
the model after read in.

Alternatively, you can set the advanced options
and to TRUE in a .ini file to enable the showing
of model changes. These advanced options are
user-specific.
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Option Description
Enable write out
revision comment

Select the check box to enable the entering of
revision comments.

When you write out, you can enter a revision
comment and code in the comment dialog box. If
you enable the revision comments, the comment
dialog box is displayed for all the model users.

Alternatively, you can set the advanced option to 
TRUE in .ini files to enable the revision
comment. This advanced option is model-specific.

• Copy project folder
files to model folder

• Copy firm folder
files to model folder

• Overwrite model
folder files

If you have stored files, such as property files,
report templates (.rpt), or graphical templates
(.tpl) in a project folder or a firm folder, or their
designated sub-folders, you can copy the files to
the model folder. Files that are placed to the
model folder are synchronized by Tekla Model
Sharing. This means that by having copies of the
files in the model folder, you can ensure that the
files are shared and synchronized appropriately.

Select whether the project or the firm folder files
are copied to the model folder that you are going
to share. Select the check boxes and click the
Copy files button. We recommend that you copy
files from the project and firm folders.

You can also select whether the copied project or
firm folder files replace the existing files of the
same name in the model folder.

Individual files can be copied to the model folder
at any time. The next time you write out, the files
are shared to all model users.

See also

Best practices in Tekla Model Sharing (page 58)

Exclude a model from the sharing service in Tekla Model
Sharing
If needed, you can exclude yourself and your local version of the model from
the sharing service.

When you exclude a model, your local version of the model is no longer
connected to the sharing service and you cannot share your changes
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anymore. However, the model instance still exists in the sharing service and
other users can continue working with the model normally.

NOTE After you have excluded your local version of the model from the
sharing service, you cannot merge the excluded model back to the
original shared model. The excluded model is completely new and it
has no connection to the model in the sharing service.

All users, regardless of their user role (page 18) (Owner, Editor, Project
viewer, Viewer), can exclude their local version of the model from the sharing
service.

1. On the File menu, click Sharing --> Exclude from sharing . 

A confirmation message is displayed.

2. Click Continue. 

Your local version of the model is disconnected from the sharing service,
and you cannot write out or read in (page 28) changes anymore.

The model automatically becomes a single-user model.

After you have excluded your local version of the model from the sharing
service you can

• continue working with the model in single-user mode.

• start working with the model in multi-user mode (page 45).

• start working with the model again in Tekla Model Sharing.

If you would like to start working again with the excluded model in Tekla
Model Sharing, you can either

• start sharing (page 18) the model and invite other users to join the model.

If you start to share the model, the model is completely new and it has no
connection to the previous model in the sharing service, even though the
model retains its old name.

• join (page 23) the same model again in the Shared models dialog box in
File --> Sharing --> Browse shared models.

When you join the model, you can select a baseline or an update (page 39)
to join.

If you join the model again, you need to save a new local version of the
model on your computer. If you do not change the name of the model, you
may have several models that have the same name in the Shared models
dialog box. All these local versions of the model need to be saved in
different locations on your computer, because you cannot have two or
more models of the same name in the same folder.
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Convert a shared model to a multi-user model in Tekla
Model Sharing
If needed, you can stop working with a shared model in Tekla Model Sharing
and convert your local version of the model to a multi-user model.

A model cannot be simultaneously shared and used in multi-user mode
(page 92). If you want to start using multi-user mode as a means to share
your model instead of Tekla Model Sharing, you need to first exclude your
local version of the model from the sharing service and then convert it to a
multi-user model.

NOTE The excluded model has no connection to the original shared model
in the sharing service. This means that if you exclude your local
version of the model from the sharing service and start to use the
model in multi-user mode, you cannot later merge the original shared
model and the multi-user model.

1. Exclude your local version of the shared model from the sharing service to
make it a single-user model:

a. Open the shared model that you want to convert to a multi-user
model.

b. On the File menu, click Sharing --> Exclude from sharing . 

A confirmation message is displayed.

c. Click Continue. 

The model automatically becomes a single-user model.

Your local version of the model is disconnected from the sharing
service, and you cannot write out or read in changes anymore.
However, the model instance still exists in the sharing service and
other users can continue working with the model normally.

2. Convert the current single-user model to a multi-user model:

a. On the File menu, click Sharing --> Convert to a multi-user model.

b. Enter the multi-user server name or select the name from the list in
the Convert to multi-user model dialog box.

c. Click Convert. 

The current model is converted to a multi-user model and you can
start using the model in multi-user mode.

See also

Share a model in Tekla Model Sharing (page 18)
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1.3 What is shared in Tekla Model Sharing
By default, all the model data is shared when you share a model in Tekla
Model Sharing.

How data is shared in Tekla Model Sharing depends on the type of the shared
data.

• Some data is shared incrementally.

This means that only the new and changed data is shared. When you read
in, the data that is fetched from the sharing service is merged to the data
on your computer.

NOTE You cannot remove or replace incrementally shared databases.
The compatibility of incrementally shared databases is checked
when the model is opened.

• Some data is shared, but it cannot be updated incrementally.

When you read in, the data that is fetched from the sharing service
overwrites the data on your computer.

• Some data is not shared.

Empty folders under the model folder are not shared.

By default, Organizer data is not shared.

However, you can use the Organizer import and export with Tekla Model
Sharing to share Organizer changes.

NOTE Some of the catalog files that are located in the environment folders
(rebar_database.inp, assdb.db, screwdb.db, matdb.bin, profdb.bin)
are copied to the model folder when the sharing is started.

How data is shared
If you want to check the files that have been overwritten when you read in,
click File --> Sharing --> Open file backup folder to open the
\ModelSharing\BackUpEnv folder under the model folder. The folder
contains overwritten files from the three latest read ins. You can then, for
example, copy the files back to your model or check the files for change
detection.

NOTE We recommend that you do not remove or replace any databases. If you
remove or replace a database, you must create a new baseline of the model.
All other users must then join this new baseline, and then continue reading in
packets.
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Databases

 Description
Model database Model database .db1 is shared incrementally.
Numbering
database

Numbering database .db2 is shared, but it cannot be
updated incrementally.

If you have modified the family numbering settings and
you read in, you lose the changes if another user has
changed the family numbering settings and has written
out.

NOTE We recommend that one user updates and
shares the numbering settings with other users
by writing them out. In case the user needs to
read in before writing out the numbering
updates, it is important to check that the
settings are as they were before starting to
share them.

We recommend you to use the Number series
of selected objects command on the
Drawings & reports tab when numbering.

Create your model output, such as drawings, reports,
NC files and IFC files, after a successful write out.

Model history
database

Model history database history.db is shared
incrementally.

Plan database Plan databases .db3 are shared, but they cannot be
updated incrementally.

If you have imported a CIS/2 or a SDNF model and you
read in, you lose the plan database changes if another
user has imported the same CIS/2 or SDNF model and
has written out.

Analysis model
database

Analysis model database .db6 and analysis results
model database .db5 are shared, but they cannot be
updated incrementally.

If you have modified an analysis model and you read in,
you lose the analysis model changes if another user
has changed the same analysis model and has written
out.

Custom
components and
sketched profiles

Custom components and sketched profiles database
xslib.db1 is shared incrementally.
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 Description
Standard-part
model database

Standard-part model .db1 is shared when you save the
standard-part model in a separate folder under the
model folder.

Ensure that XS_STD_PART_MODEL is set relative to the
model folder and that it points to the correct standard-
part model, for example, 
XS_STD_PART_MODEL=.\StandardParts\.

Catalogs

 Description
Profile catalog Shared model contains the profile catalog file

profdb.bin.

When you add and use a new profile definition in the
shared model, the definition is shared the next time
you write out. When another user reads in this new
definition, the profdb.bin file in the user's model
folder is updated to include the added definition.

You can also update (page 53) the profile catalog with
new definitions without creating any new objects or
change the existing profile definitions of a profile that
is already used in the model.

Rebar catalog Shared model contains the rebar catalog file
rebar_database.inp.

When you add and use a new rebar definition in the
shared model, the definition is shared the next time
you write out. When another user reads in this new
definition, the rebar_database.inp file in the user's
model folder is updated to include the added
definition.

You can also update the rebar catalog with new
definitions without creating any new objects.

Bolt catalog

Bolt assembly
catalog

Shared model contains the bolt catalog file
screwdb.db and the bolt assembly catalog file
assdb.db.

When you add and use a new bolt definition or bolt
assembly definition in the shared model, the definition
is shared the next time you write out. When another
user reads in this new definition, the screwdb.db and
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 Description
assdb.db files in the user's model folder are updated
to include the added definition.

You can also update the bolt catalog and bolt assembly
catalog with new definitions without creating any new
objects.

Material catalog Shared model contains the material catalog file
matdb.bin.

When you add and use a new material definition in the
shared model, the definition is shared the next time
you write out. When another user reads in this new
definition, the matdb.bin file in the user's model
folder is updated to include the added definition.

You can also update the material catalog with new
definitions without creating any new objects.

UDAs, options, views, pour units

 Desription
User-defined
attribute (UDA)
definitions

When a model is created, the user-defined attribute
definitions are read from the objects.inp files and
the definitions are stored to the environment.db
database. Modified and added new attribute
definitions are shared incrementally.

New attribute definitions are added to the database
automatically when the model is opened. If the current
objects.inp file has a different definition than the
environment.db, it is possible to take changes to use
by clicking File --> Diagnose & repair --> Diagnose
and change attribute definitions .

If the objects.inp file is in the model folder, it is
shared as a file and it overrides the local objects.inp
file when you read in.

Options When a model is created, the options are read from
the options.ini files and the model-specific options
are stored to options_model.db and
options_drawings.db databases.

Model-specific options can be modified using the
Options and Advanced Options dialog boxes.
Modifications to model-specific options are shared
incrementally.

• Some of the options are of the type SYSTEM(ROLE).
These options are read from the .ini files and are
not shared. It is possible to change SYSTEM(ROLE)
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 Desription
model option to MODEL(ROLE) option and the
drawing option to DRAWINGS(ROLE) option. The
options are then stored to the options_model.db
or options_drawings.db databases in the model
folder, and the value is shared incrementally.

• Some of the options are of the type USER. These
options are user-specific and they are not shared.

• Some of the options are of the type SYSTEM. These
options are user-specific and they are not shared. It
is possible to change a SYSTEM option to a
MODEL(SYSTEM) option. If you change a SYSTEM
option to MODEL(SYSTEM), the changed value only
works for the current model. These options are not
shared.

Other important
files in the model
folder

The database ID range mapper file db.idrm and the
library database ID range mapper file xslib.idrm are
related to the handling of IDs. These files are needed,
for example, to open drawings that have been created
in single-user or multi-user modes.

The plotdev.bin file contains the print device
definitions that you create in Printer Catalog (old
printing). The file is shared when located in the model
folder.

NOTE If your project has users that work in different
offices and with different printers, you should
not save any local changes to the
plotdev.bin file in the model folder. Save the
local changes in the XS_FIRM folder instead.

View sharing By default, views are not shared. Views are shared if
they have a name, and the Share option in the View
Properties dialog box is set to Shared.

Note that when you join a model, you get all the model
views but changes to the views are not shared if the
Share option is set to Not shared.

Pour unit
information

Automatic assignments of objects to pour units are not
shared. The Calculate pour units command has to be
run in the local versions of the shared model to update
the pour units.

If XS_CALCULATE_POUR_UNITS_ON_SHARING is set to 
TRUE (which is the default value), Tekla Structures
automatically calculates and updates the pour units
during writing out and reading in.
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 Desription
If XS_CALCULATE_POUR_UNITS_ON_SHARING is set to 
FALSE, each user has to run the Calculate pour units
command in their local version of the shared model to
update the pour units.

Manual assignments created by using the Add to pour
unit and Remove from pour unit commands are
shared.

Exclude files and folders from Tekla Model Sharing
By default, files and folders in the model folder are shared when you share a
model in Tekla Model Sharing. If you do not want to share all of the model
folder files or folders, you can select to exclude some of them from sharing.

NOTE Tekla Model Sharing works only if the model is the same for all users.
Tekla Structures takes care of model-specific data sharing. You can
only exclude files that do not have an effect on the model. You cannot
exclude any of the databases that are in the model folder, xslib.db1,
for example.

Empty folders under the model folder and some files are excluded
automatically.

1. On the File menu, click Sharing --> Sharing settings . 

The Sharing settings dialog box opens.

2. Click the Exclude button to see which files and folders in the model folder
are excluded from sharing, and to exclude more files or folders. 

Some of the files and folders are excluded automatically from sharing.
These files and folders appear on the Excluded model folder files and
directories list, and they cannot be removed from the list.

a. If you want to exclude more folders or files, click the Directory or the
File button.

b. Select the folder or the file to be excluded. 

The excluded folders and files are added to the Excluded model
folder files and directories list.

If you exclude a folder, all its sub-folders and sub-files are also
excluded from Tekla Model Sharing.

You can exclude files in several ways. For example, if you have a file
called TeklaStructures.bbb, and you use the following settings to
exclude the files:
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Option Description
(x.x) TeklaStructures.bbb is excluded from sharing.
(x.*) All the files with TeklaStructures. are excluded from sharing.
(*.x) All the files with .bbb are excluded from sharing.
(*.*) All the files from that folder, but not from its sub-folders, are

excluded from sharing.

c. If you want to remove the added folders or files from the list of
excluded files, click Remove. 

You cannot remove a folder or a file that has been excluded
automatically.

3. Click OK when you have finished selecting the excluded files.

How to share catalog updates
Sometimes you may need to update catalogs with new definitions, such as
new profiles, and share the changes without creating any objects with the new
definitions.

1. Ensure that all users on the shared model write out (page 28) their
changes.

2. Read in (page 28) all the model changes.

3. Update the needed catalogs.

4. Create a new baseline (page 39).

5. Ensure that all users join (page 23) the created baseline. 

After users have joined the baseline:

a. Ensure that users check that their settings for excluded files and
folders are up-to-date in File --> Sharing --> Sharing settings -->
Exclude, or that they copy the FileSharing.ini file from the
previous local version of the model in ..\TeklaStructuresModels
\<model>\ModelSharing\Settings.

b. Ensure that users remove their previous local versions of the model.

How to share Organizer data
By default, Organizer data is not shared. However, you can use the Organizer
import and export with Tekla Model Sharing to share Organizer changes.

1. Select a user who is responsible for the Organizer data. This is User A.
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2. User A creates the Organizer data and exports the data to a model
subfolder. 

Note that the selected folder cannot be the default ProjectOrganizer
folder.

3. User A writes out (page 28).

4. User B reads in (page 28) and notices that there is new data available.

5. User B opens Organizer and imports the data that User A has exported.

6. User B removes the old Organizer data and saves the model.

7. User A updates the Organizer data, exports the update and writes out.

8. User B reads in and imports the updated data to Organizer. 

The data appears as new in Organizer. User B removes the old data.

How different object types work in shared models
When several users modify the model at the same time in Tekla Model
Sharing, conflicts may occur.

In general, all object types work similarly in Tekla Model Sharing. When you
read in, the changes in the incoming packet override your local changes to the
same object. In other words, if several users modify the same object, the user
who first writes out the changes to the sharing service wins in conflicts.

Before you start to share models, agree on common ways of working. For
example, you can agree that users work on different areas of the model.

Object / Property Description
Model objects A shared modification to an object property

overrides any other object property modification.

For example, one user modifies a beam profile and
writes out. Another user has modified the material
of the same beam and reads in. The user who
modified the beam material loses the changes,
because the shared changes override the local
changes to the same object.

Family numbering Check the family numbering settings.

Family numbering settings are shared but cannot be
incrementally updated. We recommend that one
user first reads in all the packets, makes the updates
and then shares the settings by writing them out. If
the user needs to read in before writing out, it is
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Object / Property Description
important to check that the settings are as they were
before starting to share them.

Give start numbers in wide ranges so that you do not
run out of numbers within a numbering series, and
that any numbering series does not overlap with
another.

We recommend you to use the Number series of
selected objects command on the Drawings &
reports tab when numbering.

Grids If there is a conflict in sharing grids, grids are
recreated using the original values that have been
set in the grid properties. Any manually added grid
lines are lost.

For example, when two users modify a grid by
adding extra grid lines and write out, the added grid
lines disappear from the model when they read in.

Catalogs Check the catalogs so that they include all the
needed definitions.

Starting from Tekla Structures 2018, the shape
geometry files that are in .xml format are
automatically converted to .tez format in shared
models.

User-defined
attributes (UDAs)

A shared change to a user-defined attribute (UDA)
overrides changes to the same UDA only.

For example, a change in the Comment UDA
overrides a change to the Comment UDA but not to
the Shorten UDA.

A shared change to a part does not override UDA
changes and vice versa.

Part and the related
component

A shared change to a part does not override
component changes and vice versa.

Custom components If a user deletes a custom component from the
Applications & components catalog in the local
version of the shared model, reading in causes an
instance of the custom component to appear in the
model even if the component was not used in the
model.

You cannot edit the component instance in the
model. If you need to edit the component, explode it
first.
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Object / Property Description
Drawings There can be duplicate drawings from the same part.

For example, two users create drawings from the
same part when they are working on their local
versions of the shared model. When both users write
out their changes, two drawings appear in
Document manager. Tekla Structures does not
delete either of the drawings, and it does not merge
the changes from the drawings. You need to visually
check the drawings and decide which drawing to
delete, or to use drawing locks (page 35) to prevent
other users modifying the drawings.

Pours Agree whether pour management will be used in the
model and set XS_ENABLE_POUR_MANAGEMENT
accordingly.

If pour management is enabled in the model, do not
disable it using XS_ENABLE_POUR_MANAGEMENT,
especially in the middle of the project. This may
cause problems if you have drawings containing
pour objects, and if you are sharing your model. The
pour objects and pour breaks in the model and in
the drawings may get invalid, and you may lose all
pour-related modeling work.

Automatic assignments of objects to pour units are
not shared. The Calculate pour units command has
to be run to update the pour units.

• If XS_CALCULATE_POUR_UNITS_ON_SHARING is
set to TRUE (which is the default value), Tekla
Structures automatically calculates and updates
the pour units during writing out and reading in.

• If XS_CALCULATE_POUR_UNITS_ON_SHARING is
set to FALSE, each user has to run the Calculate
pour units command in their local version of the
shared model when they need up-to-date pour
unit information.

For example, user 1 moves a reinforcing bar so
that it touches a pour object, runs the Calculate
pour units command to add the bar to the pour
unit, and writes out. When user 2 reads in, user 2
sees that the reinforcing bar has been moved,
but the bar has not been added to the pour unit.

Manual assignments, and other modifications to
pour objects and to the objects attached to the pour
objects (such as changes to geometry or location),
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Object / Property Description
are shared. A shared manual change in pour unit
assignment overrides a local change.

For example, user 1 adds an embed to a pour unit by
using the Add to pour unit command, and writes
out. User 2 has added the same embed to another
pour unit by using the Add to pour unit command.
When user 2 reads in, user 2 sees that the embed
has been added to the pour unit user 1 added it to.

Standard files for
numbering setup

Standard files for numbering setup are not loaded
automatically when you read in. If you want to take
them in to use, you need to reload them after
reading in.

WARNING If an object deletion has been written out to the sharing service, the
object will be deleted in your model when you read in. This happens
regardless of whether you have modified the object before reading in.
Deleted objects remain deleted if the deletion has been shared.

Deleted objects are not visualized when you read in.

How property files in the XS_FIRM and the XS_PROJECT
folders are shared
You can store property files in user-defined sub-folders under the firm or
project folders. The property files are copied and shared in Tekla Model
Sharing in two situations: when you start sharing a model, or when you have a
shared model open and click the Copy files button in the Sharing settings
dialog box.

Property files are copied and shared from the following folders:

1. The \attributes folder under the model folder.

2. The user-defined sub-folders under the XS_PROJECT folder.

If the XS_PROJECT folder is empty, Tekla Structures skips it when copying
files.

3. The user-defined sub-folders under the XS_FIRM folder.

If the XS_FIRM folder is empty, Tekla Structures skips it when copying
files.

4. The sub-folders of the environment folder.

The folders are searched in the order they are listed above. When Tekla
Structures finds the first corresponding file, that file is selected. Other
corresponding files are ignored, and the file names are stored in the error log.
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Note that if the following folders are immediate sub-folders of project or firm
folders, Tekla Structures does not read property files from the folders:

• ProjectOrganizerData
• ProjectOrganizerData\DefaultCategoryTrees
• ProjectOrganizerData\PropertyTemplates
• ProjectOrganizerData\ExcelTemplates

• AdditionalIPSets
• macros

• macros\drawings
• macros\modeling

• Drawing Details
• extensions

• extensions\drawings
• extensions\model

• CustomInquiry
• PropertyRepository\Templates
• symbols
• template

• template\mark
• template\settings
• template\tooltips

• profil
• profil\ShapeGeometries
• profil\Shapes

1.4 Best practices in Tekla Model Sharing
To keep your shared models in good shape and to share your changes
successfully, follow the Tekla Model Sharing best practices below.

NOTE The users of the same shared model need to have the same Tekla
Structures version, and use the same latest service pack.

For general Tekla Model Sharing troubleshooting instructions, see
Troubleshooting Tekla Model Sharing.
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Install the Cache service for Tekla Model Sharing
Tekla Model Sharing Cache service downloads model data from the Tekla
Model Sharing service and caches the data in the file system inside a LAN.
Using the cache service reduces the use of the Internet, resulting in faster
download times when the same data is requested more than once. Note that
the cache is not used for packets that are written out.

The cache service needs an Internet connection to download model data from
the sharing service. The first time a user fetches a packet it will be loaded to
the cache service. Any following requests to the same packet will then be
served fast from the cache service inside the LAN.

The cache service is useful even if there is only one Tekla Model Sharing user
in the same office. For example, rejoining a model is faster as the model data
is available in the cache service. In addition, the model data is always loaded
as small data blocks. This is useful if the downloading is interrupted for some
reason, because the cache service can just download the missing blocks later.

If there are several Tekla Model Sharing users in the same office, we highly
recommend you to install the Tekla Model Sharing Cache service. The cache
service is recommended especially in regions where the download speed may
be limited.

The image below shows how the model data is stored to the sharing service
and used with the Tekla Model Sharing Cache service.
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Software and system requirements for a cache installation:

• Windows Server 2008 R2, or later

• .NET Framework 4.5.1

Install a cache service in the following way:

1. Ensure that you have an active Windows computer or a server with
enough disk space to store the cached model data.

2. Download the Tekla Model Sharing Cache service installation file from
Tekla Downloads.

3. Run the installation file and follow the steps in the installation wizard to
complete the installation. 

• The default cache folder is C:\TeklaModelSharingCache. If needed,
you can change the folder destination.

Ensure that the destination folder has enough disk space for the
estimated usage of the service. The required disk space can vary from
a few gigabytes to terabytes, depending on the amount of Tekla Model
Sharing users and the size of the models.

• The default TCP/IP port number for the cache service is 9998.

Use this port number when you configure Tekla Structures client
workstations to use the cache. This port is the main communication
and control channel to the cache service.

• The default TCP/IP port number for internal communication is 9001.

This port is automatically fetched from the cache service, and it is used
for the actual data transfer.

Network access

You need to allow inbound traffic for TCP/IP ports (defaults 9001 and
9998) for the cache service host.

If the ports cause conflicts or other problems because of other services or
a firewall, you can change the ports to some other ports.

The cache service needs an Internet connection to download model
changes from the sharing service.

NOTE If you later need to modify the installation, re-run the
TeklaModelSharingCacheService.exe installation file and
select Repair. You can then change the previously set cache
folder or port numbers. To use content from the previous cache
folder, copy or move the needed content to the new folder.

4. Check that the Tekla Model Sharing Cache service has started. 
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• Locate Tekla Model Sharing Cache from the Windows services by
using, for example, the Computer Management console 
compmgmt.msc or the Services management console services.msc.

• Use Windows Event Viewer to verify that there are no errors from the
service and that there are Information messages showing that the
service has started.

5. Configure Tekla Structures client workstations to use the cache. 

In Tekla Structures, on the File menu, click Sharing --> Sharing settings .

In the Sharing settings dialog box:

• Name is the name of the computer on which the cache is installed. To
check the computer name, click Windows Control Panel --> System
and Security --> System .

• Port is the cache service port number that you have set when you
installed the cache service. The default value is 9998.

Troubleshoot the cache service installation

If you cannot connect to the service from Tekla Structures:

• Ensure that the Tekla Model Sharing Windows Service is running.

• Ensure sure that the firewalls do not block TCP/IP ports configured to Tekla
Structures, for example 9001 or 9998 when you use the default ports.

If the service does not start:

• Check the Windows Event Viewer's Application Log for possible errors.

Use GUIDs correctly in shared models
Tekla Structures objects have an identifier that is shown as an object GUID,
Globally Unique Identifier, that is also used in Tekla Model Sharing.

This means that features that do not use GUIDs need to be changed to use
GUIDs:

• Interoperability import/export actions:

• FabTrol XML

• ASCII

• All other applications, macros and report processes that rely on static IDs.
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Save local versions of shared models on your computer
We recommend that you save the local versions of shared models on your
computer instead of a network drive for two main reasons:

• The performance of shared models is better when the local models are
saved on your own computer. This means that the models open faster, for
example.

• Saving shared models on your own computer prevents other users from
accessing them and accidentally blocking important files.

If you still want to save local models on a network drive, use a private network
drive that other users cannot access.

Create baselines regularly
The Owner of a model should create baselines of the model regularly. For
example, you can create a baseline once a week.

We recommend creating a new baseline each time a new user has been
invited to the model. This way, joining the shared model is faster.

Back up shared models
We recommend you to back up the models used in Tekla Model Sharing. In
case there are problems with a shared model, it is possible to select any user's
local version of the model, or a model that has been backed up, and continue
working using that model. Make sure that you have the complete backed up
model in use and that the model folder includes, for example, drawings and
different databases. This ensures that the model functions properly and you
do not lose any data. If the backed up version of the model is old, reading in all
the changes may take some time.

Back up your models according to your company conventions, for example, by
using Windows Backup. You can also use the File --> Save as --> Save and
create backup copy command to create a backup copy of the model. The
backup copy will have the same GUIDs as the original model.

Note that the Save as command cannot be used for backing up the model. If
you use Save as, the model gets new IDs and it has no relation to the original
model. If you use the Save as command, the model history is not copied with
the saved model.

Number model objects in Tekla Model Sharing
Numbering a shared model has three main phases: reading in the changes
made by other users, numbering a series of objects, and writing out the
numbering changes. Always use the Number series of selected objects
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command when you number parts in a shared model. To avoid unnecessary
work and conflicts, do not use the Number modified objects command.

Before you start numbering objects in a shared model, you should plan the
numbering carefully. We recommend that you divide the model into phases,
and each user only numbers objects within the phase they are working on.
This way, you can avoid numbering conflicts in your shared models.

To number a phase, do the following:

1. Finish the changes you are making in the phase that you are working on.

2. Save the model.

3. Read in (page 27) the changes made by other users.

4. Review the changes and save the model.

5. Select the parts in a numbering series that have been modified. 

You can create selection filters to select objects in a specific numbering
series. For example, you can create a selection filter that allows you to
select objects with the same assembly start number.

6. On the Drawings & reports tab, select Perform numbering --> Number
series of selected objects . 

Repeat steps 5 to 6 for different numbering series, if needed.

7. When numbering has been performed successfully, save the model.

8. Write out (page 28) your changes immediately.

Use XS_FIRM and XS_PROJECT folders with shared models
Using project folders and firm folders in shared models is the easiest when
you use a sub-folder in a Trimble Connect project as the project or firm folder.

The project and firm folder information is only updated from the Trimble
Connect project to local versions of the shared models, not vice versa. In
practice, this means that Tekla Structures downloads new files from the
project or film folder to the local model and updates any changed files. If a
local file is not in the Trimble Connect project sub-folder, it is removed from
the local model.

When Tekla Structures detects a change between the local model data and the
data in the Trimble Connect project or firm folder, you get the following
notification:
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If you click Yes, the model is saved and closed. Then, the local model data is
updated and re-opened.

To set a folder in a Trimble Connect project as the XS_FIRM or the 
XS_PROJECT folder:

1. On the File menu, go to Settings --> Advanced options.

2. Depending on the option, do one of the following: 

To set a Trimble
Connect project sub-

folder as

Do this

The XS_PROJECT folder a. In the Advanced Options dialog box, find the
XS_PROJECT option.

b. Set the value of XS_PROJECT to
%CONNECT_FOLDER_SYNC%.

%CONNECT_FOLDER_SYNC% points to :\Users
\<user>\AppData\Local\Trimble\Tekla
folder sync\<folder>

c. NOTE If you use the same Trimble Connect
project as the XS_PROJECT folder and
for collaboration, you need to use a
sub-folder that is separated from the
Trimble Connect collaboration
information as the XS_PROJECT
folder. In this case, the sub-folder is
set as %CONNECT_FOLDER_SYNC%
\<folder>\<sub-folder of the
folder>.

For example, you could save the
project folder under the Project
settings folder with the name
Project. In this case, the value
should be set to
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To set a Trimble
Connect project sub-

folder as

Do this

%CONNECT_FOLDER_SYNC%\Project
Settings\Project.

The XS_FIRM folder a. In the Advanced Options dialog box, find the
XS_FIRM option.

b. Set the value of XS_FIRM to
%CONNECT_FOLDER_SYNC
%<ProjectID>;<region>.

You can see the project ID in Trimble Connect
for Browser:

The region is the same as the project server
location setting. The options are:

• asia

• europe

• northAmerica

So, for example, the value could be
%CONNECT_FOLDER_SYNC%m1G-
M21Ca_o;northAmerica.

NOTE If you use the same Trimble Connect
project as the XS_FIRM folder and for
collaboration, you need to use a sub-
folder that is separated from the
Trimble Connect collaboration
information as the XS_FIRM folder. In
this case, the sub-folder is set as
%CONNECT_FOLDER_SYNC%
\<ProjectID>;<region>
%<folder>%<sub-folder of the
folder>.

For example, you could save the
project folder under the Project
settings folder with the name
Project. In this case, the value
should be set to
%CONNECT_FOLDER_SYNC%\m1G-
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To set a Trimble
Connect project sub-

folder as

Do this

M21Ca_o;northAmerica%Project
Settings%Project.

3. Click OK to save the project or firm folder.

4. Close and re-open the model to activate the new firm or project folder.

1.5 Repair Tekla Model Sharing issues

Restore shared models
If a shared model has problems that may cause loss of working time, a
company administrator can delete the model versions that have problems
using Management Console for Tekla Model Sharing. It is also possible that a
user of a shared model restores a previous version of the model in Tekla
Structures, and that model is used in Tekla Model Sharing.

Management Console for Tekla Model Sharing provides a web-based access
for administrators to manage all shared models of an organization. An
administrator can lock a model and name one user as the lock owner who can
investigate the model in Tekla Structures. Once the lock owner finds the
problem, the administrator can delete the model versions that are causing the
problem, and then unlock the model so that it can be used normally again.

While the model is locked, the sharing commands in Tekla Structures are
available as follows:

• The Read in and Write out icons have yellow arrows . Only
the lock owner can use these commands.

• On the File menu, the Read in, Write out, Create baseline and Users
commands are available for the lock owner.

• In the Shared models dialog box, the Edit model, Manage users, and

Remove model from cloud commands , and joining a particular
model are available for the lock owner.

For other users the sharing commands are not available.

If a user of the shared model has already read in or written out any of the
model versions that the administrator has deleted, Tekla Structures shows the

Write out and Read in icons with red arrows  for this user. The
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sharing commands on the File menu are not available. The user needs to
rejoin the model.

If a user is not using any of the deleted versions, the user does not need to
rejoin.

Note that it is also possible to revert to an earlier version of the model without
further investigating it. The administrator can lock the model in Management
Console for Tekla Model Sharing, delete the versions that are not needed or
that contain errors, and then unlock the model. After this, the users need to
rejoin the valid version of the model.

Note that when model versions are deleted, the changes that have been made
in those versions are lost from the model. The changes that should be
included in the model need to be made again and read in.

Another option to take a previous version of the model into use is that a user
of the shared model performs the following steps:

1. Join (page 23) the model again.

2. Read in (page 27) the packets until you have reached the preferred level in
the model history.

3. Exclude (page 44) the model from sharing.

4. Start sharing (page 18) and invite other users again to the model. 

Ensure that all the users within the model start to use the restored
version of the model.

Rejoin the model if the model is not saved after write out
If there are errors in writing out changes to the sharing service, you may need
to rejoin the model. Tekla Structures will show you an error message if the
errors in the write out could cause database inconsistencies and corrupt
model data.

When you write out, Tekla Model Sharing does the following:

1. Saves the model.

2. Prepares the incremental packet. The data in the model folder is not
changed yet.

3. Uploads the incremental packet to the sharing service.

4. Saves the model again if the incremental packet is uploaded successfully.
Local model data is updated with the needed information.

Tekla Structures will not show you an error message if there are errors at any
step before step 4. The sharing service has not received the model update yet.
You can try to write out again as the model folder does not contain any data
that would prevent the write out. If there are new updates available for the
model, first read in the updates and then try to write out again.
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If there are errors at step 4, Tekla Structures shows you an error message
advising you to rejoin the model. After joining, you can check from the sharing
history (page 31) that your write out was uploaded to the sharing service.

Errors at step 4 mean that the model may not have been saved correctly, and
model data may be corrupted or lost. The model has several different Tekla
Structures databases each of them with their own baseline. If there are errors,
the Tekla Structures model does not have all the needed information of what
has been shared.

React to Tekla Model Sharing error messages

Message Description Do this
Failed to open model. This message appears

when the selected model
cannot be opened.

This can happen if a
model is corrupted, or if
another program is
reserving files that are
important for opening
the model.

1. Look for errors in
the following log
files:

• In the \logs
folder under the
model folder:

• modelshari
ng.log

• error_<use
r>_<YYYYMM
DD>_<HHMMS
S>.log

• sharingfac
ade.log

• In the
\TeklaStructu
resModels
folder:

• TeklaStruc
tures_<use
r>.log

• In the \Users
\<user>
\AppData
\Local\Tekla
DataSharing
folder:

Licensing,
sign-in, and

opening
errors
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Message Description Do this
• ClientLog_

cat.txt
• ClientLog_

dog.txt
2. Proceed as the error

messages require.

For example, if
another application
is blocking a file,
close that
application.

3. If you do not know
how to proceed or
the issues persist,
contact Tekla
Structures support.

Invalid database files
have been detected:
[invalid files]

When you open a shared
model, certain database
files are checked.

This message appears if
there are issues in the
database files that are
checked. The invalid files
are listed at the end of
the error message.

1. Look for errors in
the following log
files:

• In the \logs
folder under the
model folder:

• modelshari
ng.log

• error_<use
r>_<YYYYMM
DD>_<HHMMS
S>.log

• sharingfac
ade.log

• In the
\TeklaStructu
resModels
folder:

• TeklaStruc
tures_<use
r>.log

• In the \Users
\<user>
\AppData
\Local\Tekla
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Message Description Do this
DataSharing
folder:

• ClientLog_
cat.txt

• ClientLog_
dog.txt

2. Proceed as the error
messages require.

For example, if
another application
is blocking a file,
close that
application.

3. If the model is
currently open,
diagnose and repair
the model.

4. If the problem
persists, try to take
a backup copy in
use by replacing
all .db files in the
model folder
with .db.bak files.

Login failed Signing in to the Tekla
Model Sharing sharing
service has failed.

1. Open Internet
Explorer and clear
the browser
cookies.

2. Optionally, sign out
from all Tekla
Online services and
ensure the services
do not automatically
remember your
sign-in information.

3. Try signing in again.

4. If the issues persist,
contact Tekla
Structures support.

Model does not exist. The model that you are
trying to open has been
deleted from the Tekla
Model Sharing Service.

• If you need to access
the deleted model,
contact Tekla
Structures support.
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Message Description Do this
Model requires
environment:
[Environment name]

The model has been
shared with a particular
environment, but you
are trying to join the
model using another
environment.

We recommend that you
use the original
environment, if possible.
Using another
environment might
cause problems when
you are working with the
model.

1. According to your
situation, do either
of the following:

• To join the
model with
another
environment,
click OK.

• To use the
original
environment,
click Cancel and
switch to the
original
environment.

The command could not
be completed, Tekla
Structures must close.
After restarting Tekla
Structures run diagnose
& repair command and
try again.

Tekla Structures cannot
perform the selected
command right now
because of errors and
inconsistencies in model
objects or the library
database (xslib).

1. Restart Tekla
Structures.

2. Open the shared
model that you
were working with
when Tekla
Structures was
closed.

3. On the File menu,
click Diagnose &
repair, and select
an appropriate
command.

For more
information, see .

4. Try to perform the
selected command
again.

The command could not
be completed, Tekla
Structures must close.
Try again after restarting
Tekla Structures.

Tekla Structures cannot
perform the selected
command right now.

For example, this might
happen because of a
database issue or a
canceled operation.

1. Restart Tekla
Structures.

2. Open the shared
model that you
were working with
when Tekla
Structures was
closed.

Working collaboratively within a Tekla Structures
model

71 Repair Tekla Model Sharing issues



Message Description Do this
3. Try to perform the

selected command
again.

4. If the issues persist,
contact Tekla
Structures support.

You do not have
permissions to remove
model from service.

For safety reasons, only
Tekla Model Sharing
users with the Owner
role can exclude models
from the Tekla Model
Sharing sharing service.

This message appears if
you are trying to exclude
a model from the Tekla
Model Sharing sharing
service, but your role
(Editor, Viewer, or
Project viewer) does
not allow doing that.

• Do either of the
following:

• Ask a user with
the Owner role to
change your role.

• Ask a user with
the Owner role to
exclude the
model from the
Tekla Model
Sharing sharing
service.

Your Tekla Model
Sharing license
subscription expires in
[X] days.

Your Tekla Model
Sharing license
subscription is about to
expire.

• Contact your
organization's license
administrator and
ask them to renew
your license
subscription.

Message Description Do this
Removing model from
the service failed.

Tekla Structures cannot
exclude the model from
the Tekla Model Sharing
sharing service.

1. Try again.

2. If the issues persist,
contact Tekla
Structures support.

Removing model from
the computer failed.

You cannot delete the
selected model from
your computer.

1. Ensure that the
model still exists on
your computer.

2. Ensure that the
model or any of its
files are not open in
Tekla Structures or
in another
application.

3. Try again.

File removal
errors
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Message Description Do this
Removing model from
the computer failed.
Model is in use.

You cannot delete the
selected model from
your computer because
the model is currently
open.

1. Close the model.

2. Try deleting the
model again.

The Tekla Cloud service
cannot be removed from
list of known services.

Users cannot delete the Tekla Cloud service.

Message Description Do this
Your permission level
has been modified. You
no longer have
permissions to manage
users for this shared
model. You may
continue to use the
model otherwise.
Contact the model
owner if you need
permissions.

A Tekla Model Sharing
user with the Owner
role has changed your
role in the shared
model, so that you can
no longer manage the
users of the model in the
Users dialog box.

• Do either of the
following:

• Ask a user with
the Owner role to
change your role
to Owner. Then,
try again.

• Ask a user with
the Owner role to
manage the users
as necessary.

Message Description Do this
Check the port number. The port number is

incorrect.
1. Find out and

type the correct
port number.

2. Type in the
correct port
number and try
again.

Check the server name. The server name is
incorrect.

1. Find out and
type the correct
server name.

2. Type the correct
server name
and try again.

Role and
permission

errors

Sharing and
connection

errors
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Message Description Do this
Connecting to model
sharing service failed as
the email is already in use
in another organization.

Please check the model
sharing log, and contact
Tekla Structures support if
the problem persists.

You cannot connect to the
Tekla Model Sharing
service because the email
address that you are using
has been added to another
organization.

A user can only be added
to one organization at a
time.

• According to your
needs, do one of
the following:

• Ask your
organization's
license
administrator
to move you
back to the
original
organization
and add you
to the new
organization
as an external
user.

This way, you
can work on
existing
models. Note
that as an
external user,
you cannot
start sharing
new models.

• Create a new
email address
in the new
organization,
and then,
create a new
Trimble
Identity using
the new
account.

• If you need
full access to
the models of
both
organizations,
contact Tekla
Structures
support.
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Message Description Do this
Connection to proxy
server failed.

Tekla Model Sharing
cannot connect to the
proxy server.

1. Ensure that you
have access to
the proxy
server.

2. Ensure that the
proxy server is
running.

Even when Tekla
Model Sharing
cannot connect to
the proxy server,
Tekla Model Sharing
can retrieve
information using
the sharing service.

Different Tekla Structures
versions cannot be used
in the same model sharing
project.

You can save the model
and start sharing again to
create a new project, or
close the model without
saving and continue with
the original version
[version number].

All users need to use the
same Tekla Structures
version when working on a
shared model.

This message appears if
you try to open a shared
model with a different
Tekla Structures version.

• Do either of the
following:

• Save the
model in the
Tekla
Structures
version that
you are using,
and start
sharing the
newly saved
model.

• Close the
model without
saving it and
open the
model using
the Tekla
Structures
version with
which the
model was
originally
shared.

Exclude from sharing
failed

Tekla Structures cannot
exclude the model from
the Tekla Model Sharing
sharing service.

1. Look for errors
in the following
log files:

• In the \logs
folder under
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Message Description Do this
the model
folder:

• modelsh
aring.l
og

• error_<
user>_<
YYYYMMD
D>_<HHM
MSS>.lo
g

• sharing
facade.
log

• In the
\TeklaStru
cturesMode
ls folder:

• TeklaSt
ructure
s_<user
>.log

• In the
\Users
\<user>
\AppData
\Local
\Tekla
DataSharin
g folder:

• ClientL
og_cat.
txt

• ClientL
og_dog.
txt

2. Proceed as the
error messages
require.

For example, if
another
application is
blocking a file,
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Message Description Do this
close that
application.

3. If you do not
know how to
proceed or the
issues persist,
contact Tekla
Structures
support.

Fatal database integrity
error discovered during
the operation. Use the
Diagnose Model
command to find
problematic objects.

Some of the databases
that the model uses have
been corrupted. Tekla
Structures needs to
diagnose the model to find
out how the model can be
repaired.

1. Go to File menu
and select
Diagnose &
repair -->
Diagnose
model .

The errors and
inconsistencies
found in the
model are listed
in a report.
Some of them
are
automatically
corrected, some
of them are
warnings that
you need to
correct
manually. For
more
information,
see .

2. If you do not
know how to
proceed or the
issues persist,
contact Tekla
Structures
support.

Not enough memory A change management
operation has failed
because of insufficient
system memory.

1. To release
memory, close
some open
applications.

2. Try again.
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Message Description Do this
Operation is not allowed
for shared model.

This message appears when you are trying to fix
ID gaps in a shared model. Fixing ID gaps is only
used to repair models that are not shared and
that have been saved in Tekla Structures 2016i or
older.

Sharing operation failed Tekla Model Sharing
cannot find all necessary
information.

1. Look for errors
in the following
log files:

• In the \logs
folder under
the model
folder:

• modelsh
aring.l
og

• error_<
user>_<
YYYYMMD
D>_<HHM
MSS>.lo
g

• sharing
facade.
log

• In the
\TeklaStru
cturesMode
ls folder:

• TeklaSt
ructure
s_<user
>.log

• In the
\Users
\<user>
\AppData
\Local
\Tekla
DataSharin
g folder:

• ClientL
og_cat.
txt
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Message Description Do this
• ClientL

og_dog.
txt

2. Proceed as the
error messages
require.

For example, if
another
application is
blocking a file,
close that
application.

3. If you do not
know how to
proceed or the
issues persist,
contact Tekla
Structures
support.

Sharing operation failed.
Please check the Internet
connection and Tekla
Model Sharing Status in
https://
status.teklamodelsharing.
com/.

Tekla Model Sharing
cannot retrieve all
necessary information.

1. Check that your
Internet
connection
works properly.

2. Go to https://
status.teklamod
elsharing.com/
and check the
Tekla Model
Sharing Status.

Sharing operation failed.
Please check the model
sharing log, and contact
Tekla Structures support if
the problem persists.

Tekla Model Sharing
cannot retrieve all
necessary information.

1. Open the \logs
folder under the
model folder.

2. Look for error
messages in the
modelsharing.
log file.

3. Proceed as the
error messages
require.

4. If you do not
know how to
proceed or the
issues persist,
contact Tekla
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Message Description Do this
Structures
support.

Sharing operation failed.
Service could not be
reached - realm or server
address could be wrong.
Please check the model
sharing log, and contact
Tekla Structures support if
the problem persists.

Tekla Model Sharing
cannot retrieve all
necessary information.

1. Open the \logs
folder under the
model folder.

2. Look for error
messages in the
modelsharing.
log file.

3. Proceed as the
error messages
require.

4. If you do not
know how to
proceed or the
issues persist,
contact Tekla
Structures
support.

Invalid database files have
been detected: [invalid
files]

The versions of these
databases do not match.
To enable sharing
operations in this model,
backup files will be used.

Some of the databases used in the shared model
have been deleted or replaced with irrelevant
databases. Instead, Tekla Structures
automatically uses the available backup files. You
do not need to react to this message.

Invalid database files have
been detected: [invalid
files]

The versions of these
databases do not match.
To enable sharing
operations in this model,
databases are needed
from a model that has the
correct version (packet
number).

Some of the databases
used in the shared model
have been deleted or
replaced with irrelevant
databases. Because of this,
Tekla Structures cannot
open the model.

1. In the shared
model, join
(page 23) the
packet that is
mentioned in
the error
message.

2. Open File
Explorer and
copy the
necessary
database file to
the newer
version of the
model.

3. Try opening the
model again.
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Message Description Do this
This model has been
shared in a previous
version. Sharing
operations cannot be
used in this release. If you
save the model in this
version, it will be excluded
from sharing.

/

This model has been
shared in a previous
version. If you save it now,
it will be excluded from
sharing.

The current model has
been shared in an earlier
Tekla Structures version,
so you cannot share your
changes or read in other
users' changes with a
newer Tekla Structures
version.

Do either of the
following:

• Close the model
without saving,
and open it with
the earlier Tekla
Structures
version with
which it has been
shared.

• If you want to use
the current
version of Tekla
Structures, save
the model and
start sharing the
model again with
the newer
version.

Note that all
other Tekla
Structures users
in the project also
need to use the
newer version.

Message Description Do this
Another user has
reserved the next write
out

This message appears if
another user has already
reserved the next write
out.

You cannot reserve the
next write out if another
user has already
reserved it.

• Do any of the
following:

• Find out who the
other user is and
ask them to
release the next
write out.
(page 28)

• Wait for the other
user to write out
their changes
before you write
out your changes.

Read-in and
write out

errors
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Message Description Do this
• Wait for an hour.

If the other user
does not write out
their changes in
that time, the
next write out will
be released.

• Ask a user with
administrator
rights to unlock
the model in

When an
administrator
unlocks the
model, the next
write out is
released.

Failed to populate the
changes list

This message appears
when change
management fails to
show the list of latest
changes.

1. Look for errors in
the following log
files:

• In the \logs
folder under the
model folder:

• modelshari
ng.log

• error_<use
r>_<YYYYMM
DD>_<HHMMS
S>.log

• sharingfac
ade.log

• In the
\TeklaStructu
resModels
folder:

• TeklaStruc
tures_<use
r>.log

• In the \Users
\<user>
\AppData
\Local\Tekla
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Message Description Do this
DataSharing
folder:

• ClientLog_
cat.txt

• ClientLog_
dog.txt

2. Contact Tekla
Structures support.

Failed to release next
write out.

This message appears if
you cannot release the
write out that you
previously reserved.

This is usually an
Internet connection
issue.

1. Check your Internet
connection.

2. Try again

OR

Wait one hour. The
write out is
automatically
released after that
time.

Failed to reserve next
write out.

This message appears if
you cannot reserve the
next write out.

1. Check your Internet
connection.

2. Try again

OR

Find out if another
user has reserved
the next write out. If
yes, you can ask
them to release the
next write out.

No new shared data
available.

You can only read in changes that other users have
shared.

This message appears in the status bar at the
bottom of Tekla Structures when you try to read in
other users' changes, but no new changes have
been shared.

Please provide comment
for operation

A comment is required
whenever you reserve
the next write out in a
shared model.

This message appears if
you have attempted to
reserve the next write

1. Click OK to close the
error message.

2. Type a comment
that describes why
you want to reserve
the next write out.

3. Click Reserve.
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Message Description Do this
out without typing a
comment.

The following characters
are not allowed in Code
or Comment field: < & >

This message appears if
you try to use the
characters "<", "&", or
">" when you type a
revision code or
comment at write-out.

Note that you can only
type revision codes or
comments if the Enable
write out revision
comment check box is
selected in the Sharing
settings dialog box.

1. Remove the
forbidden
characters from the
revision code or
revision comment.

2. Click Save to write
out your changes.

The revision code
exceeds maximum
length ([X] out of [Y]
characters used).

The revision code that
you have typed is too
long.

• Type a shorter
revision code.

The revision comment
exceeds maximum
length ([X] out of [Y]
characters used.)

The revision comment
that you have typed is
too long.

• Type a shorter
revision comment.

Write Out is not allowed
because the model is
not up to date. Use Read
In to update the model.

You cannot write out
your changes before you
have read in the changes
that other users have
made before you.

1. On the File menu,
click Sharing -->
Read in , or click

 on the Quick
Access Toolbar.

2. View the changes
made by other
users.

3. To share your
changes, on the File
menu, click Sharing
--> Write out , or

click  on the
Quick Access
Toolbar.
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Get support for sharing issues
You can contact Tekla Structures support to solve Tekla Model Sharing issues.

When you deliver your model to your local support for investigation, ensure
that you include the following:

• The model. Zip the model but do not save it anymore before delivering it.

• Give Viewer permissions to your local support by inviting their email
address to the model.

If the issues persist, prepare to also invite the Tekla Structures global
helpdesk (tms-support-no-reply@tekla.com) to the model.

Remember to remove any support email addresses from the user list after
the model has been investigated.

• A detailed description of the problem.

Include steps to reproduce the problem if possible.

• Images and screenshots.

• Which Tekla Structures version you are using.

• Which environment and role you are using.

1.6 Multi-user mode
You can work on Tekla Structures models in either single-user or multi-user
mode. Multi-user mode allows several users to access the same model at the
same time. Several users can work on the same project and be aware of the
others’ progress. This eliminates the need for copying and merging models.

Advantages

• No duplicate models to control, track or store

• Using only one model reduces on site errors

• Erection plans based on a single master model

• Bolt and material lists generated from a single master model

• Ability to share the workload of large projects among many users

• Ability to collect model history (see XS_COLLECT_MODEL_HISTORY)

Other issues to consider

As with all projects, you need to plan your multi-user project carefully. Some
issues to consider are:

• Only one user can save to the master model at a time
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• Use a numbering plan. When working with multi-user models, always use
the option Synchronize with master model (save-numbering-save) in
the Numbering setup dialog box to prevent saving conflicts.

• Schedule numbering sessions appropriately (it can take some time to
number larger models)

• If possible, assign distinct areas of the model to each user to avoid conflicts
that may happen when several users are working in the same area.

• You should never use a mix of single-user and multi-user setups on one
project. Saving a multi-user model in single-user mode deletes changes by
other users working on the model, and can also corrupt the model. See
Saving in multi-user mode (page 93) to find out how saving works in multi-
user mode.

NOTE Tekla Structures multi-user mode only runs on TCP/IP-based
networks.

See also

Multi-user system (page 86)

How multi-user works (page 92)

Saving in multi-user mode (page 93)

Autosaving in multi-user mode (page 94)

Shutting down the model in multi-user mode (page 96)

Copy multi-user models (page 97)

Error messages in multi-user mode (page 97)

Multi-user system
A Tekla Structures multi-user system runs on a TCP/IP network and consists of:

• A server computer running the multi-user server (xs_server.exe started
by the AlwaysUp utility)

• A file server computer containing the master model

• Client computers running Tekla Structures

For information on the recommended multi-user setup, see .

Tekla Structures multi-user server as a service
Tekla Structures multi-user server runs as a service that is started
automatically when you start the computer. You do not need to log in to the
service.
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Tekla Structures multi-user server performs the following main tasks:

• Locks the model when somebody saves or numbers the model

• Identifies client computers

• Keeps track of active multi-users

• Gives numbers for general arrangement drawings and multidrawings

• Displays warnings if an another user has already edited or is currently
editing drawings or the same model object

To optimize the performance of a multi-user system, run as few other
programs as possible on the Tekla Structures multi-user server.

Server shutdown

Users should save their working models to the master model before the Tekla
Structures multi-user server is stopped. If the service is stopped before saving
the working models, for example because the server computer needs a
restart, simply restart the service and have users save their working models to
the master model.

Install Tekla Structures multi-user server as a service
The Tekla Structures multi-user server installer installs the multi-user server as
a service. When you have installed the server, the service is always available
and it is automatically started when the server computer is started. There is no
need to log in and no need to start the server manually every time you start
your computer. Tekla Structures multi-user server allows many users to work
on the same model simultaneously.

We recommend that you use the latest multi-user server version available
regardless of the Tekla Structures version that you use.

1. Download the multi-user server software installation file from Tekla
Downloads.

2. Double-click the installation file to run the installation.

3. Follow the steps in the installation wizard to complete the installation. 

The server is by default installed to:

c:\Program Files (x86)\Tekla Structures Multiuser Server
You cannot change the installation path during the installation.

If you install the multi-user server on your own computer, the server
name is the name of your computer.

The multi-user server uses TCP/IP port 1238.

The installation log is written to the xs_server.log file that is available in
c:\ProgramData\TeklaStructuresServer.
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Restart the multi-user server service
If you receive an error message saying that the model is locked, it might be
useful to restart the Tekla Structures multi-user server service. You can restart
the multi-user server service without restarting the server computer.

1. Ensure that all users of the Tekla Structures multi-user server have been
logged out of Tekla Structures.

2. Find and open the server computer that hosts the Tekla Structures multi-
user server service. 

The name of the server computer is the same as the server name that you
type when you log into the multi-user model.

3. On the server computer, go to ..\ProgramData
\TeklaStructuresServer. 

For example, C:\ProgramData\TeklaStructuresServer.

In the ..\ProgramData\TeklaStructuresServer folder, you may find
a file called tcpip_localhost_<xxxx>.db.

4. If the tcpip_localhost_<xxxx>.db file exists in the ..\ProgramData
\TeklaStructuresServer folder, delete the file. 

If the tcpip_localhost_<xxxx>.db does not exist in the <root
folder>\ProgramData\TeklaStructuresServer folder, skip step 4.

5. Open the Windows Start menu and type Services in the search field.

6. Click Services.

7. In the Services dialog box, find and select Tekla Structures Multiuser
Server.

8. Click Restart and wait until the Tekla Structures multi-user service
restarts.

We recommend that you reserve a particular time during the workday when
the multi-user server service is restarted.

You can use the Task Scheduler app in Windows to create a task that
automatically restarts Tekla Structures multi-user server.

Install a new instance of the multi-user server service
You can have several instances of the Tekla Structures multi-user server
service on the same server computer.

Installing new instances of the multi-user server service is very important if
you want to have several models with the same name, because the multi-user
server uses the model name to identify models.

Note that you can have approximately 80 instances of the Tekla Structures
multi-user server service on the same server computer. The exact maximum
number of instances is not known. If you need a large number of multi-user
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server services, we recommend that you divide the services between multiple
server computers.

1. Find and open the server computer that hosts the multi-user server
service. 

The name of the server computer is the same as the server name that you
enter when you log into the multi-user model.

2. Go to C:\Program Files (x86)\Tekla Structures Multiuser
Server.

3. To create a new instance of the Tekla Structures multi-user server service,
right-click TS_MUSaas_Install.

4. Select Run as administrator and click Yes to confirm. 

The related Command Prompt window opens. You can see the default
service name, port number and destination for the new instance. The last
character of the service name is the identifier of the instance.

The default identifier is 2, whereas the default port number is 1239.

5. If necessary, change the identifier or port number of the new instance. 

To Do this
Change the identifier a. Press I on the keyboard.

b. Press Enter.

c. Type the new identifier.

d. Press Enter to change the
identifier.

Change the port number a. Press P on the keyboard.

b. Press Enter.

c. Type the new port number.

d. Press Enter to change the port
number.

6. When you are ready, press any key on the keyboard except for I, P, or Q. 

A new instance of the Tekla Structures multi-user server is installed and
started.

7. Press any key on the keyboard to close the Command Prompt window.

Uninstall an instance of the multi-user server service
If you need to uninstall an instance of the Tekla Structures multi-user server
service, do the following:

Working collaboratively within a Tekla Structures
model

89 Multi-user mode



1. Find and open the server computer that hosts the multi-user server
service. 

The name of the server computer is the same as the server name that you
enter when you log into the multi-user model.

2. Go to C:\Program Files (x86)\Tekla Structures Multiuser
Server.

3. To create a new instance of the Tekla Structures multi-user server service,
right-click TS_MUSaas_Uninstall.

4. Select Run as administrator and click Yes to confirm. 

The related Command Prompt window opens.

5. Type the identifier of the instance that you want to uninstall, and press
Enter. 

The identifier is the last character of the instance name. For example, if
the instance name is Tekla Structures Multiuser Server 2, the
identifier is 2.

6. Type Y to confirm uninstalling the instance, and press Enter. 

The selected instance of the Tekla Structures multi-user server service is
stopped and uninstalled. All files stored in the associated multi-user
server folder are deleted.

7. Press any key on the keyboard to close the Command Prompt window.

Change the server of a multi-user model
You can change the Tekla Structures server of a multi-user model.

1. On the File menu, click Sharing --> Change multi-user server .

2. Enter the new server name or select it from the list.

3. Click Change. 

If the connection to the new server cannot be established, the old
connection is restored.

NOTE The file .This_is_multiuser_model located in the model folder defines
whether the model is a multi-user or a single-user model. The file includes
also the name of the server. You can open the file using any standard text
editor.

See also

Convert a multi-user model to a single-user model (page 90)

Convert a single-user model to a multi-user model (page 91)
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Convert a multi-user model to a single-user model
You can convert a multi-user model to a single-user model and open it in the
single-user mode.

To Do this
Convert a current, open model On the File menu, click Sharing -->

Convert to a single-user model .

The current model is converted to a
single-user model.

Convert some other than the current
model

1. On the File menu, click Open -->
All models .

2. Select the multi-user model to be
converted from the list of models
and click Convert to single-user
model.

3. Click Convert in the Convert to
single-user model dialog box.

See also

Convert a single-user model to a multi-user model (page 91)

Convert a single-user model to a multi-user model
You can convert a single-user model to a multi-user model and open it in the
multi-user mode.

To Do this
Convert a current, open model 1. On the File menu, click Sharing --

> Convert to a multi-user
model .

2. Enter the multi-user server name
or select the name from the list in
the Convert to multi-user
model dialog box.

3. Click Convert.

The current model is converted
to a multi-user model.

Convert some other than the current
model

1. On the File menu, click Open -->
All models .

2. Select the single-user model to
be converted from the list of
models, and click Convert to
multi-user model.
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To Do this
3. Enter the multi-user server name

or select the name from the list in
the Convert to multi-user
model dialog box.

4. Click Convert.

See also

Convert a multi-user model to a single-user model (page 90)

How multi-user works

The multi-user model consists of a single master model. Each user can access
this model and open their own local view of the model. This local view is called
a working model. The above image shows one possible configuration of the
multi-user system.

Any changes a user makes to his working model are local and are not visible to
other users until he saves the working model to the master model.
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The multi-user system can contain several client computers, where users work
on their working models. The master model can be located anywhere on the
network, including any of the client computers.

When you open a multi-user model on a client computer, Tekla Structures
makes a copy of the master model to the memory of the client computer (a
working model).

When you click Save to save your working model back to the master model,
Tekla Structures:

1. Takes a new copy of the master model and compares your working model
with it.

2. Saves the changes in your working model to the copy of the master model
(locally).

3. Saves this copy back to the master model. (When other users save their
working models, they can now see your changes.)

4. Takes a new copy of the master model and saves it locally as your working
model. (You can see your own changes and those uploaded by other
users.)

The multi-user model is locked during opening, saving and numbering. When
one of the users performs any of these operations, other users cannot
perform them during that time.

Locks for models in multi-user mode
To preserve the integrity of the multi-user model, Tekla Structures locks the
master model when a user:

• Opens the multi-user model

• Saves a working model to the master model

• Runs numbering

When you try to save the model that is locked, Tekla Structures gives you an
option to queue for saving until the model is unlocked. Tekla Structures keeps
on retrying saving every 15 seconds until the operation is completed or until
you cancel the operation.

See also

Saving in multi-user mode (page 93)

Saving in multi-user mode
Tekla Structures preserves the integrity of the model, even if more than one
user modifies the same model objects. If two users modify the same object,
then save to the master model, the master model will only contain the
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changes of the user who most recently saved their working model to the
master model.

TIP To avoid potential save conflicts, have users work on different areas of the
model.

Tekla Structures creates connections to the right parts, even if the part is
moved by another user.

Note that if you use the Save as command to save the model, the model
history is not copied with the saved model.

Speeding up the saving process

The following advice may help in speeding up the saving process:

• Check your network connection speed, because it can slow down the
saving process significantly.

• Close down all the views of the model before saving.

• Set the advanced options XS_PROJECT and XS_FIRM so that they point to a
local drive and move most of the system files there. If there are many
system files in the network drive, saving may become slower than when
using system files located on your own hard drive. Each user should use
the same files to ensure similar outcome.

• Delete any hidden reference models which you do not need anymore.

See also

How multi-user works (page 92)

Autosaving in multi-user mode
Autosave only saves the working model, not the master model. Other users do
not see the modifications you make after an Autosave. In multi-user mode,
this makes Autosave much faster than the Save command. Save updates the
master model.

By default, Tekla Structures saves the Autosave files in the master model
folder with the filename <model>.db1_<user>. If several people are using
the same username, conflicts will occur.

To avoid conflicts and problems caused by the network traffic, store the
Autosave files locally, not in the model folder that is located on a network
drive. Set the advanced option XS_AUTOSAVE_DIRECTORY, for example, to 
XS_AUTOSAVE_DIRECTORY=C:\TeklaStructuresModels\autosave. By
saving autosave files locally you make sure that if there are problems in the
network traffic, you are still able to save your own work.

1. On the File menu, click Settings --> Options, and in the General settings
define the Autosave intervals for operations performed in the drawing
and the model.
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2. Periodically autosave the model manually.

To do so, create a shortcut for the Autosave command. Click File menu --
> Settings and in the Customize area select Keyboard shortcuts.

NOTE Remember to save regularly to the master model by clicking Save.

See also

Error messages in multi-user mode (page 97)

Copy multi-user models (page 97)

How multi-user works (page 92)

Model history in multi-user mode
Tekla Structures collects model history on the actions that have taken place in
the a model. In a multi-user model, the model history shows when the model
has been changed, how the model has changed, who has made the changes,
and the model revision comments.

Collect model history in multi-user mode

1. On the File menu, click Settings --> Advanced options.

2. Go to the Speed and Accuracy tab.

3. Set XS_COLLECT_MODEL_HISTORY to TRUE.

4. Set XS_CLEAR_MODEL_HISTORY to FALSE.

5. Optional: Go to the Multi-user tab. 

Set XS_SAVE_WITH_COMMENT to TRUE.

This enables the saving of model revision comments.

View model history in multi-user mode

To view model history, do one of the following:

• On the ribbon, click  and select an object in the model.

The model history is shown in the Inquire object dialog box.

• Create a model history report.

1. On the Drawings & reports tab, click Reports.

2. Select a report template that shows model history from the list. The
name of the report template may vary in different environments.

In the Default environment, the report template is called
Q_Model_History_Report.
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3. Click Create from all to create a report on all the objects in a model,
or select one or more objects in the model and click Create from
selected to create a report from the selected objects.

Save model revision comments in multi-user mode
You can save model revision comments when working with multi-user models.
This means that all objects which have been changed during the last save
interval include the revision information in them. You can use this information
in filtering and reports. You can also use it to examine which users have
modified the objects.

• The Owner is the user, who has added the object into the model.

• History shows when the model has been changed, how the model has
changed, who has made the changes, and the model revision comments.

Before you can save model revision comments, check the following:

• Set the advanced option to TRUE in File --> Settings --> Advanced options
--> Multi-user.

• Set the advanced option to TRUE in File --> Settings --> Advanced options
--> Speed and Accuracy.

1. When you have set the advanced options mentioned above to TRUE, Tekla
Structures displays the Model revision comments dialog box when you
are saving the model. Enter the desired revision comment and code in the
Model revision comment and Model revision code boxes.

2. Click OK.

Tekla Structures applies the values of this dialog box to parts that were
changed after the last save. When you inquire objects, you can see the model
revision information in the Inquire object dialog box. You can use this
information also for selection and view filtering.

Shutting down the model in multi-user mode
Do not shut down the computer containing the master model while other
users are working on their working models. They will not be able to save their
changes to the master model.

If this does happen, to avoid losing any changes, follow the steps below:

1. Keep the working model(s) open on the client computer(s).

2. Restart the computer containing the master model.

3. Open the master model on the computer containing it and autosave the
model.

4. Click Save on the client computers to save the working models to the
master model.
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See also

Saving in multi-user mode (page 93)

Autosaving in multi-user mode (page 94)

Copy multi-user models
1. Have all users save and close their working models.

2. On the File menu, click Open --> All models .

3. From the list of models, select the multi-user model and click Convert to
single-user model --> Convert .

4. Use Save as to make a copy of the model.

5. Exit Tekla Structures and re-open the model in multi-user mode to
continue working on it.

Display active multi-users
You can display information on users working on the same server.

To display active multi-users, click File menu --> Sharing --> Active multi-
users.

The Active Multi-Users dialog box displays the following information:

Option Description
Locked The time when the model was locked.
Model name The name of the model.
User Users that are currently working on

models on the server.
Latest login The time when the users have logged

in.
Latest access to server The time when the users have last

accessed the server.
Editing drawings The drawings that are currently being

edited.
Edited drawings The drawings that have been edited

and saved to the server.

TIP The Active Multi-Users dialog box is refreshed every 30 seconds. You can
refresh it immediately by clicking Refresh.
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Error messages in multi-user mode

Error message Problem Solution
Database write
conflicts detected

More than one user has
changed an object.

Check the
conflict.log. It lists
the GUID numbers of
the objects that more
than one user has
changed. This is not
usually a critical
problem. No need to use
the Check database
tool. See also Saving in
multi-user mode
(page 93)

Could not save model.
Possible reasons are:

- disk is full or write
protected

- locked .tmp -file(s)
exists in the model
directory

You tried to save a multi-
user model to a
computer or folder that
you could not access.

• Check that you have
permission to write
to the model folder.

• Check that there is
enough disk space to
save the model.

• Restart the computer
where you want to
save the model. Try
to save the model
again.

• Delete the .tmp files
from the model
directory.

Database locked
cannot open model

Computer stopped
responding while saving
the model, which locks
the model.

To unlock the model, the
user whose operating
system stopped
responding should open
the model in multi-user
mode and save it.

Cannot read autosaved
model as a normal
model in the multi-use
mode

The opening of a multi-
user Autosave file has
been prevented in
single-user mode to
prevent the reading of
wrong file types.

Do not rename or move
Autosave files. Do not
open the Autosave file of
a single-user model in
multi-user mode or vice
versa.
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Remove inconsistencies from a multi-user database
To preserve the integrity of your multi-user model, you need to remove any
inconsistencies from the multi-user database at regular intervals, for example
once a day. This may also fix assemblies with no main part and drawings of
unknown (U) type.

We recommend you to check the multi-user database in single-user mode.

1. Have all other users exit the multi-user model.

2. Save your model to receive the modifications of other users.

3. Exit the model.

4. Open the model in single-user mode.

5. Exit the model without saving.

6. Re-open the model.

7. On the File menu, click Diagnose & Repair and in the Model area, click
Repair model.

8. Save the model.

9. Exit the model.

10. Re-open the model in the multi-user mode.

Modeling in multi-user mode
Before you start a project, assign each user an area of the model. To prevent
potential save conflicts, you need to avoid having more than one user working
on the same, or adjacent model objects. See also Saving in multi-user mode
(page 93).

Example

If three users are to model a project, User #1 could model columns, User #2
the 1st floor beams, and User #3 the 2nd floor beams.

In the following example, three users are working on the same model. You can
see how modeling and saving works in practice.

The master model contains columns and grids, as you can see here.

Each user opens the model in multi-user mode. All users are now working on
working models, locally.
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On the working models:

User #1 adds base plates to the columns:

User #2 adds and connects the 1st floor steel beams:
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User #3 adds and connects the 2nd floor steel beams:

User #1 clicks Save to save to the master model. His working model now
shows the base plates he added and looks like this:
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User #2 clicks Save to save to the master model. His working model now
shows his 1st floor framing and User #1’s base plates:

User #3 clicks Save to save to the master model. His working model now
shows all three users’s work:
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To see the updated master model, Users #1 and #2 need to save to the master
model again to update their working models.

See also

Numbering setup in multi-user mode (page 103)

Synchronize numbering with the master model (page 104)

Numbering setup in multi-user mode
Define the numbering settings as follows:

1. On the Drawings & reports tab, click Numbering settings -->
Numbering settings.

2. In the Numbering setup dialog box, select the Synchronize with master
model (save-numbering-save) check box.

When you select this check box, you can cancel the numbering before the
last save is made. This is useful, for example, if you want to check the
numbering results and you find something that you still want to change.

NOTE When working with multi-user models, use this option always to
prevent saving conflicts.

3. Modify the other properties as required.
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4. Click OK.

Tekla Structures will now save the model before and after you number all
parts or modified parts.

When you click Perform numbering --> Number modified objects on the
Drawings & reports tab to run numbering, Tekla Structures displays a list that
shows the numbering progress. When the numbering is finished, the changed
numbering results are highlighted in the list. When you select an item on the
list, Tekla Structures highlights the corresponding object(s) in the model. If you
keep the F key pressed when you select the item, Tekla Structures fits the work
area of the current view around the objects.

If the numbering results are correct, click Save numbers to make the second
save. To cancel the numbering before the second save, click Cancel. If you
cancel the numbering, the model is returned to the state before numbering
and standard files are read to all dialogs.

To review the numbering results further, click Stop timer.

To change the time frame in which Tekla Structures makes the second save,
use the advanced option .

NOTE We recommend that you run the Diagnose & Repair Numbering: All
command in File menu --> Diagnose & Repair to remove any numbering
inconsistencies from the multi-user database at regular intervals, for example
once a day.

See also

Access rights in multi-user mode (page 108)

Synchronize numbering with the master model
If you need to include numbering information from areas in the model that
have been modeled by other users:

1. Ask all users to save their working models. This updates the master
model.

2. Number the model. Make sure that the Synchronize with master model
(save-numbering-save) check box is selected in the Numbering setup
dialog box (see Numbering setup in multi-user mode (page 103)). This
updates your working model to the master model, numbers the master
model, and then saves the numbered master model for all users to
access.

NOTE If you create drawings and/or reports after numbering, you need to save the
master model again to make them visible to other users.
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Drawings in multi-user mode
The multi-user environment is very useful when several users are
simultaneously editing drawings.

Tekla Structures saves each drawing in a unique file. These drawing files are
located in the drawing folder in the master model folder.

The file is in the format D0000123456.dg. The dg files are part of the model,
so you can only open them using Tekla Structures.

dg files contain the locations of views, details of any editing done to the
drawing, and the positions of dimensions, part marks, and text. The dg
filename does not contain any reference to assembly, part, or multidrawing
numbers.

If two users open and save the same drawing in their working models, then
save their changes to the master model, one set of changes will be lost. The
master model will only contain the changes of the user who most recently
saved their working model to the master model. See Saving in multi-user
mode (page 93).

The Tekla Structures multi-user server assigns the general arrangement
drawing numbers automatically. This means that each drawing gets the first
free number available. If users A and B both create a general arrangement
drawing at the same time, they are automatically assigned different numbers.
The same applies to multidrawing numbers.

See also

Guidelines for multi-user drawings (page 105)

Locks for drawings in multi-user mode (page 106)

Guidelines for multi-user drawings
You may find the following guidelines useful when you edit or check drawings:

Action Recommendation
Saving drawings Periodically save your working model

to the master model (every 5–10
drawings).

Editing drawings • Assign each user a different range
of drawings to edit.

• Lock finalized drawings.
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Action Recommendation
• If Tekla Structures displays the

message Database write
conflicts detected and a drawing
ID number, two or more users
have opened and saved the same
drawing. See Drawings in multi-
user mode (page 104).

Checking drawings Only check locked drawings.
Printing drawings Make sure that no-one else is working

with the same drawing. If you print a
drawing while someone else is editing
it and then save the model, the other
user’s changes will be lost, even
though you have not opened,
modified, or saved the drawing.

You can disable the print date by
using the advanced option
XS_DISABLE_DRAWING_PLOT_DATE.

Creating general arrangement
drawings

Create a set of empty general
arrangement drawings in the
beginning of the project, and assign a
a certain range of these ready-created
empty drawings to each user (for
example, GA1 to GA10 to User A,
GA11-GA20 to User B and so on). This
prevents overlapping general
arrangement drawing numbers in the
project.

See also

Delete unnecessary drawing files in multi-user mode (page 107)

Locks for drawings in multi-user mode

When you are about to open a drawing, Tekla Structures displays a notification
on the status of the drawing. The options are:

• Someone is already editing it.

• Someone has already edited it (drawing has been saved to their computer,
but not yet to the server).

• The drawing has already been saved and there is a newer version available
on the server.
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NOTE Locks for drawings are only used when a drawing is edited manually,
not for example when drawings are automatically edited through
cloning.

Note that to lock edited drawings, the XS_COLLECT_MODEL_HISTORY
advanced option must be set to TRUE.

Delete unnecessary drawing files in multi-user mode
Every time you update a drawing, Tekla Structures creates a new drawing
(.dg) file in the drawings sub-folder of the model. After that, the previous
drawing file is not used and might become unnecessary. To delete the
unnecessary drawing files in multi-user mode, see the following instructions.

NOTE The drawing files that are not used are not always unnecessary. If you close
the model without saving, or if Tekla Structures crashes and you cannot save
the model, the drawing files that are not used can become necessary again. In
these situations, you need the drawing files that were valid when you last
saved the model and the drawing files that were valid when the last autosave
was performed.

Having different versions of drawings allows you to revert to the previous
versions of drawings. This is especially useful if two users have edited the
same drawing.

Delete drawing files automatically in a multi-user model

In multi-user models, you can use the XS_DELETE_UNNECESSARY_DG_FILES
and XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD advanced
options to keep the number of drawing files reasonable.

The XS_DELETE_UNNECESSARY_DG_FILES advanced option defines if the
drawing files are automatically deleted or not. To automatically delete the
drawing files that are no longer used, ensure that
XS_DELETE_UNNECESSARY_DG_FILES is set to TRUE. The drawing files are
deleted when the last user exits the model and saves the model.

The XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD advanced option
defines how long the drawing files are kept before they are saved. The default
safety period is 7 days. This means that after 7 days, the drawing files that are
not used are deleted when the
XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD advanced option is
set to TRUE. You can define a different safety period according to your needs.

Delete unnecessary drawing files manually in a multi-user model

The Remove unnecessary drawing files command deletes all drawing files
that do not have a corresponding drawing in the current version of the model,
regardless of the safety period. Note that also the drawing files that have a
corresponding version in the last saved or autosaved version of the model are
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deleted, if there is no corresponding drawing in the current version of the
model.

We recommend that you use the Remove unnecessary drawing files
command when you want to archive the model or give the model to another
user.

NOTE To avoid deleting drawing files that are still needed, we recommend
that you only use the Remove unnecessary drawing files command
if you are an experienced Tekla Structures user.

Before you use the Remove unnecessary drawing files command, ensure
that:

• You are the only user that has the multi-user model open.

• You have full privileges (page 108) in the multi-user model. If you do not
have full privileges in the model, you cannot delete the unnecessary
drawing files manually.

To delete the unnecessary drawing files manually:

1. Save the model.

Saving the model ensures that any drawings that are still needed are not
accidentally deleted.

2. Convert the model to a single-user model. (page 90)

3. Search for the Remove unnecessary drawing files command in Quick
Launch.

4. When Tekla Structures finds the command, select it and press Enter.

Tekla Structures deletes all drawings that do not have a corresponding
drawing in the current version of the model.

5. Convert the model back to a multi-user model. (page 91)

Access rights in multi-user mode
You can use privileges to control access rights. The person who has created
the model, or anyone from the same organization, can control access rights to
the model using privileges. In practice, the privileges of the model are
controlled via the privileges.inp file.

By modifying the privileges.inp file, you can control:

• access to modify user-defined attributes.

• access to modify object properties. This is done by locking and unlocking
objects.

• access to modify numbering settings.
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• access to remove users on multi-user server.

• access to save standard files.

You can prevent your model and drawings being accidentally modified by
using the Locked user-defined attribute (UDA) or drawing locks, or locks in
Phase manager. Using the Locked UDA and privileges together you can even
restrict some users or organizations from modifying your model.

For example, you can limit access to the model so that a checker can only
change status attributes. Or you could prevent certain users from changing
the user-defined attributes used for approval or manufacturing and erection
status.

The privileges.inp file is also used in Tekla Model Sharing to control which
users are allowed to modify the user-defined attributes or numbering settings
of a shared model and save standard files.

Change access rights in the privileges.inp file
How the privileges work:

• The privileges.inp file serves as a user interface for updating the
privileges in a model.

• The privileges are loaded from the privileges.inp file and stored in the
model.

• The privileges are loaded from the privileges.inp file only if the current
user is allowed to do so.

• If there is no privileges.inp file or if it cannot be loaded, then the
privileges that are already stored in the model (if any) are used.

• If you do not set any privileges, all users have full rights.

• Tekla Structures checks the privilege defaults in the privileges.inp file
when you create a model, and each time you open a model.

• Tekla Structures searches for the file first in the current model folder, then
in the folder defined for the advanced option XS_INP.

NOTE Only the person who created the model, or anyone from the same
organization, can modify the privileges of the model via the privileges.inp
file.

To change the access rights:

1. Close the model.

2. Open the privileges.inp file, located in ..\ProgramData\Trimble
\Tekla Structures\<version>\environments\common\inp folder,
in any text editor.

3. Change the desired settings and save the file.
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4. Re-open the model.

Example

Below is an example of the privileges.inp file. The slash (/) or backslash (\)
separates the user name from the organization (<organization>/<user>). If
no user name is entered, it means anyone in the company. Each row contains
three columns, separated by tabs.

If you want to give the privileges only to one user or only to some users, you
first have to exclude everyone and then include the users who you want to
give the privileges.

Note that the organization and the user names are case sensitive. For
example, COMPANYA is not the same as companyA.

Options in the privileges.inp file
The following commands are available in the privileges.inp file:

• access to modify any user-defined attribute (UDA) - attribute:UDA_NAME
• access to modify object properties - attribute:OBJECT_LOCKED
• access to modify numbering settings - action:PartnumbersOptions
• access to perform numbering - action:PerformNumbering
• access to remove users in multi-user model - 

action:AllowMultiuserKick
• access to save standard files - action:SaveStandard
• access to add watermarks to printed drawings - 

action:DrawingWatermark
When you want to give the right only to one user or some users, you have to
first exclude everyone and then include the users.

Column Option Description
protected user-
defined attribute

attribute: name Affects the protected user-defined
attribute "name". Check the exact
spelling of the name in the
objects.inp.

OR
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Column Option Description
action action: name Affects the action "name". The

available actions:

• PartnumbersOptions: Controls
access to numbering settings.

Limitation: only full/none

• PerformNumbering: Controls
access to performing numbering.

• AllowMultiuserKick: Controls
access to removing users from a
multi-user model.

Limitation: only full/none

• SaveStandard: Controls access to
saving standard files.

Limitations: only standard

• DrawingWatermark: Controls
access to adding watermarks for
printed drawings.

user everyone All users
domain/ Affects all users within the network

domain "domain".
domain/nn Affects the user "nn" in the network

domain "domain".
nn Affects the user "nn".

rights full User can change the user-defined
attribute.

view User can view the user-defined
attribute, but not change it. This
option appears dimmed to the user.

none The user-defined attribute is hidden
from the user.

User-defined attribute Locked
To protect objects from being accidentally modified, you can use the Locked
user-defined attribute (UDA).

You can use it for

• parts (separately for beams, columns, etc.)

• bolts

• welds
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• specific drawing types

• project properties

• phase properties

The Locked user-defined attribute (UDA) has three values, Yes, No and
Organization. When set to Yes, the object is locked and you cannot modify its
properties. You can only change the object’s user-defined attributes that do
not affect numbering. If you try to modify a locked object, Tekla Structures
displays the following warning message:

"There are locked objects, see report. The operation could not be performed."

The OBJECT_LOCKED attribute in the objects.inp file defines whether the
Locked user-defined attribute (UDA) is visible in the Tekla Structures user
interface.

NOTE Make sure that numbering is up-to-date before you lock objects.

Control access to lock and unlock objects in a multi-user model
Use the OBJECT_LOCKED attribute in the privileges.inp file to set users'
access to the user-defined attribute (UDA) Locked and thus prevent users
from locking and unlocking objects.

Example

Only users man and man2 have full rights to lock and unlock objects. The
attribute is hidden from everybody else:

NOTE To protect other user-defined attributes, you need to list them in the
privileges.inp file.

Control access to numbering in a multi-user model
Use the PartnumbersOptions in the privileges.inp file to restrict users'
access to the numbering properties and thus prevent unauthorized users from
modifying the numbering settings.

NOTE Users can still run numbering even if they have no privilege to modify the
numbering settings.
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If a user who has no privilege to modify properties in the Numbering Setup
dialog box tries to access the dialog box, Tekla Structures displays a warning
message which states that the user does not have the required privilege.

Example

Only admin can modify the properties in the Numbering Setup dialog box:

Control access to save standard files in a multi-user model
Use the SaveStandard action in the privileges.inp file to control users'
access to save standard files.

Example

Only admin has rights to save standard files in network domain 
ORGANIZATION:

Control access to remove users from a multi-user model
Use the AllowMultiuserKick action in the privileges.inp to restrict
permissions to remove users from a multi-user model.

You can define that undesired active multi-users can be removed from the
user list in the Active multi-users dialog box. This is useful, for example, if an
application error has occurred on the user’s computer, and the locks on locked
objects need to be cleared by removing the user.

Define the AllowMultiuserKick action in the privileges.inp file and give
full permissions to the user who you want to be able to remove other users
from the model.

Example

Only user jsmith has full permissions to remove users:
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To remove a user:

1. On the File menu, click Sharing --> Active multi-users.

2. Right-click a user who you want to remove and select Clear locks.

3. Click Refresh to remove the user.

All the locks that the user has on objects and the user are removed.

1.7 Trimble Connector
Trimble Connector enables the connection between Tekla Structures and
Trimble Connect for Windows or Trimble Connect for Browser for sharing
models and ToDo notes, matching views and selected objects.

With Trimble Connector, you can

• link a model to a project (page 116)

• create a new Trimble Connect project

• download a reference model (page 118) from a Trimble Connect project to
a Tekla Structures model

• upload a model (page 118) to a Trimble Connect project as a .tekla file

• export model objects as reference models (page 118) to Trimble Connect
projects

• create, modify, assign, and comment on ToDo notes

• select the same objects in both and (page 132)

• match the camera position, zoom level, and projection of model views in
and in (page 132)

All operations between Tekla Structures and Trimble Connect use the project
base point. This means that, for example, reference models from Tekla
Structures are placed in relation to the project base point in Trimble Connect.
If you have not defined a project base point, the model origin is used.

NOTE You need to have a Trimble Identity before you can start using Trimble
Connector.

NOTE Trimble Connect related metadata and all reference models are
located in the ..\TeklaStructuresModels\<model>\TConnect
folder. Exported reference model settings are stored to
the ..\TeklaStructuresModels\<model>\Links folder. Trimble
Connector does not work correctly if you manually modify the files in
these folders.
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Launch Trimble Connector
You can launch Trimble Connector in multiple ways:

• Through the ribbon:

• To open the model list, on the Trimble Connect tab, click Models.

For more information on managing reference models, see Manage
reference models in Trimble Connector (page 118).

• To open the list of ToDo notes, on the Trimble Connect tab, click
ToDos.

For more information on managing ToDo notes, see Work with ToDos in
Trimble Connector (page 124).

• Through the file menu:

• To download a reference model from any Trimble Connect project to a
Tekla Structures model, click File --> Import --> .

• To publish an IFC reference model of the open Tekla Structures model
to any Trimble Connect project, click File --> Export --> .

Trimble Connector opens. You can link your job to a Trimble Connect project if
you have not done that earlier. You can also create a new project.

To start working with Trimble Connector, you need to sign in to Tekla
Structures using your Trimble Identity.

Launch Trimble Connect from Tekla Structures
You can launch Trimble Connect in multiple ways:

• Through the ribbon:

To launch Trimble Connect for Windows or Trimble Connect for Browser,
click one of these buttons on the Trimble Connect ribbon tab:

•  For Browser:

If you have linked the model to a Trimble Connect project, the project
activity page opens in Trimble Connect for Browser.

If you have not linked the model to a project, http://

connect.trimble.com/ opens whenever you click  For Browser or
any of the menu options underneath it.

•  For Browser --> Project explorer:

The project explorer page opens in Trimble Connect for Browser.
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•  For Browser --> 3D view:

The 3D model view opens in Trimble Connect for Browser.

•  For Browser --> Team:

The team page opens in Trimble Connect for Browser.

•  For Windows:

If you have attached a project, the project detail view opens in Trimble
Connect for Windows.

If you have not attached a project, the projects view opens in Trimble
Connect for Windows.

If you have not installed Trimble Connect for Windows, the web page to
download Trimble Connect for Windows opens: https://
app.connect.trimble.com/tc/app#/store.

Link a Tekla Structures model to a Trimble Connect project
To start collaboration between Tekla Structures and Trimble Connect, you
need to link your Tekla Structures model to a Trimble Connect project.

1. To start linking your model to a Trimble Connect project, do either of the
following:

a. To link a new model, select the Start Trimble Connect collaboration
check box while creating the model,

b. To link an open model, go to the File menu and select --> Start
collaboration.

2. According to your needs, do either of the following: 

• To link the model to a new Trimble Connect project, type a name for
the project in the field at the top of the Select project dialog box.

• To link the model to an existing Trimble Connect project, select the
project from the list at the top of the Select project dialog box.

3. Select the geographical location of the project from the Project Server
Location list.

4. Select your Trimble Connect license from the License list.

5. Click Create or OK.

The model is linked to the selected Trimble Connect project. You can now start
working and, for example, download or upload reference models, add Connect
models as overlays on top of the model, or add ToDo notes.
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Unlink a Tekla Structures model from the Trimble Connect project
1. On the File menu, click --> Exclude from collaboration.

2. To confirm unlinking the model from the linked Trimble Connect project,
click OK.

Link a Tekla Structures model to a Trimble Connect project
To start collaboration between Tekla Structures and Trimble Connect, you
need to link your Tekla Structures model to a Trimble Connect project.

1. To start linking your model to a Trimble Connect project, do either of the
following:

a. To link a new model, select the Start Trimble Connect collaboration
check box while creating the model,

b. To link an open model, go to the File menu and select --> Start
collaboration.

2. According to your needs, do either of the following: 

• To link the model to a new Trimble Connect project, type a name for
the project in the field at the top of the Select project dialog box.

• To link the model to an existing Trimble Connect project, select the
project from the list at the top of the Select project dialog box.

3. Select the geographical location of the project from the Project Server
Location list.

4. Select your Trimble Connect license from the License list.

5. Click Create or OK.

The model is linked to the selected Trimble Connect project. You can now start
working and, for example, download or upload reference models, add Connect
models as overlays on top of the model, or add ToDo notes.

Upload the Tekla Structures model to Trimble Connect
You can upload the current Tekla Structures model to a Trimble Connect
project folder as a read-only .tekla file. The .tekla file can then be used as
lightweight reference model with Tekla Structures or any Trimble Connect
product. .tekla reference models list and visualize model objects, parts,
rebars, bolts, and assemblies. However, pours and pour units are not
included.

1. On the File menu, go to Settings --> Advanced options.

2. In the Advanced Options dialog box, find the
XS_CONNECT_UPLOAD_MODEL_FOLDER option.
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3. Type or paste a file path to the Trimble Connect folder where you want to
upload the Tekla Structures model. 

The default file path is Structural\Tekla models.

4. Click OK to save the folder path.

5. Go to the Trimble Connect ribbon tab.

6. On the ribbon, click  Upload model.

7. To confirm saving the model and uploading the entire model folder to the
attached Trimble Connect project, click Save and upload.

The Tekla Structures model is uploaded as a .tekla file to the Trimble
Connect project folder that you defined. If needed, you can later attach the file
to your model as a Connect overlay model. (page 122)

Note that if you want to move the model to another folder after uploading it,
you need to do so manually in Trimble Connect.

NOTE The  Upload model button does not upload shared models to
Trimble Connect. Instead, you can use the
XS_UPLOAD_SHARED_MODEL_TO_CONNECT advanced option to select
if and when a shared model is uploaded to a Trimble Connect project
folder.

In the Advanced Options dialog box, set the value of
XS_UPLOAD_SHARED_MODEL_TO_CONNECT to one of the following:

• BASELINE = The shared model is automatically uploaded to the set
Trimble Connect project folder each time a user creates a new
baseline.

• WRITEOUT = The shared model is automatically uploaded to the set
Trimble Connect project folder after each successful write out.

If you do not want to upload the model to a Trimble Connect project
folder, clear the Value field.

See also

Trimble Connector (page 114)

Manage reference models in Trimble Connector (page 118)

Manage reference models in Trimble Connector
With Trimble Connector, you can manage two types of reference models:
regular reference models and Connect overlay models. Reference models are
part of the Tekla Structures model, and they can be downloaded from, or
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exported to Trimble Connect projects. Connect overlay models are lightweight
reference models that are stored in the attached Trimble Connect project.
Connect overlay models can be quickly attached to the Tekla Structures model
to show model objects on top of the Tekla Structures model.

• To start managing reference models, on the Trimble Connect ribbon tab,

click  Models.

The Trimble Connect - Models dialog box opens. Here, you can manage
reference models on the Reference models tab, and Connect overlay models
on the Connect models tab.

Upload reference models or reference model updates
You can upload both new Tekla Structures reference models or updated
versions of Tekla Structures reference models to attached Trimble Connect
projects.

New and updated reference models are marked in different ways:

Icon or label Meaning
The Tekla Structures reference model has not been
uploaded to a Trimble Connect project.
The newest version of the Tekla Structures
reference model has not been uploaded to a
Trimble Connect project.
The reference model has the same version in Tekla
Structures and in Trimble Connect.

1. Open the Reference models tab in the Trimble Connect - Models dialog
box.

2. To upload a new reference model or a new version of the reference

model to the Trimble Connect project, click the  icon.

Download reference models or reference model updates
You can download and insert either new or updated reference models from a
Trimble Connect project to a Tekla Structures model.

The reference models and their versions are marked with different icons
depending on whether they are up-to-date:

Working collaboratively within a Tekla Structures
model

119 Trimble Connector



Icon Meaning
The reference model has been updated in the
Trimble Connect project after the last time that it
has been downloaded to Tekla Structures.

•
Click  to download the latest version of the
model.

The updated version of the reference model has
not been downloaded to Tekla Structures.

•
Click  to insert the version in the Tekla
Structures model.

The reference model version exists in the Tekla
Structures model sub-folder but has not been
inserted in the Tekla Structures model.

•
Click  to insert the version in the Tekla
Structures model.

The reference model has the same version in Tekla
Structures and in Trimble Connect.

1. On the Reference models tab in the Trimble Connect - Models dialog
box, double-click a folder. 

A list of reference models in that folder is shown.

2. To show the versions of an reference model, click the arrow on the left
side of the reference model name.

3. Do either of the following:

• Select the reference model that you want to download and click .

• Select the updated reference model version that you want to

download and click .

The new reference model or the updated reference model version is
downloaded to a Tekla Structures model sub-folder and inserted to the Tekla
Structures model.

Create new folders for reference models
1. On the Reference models tab in the Trimble Connect - Models dialog

box, click .
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2. In the Select folders dialog box, double-click the project to see the folders
inside the project. 

If a folder has sub-folders, you can view them by double-clicking the
folder.

3. Select one or more folders where you want to link the reference model
and click OK. 

You can also create a new folder by typing a name for the folder and
clicking Create, or remove an existing folder from the list by hovering

over the folder and clicking .

The selected folders are added to the Folders list on the Reference models
tab in the Trimble Connect - Models dialog box.

Export Tekla Structures model objects as an .ifc reference model to a
Trimble Connect project
You can create an .ifc coordination view 2.0 file from Tekla Structures model
objects and export it to a Trimble Connect project. You can create the file from
selected model objects, or from all model objects.

1. On the Reference models tab, double-click the folder where you want to
add the exported .ifc model.

2. To start the export, click .

The Trimble Connect - Export IFC to Trimble Connect dialog box opens.

3. Enter a name for the exported model or model objects.

The name of the export needs to be unique within the project.

4. In the Export list, select if you want to export all model objects (All),
selected model objects (Selected), or filtered objects (Filter).

• If you selected Selected, select the objects in the model view.

• If you selected Filter, select an existing filter in the Filter list, or click 
to create a new filter.

For more information, see .

5. Select which IFC export settings you want to use:

• To use existing IFC export settings, select the settings file in the IFC
export settings list.

The settings file needs to be located in the model \attributes folder,
so that you can select it in the IFC export settings list.

• To create new IFC export settings, click  on the right side of the IFC
export settings list.

For more information, see Export to IFC.
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If you do not select a settings file, the .ifc model is created of parts only,
not assemblies.

Note that if you do not define a settings file that specifies which object
types you want to export, only surface geometry is exported.

6. Click OK.

When the .ifc model has been exported, you can download the reference
model to the Tekla Structures model. Select the reference model in the

Trimble Connect - Models dialog box, and click . After a successful

export, the model is marked with .

If the Tekla Structures model has an updated version of the exported

reference model, click  to export the updated version of the reference
model.

If you do not specify a settings file, the .ifc file only includes parts and grids.
The .ifc file does not include assembly information, which means that you
can export only main parts. You can add additional property sets by saving a
property set through File --> Export --> IFC , use the file name ifc.xml.

If you have not defined where the .ifc model is positioned in the Export to
IFC dialog box, the exported IFC model is placed in relation to the project base
point in the Trimble Connect 3D view. If a project base point has not been
defined, the model is placed in relation to the model origin.

Manage Connect overlay models in Trimble Connector
Connect overlay models are lightweight reference models that are not part of
the Tekla Structures models, but can be used as overlays on top of Tekla
Structures models.

Connect overlay models are saved in the Trimble Connect project, so you
cannot use them in a Tekla Structures model unless the Tekla Structures
model has been linked to a Trimble Connect project. Before you can start
working with Connect overlay models, link your .

1. Open to the Connect models tab in the Trimble Connect - Models dialog
box.

2. If necessary, do any of the following:

• To only show model objects that are within the current work area,
select the Show inside work area only check box.

• To show a list of all folders and Connect overlay models in the Trimble
Connect project, select Everything in project in the list at the top of
the Connect models tab.
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• To only show a list of folders and Connect overlay models that you can
currently show or hide in this model, select Used in this model in the
list at the top of the Connect models tab.

3. In the Connect model list, do any of the following: 

To Do this
Hide or show Connect
overlay models • To hide an Connect overlay model, click  on

the left side of the model.

• To show an Connect overlay model, click  on
the left side of the model.

• To hide all Connect overlay models in a Trimble
Connect folder, click  on the left side of the
folder.

• To show all Connect overlay models in a

Trimble Connect folder, click .

If a folder or its sub-folders do not have any
Connect overlay models that can be shown in
Tekla Structures, the arrow symbol is not
shown next to the eye icon.

Adjust the scale and
position of Connect
overlay models

a. Select the Connect overlay model whose
position you want to adjust.

b. To show the model properties, click
Properties at the bottom of the Trimble
Connect - Models dialog box.

Note that the properties are relative to the
project base point. Changing the model
position or scale in the Properties section are
applied to both Tekla Structures and Trimble
Connect.

c. Type new values for the scale, position, or
rotation of the model.

d. To apply the changes to the Tekla Structures
model view, click Modify.

The properties are stored in Trimble Connect.

To return to the initial scale and position of the
model, click Reset.

Remove a Connect
overlay model from the
Used in the model list

a. Ensure that you have the Used in the model
list open.

b. Select the Connect overlay model that you
want to remove.
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To Do this

c. Click .

d. Select Remove from used model tree.

The Connect overlay model is removed from the
Used in the model list.

If you want to show the Connect overlay model
again, switch to the Everything in project list and

click . The Connect overlay model appears in the
Used in the model list again.

Create a sub-folder for
Connect overlay models
under a Trimble Connect
folder

a. Select the folder under which you want to add
a sub-folder.

b. Click .

c. Select Create new folder.

d. Name the folder and click Create.
Add a new Connect
overlay model

a. Select the folder under which you want to add
a new Connect overlay model.

b. Click .

c. Select Attach model.

You can now show the new Connect overlay model
in the Tekla Structures model view.

Zoom to an Connect
overlay model

a. Select the Connect overlay model to which you
want into zoom in Tekla Structures.

b. Click .

c. Select Zoom to model.

d. Select the model view in which you want to
zoom to the selected model.

e. Click Yes to confirm zooming to the selected
model view.

Work with ToDos in Trimble Connector
The  ToDo list in Trimble Connector displays the ToDo notes added to the
project. You can add ToDo notes and reply to notes of other project members.
The ToDo notes are shared to all project members by default, but you can
select a user or a user group to whom you want to assign the ToDo with a due
date when it needs to be resolved.
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Open and view the ToDo list
You need to have a project linked to the current model to open to view or
create ToDo notes.

1. On the Trimble Connect ribbon tab, click ToDos.

2. In the Trimble Connect - ToDos dialog box, do any of the following:

• To sort the ToDo list according to different criteria, click one of the
available columns.

You can sort ToDo notes by Author, Assignee, Due date, Status, or
Priority.

• To search for specific ToDo notes, start typing a search word in the
Search... field.

Trimble Connector shows the ToDo notes that match you search.

• To group ToDo notes, select the grouping option in the Group by list.

The options are Author, Status, Priority, Type, Tag, Creation date,
and Last modified date

3. To close the ToDo list, click the  Close button.

Create ToDo notes
1. If you want to create a ToDo with a view and a snapshot, select the native

Tekla Structures objects in the model view. 

When you create a ToDo with a view and a snapshot, note that:

• The coordinate system follows what has been set in the Work plane
handler toolbar.

• We do not recommend creating a view of many objects at a time,
because if you do so, creating the ToDo may take a long time.

When you create a view, an IFC file of the selected native objects is
created and uploaded to the project root\TeklaStructures-ToDos
folder.

You can also create ToDo notes without a view and a snapshot. To do so,
do not select any objects in the Tekla Structures model view.

2. In the Trimble Connect - ToDos dialog box, click the  Create ToDo
button.

3. Type a Title and a Description for the ToDo note. 

TheTitle and the Description are mandatory. You cannot save a ToDo
note without a title and a description.
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4. To assign the ToDo note to a user or a user group, click Select next to
Assignee and select a project member or a user group. 

To filter the options that are shown, start typing the name of the user or
the user group.

ToDo notes can be assigned to other users when the project has been
shared.

5. If needed, do one or more of the following:

• To add tags, type a tag in the Tags box and press Enter to save the tag.

You can add several tags.

• Select a priority for the ToDo note from the Priority list.

• To set a due date for the ToDo note, type the due date in the Due
Date box, or click  to select the due date from the calendar.

• To define the type of the ToDo, select an option from the Type list.

• To define the status of the ToDo note, select an option from the Status
list.

• Type the completion percentage of the ToDo note in the Completion
% box.

6. To add an attachment, click  Add attachment, and do one or both of
the following:

• Click  and  to browse for a file on your computer and add the
file to the selected folder. Then, click OK.

• Click  to browse for a file on your computer and click Add from
my computer. Then, attach the file to the current ToDo note and click
OK.

You can open an attachment by double-clicking it.

The attachment opens the file if Windows has a file association for the
filename extension. Model files are not opened.

You can also delete attachments. To do so, click X on the right side of the
attachment.

7. To save the ToDo note, click Save.

The saved ToDo note is immediately synchronized to Trimble Connect. After
the ToDo note has been uploaded to Trimble Connect, it receives a unique
name consisting of the abbreviated project name and a running number.

In Trimble Connect, you can see the ToDo note on the ToDo and Activity tabs.
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View and modify ToDo notes
1. In the Trimble Connect - ToDos dialog box, double-click the ToDo note

that you want to view.

2. Click Edit.

3. Adjust the ToDo information according to your needs. 

For example, you can change the assignee, status, or completion
percentage.

4. To save the changes, click Save.

You can close the ToDo property pane by clicking the  Close button.

Add comments to ToDo notes
Any user in the project can comment on any ToDo.

1. In the Trimble Connect - ToDos dialog box, double-click the ToDo note
that you want to comment.

2. Scroll down until you see the Comments box.

3. Type any comments about the ToDo note.

4. If necessary, add an attachment by clicking  and do one or both of the
following:

• Click  and  to browse for a file on your computer and add the
file to the selected folder. Then, click OK.

• Click  to browse for a file on your computer and click Add from
my computer. Then, attach the file to the current ToDo note and click
OK.

5. To save your comment, click Add comment.

Project administrators and ToDo creators can also delete comments by

clicking  Delete next to the Comments box.

You can close the ToDo property pane by clicking the  Close button.

Create markups for ToDo notes
You can create ToDo markups in Trimble Connector and show the markups
both in Tekla Structures and in Trimble Connect.

1. To add markups in the current model, use the markup tools at the bottom
of Trimble Connector: 
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Button Action How to use

Removes all clip
planes from all
model views.

• At the bottom of Trimble Connector,

click .

Removes all
markups from
the model.

• At the bottom of Trimble Connector,

click .

Creates a
measurement
markup.

Measurement
markups show
the distance
between two
points.

a. In the model, pick the points whose
distance you want to see.

You can pick points, edges or faces.

b. Pick the point where you want to
place the measurement.

Creates a cloud
markup.

a. In the model, pick the center point of
the cloud.

b. Pick the position of the cloud edge.

Tekla Structures creates the cloud
perpendicular to the view plane defined
by the center location you picked.

Creates a line
markup.

a. In the model, pick the start point of
the line.

Note that the arrow is created at the
start point.

b. Pick the end point of the line.

Creates a text
markup that
consists of:

• text or a
UDA or a
report
attribute

• a leader line

a. Type the text or prefix in the text box
under the markup commands.

b. Select a UDA or a report attribute
from the list under the markup
commands.

In the image above, Approved by
has been entered as text and UDA:
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Button Action How to use
Approved by has been selected from
the list of available attributes.

c. Pick the start point of the leader line.

d. Pick the point where you want to add
the text.

TIP To add more UDAs or report
attributes in the list of available
attributes, or to add new attributes
to the Text markup attribute
options list so that they would be
available for selection, click the
Maintain text markup attribute
options button in the bottom-right
corner.

The Text markup attribute
options dialog box opens:

Here, you can:

• Select the UDAs or report
attributes that you want to add in
the list of available attributes-

• Add new attributes using the
options at the top. You need to:

a. Select if the attribute is UDA
or Report.

b. Select the attribute type
(Integer, Double or String).
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Button Action How to use

c. Type a name for the
attribute.

d. To add an assembly
attribute, select the
Assembly check box.

e. Click + to add the new
attribute to the list.

Creates a pencil
markup, or a
freehand
markup.

a. In the model, pick a start point for the
markup.

b. Move the mouse pointer to draw the
shape that you want.

Do not hold down the left mouse
button.

c. Pick the end point of the markup.

Tekla Structures creates the markup
perpendicular to the view plane defined
by the start point you picked.

2. Select the necessary model objects in the Tekla Structures model.

3. Click the  Create ToDo button.

4. Enter the ToDo information. 

You need to enter at least a title and a description for the ToDo.

5. Ensure that the ToDo is synchronized with Trimble Connect. 

You can click the  Refresh the list button to manually upload the ToDo
to Trimble Connect.

Assign ToDo notes
Once a project has been shared, ToDos can be assigned to other users. You
can assign the ToDo only if you are the administrator of the project, or if you
have created the ToDo. You can only assign ToDos created in Trimble
Connector.

1. Set the priority, type and the status of the ToDo, if needed.

2. Click the Save button to save changes.

1. In the Trimble Connect - ToDos dialog box, double-click the ToDo note
that you want to assign.

2. Click Edit.
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3. Click Select next to Assignee and select a project member or a user
group. 

To filter the options that are shown, start typing the name of the user or
the user group.

4. To set a due date for the ToDo note, type the due date in the Due Date
box, or click  to select the due date from the calendar.

5. If necessary, do any of the following:

• Select a priority for the ToDo note from the Priority list.

• To define the type of the ToDo, select an option from the Type list.

• To define the status of the ToDo note, select an option from the Status
list.

6. To save the changes, click Save.

You can close the ToDo property pane by clicking the  Close button.

Adjust the ToDo view settings

1. In the Trimble Connect - ToDos dialog box, click the  Settings button.

2. Select the Double-click the ToDo view settings to use:

• Adjusts camera and view projection: This option is needed if you do
not want the snapshot view to change because of coordinate system
difference, for example, to keep the current view untouched. If you
select this option, the view projection will also change if the Tekla
Structures view projection differs from the ToDo note snapshot view
projection.

• Removes and adds clip planes: Clip planes in the Tekla Structures
view are removed, and clip planes in the ToDo view are added to the
Tekla Structures view. This option can only be used available if the
Adjusts camera and view projection option is selected.

• Selects objects: This option selects the Tekla Structures native object
if the corresponding object has been selected in the ToDo view. If the
coordinate systems differ, it is possible to select objects and zoom to
the selected objects.

These settings affect the snapshot view in ToDo notes.

3. To close the settings pane, click the  Close button.
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Synchronize ToDo notes
If another project member creates or comments on ToDo notes, the ToDos are
automatically synchronized. Alternatively, you can upload ToDo changes
manually:

• In the Trimble Connect - ToDos dialog box, click the  Refresh the list
button.

Match views and selections between Tekla Structures and
Trimble Connect for Windows
If you are working in Tekla Structures and Trimble Connect for Windows at the
same time, you can collaborate with the two applications. In practice, this
means that you can match the zoom and projection of the 3D model views,
and select the same objects in both applications.

Before collaborating, you need to do the following:

• Have a project open in Trimble Connect for Windows and a model open in
Tekla Structures.

• Export the Tekla Structures model to Trimble Connect in the IFC format.

For more information, see Manage reference models in Trimble Connector
(page 118).

• Download and show the model in Trimble Connect for Windows.

Match the camera position, zoom level, and projection of model views
You can adjust the model views in Tekla Structures and in Trimble Connect for
Windows to match each other as well as possible. When you do so, the camera
position, zoom level, and view projection of the views are synchronized. You
can select which model view is the principal model view to which you want to
match the other model view.

• Do either of the following: 

To Do this
Adjust the Tekla
Structures model view to
match the Trimble
Connect for Windows
view

• On the Trimble Connect tab, click  Match
with Trimble Connect for Windows view.

Adjust the Trimble
Connect for Windows
model view to match the
Tekla Structures view

• On the Trimble Connect tab, click  Match
with Tekla Structures view.
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Select the same objects
• Do either of the following: 

To Do this
Select the currently
selected Trimble
Connect objects also in
the Tekla Structures
model

• On the Trimble Connect tab, click  Select
in Trimble Connect for Windows.

Select the currently
selected Tekla Structures
model objects also in
Trimble Connect for
Windows

• On the Trimble Connect tab, click  Select
in Tekla Structures.
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2 Get started with import and
export formats

Tekla Structures is highly interoperable. If you need to exchange model
information with users of other software or systems, you can import and
export information in many standard file formats or even establish a direct
link with several other products.

• In most cases, the format used for the exchange is a general industry
standard format (page 134) supported by many different tools.

• Formats may be supported for import, export or both. See Compatible file
formats and software with Tekla Structures (page 135) for a listing. There
you can also find tables of supported software listing the options you have
for sharing data with many commonly used tools.

• When you are ready to exchange data, see Import to and export from Tekla
Structures (page 154)

• You can install new capabilities such as new import and export formats or
direct links to other software from the (page 492).

• If your organization has a capable programmer, you can even add your
own customized import and export formats or direct links to other
software and systems using Tekla Open API.

2.1 Industry standards
There are many industry standard file transfer formats. The principle ones
supported by Tekla Structures are IFC, CIS/2, DSTV, SDNF, DGN, DXF, DWG,
IGES, and STEP. Older formats are also included. For a tighter integration, you
can link to Tekla Structures using the Tekla Open API technology.

The file name extension normally informs the user which format it is based
upon. If you do not know what format it is, or the file does not import, then
you will need to open the file in a text editor to look at the header information,
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where the file type and the authoring application is usually noted. With CIS/2
files the authoring application and version number is sometimes written at the
end of the file.

See also

Compatible file formats and software with Tekla Structures (page 135)

2.2 Compatible file formats and software with Tekla
Structures
The following tables list the interoperability possibilities of Tekla Structures.

The Compatible file formats list includes the possible file formats for import
and export in Tekla Structures.

The compatible software lists include software that are compatible with Tekla
Structures. Some of the listed software have a direct link with Tekla Structures.
Many direct links are available in Tekla Warehouse.

Compatible file formats

You can import and export several formats in Tekla Structures.

The following table lists many of the different formats you can use in Tekla
Structures to import and export data (page 154).

To use some of the formats, you need to download an extension from Tekla
Warehouse.

Format Import Export
3D image (.obj ) X  
aSa (.TEK)  X
Autodesk 3DS Max format (.3ds) X  
Autodesk (.dwg) X X
Autodesk (.dxf) X X
Bentley ISM X X
BIM Collaboration format (.bcf) X X
Blender files (.blend) X  
BTL Export (.btl)  X
BVBS (.abs)  X
CIS/2 LPM5/LPM6 analytical (.stp,.p21,.step) X X
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Format Import Export
CIS/2 LPM5/LPM6 design (.stp,.p21,.step) X X
CIS/2 LPM6 manufacturing (.stp,.p21,.step)  X
CPIxml  X
COLLADA (.dae) X  
DSTV (.nc,.stp,.mis) X X
EJE  X
Elematic ELiPLAN, ELiPOS (.eli) X X
EPC  X
Fabsuite (.xml) X X
FabTrol Kiss (.kss)  X
FabTrol MIS Xml (.xml) X X
Filmbox (.fbx) X  
GL Transmission Format (.glft) X  
High Level Interface File (.hli) X X
HMS (.sot)  X
IBB Betsy (.fa, .f, .ev)  X
IFC2x2 (.ifc) ** X  
IFC2x3 (.ifc) ** X X
IFC4 (.ifc) ** X X
IFCXML 2X3 (.ifcXML) ** X X
IFCZIP 2x3 (.ifcZIP) ** X X
Initial Graphics Exchange Specification (IGES)
(.iges,.igs)

X X

LandXML (.xml) X  
Microsoft Project (.xml) X X
Microstation (.dgn) X X
Oracle Primavera P6 (.xml) X X
Plant Design Management System (.pdms)  X
Polygon File Format (.ply) X  
SAP, Oracle, ODBC, etc. X * X *
SketchUp (.skp) X X
Staad ASCII (.std) X X
Steel Detailing Neutral Format (.sdf,.sdnf, .dat) X X
Steel12000  X
STEP AP203 (.stp,.step) X
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Format Import Export
STEP AP214 (.stp,.step) X X
StruM.I.S X X
Tekla Collaboration (.tczip) X X
Tekla-FabTrol Report (.xsr)  X
Tekla Structural Designer neutral (.cxl) X X
Tekla Structures shape (.tsc) X X
Trimble Field Link (.tfl) X X
Trimble LM80 (.txt,.cnx) X X
TubeNC (.xml)  X
Unitechnik (.uni, .cam)  X

* Tekla OpenAPI used

**For a list of IFC applications certified by buildingSMART international, see
Certified Software.

Compatible Trimble software

The following table lists the Trimble software that is compatible with Tekla
Structures.

Trimble product Import to Tekla
Structures

Export from Tekla
Structures

3D+ Autodesk (.dwg)

Autodesk (.dxf)

Steel Detailing Neutral
Format (.sdf, .sdnf)

Autodesk (.dwg)

Autodesk (.dxf)

DuctDesigner 3D Autodesk (.dwg)

Autodesk (.dxf)

IFC2X3 (.ifc)

Autodesk (.dwg)

Autodesk (.dxf)

IFC2X3 (.ifc)
PipeDesigner 3D Autodesk (.dwg)

Autodesk (.dxf)

IFC2X3 (.ifc)

Autodesk (.dwg)

Autodesk (.dxf)

IFC2X3 (.ifc)
Plancal IFC2X3 (.ifc)

Autodesk (.dwg)

Autodesk (.dxf)

IFC2X3 (.ifc)

Autodesk (.dwg)

Autodesk (.dxf)
SketchUp Make SketchUp (.skp) SketchUp (.skp)
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Trimble product Import to Tekla
Structures

Export from Tekla
Structures

SketchUp Pro SketchUp (.skp)
Autodesk (.dwg)

Autodesk (.dxf)

SketchUp (.skp)
Autodesk (.dwg)

Autodesk (.dxf)
Tekla Field3D IFC2X3 (.ifc)
Tekla Civil Direct Link

LandXML (.xml)

Direct Link

IFC2X3 (.ifc)
Tekla Collaboration Tekla Collaboration files

( .tczip)
Tekla Collaboration files
( .tczip)

Tekla Structural
Designer

Neutral XML (.cxl) Neutral XML (.cxl)

Trimble Business Centre LandXML (.xml)  
Trimble Connect Direct Link

IFC2X3 (.ifc)

Direct Link

IFC2X3 (.ifc)
Trimble Field Link Trimble Field Link (.tfl) Trimble Field Link (.tfl)
Trimble LM80 Desktop Autodesk (.dxf)

LM80 (.cnx, .txt)

Autodesk (.dxf)

LM80 (.cnx, .txt)
Vico Office  Direct Link

 Autodesk (.dwg)
 Autodesk (.dxf)
 IFC2X3 (.ifc)
IfcXML 2X3 (.xml) IfcXML 2X3 (.xml)
 Microstation (.dgn)
Excel Spreadsheet
(.xls)

Excel Spreadsheet
(.xls)

Vico Schedule Planner Direct Link
.xml

Direct Link
.xml

Compatible software with direct links

The following table lists the software that have a direct link with Tekla
Structures to import and export data (page 154).

Many direct links are available in Tekla Warehouse.

The table also lists the file formats that can be used in case the direct link is
not possible.
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Product Company Import to Tekla
Structures

Export from Tekla
Structures

ADConX ADConX Direct Link
AxisVM Inter-CAD Kft. Direct Link Direct Link

IFC2X3 (.ifc)
BeamMaster AGT Direct Link
Bentley
Architecture

Bentley Direct Link (ISM) Direct Link (ISM)
Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IFC2X3 (.ifc) IFC2X3 (.ifc)
Microstation (.dgn) Microstation (.dgn)
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

Bentley
Structural

Bentley Direct Link (ISM) Direct Link (ISM)
Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
CIS/2 LPM6 design
(.stp, .p21, .step)

 

IFC2X3 (.ifc) IFC2X3 (.ifc)
Microstation (.dgn) Microstation (.dgn)
Steel Detailing
Neutral Format
(.sdf, .sdnf)

 

STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

CYPECAD Cype Direct Link
Diamonds Buildsoft Direct Link Direct Link
Fabsuite Fabsuite Direct Link

KISS (.kss)

Direct Link

KISS (.kss)
FEM Design StruSoft Direct Link

IFC2X3 (.ifc)

Direct Link

IFC2X3 (.ifc)
IDEA StatiCa IDEA StatiCa  Direct Link
Joints For
Tekla

Progetto
Archimede

Direct Link

Lantek Lantek Direct Link Direct Link
LIRA-SAPR LIRA SAPR Direct Link (Default,

Russia)
Direct Link
(Default, Russia)

LIRA 10 LIRA SOFT Direct Link (Russia) Direct Link (Russia)
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Product Company Import to Tekla
Structures

Export from Tekla
Structures

Meridian
Prolog

Trimble Direct Link

Midas Gen MIDAS Direct Link Direct Link
ModeSt Tecnisoft Direct Link Direct Link
PEMA
WeldControl

Pemamek Direct Link

Pipelabo Maruhide Direct Link
PowerConnec
t

Buildsoft Direct Link Direct Link

PowerFrame Buildsoft Direct Link Direct Link
ProCAM HGG Direct Link Direct Link
Pro-Fit Zeman Direct Link
Qnect Qnect Direct Link
Raptor Peddinghaus  Direct Link
RFEM Dlubal Direct Link

CIS/2 LPM6 analytical
(.stp, .p21, .step)

IFC2X3 (.ifc)

Direct Link

CIS/2 LPM6
analytical
(.stp, .p21, .step)

IFC2X3 (.ifc)
RISA 3D
(Suite)

Risa Technology Direct Link (US
market)

Direct Link (US
market)

Autodesk (.dxf) Autodesk (.dxf)
CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6
analytical
(.stp, .p21, .step)

CIS/2 LPM6 design
(.stp, .p21, .step)

CIS/2 LPM6 design
(.stp, .p21, .step)

Steel Detailing
Neutral Format
(.sdf, .sdnf)

 

RisaConnectio
n

Risa Technology Direct Link (US, UK,
Germany, Sweden,
Norway, China, India,
Australia)

Direct Link (US, UK,
Germany, Sweden,
Norway, China,
India, Australia)

Get started with import and export formats 140 Compatible file formats and software with Tekla
Structures



Product Company Import to Tekla
Structures

Export from Tekla
Structures

Robot
Millenium

Autodesk Direct Link

CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6 design
(.stp, .p21, .step)

Direct Link

CIS/2 LPM6
analytical
(.stp, .p21, .step)

CIS/2 LPM6 design
(.stp, .p21, .step)

RSTAB Dlubal Direct Link

CIS/2 LPM6 analytical
(.stp, .p21, .step)

IFC2X3 (.ifc)

Direct Link

CIS/2 LPM6
analytical
(.stp, .p21, .step)

IFC2X3 (.ifc)
SAP2000 Computers &

Structures, Inc.
Direct Link Direct Link
Direct Link (ISM) Direct Link (ISM)
Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6
analytical
(.stp, .p21, .step)

SCIA Nemetschek Direct Link Direct Link
Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IFC2X3 (.ifc) IFC2X3 (.ifc)
Steel Detailing
Neutral Format
(.sdf, .sdnf)

Steel Detailing
Neutral Format
(.sdf, .sdnf)

S-FRAME S-FRAME
Software Inc.

Direct Link

Autodesk (.dxf)

Direct Link

Autodesk (.dxf)
Sicam Controlled

Automation
 Direct Link

STAAD.Pro Bentley Direct Link Direct Link
Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6
analytical
(.stp, .p21, .step)

 Staad ASCII file
(.std)
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Product Company Import to Tekla
Structures

Export from Tekla
Structures

Steel Detailing
Neutral Format
(.sdf, .sdnf)

 

ISM ISM
Steel Projects
PLM

Steel Projects Direct Link Direct Link

StruM.I.S StruM.I.S Direct Link BSWX (.bswx )
Vacam Voortman Direct Link

Compatible software

The following table lists Tekla Structures compatible software and the formats
that you can import to and export from (page 154)Tekla Structures.

For a list of IFC applications certified by buildingSMART international, see
Certified Software.

To find out more about the various import and export tools, see Import to and
export from Tekla Structures (page 154).

Product Company Import to Tekla
Structures

Export from Tekla
Structures

3ds Max Autodesk Autodesk (.dwg)

Autodesk (.dxf)

IGES (.iges, .igs)

Autodesk (.dwg)

Autodesk (.dxf)

3ds Max
Design/VIZ

Autodesk Autodesk (.dwg)

Autodesk (.dxf)

IGES (.iges, .igs)

Autodesk (.dwg)

Autodesk (.dxf)

A+ Software ArmaPlus  BVBS (.abs)

Soulé (.xml)

aSa (.TEK)
Adapt Adapt

Corporatio
n

Autodesk (.dwg)

Autodesk (.dxf)

Autodesk (.dwg)

Autodesk (.dxf)

Advanced
Steel,
Advanced
Design/
Engineering

Autodesk CIS/2 LPM5 analytical
(.stp, .p21, .step)

IFC2X3 (.ifc)

Steel Detailing Neutral
Format (.sdf, .sdnf)

CIS/2 LPM5 analytical
(.stp, .p21, .step)

IFC2X3 (.ifc)

Steel Detailing Neutral
Format (.sdf, .sdnf)
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Product Company Import to Tekla
Structures

Export from Tekla
Structures

Allplan/
Planbar

Nemetsch
ek

Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IFC2X3 (.ifc) IFC2X3 (.ifc)
Microstation (.dgn) Microstation (.dgn)

ANSYS ANSYS IGES (.iges, .igs) IGES (.iges, .igs)
ArchiCAD Graphisoft

/
Nemetsch
ek

Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IFC2X3 (.ifc) IFC2X3 (.ifc)
IFCXML 2X3 (.xml) IFCXML 2X3 (.xml)
IFCZIP (.ifczip) IFCZIP (.ifczip)
Coordinated view v1 Coordinated view v1

ArchonCAD ArchonCA
D Ltd.

Autodesk (.dwg)

Autodesk (.dxf)

IGES (.iges, .igs)

Autodesk (.dwg)

Autodesk (.dxf)

Armaor Ariadis BVBS (.abs)
Artube Adige STEP (.stp, .step)

IGES (.iges, .igs)

IFC (.ifc)
aSa Rebar Applied

Systems
Associates
Inc

aSa Rebar file (.TEK)

ASI Applied
Science
Internation
al LLC

Staad ASCII file (.std)

AutoCAD Autodesk Autodesk (.dwg)

Autodesk (.dxf)

Autodesk (.dwg)

Autodesk (.dxf)
AutoCAD
Architecture

Autodesk Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IFC2X3 (.ifc) IFC2X3 (.ifc)
IGES (.iges, .igs) Microstation (.dgn)

AutoCAD Civil
3D

Autodesk Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
Microstation (.dgn)  
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LandXML files (.xml)  
AutoCAD MEP Autodesk Autodesk (.dwg) Autodesk (.dwg)

Autodesk (.dxf) Autodesk (.dxf)
IFC2X3 (.ifc) IFC2X3 (.ifc)
 Microstation (.dgn)

AutoPLANT Bentley Autodesk (.dwg)

Autodesk (.dxf)

Autodesk (.dwg)

Autodesk (.dxf)
AutoVue Oracle Autodesk (.dwg)

Autodesk (.dxf)

IFC2X3 (.ifc)

STEP AP214
(.stp, .step)

Aveva E3D AVEVA Microstation (.dgn)

Steel Detailing Neutral
Format
(.sdf, .sdnf, .dat)

.ifc based Tekla
Collaboration files
(.tczip)

Microstation (.dgn)

Steel Detailing Neutral
Format
(.sdf, .sdnf, .dat)

.ifc based Tekla
Collaboration files
(.tczip)

AviCAD Progress/
EBAWE

Unitechnik (.cam),
BVBS (.abs)

Bentley
Building
Electrical
Systems

Bentley Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IFC2X3 (.ifc) IFC2X3 (.ifc)
Microstation (.dgn) Microstation (.dgn)
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

Bentley
Building
Mechanical
Systems

Bentley Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IFC2X3 (.ifc) IFC2X3 (.ifc)
Microstation (.dgn) Microstation (.dgn)
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

Bentley
Inroads

Bentley LandXML files (.xml)
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Betsy IBB –
Consultant
s &
Engineers

Betsy (.fa), Betsy (.f),
Betsy (.ev)

Cadmatic Cadmatic Autodesk (.dwg)

Autodesk (.dxf)

IFC2X3 (.ifc)

Autodesk (.dwg)

Autodesk (.dxf)

IFC2X3 (.ifc)
CADmep+ MAP

Software /
Autodesk

Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IFC2X3 (.ifc) IFC2X3 (.ifc)
IFCXML 2X3 (.xml) IFCXML 2X3 (.xml)
IFCZip (.ifczip) IFCZip (.ifczip)

CADPipe AEC
Design
Group

Autodesk (.dwg)

Autodesk (.dxf)

Autodesk (.dwg)

Autodesk (.dxf)

CADWorx Plant Intergraph
/ Hexagon

Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 design
(.stp,.p21,.step)

CIS/2 LPM6 design
(.stp,.p21,.step)

CAESAR II Intergraph
/ Hexagon

Autodesk (.dwg) Autodesk (.dwg)

CATIA Dassault Autodesk (.dwg)  
Autodesk (.dxf)  
IGES (.iges, .igs)  
Steel Detailing Neutral
Format (.sdf, .sdnf)

Steel Detailing Neutral
Format (.sdf, .sdnf)

STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

Concrete Pro LAP Laser
GmbH

Autodesk (.dwg)

Autodesk (.dxf)

Unitechnik (.cam)
ConSteel ConSteel

Solutions
Limited

ASCII
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Corobs Müller
Opladen

TubeNC (.xml)

Daystar
Software

Daystar
Software
Inc.

Autodesk (.dxf)

Steel Detailing Neutral
Format (.sdf, .sdnf)

Autodesk (.dxf)

Steel Detailing Neutral
Format (.sdf, .sdnf)

DDS-CAD DDS IFC2X3 (.ifc) IFC2X3 (.ifc)
Digital Project Gehry

Technologi
es

Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IGES (.iges, .igs)  
Steel Detailing Neutral
Format (.sdf, .sdnf)

Steel Detailing Neutral
Format (.sdf, .sdnf)

STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

ebos Progress/
EBAWE

Unitechnik (.cam)

elcoCAD Hannappel
SOFTWAR
E GmbH

Autodesk (.dwg)

Autodesk (.dxf)

Autodesk (.dwg)

Autodesk (.dxf)

ELiPLAN Elematic ELiPLAN (.eli) ELiPLAN (.eli)
ELiPOS Elematic ELiPLAN (.eli)
EliteCAD Messerli

Informatik
IFC2X3 (.ifc)
Autodesk (.dxf)

IFC2X3 (.ifc)

Autodesk (.dxf)
ETABS Computers

&Structure
s, Inc.

Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6 analytical
(.stp, .p21, .step)

Steel Detailing Neutral
Format (.sdf, .sdnf)

Steel Detailing Neutral
Format (.sdf, .sdnf)

 STEP AP214
(.stp, .step)

FabPro Pipe UHP
Process
Piping Inc.

Autodesk (.dwg)

Autodesk (.dxf)

Autodesk (.dwg)

Autodesk (.dxf)

FabTrol MRP FabTrol FabTrol MIS XML (.xml) FabTrol MIS XML (.xml)

FabTrol KISS File (.kss)

Tekla-FabTrol Report
(.xsr)
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FactoryCAD Siemens Autodesk (.dwg)

Autodesk (.dxf)

Autodesk (.dwg)

Autodesk (.dxf)
FelixCAD SofTec Autodesk (.dwg)

Autodesk (.dxf)

Autodesk (.dwg)

Autodesk (.dxf)
Floor Pro Adapt

Corporatio
n

Autodesk (.dwg)

Autodesk (.dxf)

Autodesk (.dwg)

Autodesk (.dxf)

FormZ AutoDesSy
s, Inc.

Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IGES (.iges, .igs)  
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

FXTube Mazak STEP (.stp, .step)

IGES (.iges, .igs)

IFC (.ifc)
GSA Oasys CIS/2 LPM6 analytical

(.stp, .p21, .step)
CIS/2 LPM6 analytical
(.stp, .p21, .step)

GT Strudl GT Strudl Autodesk (.dxf)

CIS/2 LPM6 analytical
(.stp, .p21, .step)

Autodesk (.dxf)

HMS HMS HMS (.sot)
HOOPS Tech Soft

3D
Autodesk (.dwg)

Autodesk (.dxf)
Inventor Autodesk Autodesk (.dwg) Autodesk (.dwg)

Autodesk (.dxf) Autodesk (.dxf)
IGES (.iges, .igs)  
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

IronCAD IronCAD Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IGES (.iges, .igs)  
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

iTWO RIB
Software
AG

CPIxml (.xml)
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KeyCreator Kubotek Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IGES (.iges, .igs)  
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

LEIT2000 SAA Unitechnik (.cam)
LP-System Lennerts &

Partner
BVBS (.abs)

MagiCAD Progman Autodesk (.dwg)

IFC2X3 (.ifc)

Autodesk (.dwg)

IFC2X3 (.ifc)
MasterFrame MasterSeri

es
DSTV96
(.nc, .stp, .mis)

DSTV96
(.nc, .stp, .mis)

Maxon Cinema
4D

Nemetsch
ek

Autodesk (.dwg)

Autodesk (.dxf)

Autodesk (.dwg)

Autodesk (.dxf)
Maya Autodesk Autodesk (.dxf)

IGES (.iges, .igs)

STEP AP214
(.stp, .step)

Autodesk Maya
Autodesk (.dxf)

Mesh Welding EVG
(Filzmoser)

Unitechnik (.cam)

BVBS (.abs)
Mesh Welding A.W.M. Unitechnik (.cam)
Mesh Welding Progress /

EBAWE
Unitechnik (.cam)

Microsoft
Office Project

Microsoft Project (.xml) Project (.xml)

Microstran Engineerin
g Systems
Pty Limited

Autodesk (.dxf) Autodesk (.dxf)

Microstation Bentley Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IGES (.iges, .igs) IGES (.iges, .igs)
Microstation (.dgn) Microstation (.dgn)
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

Multiframe Daystar
Software
Inc.

Autodesk (.dxf)

Steel Detailing Neutral
Format (.sdf, .sdnf)

Autodesk (.dxf)

Steel Detailing Neutral
Format (.sdf, .sdnf)
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Nastran MSC
Software
Corporatio
n

Autodesk (.dwg)

IGES (.iges, .igs)

Autodesk (.dwg)

IGES (.iges, .igs)

NavisWorks Autodesk Autodesk (.dwg)

Autodesk (.dxf)

CIS/2 LPM6 analytical
(.stp, .p21, .step)

IFC2X3 (.ifc)

Microstation (.dgn)
NX (Unigraph) Siemens Autodesk (.dwg) Autodesk (.dwg)

Autodesk (.dxf) Autodesk (.dxf)
IGES (.iges, .igs)  
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

PDMS AVEVA Microstation (.dgn)

Steel Detailing Neutral
Format
(.sdf, .sdnf, .dat)

Tekla Collaboration
files (.tczip)

Microstation (.dgn)

Steel Detailing Neutral
Format
(.sdf, .sdnf, .dat)

Tekla Collaboration
files (.tczip)

PDS Intergraph
/ Hexagon

Microstation (.dgn)

Steel Detailing Neutral
Format (.dat)

Microstation (.dgn)

Steel Detailing Neutral
Format (.dat)

Peikko
Designer

Peikko
Group
Corporatio
n

Plug-ins Plug-ins

PipeCAD Mc4
Software

Autodesk (.dxf) Autodesk (.dxf)

Plant-4D CEA
Technolog
y

Autodesk (.dwg)

Autodesk (.dxf)

Microstation (.dgn)
PRIAMOS GTSdata CPIxml (.xml)

Unitechnik (.cam)
Primavera Oracle P6 (.xml) P6 (.xml)
ProStructures Bentley  Autodesk (.dwg)

Get started with import and export formats 149 Compatible file formats and software with Tekla
Structures



Product Company Import to Tekla
Structures

Export from Tekla
Structures

 Autodesk (.dxf)
 Microstation (.dgn)
Steel Detailing Neutral
Format (.sdf, .sdnf)

Steel Detailing Neutral
Format (.sdf, .sdnf)

ISM ISM
Pro/Engineer PTC IGES (.iges, .igs)

STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

ProFit Progress/
EBAWE

BVBS (.abs)

Prokon Prokon CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6 analytical
(.stp, .p21, .step)

PythonX Lincoln
Electric

DSTV

RAM (CAD
Studio)

Bentley Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6 design
(.stp, .p21, .step)

CIS/2 LPM6 design
(.stp, .p21, .step)

ISM ISM
Revit
Architecture/M
EP

Autodesk Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IFC2X3 (.ifc) IFC2X3 (.ifc)
Microstation (.dgn) Microstation (.dgn)
 Tekla Collaboration

files (.tczip)
Revit Structure Autodesk Autodesk (.dwg) Autodesk (.dwg)

Autodesk (.dxf) Autodesk (.dxf)
CIS/2 LPM6 design
(.stp, .p21, .step)

CIS/2 LPM6 design
(.stp, .p21, .step)

IFC2X3 (.ifc) IFC2X3 (.ifc)
Microstation (.dgn) Microstation (.dgn)
 Tekla Collaboration

files (.tczip)
Rhinoceros McNeel

North
America

Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
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IGES (.iges, .igs)  
Microstation (.dgn) Microstation (.dgn)
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

Geometry Gym link Geometry Gym link
RinasWeld Kranendon

k
IFC2X3 (.ifc)

SACS Engineerin
g
Dynamics
Inc.

Autodesk (.dxf)

Steel Detailing Neutral
Format (.sdnf)

SAFE Computers
&
Structures,
Inc.

Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6 analytical
(.stp, .p21, .step)

IGES (.iges, .igs)  
SAM Bestech

Limited
Autodesk (.dxf) Autodesk (.dxf)

Schnell
Software

Schnell
Software

BVBS (.abs)

Unitechnik (rebar/
mesh)

SDS/2 Design
Data

Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6 design
(.stp, .p21, .step)

CIS/2 LPM6 design
(.stp, .p21, .step)

 CIS/2 LPM6
manufacturing
(.stp, .p21, .step)

Microstation (.dgn) Microstation (.dgn)
Smart 3D
(SmartPlant /
SmartMarine)

Intergraph
/ Hexagon

CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6 design
(.stp, .p21, .step)

CIS/2 LPM6 design
(.stp, .p21, .step)

Microstation (.dgn) Microstation (.dgn)
IFC2X3 (.ifc), with
SmartPlant 3D
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Solibri Model
Checker/Model
Viewer

Solibri IFC2X3 (.ifc)

SolidEdge Siemens Autodesk (.dxf) Autodesk (.dxf)
Microstation (.dgn) Microstation (.dgn)
IGES (.iges, .igs)  
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

SolidWorks Dassault Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IGES (.iges, .igs)  
IFC2X3 (.ifc) IFC2X3 (.ifc)
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

Soulé Soulé
Software
Inc.

 .xml
BVBS (.abs)

SPACE GASS SPACE
GASS

CIS/2 LPM6 analytical
(.stp, .p21, .step)

CIS/2 LPM6 analytical
(.stp, .p21, .step)

SpaceClaim SpaceClai
m Co.

Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
IGES (.iges, .igs)  
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

Steel Smart
System

Applied
Science
Internation
al, LLC

Autodesk (.dwg)

Autodesk (.dxf)

Autodesk (.dwg)

Autodesk (.dxf)

StructureWork
s

Structure
Works LLC.

Autodesk (.dwg)  
Autodesk (.dxf)  
IGES (.iges, .igs)  
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)

TurboCAD IMSI
Design

Autodesk (.dwg) Autodesk (.dwg)
Autodesk (.dxf) Autodesk (.dxf)
Microstation (.dgn) Microstation (.dgn)
STEP AP203/AP214
(.stp, .step)

STEP AP214
(.stp, .step)
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UniCAM Unitechnik Unitechnik
(.cam, .uni)

Unigraphics Siemens
PLM
Software

IGES (.iges, .igs)

Vernon Lincoln
Electric

TubeNC (.xml)

VectorWorks Nemetsch
ek

IFC2X3 (.ifc)

IGES (.iges, .igs)

Autodesk (.dwg)

Autodesk (.dxf)

IFC2X3 (.ifc)
Volo View Autodesk Autodesk (.dwg)

Autodesk (.dxf)

Autodesk (.dwg)

Autodesk (.dxf)
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3 Import to and export from
Tekla Structures

Tekla Structures has several tools you can use to import and export physical
and reference models and the information they contain.

For details about compatible software in import and export, seeCompatible
file formats and software with Tekla Structures (page 135) .

NOTE The import and export functionality is not available in all Tekla Structures
configurations. For more information, see .

You can use import and export in Tekla Structures for several purposes:

• You can import reference models to Tekla Structures. For example, you can
import an architectural model, a plant design model, or a heating,
ventilating and air-conditioning (HVAC) model as a reference model.
Reference models can also be simple 2D drawings that are imported and
then used as a layout to directly build the model on.

• You can import 2D or 3D models created by other software, then detail or
manipulate the structural objects using Tekla Structures. Once the model is
complete, you can export it, and return it to the architect or engineer for
review.

• You can create reports from the imported models from most of the
formats.

• You can export Tekla Structures models for use in Analysis & Design
(several formats). Then you can import the Analysis & Design results back
to the Tekla Structures model.

• Various model transfers can be completed for the engineering and
contractor phase of the project.

• You can import shapes from many formats. Shapes are used in defining
items.
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• You can export data for use in manufacturing information systems and in
the fabrication phase:

• You can export CNC data (Computer Numerical Control) for use by
automated cutting, drilling and welding CNC machinery.

• You can export to MIS (Manufacturing Information Systems) so that
fabricators can track project progress, for example.

Click the links below to find out more about the various types of import and
export:

Reference models and compatible formats (page 159)

IFC (page 191)

DWG and DXF (page 230)

DGN (page 263)

LandXML (page 268)

PDF (page 270)

SketchUp (page 271)

Point clouds (page 272)

NC files (page 325)

FEM (page 318)

ASCII files (page 369)

CIS and CIMSteel models (page 361)

MIS lists (page 360)

FabTrol XML files (page 368)

PDMS/E3D (page 369)

HMS (page 471)

ELiPLAN (page 455)

BVBS (page 444)

Unitechnik (page 373)

Analysis and design systems (page 305)

CAD (page 478)

Layout manager (page 286)

Trimble Connector (page 114)

In addition to these built-in import and export tools, you have a variety of links
to other applications available in Tekla Warehouse that you can download.
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3.1 Conversion files
Conversion files (.cnv) map Tekla Structures profile, twin profile, and material
names with names used in other software.

Conversion files are simple text files, containing the Tekla Structures name in
the first column, and the name used in the other software package in the
second column. Columns are separated by a space. All parametric profiles
must be entered in the profile conversion file.

You can use the same conversion file both when importing and exporting
models, and you can specify the location of conversion files in most of the
import and export tools.

If you enter a conversion file name without a path, Tekla Structures searches
for the file in the current model folder. If you leave the box empty, Tekla
Structures searches for the file indicated by the advanced option XS_PROFDB
in File menu --> Settings --> Advanced options --> File Locations . This is
also the case, if the tool does not allow you to define the path and conversion
file.

Tekla Structures has several conversion files in the standard installation, and
you can also create your own. Standard conversion files are located in the 
\profil folder under the environment folder ...\ProgramData\Trimble
\Tekla Structures\<version>\environments\ folder. The exact location
may vary depending on your environment. All conversion files have the .cnv
extension.

Create conversion files
You can create your own conversion files if the ones that come with Tekla
Structures installation do not suit your needs.
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1. Open an existing conversion file using any standard text editor. 

By default, conversion files are located in the \profil folder under the
environment folder...\ProgramData\Trimble\Tekla Structures
\<version>\environments\. The exact location may vary depending on
your environment.

2. Save the file with another name. 

If the export/import tool allows you to define the path to the conversion
file, you can save the file where you like. If this is not the case, save the file
in a location defined by the advanced option XS_PROFDB in File menu -->
Settings --> Advanced options --> File Locations .

3. Modify the file: enter profile names recognized by Tekla Structures in the
first column, and the corresponding name recognized by the other
software in the second column. 

While modifying, ensure that:

• You do not have blank material definitions (" ", empty quotation
marks).

• You do not have spaces in the profile position strings. For example,
enter "Hand_ Rail" not Hand Rail".

4. Save your changes. 

NOTE • All the three files (profile, twin profile and material) are not
needed if the differences in the profile name is just concerning
* X or x formats, because these are normally handled
automatically. For example, if you wanted to import
UC254x254x73 to be UC254*254*73, the lower case "x" is
automatically changed to "X" so the format of the conversion
file would be UC254*254*73 254X254X73.

• If you have problems importing the model, check any error
messages in the Tekla Structures log file, and check the
conversion files.

Example

Below are some examples of conversion files:

SDNF
! Profile name conversion Tekla Structures -> SDNF
!
! If Converted-name does not exist, it will be the same
! as Tekla Structures-name.

! Tekla Structures-name Converted-name
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C10X15.3 C10X15.3
C10X20 C10X20
C10X25 C10X25
C10X30 C10X30
C12X20.7 C12X20.7
C12X25 C12X25
C12X30 C12X30
C15X33.9 C15X33.9
C15X40 C15X40
C15X50 C15X50
C3X4.1 3X4.1
DSTV
! Profile name conversion Tekla Structures -> DSTV
!
! If Converted-name does not exist, it will be the same
! as Tekla Structures-name.

! Tekla Structures-name Converted-name

C10X15.3  C10X15.3
C10X20    C10X20
C10X25    C10X25
C10X30    C10X30
C12X20.7  C12X20.7
C12X25    C12X25
Below there is first an example of an incorrect conversion file and then of a
correct one, errors are highlighted:

00100782 4 0 2 "brace" "Tread 4" 1 "TREAD4.5" "" 0.000000 0 0 
0.000000 1.000000 0.000000 16.250000 13.154267 3.857143
15.500000 13.154267 3.857143 0.000000 0.000000 0.000000
0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
0.000000 0 0 0 0 0 0 0 0 0 0 0 0
00100782 4 0 2 "brace" "Tread_4" 1 "TREAD4.5" "A36" 0.000000
0 0 0.000000 1.000000 0.000000 16.250000 13.154267 3.857143
15.500000 13.154267 3.857143 0.000000 0.000000 0.000000
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0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
0.000000 0 0 0 0 0 0 0 0 0 0 0 0

Twin profile conversion files
Tekla Structures contains separate conversion files for twin profiles, and it
reads the twin profile conversion file before the profile conversion file, so you
must include the profiles from the original model in the import.

The twin profile conversion file is a text file containing the profile prefix
(characters only) and the distance between the profiles in mm, separated by a
space. Tekla Structures converts all profiles with the specified prefix to twin
profiles.

The twin profile conversion file could be named twin_profiles.cnv and it
could contain lines such as the one below:

DL 20
The distance between the profiles is the same for all profiles with the same
profile prefix. For example, profiles with the prefix DL will always have the
same spacing. If you want different spacing values, then you need to use a
different profile prefix.

You also need to add the twin profile to the profile conversion file to get the
DL profile converted to L-profile:

L200*20 DL200/20-20

Limitations

• Twin profile conversion cannot be used for profiles that start with a
number. This means that you cannot define double angles as 2L. Instead,
you need to use DL as the prefix for a twin profile, for example: 
DL200/20-20.

• Twin profile conversion does not work for FEM import. We recommend
that each angle is modeled separately rather than as twin profiles, as SP3D
does not control the gaps between members in the same way as Tekla
Structures and there are, for example, various conversion and mapping
difficulties. Ii is easier to convert members that are modeled as two
members.

3.2 Reference models and compatible formats
A reference model is a file that helps you to build a Tekla Structures model. A
reference model may be created in Tekla Structures or another software or
modeling tool and then inserted to Tekla Structures.
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For example, an architectural model, a plant design model, or a heating,
ventilating and air-conditioning (HVAC) model can be used as a reference
model. Reference models can also be simple 2D drawings that are inserted
and then used as a layout to directly build the model on. You can snap to
reference model geometry.

Reference models of different formats, such as IFC, IFC4, IFCzip, IFCxml, tcZIP,
3DD, DXF, DWG, DGN, XML, LandXML, STP, IGS, SKP and PDF, are converted by
the TrimBimConverter to TrimBIM (.trb) at reference model insert. The .trb
file is saved in the current model folder. The reference cache is created in the
cache folder based on the advanced option XS_REFERENCE_CACHE when the
reference model is set visible, which happens automatically at insert and
update.

The following file types are supported, for example:

• AutoCAD files.dxf
• AutoCAD files .dwg (supported version ACAD2018 and earlier)

• IFC files .ifc, .ifczip, .ifcxml
• IGES files .igs, .iges
• LandXML files .xml
• MicroStation files.dgn, .prp
• PDF files .pdf
• Tekla Collaboration files .tczip
• SketchUp files .skp (supported version SketchUp 2020 and earlier)

• STEP files .stp, .STEP
• Filmbox files .fbx
• COLLADA files .dae
• Autodesk 3DS Max format files .3ds
• 3D image files .obj
• Blender files .blend
• GL Transmission Format files .glft
• Polygon File Format files .ply
• Tekla files .tekla
The Add model dialog box lists the extensions of all formats that are currently
supported by Tekla Structures.

Some reference models are automatically subdivided or split into reference
model objects.

TIP You can disable the roll-over highlight, which can speed up zooming.
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Reference model plug-ins in Tekla Warehouse

Reference model plug-ins are available as .tsep plug-ins in Tekla Warehouse.
Tekla Structures installation contains the plug-ins, but you can get newer ones
from Tekla Warehouse. First download the needed package from Tekla
Warehouse, and then import it to the Applications & components catalog.

For more information about .tsep packages, see .

Reference models in drawings

You can show reference models in drawings and adjust their visibility
settings: .

See also

Insert a reference model (page 161)

Modify reference model details (page 167)

Lock reference models (page 169)

View reference models (page 163)

Detect changes between reference model versions (page 169)

Define a comparison set for reference model change detection (page 175)

Export change detection results to Excel (page 179)

Reference model objects (page 185)

Inquire reference model contents (page 184)

Examine reference model hierarchy and modify reference model objects
(page 186)

Insert a reference model
You can insert reference models in a Tekla Structures model. You can use the
reference models to overlay different discipline models with your own model.
These disciplines can be architect, plant engineer, services engineer or other
structural disciplines.

Note that the reference model name should not contain any special
characters.

1. Open a Tekla Structures model where you want to insert the reference
model.

2. Open the Reference Models list by clicking the Reference Models button

in the side pane .

3. In the Reference Models list, click the Add model button.
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4. In the Add model dialog box, if you have any previously created reference
model properties files, load the desired file by selecting the file from the
properties file list at the top.

5. In the Add model dialog box, browse for the reference model file by
clicking Browse.... 

You can also drag reference models from Windows Explorer, and insert
several models at a time.

For a list of compatible formats, see Reference models and compatible
formats (page 159).

6. Select a group for the model or enter the name of a new group. 

If you do not enter a name for the group, the reference model is inserted
in the Default group.

You can also drag models to an existing group or create a new group later
on.

7. In Location by, select one of the following options: 

Model origin inserts the model relative to 0,0,0.

Work plane inserts the model relative to the current work plane
coordinate system.

Base point:<name of base point> inserts the model relative to the
base point by using coordinate system values East coordinate, North
coordinate, Elevation, and Angle to North from the base point
definition in Project properties.

8. Select where you want to place the reference model. You can enter
coordinates in the Offset boxes or pick a position for the reference model
origin. 

The maximum number of decimals for coordinates is 13.

9. Set the Scale of the reference model if it is different from the one in the
Tekla Structures model. 

Note that you need to set the scale for a DWG or a DXF file already in
AutoCAD. When you define the measurement unit for a DWG or a DXF file
and save the file in AutoCAD, the unit is recognized in Tekla Structures,
and the reference model is scaled correctly.

The maximum number of decimals for scale is 13.

10. You can rotate the model around model Z axis by picking a location in the
model or entering the desired value in the Rotation box. 

The maximum number of decimals for the rotation value is 7.

11. Click More to show more details and add the Code, Title, Phase and
Description of the reference model. 

By default, the title is the same as the name of the inserted reference
model. You may want to use the name of the discipline or the company

Import to and export from Tekla Structures 162 Reference models and compatible formats



instead, for example. The code could be a site number, project number, or
accounting number. Write the description according to the company
conventions. The phase is the design phase of the reference model (not
the phase in the Tekla Structures model).

Below is an example of these details when you inquire the reference
model.

You can also modify all the details after you have inserted the model.

12. Click Add model.

13. If the inserted reference model lies outside the work area and is not fully
or at all visible in the model view, Tekla Structures displays a warning
message. Click Expand to extend the work area to see the reference
model in the model view. 

The reference model is inserted in the current phase of the Tekla
Structures model.

Note that for IFC reference models the elevation offset value is not read
from the inserted reference model.

When a reference model is inserted or updated, reference model data is
copied to Tekla Structures model internal data storage located in the
<current model>\datastorage\ref folder. The reference model is
visible even if the original file is removed from its original location. The
reference model data in this folder should not be touched.

NOTE Do not insert the same reference model to the Tekla Structures model several
times. One person only should update the reference model (click Refresh) to
avoid duplicate object data.

When you want to update the reference model, do not delete the old
reference model from an open Tekla Structures model and replace it with a
new one, because then you would lose the work done on reference objects in
the old model. Use the change detection functionality instead.

TIP To only clip reference models and point clouds with the clip plane tool, set the
advanced option XS_DO_NOT_CLIP_NATIVE_OBJECTS_WITH_CLIP_PLANE to TRUE.
If you do this, the native objects are not clipped.

See also

Modify reference model details (page 167)
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View reference models
There are many ways you can select what you want to show about the
reference models and how.

For details about inserting reference models, see Insert a reference model
(page 161).

To: Do this:
Open theReference Models
list

•
Click the  Reference Models button
in the side pane on the right side of the
Tekla Structures main window.

Hide and show reference
models

•
Click the eye button  next to the
model you want to hide.

The button changes to  and the
reference model is hidden in the 3D view.

• Click the eye button again to show the
model.

Hide and show a group of
reference models

•
Click the eye button  next to the
group you want to hide. The group eye
button and the reference model eye

buttons all change to , and all the
reference models included in the group
are hidden in the Tekla Structures model.

• Click the eye button again to show all the
models in the group.

• If a group contains both hidden and
visible models, the eye button for the

group looks like this .

• If there are no reference models in a

group, the eye button looks like this .
Highlight the reference model
in the 3D view

• Click the reference model in the
Reference Models list.

Show reference model details • Double-click the reference model in the
Reference Models list.

Show reference model object
details

1. Double-click the reference model in the
Reference Models list.
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To: Do this:
2.

Ensure that the  Select assemblies

selection switch (for assemblies) or 
Select objects in assemblies selection
switch (for parts) is active.

3. Point the reference model in the model
view, hold down Shift and scroll to the
hierarchy level where the desired
reference model object is located.

4. Point the object and double-click it to
open the reference model object details.

Rotate the reference model
around model Z axis.

• In the reference model details, enter the
desired value in the Rotation box. You
can also pick the rotation.

Hide and show reference
model layers

1. Double-click the reference model in the
Reference Models list to open the
details.

2. Click the small arrow on the Layers row
to show the list of layers.

3. You can show and hide individual layers
or all layers:

• To hide all layers, click the eye button

 on the Layers row.

• To hide individual layers, click the eye

buttons  of the individual layers.

• To hide several layers, holding down
Ctrl, click the desired layers and then
click the eye button of one of the
selected layers.

• If the Layers list contains both
hidden and visible layers, the eye
button for the Layers row looks like

this .

• If you hide all layers, the eye button

for the Layers row changes to .

Import to and export from Tekla Structures 165 Reference models and compatible formats



To: Do this:
• If you hide individual layers, the eye

button for the hidden layers changes

to .

Note that layer visibilities do not affect model
visibility, which means that the model eye
icon is visible even though all layers are
hidden.

Detect changes between
different versions of reference
models

For details about change detection, see
Detect changes between reference model
versions (page 169).

For details about comparison sets, see
Define a comparison set for reference model
change detection (page 175).

Refresh all reference models • If the file name or path has not changed,
open the Reference Models list and click

the  Refresh button.

All models that are not up to date are
reloaded. If a reference model is not

found, a warning sign  is displayed.

• If the file name or path has not changed,
open reference model details, browse for
the new file and click Modify.

You can also refresh locked reference
models, if you have set the advanced option 
XS_REFRESH_ALSO_LOCKED_REFERENCE_MO
DELS to TRUE in File --> Settings -->
Advanced options --> Import.

Refresh a single reference
model

1. Double-click the reference model in the
Reference Models list to open the
details.

2.
Click the  Refresh button.

The model is reloaded. If the reference

model is not found, a warning sign  is
displayed.

View user-defined attributes 1. Double-click the reference model in the
Reference Models list to open the
details.
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To: Do this:
2. Click the small arrow on the User-

defined attributes row to show the list
of user-defined attributes.

3. The user-defined attributes that are
specified for reference models in the
objects.inp file are listed in the User-
defined attributes list. Enter or select a
value from the list. By default, the
objects.inp is located
in ..\ProgramData\Trimble\Tekla
Structures\<version>
\environments\common\inp. You may
also have some objects.inp files that
you modify and keep in firm or project
folders. These files are read in certain
order.

Clip reference models only
with clip plane tool

Set the advanced option
XS_DO_NOT_CLIP_NATIVE_OBJECTS_WITH_CL
IP_PLANE to TRUE to only clip reference
models and point clouds with the clip plane
tool. If you do this, the native objects are not
clipped.

Redraw the model views after changing the
value.

This advanced option is located in the Model
View category in the Advanced Options
dialog box.

See also

Modify reference model details (page 167)

Reference model objects (page 185)

Examine reference model hierarchy and modify reference model objects
(page 186)

Lock reference models (page 169)
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Modify reference model details
After you have inserted a reference model, you can modify its details.

Limitation: Coordinates given in the Details section are always relative to
model coordinates. You can modify the coordinate system only if model
coordinate system is used in the reference model.

1. Click the  Reference Models button in the side pane on the right of
the Tekla Structures main window.

2. In the Reference Models list, double-click the reference model that you
want to modify.

3. Click the arrow on the Details row, and change the desired details: 

• Change Code, Title, Phase and Description of the reference model.

The code could be a site number, project number, or accounting
number. By default, the title is the same as the name of the inserted
reference model. You may want to use the name of the discipline or
the company instead, for example. Write the description according to
the company conventions. The phase is the design phase of the
reference model (not the phase in the Tekla Structures model).

• You can insert another version of the reference model using the File
box. For more information about version handling, see Detect changes
between reference model versions (page 169).

• In the Group box, you can select a new group for the reference model.

• You can also change the Location by selection.

By default, the Location by change does not keep the reference model
location. When you click Modify, the model position changes
according to East coordinate, North coordinate and Elevation
setting differences. If you want to calculate new offsets and keep the
current reference model location, select the check box next to the
Location by setting.

• You can change the Offset by entering new coordinates or by picking a
new offset.

• You can change the Rotation by entering a new value or picking a new
location.

• Click the arrow on the User-defined attributes row, and enter values
for the user-defined attributes.

You may enter strings (texts), select dates or enter numeric
information depending on the type of the user-defined attribute. The
reference model user-defined attributes are defined in their own
section in the objects.inp file. If you have several objects.inp
files, they are read in a specific reading order, for more information,
see .
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4. Click Modify. The changes that you made are implemented in the
reference model.

See also

Insert a reference model (page 161)

Lock reference models
You can prevent reference models from moving and from detail updates by
locking the reference models.

1. Click the Reference Models button  in the side pane on the right of
the Tekla Structures main window.

2. Move your mouse over the desired reference model in the Reference
Models list. 

The Lock/Unlock button is displayed.

3. Click the Lock/Unlock button. 

Now the reference model is locked. You can only add values for user-
defined attributes and work with layers, but you cannot modify the details
in any other way or move the model.

To lock multiple reference models, select the models from the list and

click the Lock/Unlock button  of one of the reference models.

To unlock the reference model, click the Lock/Unlock button again.

See also

Reference models and compatible formats (page 159)

Modify reference model details (page 167)

Detect changes between reference model versions
You can check the changes between different IFC reference model versions in
Tekla Structures using change detection. You can use change detection to
detect changes between reference models from different disciplines, such as
engineer or detailer. Changes are detected on object level. You can also
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compare Tekla Structures models if you have exported a Tekla Structures
model into IFC format at least twice.

Tekla Structures stores versions of the reference models for change detection.
Versioning is also needed for visualizing sharing changes and object
conversion change management.

Limitations

• Property comparison works only for IFC or IFC-based reference models.
The following formats are supported:

• .ifc
• .ifcxml
• .ifczip
• .tczip

• Deleted objects are not highlighted and cannot be selected.

Change detection

You can show changes between two stored reference model versions or
between stored version and browsed reference model file version. In both of
these cases you need to activate change detection:

1. Open the Reference Models list by clicking the  Reference Models
button in the side pane.

2. Open a reference model by double-clicking the model in the Reference
Models list.

3. Open the Change detection list by clicking the arrow on the Change
detection row.

Change detection between stored version and browsed model file
version

The file path box has automatically the full file path to the current reference
model original file. If a reference model file with the same name has changed,
you can run the change detection and skip steps 1 and 3 below .

1. Click ... and browse for an earlier version of the reference model.

2. Select the This model is newer check box next to the file path if you want
to define that the file shown in the box is newer.

3. Ensure that you have both the original reference model and the browsed

reference model version visible by setting the eye buttons active  in
the Change detection section.

4. To change the comparison set if needed, click the ... button and define the
set you want to use. Then click Update view. The comparison set contains
the properties that you want to use in version comparison.
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5. To change property set comparison tolerances, click the Property set

comparison tolerances button .

You can do any of the following in the changes list and in the property details
list:

• Export change detection results to Excel by clicking  Export to Excel.
The exported Excel file contains all or changed properties that are visible in
the changes list. The information is exported in the current language.

• Click a row in the changes list to open the related property details list in the
side pane. The content of the property details list depends on the
comparison rules that you are using. The details list also indicates how the
individual properties have changed in the Old value and New value
columns.

Note that in the property details list, if you by accident remove one of the
columns, you can bring it back by right-clicking the column title and
selecting the column from the context menu. You can then drag the
column to the desired location.

• To show the object in the model, select the Select objects in the model
check box, and then click a row in the changes list. Note that you cannot
select deleted objects.

• The older state of an object is drawn to the model view when you select the
corresponding object in the changes list.
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• To highlight the object in the changes list, select the Get selected objects
from model check box, and then click an object in the model.

• To zoom to the selected object in the model, select the Zoom to selected
check box, and then click a row in the changes list. You can also zoom to
deleted objects.

• The older state of a reference model object is drawn to the 3D view in
orange color when you select the corresponding object.

• To show only changes in the property details list, select the Show only
changes check box, and then click a row in the changes list.

• You can search for specific items using the search box at the bottom.

• If the changes list disappears, you can bring it back by clicking the 
Changes list button in the side pane. If the details list disappears, you can

bring it back by clicking the  Property details button in the side pane.
These two buttons are only visible when Change detection is active.

Update reference model and detect changes between versions

You can update a reference model with another version of the model, and
detect the changes between these two reference model versions.

1. Open another version of the reference model by browsing to it in the File
box in reference model details and clicking Modify.

This updates the original reference model with the changed information
in the other reference model version.

You can open several versions, but you can only compare two versions at
a time.

You do not need to copy the reference models to the model folder.

2. On the Change detection row, click the arrow on the row to open the
Change detection list.

In the Change detection list, the current version is bolded. The newest
version is at the top and the oldest at the bottom.

3. Ensure that both models are visible by setting the eye buttons active 
in the Change detection list.

Comparison is active only when two eye buttons are active  . You
cannot have more than two eye buttons active at the same time. If you
activate a third reference model in the list, the older version from

previously visible model is automatically set inactive , and the
comparison is done between the two models that have the active eye.

4. Set another version as the current version in the Change detection list by
right-clicking the version in the list and selecting Set as current.

Import to and export from Tekla Structures 172 Reference models and compatible formats



5. To change the comparison set, click the ... button and define the set you
want to use. Then click Update view. The comparison set contains the
properties that you want to use in version comparison.

6. To delete a version, right-click the version in the Change detection list,
and select Remove.

The current model version is modified, and this modification is shared in
multiuser mode or Tekla Model Sharing.

When you remove a version, you are asked if you want to set the model as
current and save changes.

You need to pay special attention to versioning and updating in a project.
For example, if you remove a version, the current model is updated and
you may end up with conflicts.

7. Select any or all of the check boxes for the following options: Changed,
Unchanged, Inserted and/or Deleted, and then click the Update view
button, which is displayed when you select an option.

For example, select Inserted to show with green color the objects that
were inserted between the two versions.

The changes list and the property details list are displayed. The changes
list content is based on the IFC content and has all physical object types.
The colors are the same as the ones in Change detection.

8. You can do any of the following in the changes list and in the details list:

• Click a row in the changes list to open the related property details list
in the side pane. The property details list contains at least the name,
location as origin and property set properties, basically the content is
the same as in the reference object inquiry report. The details list also
indicates how the individual properties have changed in the Old value
and New value columns.

• To highlight the object in the model, select the Select objects in the
model check box, and then click a row in the changes list. Note that
you cannot select deleted objects.

• To highlight the model object in the changes list, select the Get
selected objects from model check box, and then click an object in
the model.
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• To zoom to the selected object in the model, select the Zoom to
selected check box, and then click a row in the changes list. You can
also zoom to deleted objects.

• To show only changes in the property details list, select the Show only
changes check box, and then click a row in the changes list.

• The older state of a reference model object is drawn to the 3D view in
orange color when you select the corresponding object.

• You can search for specific items using the search box at the bottom.

• If the changes list disappears, you can bring it back by clicking the 
Changes list button in the side pane. If the details list disappears, you

can bring it back by clicking the  Property details button in the
side pane. These two buttons are only visible when Change detection
is active.

Change comparison order

• Select the This model is newer check box to define that the file shown in
the file path box is newer than the other compared file. If the file has been
updated, it appears in the box automatically and the check box is selected.

• It is possible to compare as newer (default) or older.

Select the This model is newer check box next to the file path box if you want
to define that the file shown in the box is newer.

Macro for selecting Tekla Structures native objects

The SelectCorrespondingObjectsBasedOnIfcObjectsSelection macro is
useful for cases where you exported native objects to IFC, inserted the IFC
model back to the same native model, and then you want to select the
corresponding Tekla Structures objects. You may need to select the
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corresponding objects when you want to add your own UDAs to all updated
and selected native objects, for example.

Remove old reference model versions automatically

You can remove old reference model versions automatically with the
advanced option XS_REFERENCE_MODEL_KEEP_VERSIONS_COUNT.

See also

Insert a reference model (page 161)

Convert IFC objects into native Tekla Structures objects (page 195)

Define a comparison set for reference model change
detection
Change detection in Tekla Structures compares different versions of the
reference model based on a comparison set, which tells you whether Tekla
Structures considers a change in a property a change or not. You can use the
standard property comparison set, or define a comparison set of your own.

In the reference model, when change detection is active, the changes list
shows all deleted, changed, new and not changed objects. The property details
list only contains those properties that are defined by the current comparison
set rules to be compared.

When you save a comparison file, both the standard file and a customized
comparison set file are saved to the \attributes folder under model folder.
The standard file can only be removed from model folder if it exists in
another location. If saving or removing the standard file is not successful, you
will get an error message.

Create a new comparison set
1. Open two versions of the same reference model.

2. In Change detection, click the Comparison sets button ... to open the
Comparison sets dialog box.

3. Enter a name for the comparison set. 

4. Add a new comparison rule by clicking the Add row button  and
typing or copying and pasting the property name. 

• You can copy and paste property names directly from the property
details list in change detection.
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• To include more properties within one rule, use asterisk (*), for
example:

X* (all that starts with X)

*X (all that ends with X)

• If you want to compare only one property set property, clear the
Property sets check box and create a separate rule for that property.
If you want to compare all property sets but not one property, select
the Property sets check box and create rule for that property and
leave its check box empty.

• Note that comparison rules are case insensitive.

• All rules in comparison set affect the comparison if the reference
model version has a corresponding property.

5. Add more rules in the same way as in step 2 and 3.

6. To delete a rule, select the rule and click the Delete row button . You
cannot delete fixed comparison rules, like Geometry, Location, Rotation,
Materials, Profiles, Products, Common attributes or Property sets, but
you can exclude those from comparison by leaving the check boxes next
to them empty.

7. Ensure that you have the check box selected next to all the comparison
rules you want to include in the comparison set. If you do not want to
include a rule, clear the check box. 

TIP You can also exclude attributes already included in a property set by
adding a separate row for that specific attribute and then ensuring
that you do not add a check mark in the check box next to that
specific attribute.

8. Click the Save button .
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9. Close the comparison set dialog box by clicking the Close button . If
you have not saved your changes, you will be asked if you want to keep
the changes when you close the dialog box.

10. Click the Update view button.

Properties in comparison property set

A comparison set may contain the following types of properties:

• Free property set properties, such as BaseQuantities.NetVolume

• Fixed properties that always exist in the comparison set file, but can be
excluded from the comparison

The fixed properties are listed below:

Property type Description
Geometry Object dimensions
Location The coordinates of the object in the

model
Rotation The rotation coordinates of the object
Material Material name and grade
Profile Profile name
Product IfcProduct parameters that vary

object type by type. Some properties
are optional.

Below examples of product
properties for IfcColumn:

Application full name

Application identifier

Change action

Creation date

Description

Family name

Given name

Is set last modified date

Last modified date

Middle names

Name

Object type

Organization description
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Property type Description
Organization names

Organization roles

Roles

State

Version
Common attributes Below examples of common

attributes for IfcColumn:

External Use

Fire Rating

Load bearing

Reference

COLUMNTYPE->GUID

GUID
Property sets Whatever has been added to IFC

properties.

Below examples of property set
properties for IfcColumn:

BaseQuantities.Length [mm]

BaseQuantities.NetWeight [kg]

BaseQuantities.NetVolume [mm³]

BaseQuantities.OuterSurfaceArea
[m²]

Tekla Common.Bottom elevation

Tekla Common.Class

Tekla Common.Phase

Tekla Common.Preliminary mark

Tekla Common.Top elevation

Tekla Quantity.Area per tons [m²]

Tekla Quantity.Gross footprint area
[m²]

Tekla Quantity.Height [mm]

Tekla Quantity.Length [mm]

Tekla Quantity.Net surface area [m²]

Tekla Quantity.Weight [kg]
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Property type Description
Tekla Quantity.Width [mm]

Tekla Quantity.Volume [mm³]

Define property comparison tolerances
In reference model version comparison, you can modify the property
comparison tolerance settings to get relevant changes more easily. You need
two versions from the same IFC model.

The changed row appears as light yellow if the tolerance is bigger than the
difference.

1. Open two versions of the same reference model.

2. In the Reference Models pane, open the Change detection section and
activate the change detection.

3. Click the Property set comparison tolerances button .

4. Change the tolerances by modifying the values. 

5. Apply the changes by closing the dialog box and clicking Update view. 

The changed row appears as light yellow.

You can also save the tolerances in the Property set comparison
tolerances dialog box.
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Export change detection results to Excel
The exported Excel file contains all or changed properties that are visible in
the changes list. The information is exported in the current language.

Objects that are filtered out using comparison set (page 175) filtering are not
exported.

Columns in export:

• Status

• Name

• Profile

• Material

• Type

• GUID

1. When the reference model change management (page 169) is active and

the changes list is displayed, click  Export to Excel.

2. Filter which properties are shown in the property changes list and
exported to the Excel file by using the comparison set (page 175) filtering.

3. In the Export to Excel dialog box, define the needed settings:

• Template: Select a new Excel template for the export.

• Export without column headers: If you do not want to show the
column headers in the Excel sheet, select this option.

• Export details: Exports all property details. Property details are shown
collapsed by default. When you open the collapsed details by clicking
the plus (+) button, all details are listed under titles Name, Old value
and New value.
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• Changed details only : Only exports those property details that have
changed between reference model versions.

4. If you want to save the settings in a properties file to be loaded and used
in other exports, enter a name and click Save.

5. When you are ready, click Export.

The changes list is exported to an Excel spreadsheet.

If you want, you can save the Excel where ever you want.

Example of the exported Excel when the Export details option has not been
selected.

Example of the exported Excel when the Export details option has been
selected. If you include details in the export, all property details are listed, and
the detail rows are by default collapsed. You can open the details by clicking
the plus (+) button.
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Example of the exported Excel when the Export details and Changed details
only options have been selected.

Add UDAs in reference models
If you wish to use user-defined attributes in your reference models, you need
to add the UDAs in the objects.inp file if your environment does not contain
any reference model UDAs.
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For more information on the contents of the objects.inp file, see Properties
of the objects.inp file.

For more information on adding content in the objects.inp file, see Define
and update user-defined attributes (UDAs). For an example on how to add
UDAs in the objects.inp file, see Example: Create and update a user-defined
attribute (UDA).

Note that you should not edit the original objects.inp file under the
environments folder. To define new user-defined attributes, create your own
objects.inp file in the model, project or firm folder.

Below is an example of the text you need to add to an objects.inp file to
create the UDAs which are shown in the image of the side pane.

/
**************************************************************************
*/
/* Reference attributes */
/
**************************************************************************
*/
reference(0,"j_Reference_model")
 {
 tab_page("","jd_Parameters",10)
 {
   attribute("VENDOR", "Ref. Model Vendor", string, "%s", no, none, 
"0.0", "0.0")
   {
     value("", 0)
   }
   attribute("DISCIPLINE", "Discipline", string, "%s", no, none, "0.0", 
"0.0")
   {
     value("", 0)
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   }
   attribute("PERCENT_COMPLETE", "% Complete", integer, "%s", no, none, 
"0.0", "0.0")
   {
     value("", 0)
   }
   unique_attribute("USER_PHASE", "User Phase", string, "%s", yes, none, 
"0.0", "0.0")
   {
     value("", 0)
   }
}
modify(1)
}

Inquire reference model contents
You can inquire the contents of a reference model. This is something you
might want to do after importing a reference model into Tekla Structures.

1. On the ribbon, click  Object.

2. In your Tekla Structures model, click the reference model you want to
examine. 

The contents of the reference model are listed in the Inquire object
dialog box.
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See also

Insert a reference model (page 161)

Reference model objects
Some types of reference models are automatically subdivided into reference
model objects, which is an individual part of an imported reference model. You
can define user-defined attributes separately for each reference model object
and use them for reports and the view and selection filters. They can also be
moved to a Tekla Structures model that is currently being worked on.
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Information included in a reference model object can be saved in the model
database.

The reference model objects are read-only.

Whether the reference model supports splitting depends on the file format
and file structure. .ifc models are always automatically subdivided,
and. .dwg files that include any of the following objects, are also automatically
subdivided:

• block table

• polyface mesh

• polygon mesh

• proxy object (for example, ADT)

• ACIS objects (3DSolid, Body, Region)

The file formats .dgn, .prp, .skp, .step, and .iges are not subdivided.

TIP To report a needed reference object attribute you can inquire a reference object
in the model to see the property name and then in Template Editor, add that
property name to be reported in a Reference* row.

See also

Reference models and compatible formats (page 159)

Examine reference model hierarchy and modify reference
model objects
You can view the reference model hierarchy and check the hierarchy level of
different objects. You can also add user-defined attributes to the reference
model objects. The added attributes can be used for filtering, for example.
Additionally, you can view the native reference object attributes and
properties.

1. Ensure that the Select assemblies selection switch  (for assemblies)

or Select objects in assemblies selection switch  (for parts) is active.

2. Point the reference model, hold down Shift and scroll using the middle
mouse button to the hierarchy level were the reference object is. Notice
that if the cursor is too close to a grid, the hierarchy is not scrolled.

3. Do any of the following: 

• To inquire the native reference object properties and attributes, right-
click the object and select Inquire .

• To view or modify the user-defined attributes of a reference object,
double-click the object to open the reference model object details.
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TIP There are many more commands available for the selected reference
model objects. Check rest of the commands on the pop-up menu.

Below is an example of a reference model representing a sanitary system.
When you want to scroll the hierarchy, the Select assemblies selection switch
or the Select objects in assemblies selection switch must be on. The 0 level
IfcProject in the example is the upmost level.

Below you can see one of the reference objects on the 3 level,
IfcBuildingStorey, of the same reference model.
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The last level, level 4, shows the individual parts.
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In the example below, one of the reference objects on the lowest level has
been inquired.
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Reference model assemblies
Imported IFC reference models can contain assemblies. You can select
reference model assemblies in the model view and view assembly level
information in Tekla Structures.

• You can add user-defined attributes to reference model assemblies.

• You can use the Inquire command to view information on reference model
assemblies. For example, you can view GUIDs of child objects.
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• You can create reports to view information on reference model assemblies.

3.3 IFC
IFC stands for Industry Foundation Classes, the set of internationally
standardized object definitions for use in the construction industry. IFC is
developed as an open standard by buildingSMART.

IFC offers a high-level common language for the sharing of intelligent objects,
such as building elements, between disciplines across the building life cycle.
The principal benefit of IFC is the object description – not only does the IFC
protocol preserve the full geometric description in 3D, but it also knows its
location and relationships, as well as all the properties (or parameters) of each
object.

For a list of IFC applications certified by buildingSMART international, see
Certified software.

See also

IFC interoperability concepts (page 191)

IFC insert (page 194)

Insert a reference model (page 161)

Convert IFC objects into native Tekla Structures objects (page 195)

IFC export (page 210)

IFC interoperability concepts
Some common terms and concepts used in IFC import, export, and conversion
are explained below.

B-rep

B-rep or boundary representation is a method for representing shapes using the
limits. A solid is represented as a collection of connected surface elements,
showing the boundary between solid and non-solid.

CSG

CSG or Constructive Solid Geometry is a technique used in solid modeling. CSG
allows a modeler to create a complex surface or object by
using Boolean operations to combine simpler objects.
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Boolean operations on sets

Union:

Intersection:
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Difference:

Extrusion

Sweeping is allowing a two-dimensional planar cross section to sweep through
space.

Revolved extrusion

A revolved extrusion or a solid of revolution is a solid object that is obtained by
rotating a plane cross section around a straight line (the axis) that lies on the
same plane.

Arbitrary profiles

In addition to parameterized profiles, there is a free profile shape type called
arbitrary profiles. These profiles are defined by an ifcCurve, which may have
linear and curved segments. Thin wall profiles can be defined by a centerline
and a thickness. Other profiles are defined by a closed shape. Closed profile
shape may or may not have inner voids.
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Parameterized profiles

There are several parameterized profiles available in the IFC specification.
Those include standard hot-rolled steel I, L, T, U, and Z profiles, cold formed C
profiles, and generic rectangle and circle profiles with or without a hollow.
These profiles are defined with their parameters, such as width, height, web
thickness and flange thickness.

IFC insert
You can insert IFC models as reference models to Tekla Structures, and
optionally convert the inserted IFC objects into native Tekla Structures objects
directly by using the direct conversion, or selected IFC reference objects using
conversion change management. You can use inserted IFC reference models,
for example, in clash checking, reporting and scheduling.

Insert a reference model

1. Open a Tekla Structures model where you want to insert the IFC reference
model.

2. Open the Reference Models list by clicking the Reference Models button

in the side pane .

3. Click the following link and follow the instructions for inserting the
reference model: Insert a reference model (page 161).

Supported IFC schemas and IFC applications

• Tekla Structures supports the following IFC schemas:

• IFC2X3 (recommended)

• IFC4

• For a list of applications/utilities that are purported, by their developers, to
provide IFC insert and/or export functionality, see List of all IFC
applications.

Certification

• The IFC insert IFC2X3 functionality has the IFC certification granted by
buildingSMART international. For a list of IFC-certified applications, see
Certified Software.

Supported entities

The IFC reference model insert in Tekla Structures supports all the sub-objects
of the IfcBuildingElement class and sub-objects of the IfcProduct class
including:

• Architectural entities

• Structural entities
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• Building services entities

Supported formats

• IFC (.ifc) and ifcXML (.ifcXML) formats are supported.

• You can use compressed (.ifcZIP) or uncompressed insert files.

• IFC4 does not support ifcXML.

See also

Convert IFC objects into native Tekla Structures objects (page 195)

Convert IFC objects into native Tekla Structures objects
You can convert most linear IFC reference objects such as beams, columns,
braces, plates, slabs, footings and walls into native Tekla Structures objects.
Conversion also supports polybeams that have curved sections, and have
originally been exported from Tekla Structures, and string, int and double type
UDAs. The purpose of converting IFC objects in Tekla Structures is to help in
the creation of the structural model and to avoid rework in an early modeling
phase.

In IFC object conversion, IFC objects are converted either as items or as
extrusions. Conversion as item means that an IFC object is converted as a
Tekla Structures item, where the 3D shape defines the geometry of the item.
Conversion as extrusion (page 191) means that an IFC object is converted as a
part (column, beam, plate, etc.) that has a profile extruded to create the length
of the part.

Limitation: The IFC4 and IFC4.1 formats are not supported in IFC object
conversion.

In IFC object conversion you need to do the following:

1. Before converting, check that the profiles and units in the IFC reference
model are compatible with your environment.

2. Check the object conversion settings in the IFC object conversion
settings dialog box and change them, if needed.

3. Convert the IFC objects to native Tekla Structures objects. There are two
alternative ways available in object conversion:

• Converting all selected reference model objects at one go using the
Convert IFC objects command on the Manage tab.

• Converting using the IFC object conversion change management. You
can also perform an update conversion with a new reference model
revision using the change management.

Is object conversion always necessary?
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In Tekla Structures, reference model objects can be used in a way similar to
the native objects, for example, in clash detection, reporting and scheduling.
There is no need to have everything as native, because the reference model
objects can also be used in many ways. For example, reference model objects
can be shown in drawings and they can be listed in reports.

The reference files have the benefit compared to the copied files that the
content of the files is automatically updated by the designer of that design
discipline.

Check and change the IFC object conversion settings
Before you start converting, check the conversion settings and change them if
necessary.

1. On the File menu, click Settings --> IFC object conversion settings .

2. In the IFC object conversion settings dialog box, check and change the
conversion settings: 

Create report after
conversion

Not used any longer. The changes list replaces the
report.

Set handles to top
flange

Set the reference lines of beams to top flange.

If Set handles to top flange is not selected, the
reference lines of beams are located in the middle
of the beams.

This setting is not used for polybeams for better
conversion results.

Convert B-rep object Convert B-rep objects into Tekla Structures objects.

You can select conversion to item and conversion
to extrusion separately for concrete material and
other material, for example, steel. The selected
options are applied to direct conversion and in
conversion change management.

B-rep objects are converted to items, and the items
are added to the shape catalog. The items belong
to class 996.

Primary profile
mapping

Profile name Map profiles primarily by comparing
the profile names between the IFC model and
Tekla Structures profile catalog.

Dimensions: Map profiles primarily by comparing
the object dimensions.

If the IFC object converter cannot map profiles with
the method you select as primary, it applies the
secondary (unselected) method.
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Tolerance Enter values for dimension comparison. The unit of
measurement is based on the environment.

The r value in Tolerance affects only rectangular
hollow profiles. It is used to distinguish hot rolled
profiles from cold rolled profiles.

3. Copy properties from the IFC object property sets to be used as user-
defined attributes of converted Tekla Structures objects: 

a. Click Add to add a row and enter the name of the IFC property in the
Property box.

Write the IFC property as it is shown in the Inquire dialog box
(without the prefix EXTERNAL.).

b. Enter the name of the user-defined attribute in the UDA box.

The maximum length of the user-defined attribute name is 20
characters. The user-defined attribute that you add here must also be
included in the objects.inp file. Ensure that the attribute name is
unique. Enter the original name of the user-defined attribute, not the
translation.

c. Click Type to select the format of the attribute.

The possible formats are string, integer or double. The type specifies
the IFC property datatype, not the UDA datatype.

4. Before you convert IFC objects into native Tekla Structures objects, check
the profiles and materials to ensure that the conversion will be successful,
and map the profiles or material manually in the following way: 

Import to and export from Tekla Structures 197 IFC



a. Click the Check button.

Tekla Structures displays any missing profiles or materials on the
Missing Profiles and Missing Materials tabs in the Missing
Mapping dialog box.

b. Select an appropriate option in the Tekla Structures profile and Tekla
Structures material lists to define a mapping for the missing profiles
or materials.

The mapping of profiles works for IFC data that has a profile name
but does not include enough information for conversion. You can
change your mappings later if needed. The maps are used in
conversion only if the profiles are not found from Tekla Structures
catalogs. Profile conversion follows a certain logic (page 204).

c. Click Update Mapping Catalogs and Close.

You can also open and modify the catalog files in a text editor. To do this,
click the Catalog button. When you are done, reopen the IFC object
conversion settings to take the new settings in use. The files are located in
the \attributes folder under the model folder:

TeklaStructuresCatalogMaterials.txt contains all materials

TeklaStructuresCatalogProfiles.txt contains all profiles

MappedMaterials-default.txt maps the materials

MappedProfiles-default.txt maps the profiles

5. Click OK in the IFC object conversion settings dialog box. Now you can
convert the IFC objects using one of the two available ways.

Convert selected IFC objects at one go
You can convert all imported IFC objects at one go using the current object
conversion settings. You need to have at least two or more revisions of the
same model.

1. Open the Reference Models list by clicking the Reference Models button

 in the side pane.

2. Click the Add model button, browse for the model in the Add model
dialog box, and click Add model again.

3. In the model, select the objects that you want to convert.

4. Go to the ribbon, and on the Manage tab, click Convert IFC objects. The
selected objects are converted on the basis of IFC conversion settings.
Conversion is done automatically for objects that have not been
converted earlier. Converted IFC object are listed in the changes list at the
bottom. Each object is on a row of its own, and cuts are listed
hierarchically under the related object. 
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• To select objects in model, activate the Select objects in the model
check box, and then click an object row. This also selects the related
native object.

• To highlight the object in the changes list and show its details, select
the Get selected objects from model check boxes, and then click an
object in the model.

• To zoom to the selected object in the model, select the Zoom to
selected check box, and then click a row in the changes list. The Zoom
to selected check box is disabled if the Select objects in the model is
not selected.

• To show only changes in the property details list, select the Show only
changes check box, and then click a row in the changes list.

Note that in the property details list, if you by accident remove one of
the columns, you can bring it back by right-clicking the column title and
selecting the column from the context menu. You can then drag the
column to the desired location.

• The status of an object may be New (green) Changed (yellow),
Deleted (red), or Up-to-date (blue or gray, when the conversion
change management is reopened), or Error (lilac).

• The Conversion status column shows the resulting conversion status.

• The properties of a converted object are listed in the property details
list that appears in the side pane when you click an object in the
changes list.
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5. You can update an object in the list by changing its conversion status to
Conversion and clicking Apply changes.

6. If the lists disappear, click the following buttons that are only visible when
the conversion changes list is active: 

•  The Changes list button brings back the changes list.

•  The Property details button brings back the property details list.

Convert IFC objects using conversion change management - first
conversion
Object conversion change management provides change detection and
change management on object level. Conversion change management is
needed in the initial data change management to reduce the challenges in
construction projects. Objects are not converted automatically but you need to
convert the objects using the conversion changes list.

1. Open the Reference Models list by clicking the Reference Models button

.

2. Click Add model, browse for the model in the Add model dialog box, and
click Add model again.

3. Double-click the model in the Reference Models list to open it, and then

click the Start IFC object conversion change management button . 

The current conversion status is displayed in the changes list and
conversion management is activated. The status is based on reference
model object physical changes and IFC conversion settings. The properties
of a reference object are listed in the property details list that appears
separately for each object when you click an object in the changes list.

Use the Select objects in the model, Get selected objects from model,
and Zoom to selected check boxes to review the model and the changes
and details lists.
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The reference object status and conversion status logic and colors:

Status Conversion status Color
New No conversion Green
Changed Conversion as item or

Conversion as
extrusion

Yellow

Deleted Conversion as item or
Conversion as
extrusion

Red

Up-to-date Conversion as item or
Conversion as
extrusion

Blue (gray when the
conversion change
management is
reopened)

Error No conversion Lilac

4. Convert objects by selecting the desired object rows, selecting
Conversion in the Conversion status column and clicking Apply
changes. The conversion is based on conversion settings. You can select
multiple objects. 

Import to and export from Tekla Structures 201 IFC



• After conversion, the conversion status is either Conversion as item
or Conversion as extrusion depending on the result of the
conversion.

• B-reps (page 191) are shown as Surface geometry, parametric
(page 191) profiles as Parametric and arbitrary (page 191) shapes as
Arbitrary. Assembly is also Arbitrary, and so are the reference
objects that are selected with the Select objects in assemblies or
Select objects in components selection switches.

• If B-rep (Surface geometry in the Reference type column) conversion
is selected, conversion is done as item, if not error.

• If object is extrusion (page 191) (Arbitrary or Parametric in the
Reference type column), it is converted as extrusion.

• You can force conversion to be item by selecting Conversion as item.
In this case, an extrusion object is also converted as item. The
conversion does not check if same shape is already available, meaning
new shape will always be created.

• You can force conversion to be extrusion by selecting Conversion as
extrusion. In this case, B-rep is also converted as extrusion, profile is
by mapping, or by bounding box if there is no mapping. This
conversion result is not always as preferred.

• If the conversion fails, the result is written to the Conversion status
column, and the row color is lilac.

5. If the lists disappear, click the following buttons that are only visible when
the conversion management is active: 

•  The Changes list button brings back the changes list.

•  The Property details button brings back the property details list.

Convert IFC objects using conversion change management - update
conversion
If a previously converted reference object has changed in a newer reference
model revision, you can compare the older and newer revisions of the
reference model and update the conversion.

1. Open the Reference Models list by clicking the Reference Models button

in the side pane .

2. Open the older reference model revision by double-clicking it in the
Reference Models list.

3. Update the reference model with a new revision of the reference model
by selecting a new revision file in the File list in the Details section and
clicking Modify.
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4. Click the Start IFC object conversion change management button .

5. Go through the changes: 

• Select the Select objects in the model and Zoom to selected check
boxes to see the changed objects clearly in the model.

• Click the changed row to see detailed changes in property details in
the side pane.

6. You can update previously converted objects partially by selecting the
Update check box next to a certain property in the property details pane.
For example, if you only want to update the profile information, only
select the Update check box next to the Profile row in the property
details pane.

7. To convert all objects with changed conversion status, select all rows,
change the Conversion status to Conversion and click Apply changes. 

• The objects that have a changed conversion status are converted on
the basis of the current IFC object conversion settings.

• You can update previously converted native model objects based on
previous conversion type and settings by selecting Conversion in the
Conversion status column. You cannot change the type from
extrusion to item, in this case you need to delete the native objects
and force conversion.

• If the reference object status is Deleted, select Conversion and click
Apply changes. This removes the native object and the link to the
removed reference objects.

Macro for selecting converted IFC objects
The SelectConvertedObjectsBasedOnIfcObjectsSelection macro selects the
objects that have been converted to native Tekla Structures objects. You may
need to select the converted objects to check the properties of the native
Tekla Structures objects, for example. This macro is located in the
Applications section of the Applications & components catalog.

Class values
The status of the converted object is reported in the changes list in the Class
column. Sometimes the input data in the IFC model is not adequate to
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successfully create the converted object. The following table explains what the
class values mean.

Class value IFC object data Converted object
description

990 Parametric profile with a
name

There is enough information
in the IFC model to convert
the object successfully.

991 Parametric profile without a
name

Tekla Structures determines
the name of the object based
on the objects profile.

992 Arbitrary profile with a name The profile of the converted
object may be incorrectly
rotated because there is no
parametrized profile data in
the IFC model.

993 Arbitrary profile without a
name

The profile of the converted
object may be incorrectly
rotated because there is no
parametrized profile data in
the IFC model.

The profile name is set to 
UNKNOWN.

994 B-rep piece with a name The profile may be an
extrema box due to the lack
of profile data in the IFC
model.

995 B-rep piece without a name The profile may be an
extrema box due to the lack
of profile data in the IFC
model.

The profile name is set to 
UNKNOWN.

996 B-rep piece The object is converted using
the Convert B-rep object
option in converter settings.

The converted B-rep object is
either an item or a concrete
item and is added to the
shape catalog.

Profile conversion logic in IFC object conversion
Tekla Structures uses a certain logic in converting profiles in IFC object
conversion.
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Parametric profile used in IFC model, I-, L-, U-, C-, T-, Z-, Rectangle- and Circular
type profiles can be defined parametrically:

1. If IFC file has been created with Tekla Structures, original profile name is
used.

2. If profile with same name is found from the Tekla Structures profile
catalog, it will be used.

3. Otherwise, Tekla Structures checks parameter values to find a
corresponding profile. If found, that will be used.

4. Otherwise, a default parametric profile is used.

Arbitrary profile used in IFC model, profile shape is defined with polygon:

1. If IFC file has been created with Tekla Structures, original profile name is
used.

2. If the shape is detected and found from Tekla Structures catalog, that
profile will be used. The shape detection supports the standard types of
hot rolled profiles.

3. Otherwise, a new profile is created based on the description of the
arbitrary profile.

B-rep geometry used in IFC model, object is defined with surfaces and profile
geometry information is not available:

1. If corresponding item exists in Tekla Structures model, it is used.

2. Otherwise, a new item will be created and used.

If Conversion as item is used for extrusion type of part, new item is always
created.

See also

Convert IFC objects into native Tekla Structures objects (page 195)
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Example: Convert IFC objects into Tekla Structures objects in one go

In this example, you use an IFC model as a basis for your structural model. You
will convert the beams and columns into native Tekla Structures objects.

1. Hide irrelevant IFC layers:

a. Click the Reference Models button .

b. In the Reference Models list, double-click the reference model to
open the details.

c. Open the Layers list by clicking the down arrow on the right.

d. Hide the unnecessary layers by clicking the eye button next to the
layer. 
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2. Select all visible IFC objects.

3. On the Manage tab, click Convert IFC objects. 

Tekla Structures converts the reference objects.

4. Check the profiles and materials of the IFC objects and map missing
material:

a. On the File menu, click Settings --> IFC object conversion settings .

b. Click Check. 

Tekla Structures lists the missing profiles and materials.

c. View the Missing Profiles and Missing Materials tabs. 

Tekla Structures lists a missing reference part material Concrete
Block.

d. Select CONCRETE_UNDEFINED from the list. 

e. Click Update Mapping Catalogs and Close.

f. Select the Create report after conversion check box.

g. Click OK in the IFC object conversion settings dialog box.

5. On the Manage tab, click Convert IFC objects again. 
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Tekla Structures converts the objects.

The Class for all the converted objects is 992. That means that the profile
of the converted object may be incorrectly rotated because there is no
parametrized profile data in the IFC model.

6. Check the conversion changes list: 

• Select objects in the changes list to highlight them in the model: Use
the buttons Select objects in the model and Zoom to selected.

• Compare the converted objects with the IFC objects.

• Use the Inquire object button on the ribbon to view detailed
information on objects.
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Below is an image of converted beams and columns.

See also

Convert IFC objects into native Tekla Structures objects (page 195)

Limitations in IFC object conversion

Tekla Structures is dependent on the quality of the IFC model, because it uses
information available in the model when converting objects.

Tekla Structures converts most linear IFC objects to native Tekla Structures
objects.

The following limitations exist in IFC object conversion:

• If the IFC model does not comply with standard, it might not be converted
as expected.

• Bolts, reinforcement and welds cannot be converted to native Tekla
Structures objects.

• The currently supported physical elements: IfcBeam, ifcColumn,
ifcMember, ifcPile, ifcFooting, ifcPlate, ifcDiscreteAccessory, ifcSlab, ifcWall,
ifcWallStandardCase, ifcRailing and ifcBuildingElementPart.

• Only SweptSolid, Brep, CSG and Clipping representations are supported.

• Multiple representations for one object are not supported.

• Profile offset is not supported.
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• Sometimes, chamfers may be converted incorrectly.

See also

Convert IFC objects into native Tekla Structures objects (page 195)

IFC export
You can export Tekla Structures models as IFC models.

You can export all basic parts in the Tekla Structures model such as beams,
columns, braces, slabs, panels, plates, reinforcing bars, and bolts with nuts
and washers.

Tekla Structures exports the model objects on the basis of the export settings
you define, including the property sets.

The IFC export functionality in Tekla Structures supports the IFC2X3 schema.
The IFC export functionality has the IFC certification granted by buildingSMART
international Certified Software.

IFC (.ifc) and ifcXML (.ifcXML) formats are supported. You can use
compressed (.ifcZIP) or uncompressed import files.

To Click the links below to find out
more

Define the
resulting IFC
entities for the
exported model
Tekla Structures
model objects and
the IFC export
settings, and then
export Tekla
Structures model

Export a Tekla Structures model or
selected model objects to an IFC file
(page 214)
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To Click the links below to find out
more

or a part of it into
a IFC file
Test the reference
model after
creating it

Check the exported IFC model
(page 225)

Check what kind
of base quantity
information is
included in the
Quantity takeoff
add-on view

IFC base quantities in exported IFC
model (page 225)

Take a look at the
property set
configuration files

Property set configuration files used
in IFC export (page 226)

Create additional
property sets out
of template
attributes and
user-defined
attributes, define
property
definitions for the
attributes, and
bind the property
sets to IFC entities
to be used in IFC
export

Define additional property sets for IFC
export (page 211)

Define additional property sets for IFC export
You can create additional property sets out of template attributes and user-
defined attributes, define properties for the attributes, and bind the Tekla
Structures property sets to IFC entities for IFC export. Tekla Structures saves
additional property sets in configuration files. You can keep several
configuration files in several locations. When Tekla Structures exports an IFC
file, it reads the predefined property sets and the additional property sets.

Add a new IFC property set configuration file

1. On the File menu, click Export --> IFC .

2. Select <new> in the Additional property sets list and click Edit. If you
have copied one of the predefined configuration files in the model folder,
open that one.
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3. For a new configuration file, in the Property Set Definitions dialog box,
enter a name for the configuration file in the Name box.

4. Enter a name for the property set next to the New button and click New. 

You can also select one of the property sets in the Property Set list.

You can create several property sets in one configuration file. For
example, you can add COGs, and start and end points on the part level,
and scheduling information on the assembly level.

5. For a new property set, enter a description for the property set in the
empty box.

6. Select an entity type from the Select entity types list by selecting its
check box. 

When you do this, the Select attributes list shows the attributes that are
available for the selected entity type.

7. Add the desired attributes from the Select attributes list by selecting the
check boxes next to the attribute names. 

The attribute is added to the List of all selected properties list on the
right. This list shows which attributes are exported and in which format:

• You can add new attributes by entering an attribute name in the
Attribute box in the Create/Modify property area and clicking the
Add button.

• You can modify and remove attributes on the list by selecting the
attributes on the list and clicking Modify or Remove.

8. Under Create/Modify property, define the attribute properties: 

• Select Property type for the selected attribute.

Here, always select Template attribute for those user-defined
attributes whose name contains more than 19 characters. For
example, select Template attribute for 
ASSEMBLY.USERDEFINED.PLANS_STATUS.

• Enter or modify the name of the selected attribute in the name box
Name.

• Select the Type of the attribute. The Type can be one of the following:
String (sequence of characters), Boolean(false or true), Integer
(number without a fractional part), Measurement, Real (numbers that
have decimal representations), or Time stamp.

• If the type of the user-defined attribute is Measurement:

• You can select the Measurement type: Length, Area, Volume,
Mass, Positive length or Count.

• You can select the Conversion factor and Accuracy.

User-definable accuracy allows better IFC file size optimization.
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9. Click Save to save your modifications.

1) The entity groups where Tekla Structures attributes are written in the
exported IFC file

2) The template attributes or user-defined attributes that you want to export
for the selected entity

3) List showing the selected attributes

4) The properties that you can define for the attributes

Tekla Structures model objects and corresponding IFC entities

Tekla Structures object IFC entity
Beam IfcBeam (IfcMember)
Column IfcColumn, (IfcPile), (IfcMember)
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Tekla Structures object IFC entity
Polybeam IfcBeam, (IfcMember)
Curved beam IfcBeam, (IfcMember)
Pad footing, Strip footing IfcFooting
Slab IfcSlab
Panel IfcWall or IfcWallStandardCase
Contour plate IfcPlate or IfcDiscreteAccessory
Bolts, nuts and washers IfcMechanicalFastener
Bolt hole IfcOpeningElement
Vertical braces IfcMember
Railing: Beam, Column IfcBeam, IfcColumn, (IfcRailing)
Assembly, cast unit IfcElementAssembly, (IfcRailing),

(IfcRamp), (IfcRoof), (IfcStair), (IfcWall)
Tekla Structures project IfcProject
Assembly sub-part IfcDiscreteAccessory
Bar, wire, strand, mesh, tendon, and
other component embedded in
concrete

(IfcReinforcingElement)

Reinforcement IfcReinforcingBar
Pour object, pour break IfcBuildingElementProxy
Surface treatment IfcCovering
Weld IfcFastener

NOTE • If the entity is not in parenthesis in the table above, the object is
automatically exported to this entity type. If an entity is in parenthesis, the
object is not exported to this entity type automatically, but you can select
the entity for the object on theIFC export tab.

• The IfcBuildingElementPart and IfcBuildingElement entities can also be
used. IfcBuildingElement matches beams, columns, etc, but not
assemblies.

• Polybeams are always exported as B-rep (page 191).

Export a Tekla Structures model or selected model objects to an IFC
file
You can export Tekla Structures model or a part of the model into an IFC file.

Before you start the export:

• Define the IFC entities for Tekla Structures model objects.

• Define the needed property sets (page 211).

• If you export the IFC file using the base point, define the base point.
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• To have pour objects and pour units (from Tekla Structures 2018 onwards)
in your model, set XS_ENABLE_POUR_MANAGEMENT to TRUE. In the IFC2x3
export, to export pour objects instead of CIP concrete parts select thePour
objects check box. In IFC4 export, to export pour objects and pour units
instead of cast-in-place parts and cast-in-place pcast units, select the Pours
check box. Note that pour unit export is not supported in IFC2x3.

• During the IFC export you can add classification information to assemblies
by entering the name of the classification system in the user-defined
attributes in Project properties. The classification system is written to the
IFCCLASSIFICATION field in the export file. You can define the classification
values for the assemblies in Organizer or in the UDA dialog box of the
assemblies. Note that classification information is written to the assembly
level only.

For more information about how to add classification information to
assemblies in Organizer, see How to add classification code to objects in
Organizer and export it to IFC.

For more information about adding UDAs to the UDA dialog box, see .

• You may want to check and modify the user-defined attributes of the
exported parts related to IFC export and structural information.

Define IFC entities for Tekla Structures model objects
Before you export Tekla Structures model objects to IFC, you can define the
resulting IFC entities for the exported model objects in the user-defined
attributes of the objects.
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1. Double-click an object, for example a column, to open part properties,
and click the More button.

2. On the Parameters tab, set Load bearing to Yes, if you want to define
the user-defined attribute LOAD_BEARING for the exported object. 

Set this option to No for all non-load bearing objects. Yes is the default
value.

3. On the IFC export tab, select an option in the IFC entity list to define the
IFC entity for the exported model object. 

Below is a list of entities available for a different types of Tekla Structures
objects:

Tekla Structures object IFC entity
Beam IfcBeam (IfcMember)
Column IfcColumn, (IfcPile), (IfcMember)
Polybeam IfcBeam, (IfcMember)
Curved beam IfcBeam, (IfcMember)
Pad footing, Strip footing IfcFooting
Slab IfcSlab
Panel IfcWall or IfcWallStandardCase
Contour plate IfcPlate or IfcDiscreteAccessory
Bolts, nuts and washers IfcMechanicalFastener
Bolt hole IfcOpeningElement
Vertical braces IfcMember
Railing: Beam, Column IfcBeam, IfcColumn, (IfcRailing)
Assembly, cast unit IfcElementAssembly, (IfcRailing),

(IfcRamp), (IfcRoof), (IfcStair), (IfcWall)
Tekla Structures project IfcProject
Assembly sub-part IfcDiscreteAccessory
Bar, wire, strand, mesh, tendon, and
other component embedded in
concrete

(IfcReinforcingElement)

Reinforcement IfcReinforcingBar
Pour object, pour break IfcBuildingElementProxy
Surface treatment IfcCovering
Weld IfcFastener

NOTE • If the entity is not in parenthesis in the table above, the object
is automatically exported to this entity type. If an entity is in
parenthesis, the object is not exported to this entity type
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automatically, but you can select the entity for the object on
theIFC export tab.

• The IfcBuildingElementPart and IfcBuildingElement entities
can also be used. IfcBuildingElement matches beams,
columns, etc, but not assemblies.

• Polybeams are always exported as B-rep (page 191).

4. In the IFC export type list, select Auto or B-rep: 

• The Auto option will automatically select what kind of Swept Solid IFC
object a Tekla object becomes in the IFC.

• If Auto fails for some reason (such as with a deformation) , the export
reverts to B-rep automatically, and creates a mesh-based IFC object
with less intelligence. These objects are data heavy but still
geometrically correct.

• B-rep will force the IFC object to be always mesh based.

5. Click Modify in the user-defined attributes dialog box.

Export to IFC2x3

1. Select the model objects to export. 

If you want to export all model objects, you do not have to select
anything.

2. On the File menu, click Export --> IFC.

3. Browse for the Output file location and replace the name out with the
desired file name. 

IFC files are by default exported to the \IFC folder under the model
folder. The length of the file path is limited to 80 characters. You do not
need to enter the file name extension, it will be automatically added
according to the selected File format.

4. Define the export settings: 

Option Description
Parameters tab
File format The options are IFC, IFC XML, zipped

IFC, and zipped IFC XML.
Export type Which export type to select?

• The certified Coordination view
2.0 should be your default.

• If the model is used only for
viewing purposes, or as a
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Option Description
reference model, Surface
geometry is your choice.

• Coordination view 1.0 is for
those who need to export
openings as separate objects.

• Steel fabrication view is for the
fabrication workflow, and to be
provided for manufacturing.

Surface geometry is ideal when the
need is to view the model without any
need for re-using or editing:

• Reinforcing bars are exported as
B-rep (page 191).

• Export does not support CSG
(page 191) (Constructive Solid
Geometry).

• Curved elements are exported as
B-rep.

• Bolts are exported as B-rep.

The certified Coordination view 2.0
is recommended to be used when the
geometry needs to be edited and
modified in the receiving application:

• Reinforcing bars are exported as
extrusions (page 191).

• Export uses CSG (Constructive
Solid Geometry) for presenting
cuts and voids.

• Curved elements are exported as
extrusions.

• Bolts are exported as B-rep.

Steel fabrication view is
recommended for exporting detailed
information on steel objects for steel
fabrication:

• Exports assembly presentation
and dedicated property sets.

• Bolt holes are exported as voids.

• Steel fabrication model view
configuration file for property sets
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Option Description
and properties
(IfcPropertySetConfiguratio
ns_AISC.xml) is included in the
installation by default.

Coordination view 1.0 is
recommended to be used instead of
Coordination view 2.0 when you
need to have voids and openings
presented by using opening
elements:

• Reinforcing bars are exported as
extrusions.

• Voids and openings are exported
as opening elements
(ifcOpeningElements).

• Curved elements are exported as
extrusions.

• Bolts are exported as B-rep.
Additional
property sets

• To define a new property set
(page 211), select <new> and click
Edit.

• To use an additional property set
created earlier, select the property
set from the Additional property
sets list.

Location by Model origin exports the model
relative to 0,0,0.

Work plane exports the model
Elevation relative to the current work
plane coordinate system.

Base point: <name of base
point> exports the model relative to
the base point using coordinate
system values East coordinate,
North coordinate, Elevation, Angle
to North, Latitude and Longitude
from the base point definition.

Advanced tab
Object types Select the object types to export.

To export pour objects instead of CIP
concrete parts select the Pour
objects check box.

Import to and export from Tekla Structures 219 IFC



Option Description
If you select Assemblies, you can
exclude single part assemblies by
selecting Exclude single part
assemblies in the Other area.

Note that edge chamfers are omitted
from the exported IFC model. This is
to enable better interoperability with
plant design systems. If the geometry
with edge chamfers is needed, you
can set the IFC export type to B-rep
separately for those objects in the
objects' user-defined attributes dialog
box on the IFC export tab.

Property sets Selecting the option Base quantities
adds in the exported IFC file a
Quantity takeoff add-on view
containing additional information on
the entities in the exported IFC
model.

For more information about the base
quantities, see IFC base quantities in
exported IFC model (page 225).

Default exports the default set of
properties.

Minimum exports the minimum set
of properties required by the
buildingSMART IFC standard. To view
the property sets, click View.

Other Layer names as part names uses
part names, such as COLUMN and
BEAM, as layer names for exported
objects. If this option is not selected,
then layer name will be the object's
phase number followed by the phase
name.

Export flat wide beams as plates
exports flat and wide beams as
plates. Select this option if you have
modeled plates as beams or columns
with flat profiles. For example, some
system components use beams or
columns instead of plates.

Use current view colors exports the
objects using the colors defined in
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Option Description
object representation, not the class
colors. Note that exporting object
transparency settings is not
supported.

Select Exclude single part
assemblies when you export
assemblies.

Spatial hierarchy from Organizer
uses the spatial hierarchy ( Building-
Site-Section-Floors) created in
Organizer in export.

Do the following:

a. Select Spatial hierarchy from
Organizer.

b. Create a project hierarchy in
Organizer.

c. In Organizer, right-click the
project, and select Use for
reporting.

d. Before the IFC export,
synchronize or write the
Organizer data in the Tekla
Structures model by right-clicking
the project in Organizer, and
selecting Write to the model for
reporting.

5. Select either Selected objects or All objects to define the object selection
for the export.

6. Click Export.

Export to IFC4
You can export a Tekla Structures model or a part of the model into an IFC4
file.

Before you can start the IFC4 export in Tekla Structures, you need to set the
advanced option XS_IFC4_EXPORT_PLEASE to TRUE in
teklastructures.ini.

1. Select the model objects to export. 

If you want to export all model objects, you do not have to select any
objects.

2. On the File menu, click Export --> IFC4.
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3. In the File name box, enter the file name without a file name extension. 

The extension will be automatically added according to the selected
Format. The length is not limited.

4. Browse for the Folder location. 

IFC files are by default exported to the \IFC folder under the current
model folder.

Both absolute and relative paths can be defined.

5. In Selection, select whether you want to export All objects or Selected
objects.

6. Define other export settings: 

Setting Description
Location by Model origin exports the model

relative to 0,0,0.

Work plane exports the model
relative to the current work plane
coordinate system.

Base point: <name of base
point> exports the model relative to
the base point using coordinate
system values East coordinate,
North coordinate, Elevation, Angle
to North, Latitude and Longitude
from the base point definition.

Format The options are IFC and zipped IFC.
Export type The options are Reference view and

Design transfer view.

The Reference view is intended to
support the referencing workflow,
and exported files can be used as
reference files, and viewed in a
viewer. The Reference view is not
meant to be used for conversion to
native objects.

The overall goal of the Reference
view is to provide workflows for
various software applications that do
not require modifying geometry. Such
applications enable viewing,
estimating, building, operating, and
other downstream analysis.

Design transfer view is intended for
the handover workflow, meaning
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Setting Description
import for further editing. This
requires the conversion of the IFC
entities into native objects. One
example is the takeover of the
structural engineering model (or part
of it) into the basis of the structural
detail modeling . The IFC object
conversion will be used to convert the
IFC entities to Tekla Structures native
objects. Typically import and
conversion are only needed a couple
of times, or even once only. The result
may require some rework to
accomplish a proper model.

IFC4precast view supports the
fabrication data transfer workflow of
precast elements. At this phase it
covers the fabrication of precast walls
and slabs including all the needed
reinforcement and embeds.

For more information about
IFC4precast, see IFC4precast.

Additional
property sets

• To define a new property set
(page 211), select <new> and click
Edit.

• To use an additional property set
created earlier, select the property
set from the Additional property
sets list.

• The additional property sets are
stored in the \AdditionalPSet
folder under the model folder.

Layer names as You can use phases, part names, or
template attributes as layer names
for exported objects. Select Name or
Phase from the list, or type the
attribute name in the box.

Note that you cannot use user-
defined attributes as the layer name.

Object color Select whether you want to export
objects using object class colors or
object group colors. If you select
object group colors, the defined

Import to and export from Tekla Structures 223 IFC

https://www.tekla.com/solutions/precast-fabricators/ifc4precast


Setting Description
transparency settings are also
exported.

Export flat wide
beams as plates

Select this option if you want to
export flat and wide beams as plates.
Select this option if you have modeled
plates as beams or columns with flat
profiles. For example, some system
components use beams or columns
instead of plates.

Spatial hierarchy
from Organizer

Spatial hierarchy from Organizer
uses the spatial hierarchy ( Building-
Site-Section-Floors) created in
Organizer in export.

Do the following:

a. Select Spatial hierarchy from
Organizer.

b. Create a project hierarchy in
Organizer.

c. In Organizer, right-click the
project, and select Use for
reporting.

d. Before the IFC export,
synchronize or write the
Organizer data in the Tekla
Structures model by right-clicking
the project in Organizer, and
selecting Write to the model for
reporting.

Pours When you select the option Pours,
pour objects and pour units are
exported but cast-in-place concrete
parts and cast-in-place cast units are
not exported. If you do not select this
option, cast-in-place concrete parts
and cast-in-place cast units are
exported without pour objects or
pour units.

7. Click Export.

After the export a message box is displayed. In this message box you can
select to open the folder where the exported IFC model is stored, or view the
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log file in a browser. The log file gives detailed information of the export
process, exported entities and the errors occurred during the export.

Limitations in IFC4 export

• The export is not certified by buildingSMART and may therefore have
syntax and content issues.

• The user interface does not provide all the features included in the IFC2x3
export user interface.

• The Reference view is intended to be used for design coordination and for
referencing workflow. Due to the API change, all the needed pieces of data
may not be available and therefore the resulting IFC model may be
incomplete.

• We do not recommend using IFC4 in production projects yet.

Check the exported IFC model
We recommend that you test the reference model after creating it.

To check the exported IFC model (page 214), insert the model as reference
model to the original Tekla Structures model.

Check the following things:

• Check the IFC model visually. Use different colors for the IFC model and the
original model. Use clip planes to check the model thoroughly.

• Compare the number of objects. If there are differences, check the export
log.

• Check the modeling of unsuccessfully exported objects. For example,
unnecessary cuts may result in unsuccessful export. Consider remodeling
the incorrect objects or set IFC export type to Brep for the objects.

TIP You can also use Trimble Connector (page 114) for viewing and checking
the IFC model.

IFC base quantities in exported IFC model
Base quantities are quantity definitions that are independent of a particular
method of measurement and therefore internationally applicable. Base
quantities are defined as gross and net values and provided by measurement
of the correct geometric shape representation of the element. Additional
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Quantity takeoff add-on view is included to the exported IFC model if you
select the Base quantities check box in the Export to IFC dialog box.

The Quantity takeoff add-on view contains the following base quantity
information on the entities in the exported IFC model:

 Beam Column Slab Wall
Width X X
Height X
Length X X X
Net area X
Outer surface area X X
Gross footprint area X
Net volume X X X X
Net weight X X X X

Property set configuration files used in IFC export
Tekla Structures uses configuration files for defining which user-defined
attributes and template attributes are exported as property sets into IFC
models.

Predefined property set configuration files

The predefined configuration files are read-only and they are read
from ..\ProgramData\Trimble\Tekla Structures\<version>
\Environments\Common\inp. The location may vary depending on your
environment.

IFC2x3:

• IfcPropertySetConfigurations_CV2.xml (default property sets)/
IfcPropertySetConfigurations_CV2_1.xml (property property sets)
contains the property sets for Export type Coordination view 2.0.

• IfcPropertySetConfigurations_SG.xml (default property sets)/
IfcPropertySetConfigurations_CV2_1.xml (minimum property sets)
contains the property sets for Export type Surface geometry.

• IfcPropertySetConfigurations_AISC.xml (default property sets)/
IfcPropertySetConfigurations_AISC_1.xml (minimum property
sets) contains the property sets for Export type Steel fabrication view.

The IfcPropertySetConfigurations_CV1.xsd file in the same folder is a
schema file that describes the structure of the XML file and is used for
validation of the XML file. This file is read when the software is started.
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Additional property set configuration files

When you configure property sets for IFC export in XML format, you need two
files:

• IfcPropertySetConfigurations.xsd is a schema file that describes
the structure of the XML file and is used for validation of the XML file. This
file is read when the software is started.

• IfcPropertySetConfigurations.xml is the actual property set
configuration file.

We recommend you define the additional property sets (page 211) in the
Property Set Definitions dialog box to ensure that the XML configuration files
are valid. The additional property sets you create are saved to the
\AdditionalPSets folder under the model folder by default. You can also
read additional property sets from the following folders:

• XS_SYSTEM
• XS_PROJECT
• XS_FIRM
If you use the above mentioned folders, save the files in a folder called
\AdditionalPSets under the system, project or firm folder.

Property set configuration file contents

• A configuration file includes the structure of property sets, and the data
definitions for the properties inside the property sets:

• Template attribute or UDA name. Template attributes are read from
content_attributes_global.lst and the user-defined attributes
from the environment database.

• Data type, such as String, Integer, Float, Timestamp, Boolean, Logical, or
planeanglemeasure.

• Unit type, such as length, area, volume, or mass.

• Unit value scaling of unitless UDA values. Conversion factor is added so
that unitless values can be converted to correspond to the global units
used in the IFC files. Area and volume units need these factors.
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• If you need the option type UDA value to be the same as in the user
interface, you can change the type from User defined attribute to
string type Template attribute in Property Set Definitions dialog box.

• Possibility to use default values.

• Possibility to ignore the set to export if template attribute or UDA does
not have a value.

• A configuration file includes property set binding rules to IFC entities:

• Binding to IFC entity type hierarchy including support for not only
building elements but also for bolts, reinforcing bars, and assemblies.

• Possibility to use limiting rules, such as Equal, NotEqual, LessThan,
GreaterThan, LessThanOrEqual, and GreaterThanOrEqual for numbers,
and Equal and NotEqual for texts.

You need to modify your additional property set configuration file using
a suitable editor, if you want to add these limiting rules.

• There can be any number of binding rules for any property set, but only
one property set definition for each ReferenceId.

• You can bind different property sets to different IFC entity types. For
example, a plate may have a different property set than a beam.

• If no value is found for a property in export, the export does not write the
property set at all. To avoid this, add optional=true for that property in
the property set.

Below is an example of the contents of the
IfcPropertySetConfigurations_CV2.xml file.
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Below is an example of the contents of the
IfcPropertySetConfigurations.xml file.
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3.4 DWG and DXF
DWG is the native file format of AutoCAD and the standard file format for
Autodesk products. DWG is used for 2D and 3D CAD data that is supported by
Tekla Structures.

DXF (Drawing eXchange Format) was developed by Autodesk for enabling data
interoperability between AutoCAD and other programs. As the file format does
not contain any form of part ID it is not possible to track changes between
different physical objects contained within different versions of a file. Clash
checking is not possible with a DXF file in Tekla Structures.

The DWG/DXF files imported with the DWG/DXF tool do not show the surfaces
of the imported objects, only the construction lines or lines converted to part
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profiles that can be used to create a model. If you want to show surfaces of
the objects, insert DWG and DXF files as reference models (page 161).

In DWG/DXF import, Tekla Structures supports ACAD2012 or earlier.

To determine the AutoCAD version of the DWG file, open the file in a text
editor. You will find the version code in the first six bytes:

AC1027 = 2013

AC1024 = 2010, 2011, 2012

AC1021 = 2007, 2008, 2009

AC1018 = 2004, 2005, 2006

AC1015 = 2002, 2000i, 2000

AC1014 = 14

AC1012 = 13

AC1009 = 12, 11

AC1006 = 10

AC1004 = 9

AC1002 = 2

Click the links below to find out more:

Import a 2D or 3D DWG or DXF file (page 231)

Export to 3D DWG or DXF (page 232)

Export a drawing to a 2D DWG or DXF file (page 236)

Export a drawing to 2D DWG or DXF (old export) (page 246)

Link DWG or DXF files in drawings

You can also add links to DWG or DXF files in drawings through the 2D Library
or by using the drawing ribbon command DWG/DXF:

•

•

Import a 2D or 3D DWG or DXF file
In DWG/DXF import, you can convert 2D and 3D objects as parts or reference
lines (construction lines).

1. On the File menu, click Import --> DWG/DXF .

2. Enter the name of the import file. 

Click Browse... to browse for the file.

3. Enter the offset from X, Y and Z.
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4. Enter the scale.

5. Select how to show the imported parts: 

• Reference lines displays parts in the model as construction lines.

• Parts displays the full profile of parts in the original model, based on
the profile sizes defined in the Plate profile and Beam profile boxes.
You can only use metric profiles with this option.

6. Select Use 2D import to import a two-dimensional representation of the
original object. 

This is useful when have selected the Reference lines option. Do not
select Use 2D import if you want to import the model in 3D.

7. Click Import.

Tekla Structures imports the file you specified. If you need to delete the
imported parts or reference lines, select the parts or lines and press Delete.

Limitations

When importing DWG profiles, note the following:

• The profile must be the only object in the DWG file. The file should not
include any titles, blocks or any other graphics.

• The profile must be a closed polyline.

• Generating the polylines from an ADSK 3D model requires a number of
steps to clean the profile.

• The profile needs to be scaled up.

• The DWG/DXF files imported with the DWG/DXF tool do not show the
surfaces of the imported objects, only the construction lines or lines
converted to part profiles that can be used to create a model. If you want
to show surfaces of the objects, insert DWG and DXF files as reference
models (page 161).

• The import functionality is not available in all Tekla Structures
configurations. For more information, see Tekla Structures configurations.

Export to 3D DWG or DXF
You can export selected parts or the whole model to 3D DWG. You can use
either the older export to export to 3D DWG or DXF, or the newer export to
export to 3D DWG.

Export to 3D DWG
• 3D DWG export uses Teigha libraries.
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• The surface presentation of the parts is exported. Bolt holes are not
included in the export.

• You can export objects relative to the model origin, to the base point you
define, or to the work plane.

• You can export in layers by name, phase or any template attribute or user-
defined attribute.

• Colors can be exported by class or by stored object group representation.

• You can export all objects or selected objects. You can use the Select parts
and Select objects in components selection switches for selecting the
objects to export.

Create object group color representations

If you want to use object group color representations in the export, you need
to create the object groups first, set the colors for the object groups and save
the representation settings. Note that the transparency setting is also included
in the export.

Create base points

If you want to export objects relative to a base point, you need to create a
base point in your model. For more information, see Base points.

1. Open a Tekla Structures model.

2. On the File menu, click Export --> 3D DWG . 

3. In the File name box, enter the name of the export file.

4. In the Folder box, enter the export folder path, or browse to the folder.

5. In Location by, select one of the following: 

• Model origin exports the model relative to 0,0,0.
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• Work plane exports the model relative to the current work plane
coordinate system.

• Base point <name of base point> exports the model relative to
the base point using coordinate system values East coordinate,
North coordinate, Elevation, Angle to North, Latitude and
Longitude from the base point definition.

6. In the Selection list, select All objects, or Selected objects. If you want to
export selected objects, select the objects with the appropriate selection
switches: 

• If you activate the Select parts and Select objects in components
selection switches, all the selected parts will be exported.

• If you activate the assembly or component selection, nothing will be
exported.

7. In Object color, select whether you want to export objects using object
class colors or object group colors.

8. In Layer names as, select Name or Phase from the list, or type the
template or user-defined attribute name in the box. You can use phases,
part names, or template attributes or user-defined attributes as layer
names for exported objects.

9. When you are done, click Export to export the objects according to the
defined settings. 

Tekla Structures creates the <name>.dwg file in the specified folder.

Export a model to a 3D DWG or DXF file (old export)
You can export the whole model or model parts to 3D DWG or 3D DXF file
types. By default, Tekla Structures creates a model.dwg file in the current
model folder. You can export parts, items and bolts to 3D DWG/DXF.

Limitations

The old 3D DWG/DXF export has the following limitations:

• Bolt holes are not exported.

• Curved beams and polybeams are exported as single, continuous beams.

• The number of segments in the curved beams is as defined for the
particular curved beam.

• Reinforcing bars are not exported.

• Grids are not exported.

TIP You can define the color settings for parts and other model objects. This
way you can affect the color that the objects have in the exported
DWG/DXF files.

1. Open a Tekla Structures model.
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2. On the File menu, click Export --> 3D DWG/DXF .

3. In the Export 3D DWG/DXF dialog box, accept the default export file
name, or enter another one. 

To replace an already existing export file, click the ... button and browse
for the file.

4. Select whether to export as DWG or DXF.

5. In Export as, select the representation for the exported objects: 

• Faces exports parts as faces.

Exporting 3D DWG or DXF files as Faces uses more memory and may
take longer, but the end result is better.

• Lines exports parts as lines located in the center of the profile cross
sections. This option suits well for exporting to analysis software.

• Center lines exports parts as part center lines.

• Reference lines exports parts as reference lines, drawn between the
creation points. This option suits well for exporting to analysis
software.

If the model is large, or you have less memory to use, the Reference
lines option is faster, and the resulting file size is smaller.

6. Select Part accuracy: 

• The options are High and Normal. High also exports chamfers in
profile cross-sections.

7. Select Bolt accuracy: 

• High exports entire bolt assemblies, including washers.

• Normal only exports the bolt and nut.

• No bolts exports no bolts.

8. Select whether to include Cuts in the export. 

Yes exports cuts.

9. Select whether to include Inner contours 

Yes includes the inner contours.

10. In the Export list, select what to export: 

• All objects exports the whole model.

• Selected objects exports the parts selected from the model.

To only select parts that you want to include in the export, activate the
Select parts and Select objects in components selection switches. You
can also create a selection filter that exports all the parts and objects that
you want. Components cannot be imported as such, but you need to
select the objects in components to export the included parts.
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11. Click Create.

Tekla Structures creates the export file in the current model folder. The ID of
each part is exported as an attribute and written into the export file for each
part.

Export a drawing to a 2D DWG or DXF file
You can export Tekla Structures drawings to 2D DWG and DXF format. You can
export several drawings at a time.

The DWG/DXF export is object based. For example, if you export a rectangular
part that is drawn using hidden line types, the result is a rectangular object
drawn with a dashed line. In the old line-based DWG export, the result would
be many separate short straight lines. Hatches are also exported as hatch
objects in CAD and not separate lines.

In the DWG/DXF drawing export you can:

• easily set layers for different objects, and separate mark frames from mark
text and leader lines, for example

• separate different parts from another by using filters

• use layers that have been predefined by standard CAD layer settings

• use base points and model coordinates

• embed images in the export file so that the images are no longer exported
as links

Start DWG/DXF export

1. Start the export in any of the following ways:

• On the File menu, click Export --> Drawings, and select the drawings
from the displayed Document manager.

• Click Drawings & reports --> Document manager, select the
drawings that you want to export from Document manager, and then
on the File menu, click Export --> Drawings.

• Click Drawings & reports --> Document manager, select the
drawings that you want to export from Document manager, right-
click and select Export. Note that this command is not available when
you open the Document manager in the drawing mode.

• In an open a drawing, on the File menu, click Export drawings.
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2. Click Open preview to show the preview window, where you can also
change the drawing if you have selected many drawings for export. To get
the preview visible for the first time, click Refresh preview. You can
refresh the preview again by clicking Refresh preview. The preview does
not get refreshed automatically, because this could take a long time.
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Define export settings and export to DWG/DXF
1. In the Save list, load previously saved or predefined export settings. If you

want to save modified settings for future use with another name, enter a
name for a new settings file and click Save.

2. In File location, define the location for the exported DWG files. 

The default location for DWG/DXF files is the current model folder. The
default folder for the generated DWG/DXF files can also be controlled by
the XS_DRAWING_PLOT_FILE_DIRECTORY advanced option. You can use
relative file location by using .\ in front of the output folder name. The
specified output folder is saved in the settings. Open folder when
finished opens the export folder after the export.

3. In the File type list, select DWG or DXF.

4. Select the DWG version to be used in export. There are several versions of
AutoCAD or DXF formats available. 2010 is the default.

5. Define other settings on the Options tab as necessary: 

Model space
coordinates

Select one of the following options:

• Local: Exports the drawing to the 0 point in the
CAD coordinate system. This option uses the
left bottom corner of the 1st view frame to set
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the local coordinates. If frame is expanded, the
local will move.

• Model: Matches Tekla Structures 0 point with
CAD 0 point and rotates the CAD coordinate
system accordingly in X and Y coordinates. Note
that Z coordinates are not supported.

• Base point: <name_of_base_point>: Matches
the selected base point with CAD 0 point, and
rotates the CAD coordinate system accordingly.
The base points are defined in the Tekla
Structures model through File --> Project
properties --> Base points.

Note that Z coordinates are not supported.
File prefix

File suffix

Enter a specific prefix or suffix to be used in the file
name. The preview of the file name will change
accordingly.

The DWG export supports the following drawing-
specific advanced options, which you can use to
modify the name of the exported file:

XS_DRAWING_PLOT_FILE_NAME_A
XS_DRAWING_PLOT_FILE_NAME_C
XS_DRAWING_PLOT_FILE_NAME_G
XS_DRAWING_PLOT_FILE_NAME_M
XS_DRAWING_PLOT_FILE_NAME_W
For more information about the values that you
can give to these options, see .

Embed images inside
the file

Embed all images inside the export file. No extra
image files are created in the export.

Drawing as snapshot
to CAD model space

Export all included objects to the model space and
paper space of a CAD file. Model and global
coordinates and paper space switch in the layer
settings will be ignored.

Note that if the drawing has linked or copied views,
and you have not selected Drawing as snapshot
to CAD model space, the drawing views may be
placed on top of each other, and the view limits
may not be accurate in the resulting DWG file. This
is because drawing views are not conceptually the
same as paper space viewports in the DWG format.

Also note that if you have shortened views in the
drawing, and the objects are placed in 1:1 scale,
the ends will be stretched to match the actual size
of the part. Select Drawing as snapshot to CAD
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model space to avoid stretching of the shortened
view in a CAD model space. The drawing space in a
CAD software will keep the view shortening.

Scale Define the scale for the exported DWG. This option
is only available if you have selected the Drawing
as snapshot to CAD model space check box.

For example, if you have a drawing between the
coordinates 0,0 and 800, and you define a scale
value 5, the resulting DWG is 5 times bigger, and
the DWG is located between the coordinates 0,0
and 4000.

In another example, if you have set the drawing
view scale in Tekla Structures to 1:50 and wish to
export the drawing in 1:1 scale, using export
option scale value 50 will produce the desired
result.

If you set the advanced option 
XS_EXPORT_DRAWING_TRY_TO_KEEP_LOCATION
to TRUE, Tekla Structures tries to keep the DWG
origin in the same position as the drawing view
origin. This can only be done in plan views and
elevation views. If the drawing has more than one
plan view or elevation view, Tekla Structures places
the DWG origin in the bottom-left corner of the
drawing frame.

Ungroup objects in
blocks

Exports graphical objects as individual objects,
does not add the objects to blocks. For example, a
line, hatch and rectangle will be a DWG object line,
hatch and rectangle, rather than blocks. When this
option is selected, the option Update Tekla
Structures linework only is disabled.

Update Tekla
Structures linework
only

Updates the Tekla Structures drawing content and
keeps other content that is created in a CAD
software intact in the same file. Blocks (groups),
created by Tekla Structures will be updated.

This setting is only shown if you have set the
advanced option 
XS_DWG_EXPORT_UPDATE_TS_LINEWORK_OPTION
to TRUE in the Export category in the Advanced
Options dialog box.

Note that you need to have the same drawing
exported already, and the layer setup and the layer
template must be the same as during the previous
export. All CAD lines that were added previously
will stay in the file and only Tekla Structures
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content will get updated, unless editing was done
in CAD blocks editor.

Also note that if you edit the content of a block
(CAD object), and then select the Update Tekla
Structures linework only option, the whole block
will be re-written, and the changes made in CAD
will not be kept. To keep the changes in CAD, you
need to explode a block before editing it.

For example, you may want to use this setting if
you have added drawing title blocks in the CAD file
after the first export of the drawing from Tekla
Structures, and want to keep these title blocks as
they are, and update only the objects that
exported from Tekla Structures.

6. On the Layer rules tab, you can define explicitly the layers where
different model and drawing objects, or parts of objects are exported to.
For example, you can separate outline from fills and hatches. 

You can also define here whether the line color, style and weight will be
used from Tekla Structures settings or from the target layer settings
specified in a DWG or DXF file. Note that Tekla Structures line weight, style
and colors stay as you see them in the Tekla Structures drawing, and
there is no functionality to modify them just for the DWG export.

7. To use a DWG template, use the Target layers from DWG list to browse
for the template file. If specified, the template is used for layer definition.
The DWG template should not contain any CAD objects, just layer settings,
unless it contains objects that are intended to appear on drawings
exported using this template. For example, here you could use your
standard DWG file with all the predefined layers. 

You can enter .\ and then the file name, in which case Tekla Structures
searches for the file first in the model, project and firm folders, then in the
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folder indicated by the advanced option XS_DRIVER, then in the system
folder, and finally in the user settings folder.

The DWG file not found text is displayed next to the Browse... button
until a DWG or a DXF file is found and loaded.

The target layer boxes are briefly colored in yellow when a new DWG file is
loaded from the Target layers from DWG list. When there are no layers
available in the DWG file, the boxes are colored in red.

8. Add the rules: 

• You can create a new rule by clicking the Add button on the right, or by
copying the selected rule by clicking the Copy button. You can select
multiple rules.

• You can move the rules upwards or downwards in the set by clicking
the Move up and Move down buttons. You can select multiple rules.

• If you wish to delete a rule, select it and click Delete. You can delete
multiple rules at a time.

9. Define the rule contents: 

Objects Select the objects that you want to
export.

Note that some objects, like neighbor
part marks, are currently under
marks and not listed separately. To
have them separated in the export,
you need to use Object filtering, and
create several mark rules for parts
and neighbor parts.

To include everything else that is
missing from the Objects list, add an
All object rule at the end of the rules
list, because rules are read in the
order they are listed.

To export pours, you need to have
the pours enabled in the model, see
XS_ENABLE_POUR_MANAGEMENT.

Presentation filtering Define which part of the objects
should follow the rule. You can also
select All .

The Presentation filtering options
are different for different object
types.

You cannot add more than one filter
per rule. For example, to have mark
frames separated from mark text, you
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need to create two rules for marks,
and in the first one, set the
Presentation filtering to Text, and
in the other one to Frames. See the
section Layer rule example below for
an example.

Object filtering Reads the selection filter attribute
files that have been defined in the
current model.

Note that these files are only read
from the current model folder, not
from firm or project folders.

Target layer If you have no DWG templates, or
want to create layers of your own,
type a new layer name in the Target
layer box, or select a previously used
layer from the list.

Note that after you have added a
DWG template, its layers will appear
in the Target layer list.

The target layer boxes are briefly
colored in yellow when a new DWG
file is loaded from the Target layers
from DWG list. When there are no
layers available in the DWG file, the
boxes are colored in red.

Color

Line style

Line weight

Define whether the linework is taken
from Tekla Structures settings or from
the DWG template.

Paper space To draw drawing objects correctly in
the paper space in a DWG file (and
not through the view portal), select
the Paper space check box.

If the check box is not selected, there
will only be a portal from the model
space in the paper space.

Note that it is recommended to put
drawing annotations, such as marks,
dimensions, and texts to the paper
space only. That way they will appear
correctly, for example, when a part is
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cut in a Tekla Structures drawing
view.

Include To include a rule in the final DWG,
select the Include check box next to
the rule. If you do not want to export
some objects, just clear the Include
check box.

10. Open the preview and click Refresh preview to preview the result before
exporting.

11. Click Export. 

The drawings are exported on the basis of the defined settings and rules.
The rules are read in the order that they are listed. If you have selected
Open folder when finished, the export folder will open.

The error message Drawing cannot be read is displayed if the exported
drawing is missing, not up to date or has similar problems.

When you click the Export button, Tekla Structures first checks if the files
can be written to before the export starts, and asks you to close the
necessary applications. It also checks if the files already exist and asks if
you want to overwrite the existing files.

Layer rule example

In the example below, three separate mark rules have been created that will
be exported on layers 1, 2, and 3. Lines are exported on the layer 1, texts on
the layer 2, and frames on the layer 3.

After exporting, you can show the marks in the CAD model in the following
three ways depending on the layers displayed in the CAD viewer:

All layers are shown:

Layer 1 containing the lines is hidden:
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Layer 2 containing the texts is hidden:

Layer 3 containing the frames is hidden:
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Tips
• If you export a DWG file to the Output file version 2013, a wipeout frame

will be visible on the layout side in the CAD model due to the limitations in
CAD, see below:

To avoid this, either use a DWG file layer template created in AutoCAD, or
export to version 2010 (default) or earlier.

• Another reason for the visible wipeout frame is that you are using a DWG
template where wipeout frames have been set to visible. Hide the wipeout
frames in the CAD template.

To use old DWG/DXF export
If you want to use the old DWG/DXF export, set the advanced option 
XS_USE_OLD_DRAWING_EXPORT to TRUE in an .ini file. This advanced option
is by default set to FALSE. For instructions on using the old export, see Export
a drawing to 2D DWG or DXF (old export) (page 246).

Export a drawing to 2D DWG or DXF (old export)
You can export drawings to the 2D DWG or DXF format using the old DWG/DXF
drawing export.

If you want to use the old DWG/DXF drawing export, set the advanced option 
XS_USE_OLD_DRAWING_EXPORT to TRUE in an .ini file. This advanced option
is by default set to FALSE. For instructions on using the newer DWG/DXF
drawing export, see Export a drawing to a 2D DWG or DXF file (page 236).

1. On the Drawings & reports tab, click Document manager.

2. Select from the list the drawings that you want to export.
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3. Right-click and select Export.

4. In the Export Drawings dialog box, on the Export file tab, enter the
export file name. 

If you are exporting several drawings, leave the file name box empty.

The drawings are exported by default to the \PlotFiles folder under
the current model folder. If you want to use another folder, enter the full
path.

Tekla Structures uses one of the following advanced options to define the
names for the export files. The advanced option that is used depends on
the drawing type:

XS_DRAWING_PLOT_FILE_NAME_A
XS_DRAWING_PLOT_FILE_NAME_C
XS_DRAWING_PLOT_FILE_NAME_G
XS_DRAWING_PLOT_FILE_NAME_W
XS_DRAWING_PLOT_FILE_NAME_M.

5. Select the file type: DXF or DWG.

6. If you want to include a revision mark in the file name, select Include
revision mark to file name.

7. Set the layer options on the Layer options tab: 

• Select the layer rules file.

To add or modify layers, and to assign object groups to different
layers, click Setup...

• If you want to use advanced conversion to convert the type, color and
weight of lines and layers, select Use advanced line type and layer
conversion.

• In the Conversion file box, enter the name of the file to be used in the
conversion.

By default, Tekla Structures uses the LineTypeMapping.xml file in
the ..\Tekla Structures\<version>\environments\common
\inp folder.

If you need to define your own line type mappings, you can use the file
LineTypeMapping.xml as a template when you create a conversion
file of your own.

• Select Include empty layers if you want to include empty layers in the
export.

• Select Object color by layer to have different colors on different
layers.

8. Set the other drawing export options on the Options tab: 
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• Set Drawing scale and Line type scale.

• If you want to export the drawings so that the DWG/DXF content is
grouped by object, select Export objects as groups. When you do this,
Tekla Structures makes a new group for each object (part, mark,
dimension line, etc.).

• Select Cut lines with text if you do not want to display continuous
lines in exported drawings, for example, to run the line through text or
drawing marks.

• Select Export custom lines as split lines to ensure that custom line
types have the same appearance in the software you are exporting to
and when printed. If Export custom lines as split lines is selected,
custom line types are exported as solid lines that are split to several
short lines. If Export custom lines as split lines is not selected,
custom line types are exported as defined in TeklaStructures.lin.

• Select Use paper space to export to both model space and paper
space. The unscaled contents of the drawing views are exported into
model space. The drawing layout is exported into paper space. The
layout contains scaled viewports showing appropriate areas of the
model space.

When exporting to paper space, ensure that all objects in the view are
inside the view frame. Objects that are partially outside the drawing
view frame are not exported

9. Click Export.

See also

Default line types in drawings (old export) (page 256)

Define customized line type mappings in drawing export (old export)
(page 252)

Example: Set up layers and export to DWG (old export) (page 257)

Layers in exported DWG/DXF drawings (old export) (page 248)

Create layers in DWG/DXF files for drawing export (old export) (page 249)

Assign objects to layers in drawing export (old export) (page 250)

Copying export layer settings to another project (old export) (page 252)

Layers in exported DWG/DXF drawings (old export)

In drawing DWG/DXF export, you can define the layers to which different
drawing objects belong. The benefit of using layers in export is that if you do
not want to show a certain layer in the drawing, you can turn it off.

You can define the different layers using Tekla Structures selection filters.
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You can use the LineTypeMapping.xml file to define the line type, line
weight and line color for objects on different layers. You can also add custom
line types in the TeklaStructures.lin file and use these when mapping
Tekla Structures line types to the line types in the exported DWG and DXF files.

You can export into layers of their own all object types that are listed in the
Drawing Export Layers dialog box.

The following objects cannot have layers in export because they cannot be
identified as separate objects that can have selection filters: clouds, hatches,
neighbor parts, symbols in drawings, section view titles, grid label texts,
dimension labels, weld labels, bolt mark leader lines, and part mark leader
lines. For example, hatches are exported to the same layer with the part that
the hatch belongs to.

See also

Example: Set up layers and export to DWG (old export) (page 257)

Create layers in DWG/DXF files for drawing export (old export)
You need to define the layers that are included in the exported DWG and DXF
files.

NOTE To keep track on the layers that you have, create all the layers that you
need for the final DWG/DXF drawings at the same time.

1. On the File menu, click Export --> Drawings .

2. In the Export Drawings dialog box, go to the Layer options tab and click
Setup next to the Layer rules box.

3. In the Drawing Export Layers dialog box, click Modify layers.

4. To add a layer, click Add. 

You can add as many layers as you need.

5. Click the row of the new layer in the Name column and enter a name for
the layer.

6. Click the row of the new layer in the Color column and select a color for
the new layer. 
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7. Click OK.

Next you can assign objects to the new layer.

See also

Assign objects to layers in drawing export (old export) (page 250)

Example: Set up layers and export to DWG (old export) (page 257)

Assign objects to layers in drawing export (old export)
You need to define which objects to export to certain layers in the exported
DWG/DXF file. You can do this by using a selection filter for identifying the
desired objects among all objects, and by creating a rule to export these
objects to a certain layer.

Before creating the rule, first create the selection filter.

1. Create a selection filter.

2. On the File menu, click Export --> Drawings .

3. In the Export Drawings dialog box, go to the Layer options tab, and click
Setup.

4. Open an object group by clicking the plus sign next to the group name. 

For example, click the plus sign next to Model Object.

5. Right-click a rule in the list and select Add Next Level Rule. 

For example, right-click Part.

6. Enter a name for the rule and select the selection filter that you created. 

7. Click OK.
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8. Double-click the row under the rule you just created and select the
desired layer for it in the Select Layer dialog box.

9. Click OK. 

Tekla Structures maps the selected layer to the rule.

10. Save the created layer rule settings for later use by entering a name next
to the Save as button and clicking Save as.

NOTE The order of rules is important. Organize the rules by right-clicking the rule,
and selecting Move up or Move down. The objects are exported to the first
matching layer. If there is no matching layer, the objects are exported as
Other object type.

Example: Create a rule for exporting beam marks to their own layer in
drawing export (old export)
You can export all kinds of drawing objects to layers of their own.

This example shows how you can do that for beam marks. All kinds of marks
can be exported separately to their own layers: bolt marks, part marks,
connection marks, neighbor part marks, reinforcement marks and component
marks.

First you need to create a selection filter selecting the beams and then you can
define the layer rule. Name the beam selection filter Beams.

1. On the File menu, click Export --> Drawings .

2. Go to the Layer options tab of the Export Drawings dialog box and click
Setup next to the Layer rules box.

3. Under Mark in the Drawing Export Layers dialog box, select the layer
rule of the mark you want to define to its own layer (part, bolt, connection,
neighbor part, or reinforcement mark). 

Select Part mark.
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4. Right-click Part mark and select Add Next Level Rule from the pop-up
menu. 

This opens the Layer manager rules dialog box.

5. Enter a rule name (for example, BeamMark) and select a filter that you
have created (Beam). 

6. Click OK. 

Tekla Structures creates a new rule BeamMark. Now you can connect the
new rule to a layer you have created for beam marks and use when
exporting drawings.

See also

Assign objects to layers in drawing export (old export) (page 250)

Copying export layer settings to another project (old export)
If you want your layer settings to also be available in other projects, you can
copy them to a firm or project folder.

1. On the File menu, click Export --> Drawings.

2. Go to the Layer options tab and click Setup.

3. Define the required rule and layer settings.

4. Enter a name for the layer rule settings file next to the Save as button and
click Save as.

5. Copy the file <your_layer_rule>.ldb from the \attributes folder
under the current model folder to the firm or project folder.

See also

Assign objects to layers in drawing export (old export) (page 250)

Create layers in DWG/DXF files for drawing export (old export) (page 249)

Define customized line type mappings in drawing export (old export)
You can use advanced conversion to convert the type, color and weight of
lines and layers. This way you will get the line types that you want to use in the
target software, for example, AutoCAD.
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By default, Tekla Structures uses the file LineTypeMapping.xml in the
folder ..\Tekla Structures\<version>\environments\common\inp for
the conversion.

If you need to define your own line type mappings, you can use the file
LineTypeMapping.xml as a template.

NOTE When modifying the line type mappings file, use an editor that is
capable of validating XML in order to maintain a valid document
structure.

To define your own line type mappings, do one of the following:

To Do this
Map according to line types only 1. Open the mapping file in an XML

editor.

2. Enter only the line type
information.

For example, all lines in all layers
with line type XKITLINE01 will
be exported to DASHED.

3. Save the mapping file to the
model folder.

Map according to line types and
layers

1. Open the mapping file in an XML
editor.

2. Enter the line type and layer
name.

Define the layers that the
mapping will apply to in the 
LayerName attribute.

If you leave out the attribute 
LayerName, Tekla Structures
uses the line type mapping for
any layer. If you include the
attribute LayerName, Tekla
Structures uses the line type
mapping for that layer only.

For example, all lines on the layer 
BEAM with line type XKITLINE01
will be exported to DASHED. Tekla
Structures first searches for
these kinds of mappings by
default.

3. Define the color of the line in the 
Color attribute. Enter the color
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To Do this
values in AutoCAD Color Index
(ACI) codes (numbers from 0 to
255).

4. Define the thickness of the line in
the Weight attribute. Enter the
values in hundredths of
millimeters.

5. Save the mapping file to the
model folder.
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This is how the file LineTypeMapping.xml is composed:

1. The first section consists of XML and document type definition. Do not
change or remove this section.

2. The mappings that are available are defined here. You can use these
mappings as a template for your own mappings.
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Examples

In the first example, a new Mapping element is added, where XKITLINE00
lines in the Beam layer are converted to BORDER line type, color is converted to 
10 and weight to 1.00 mm:

In the second example, a new Mapping element is added, where XKITLINE02
lines in the Part layer are converted to HIDDEN2 line type, the layer name is
converted to Part_Hidden, the color is converted to 8 and weight to 1.00
mm.

You can use the LineTypeMapping.xml file for exporting hidden lines to
separate layers. The hidden lines must then be defined to their own layers
(here Part_Hidden).

NOTE For the export to succeed, ensure that the layer (here Part_Hidden)
exists on the list of available layers in the Modify Layers dialog box.

See also

Default line types in drawings (old export) (page 256)

Default line types in drawings (old export)
Default line types are available in Tekla Structures drawings. You can map
default line types to customized line types, which are defined in
TeklaStructures.lin and further exported to DWG/DXF files.

The table below lists the default line types and shows what they look like.

Line type name Line type appearance
XKITLINE00
XKITLINE01
XKITLINE02
XKITLINE03
XKITLINE04
XKITLINE05
XKITLINE06
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See also

Define customized line type mappings in drawing export (old export)
(page 252)

Example: Set up layers and export to DWG (old export)
This example shows how to define layers and export line types on a certain
layer to their own sublayers in DWG export. The workflow consists of six tasks:

1. Example: Create a selection filter for DWG export (old export) (page 257)

2. Example: Create layers for DWG export (old export) (page 258)

3. Example: Create a rule for drawing DWG export and assign a layer to the
rule (old export) (page 258)

4. Example: Define a custom line type for DWG export (old export)
(page 259)

5. Example: Define line types and weights for layers in DWG export (old
export) (page 260)

6. Example: Export the drawing to DWG (old export) (page 261)

Example: Create a selection filter for DWG export (old export)

Start by creating a selection filter. This task is phase 1 in the workflow
Example: Set up layers and export to DWG (old export) (page 257).

To create a selection filter:

1. In the model, click the Selection filter switch .

2. In the Object Group - Selection Filter dialog box, click New filter.

3. Add new filter rules.

a. Create a filter rule that select parts according to the name BEAM.

b. Create a filter rule that selects parts according to the material S* (as
in steel).

4. Save the filter as steel-beam.
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Example: Create layers for DWG export (old export)

After creating a selection filter, you can continue by creating layers that you
want to have in the exported DWG. This task is phase 2 in the workflow
Example: Set up layers and export to DWG (old export) (page 257).

To create the layers you want to have in the exported DWG:

1. On the File menu, click Export --> Drawings.

2. Go to the Layer options tab.

3. Click Setup and then click Modify layers.

4. Click Add to add a new layer. 

Create separate layers for solid lines (steel-beam-layer) and hidden
lines (steel-beam-layer-H) within steel beams.

5. Set the color for the layers. 

Set the solid lines to red and hidden lines to blue.

6. Click OK to accept the changes.
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Example: Create a rule for drawing DWG export and assign a layer to the rule
(old export)

After creating layers, you can continue by creating a rule to export an object
group into a layer, and assign the layer to the created rule. This task is phase 3
in the workflow Example: Set up layers and export to DWG (old export)
(page 257).

To create a rule to export an object group into a layer, and assign the layer to
the created rule:

1. Right-click a model object part rule and select Add Next Level Rule.

2. Enter a name for the rule (steel-beam-rule) and select the selection
filter you created for steel beams (steel-beam). 

3. Click OK.

4. To assign a layer to a rule, double-click the row under the steel-beam-
rule and select a layer, in this case steel-beam-layer.

5. Click OK. 

6. Save the layer rule settings with the name example1 using Save as. 

7. Close the dialog box by clicking OK.
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Example: Define a custom line type for DWG export (old export)

After creating a rule, you can continue by defining a custom line type for
continuous lines in the exported DWG. In this example, you will add some line
type definitions. This is phase 4 in the workflow Example: Set up layers and
export to DWG (old export) (page 257).

To define a custom line type:

1. Open the TeklaStructures.lin file in a text editor ( ..\ProgramData
\Trimble\Tekla Structures\<version>\environments\common
\inp ).

2. Add the following line type definition in the file: 

3. Save the file. Ensure that the file name extension does not change.

Example: Define line types and weights for layers in DWG export (old export)

After defining a custom line type, you can continue by modifying the
LineTypeMapping.xml file and defining the line types and weights. This task
is phase 5 in the workflow Example: Set up layers and export to DWG (old
export) (page 257).

To define the line types and weights:

1. Open the LineTypeMapping.xml file ( ..\ProgramData\Trimble
\Tekla Structures\<version>\environments\common\inp ) in a
text editor.

2. Add the line type mappings for the layers as shown inside the lower blue
frame in the image below. Do not touch the lines inside the upper red
frame.

3. Save the file. Ensure that the file name extension does not change.
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1. The lines are on the steel-beam-layer layer.

2. The lines are drawn with XKITLINE00 (solid lines).

3. The lines are exported to CONTINUOUS lines in DWG. The line color in
DWG was already defined in the layer properties (red). The line weight in
DWG is 35.

4. The lines are on the steel-beam-layer layer.

5. The lines are drawn with XKITLINE02 (hidden lines).

6. The lines are exported to DASHED lines into a separate layer called steel-
beam-layer-H in DWG. The line color in DWG was already defined in the
layer properties (blue). The line weight in DWG is 35.

Example: Export the drawing to DWG (old export)

After you have defined all the layer settings, you can continue by exporting the
drawing. Before exporting the drawing to DWG, ensure that all the drawing
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properties are as you wish. This task is phase 6 in the workflow Example: Set
up layers and export to DWG (old export) (page 257).

To export the drawing:

1. Open the drawing that you want to export.

2. On the File menu, click Export drawings.

3. Enter a name for the export file.

4. Set the Type to DWG.

5. Go to the Layer options tab page and load the layer rule settings that you
saved earlier with the name example1.

6. Select the following check boxes: Use advanced line type and layer
conversion, Include empty layers and Object color by layer.

7. Browse for the LineTypeMapping.xml file.

8. Go to the Options tab, set the scale for the export and select the Export
objects as groups check box and, if you want to, Cut lines with text and
Export custom lines as split lines.

9. Click Export.

Open the exported DWG with an applicable DWG viewer software. You can see
that the solid lines of the steel beam are on one layer and the hidden lines are
on another layer. You can also see that columns do not match with the layer
rules you defined, so they are handled according to other rules.
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See below for examples on how the selecting and not selecting Cut lines with
text affects the result.

In the following example, Cut lines with text is selected.

In the following example, Cut lines with text is not selected.

3.5 DGN
The DGN format has been used especially for data transfer between plant
design programs. It was developed by MicroStation. It is similar to DWG in that
it is only a graphical data format. It contains unique part IDs in the given
model. It is possible to check for clashes between the Tekla Structures model
and a DGN reference model.

This format has the following limitations:

• GUID is not supported.

• DGN reference model import does not support change management or
UDAs.

• 3D DGN export supports parts only.

See also

Reference models and compatible formats (page 159)

Insert DGN files (page 264)
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Insert a reference model (page 161)

Export to 3D DGN (page 266)

Insert DGN files
You can insert DGN files as reference models to Tekla Structures.

You can view DGN reference model objects on different reference model
layers according to the level settings in the DGN file. You can use DGN models
for clash checking. Tekla Structures reference model insert supports V7 and V8
DGN formats.

A DGN file may contain one or more DGN models. A DGN model can be one of
the following three types: a design model, an extrusion model or a sheet
model. Design models are most useful in Tekla Structures as they contain
appropriate structural data.

If there are many model types available in a DGN file, Tekla Structures selects
the inserted model type in the following order:

1. Active model is inserted if it is a design model.

2. Default model is inserted if it is a design model.

3. If DGN file contains design models, the first one is inserted.

4. If there are no design models in the DGN file, the first model regardless of
the model type is inserted.

DGN reference model insert does not support UDAs or change management.

To insert a DGN file, open the Tekla Structures model where you want to insert
the reference model, and click the Reference Models button in the side pane

.

For details about the reference model import, see Insert a reference model
(page 161).

DGN objects supported in reference models

Tekla Structures can display the following DGN objects in reference models:

Object Type no. Description
Cell 2 A collection of grouped entities

with a common insertion point/
origin, scale and orientation in
2D/3D space.

Line 3
Line string 4 A series of interconnected lines.
Shape 6 Like a line string, but closed (first

point = last point).
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Object Type no. Description
Text node 7 A multi-line paragraph/block of

text.
Curve 11 A parametric spline curve.
Complex chain 12 A chained collection of other

entities (lines, line strings, arcs,
curves or b-spline curves).

Complex shape 14 Like a complex chain, but closed
(first point = last point).

Ellipse 15
Arc 16
Text 17 Supports TrueType fonts and text

styles (bold, underline, italic, etc).
3D surface 18 Like a 3D solid, but not capped on

the ends.
3D solid 19 The solid created by projecting or

rotating from a boundary entity
(line, line string, curve, arc or
ellipse).

Cone 23 Actually a truncated cone
described by two parallel circles;
if the radius of both circles is the
same, a cylinder is produced.

B-spline surface 24 See description of b-spline
curves, which also applies here;
additional data is provided by
surface boundary entities (type
25).

B-spline curve 27 Can be rational/non-rational,
uniform/non-uniform, open/
closed; entity type 27 supplies
header data and additional data
is provided by pole entities (type
21), knot entities (type 26) and
weight factor entities (type 28).

Shared cell definition 34 Similar to a DWG block definition;
basically defines a set of grouped
entities.

Shared cell instance 35 Similar to a DWG block instance;
given a particular cell 'definition',
numerous cell 'instances' can be
created at differing locations,
scales and orientations.
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Object Type no. Description
Multiline 36 A set of parallel lines, which can

be jointed (with or without visible
seams at the joints), and have
various types of end caps
(rounded, square, etc).

Mesh 105 Supports indexed face loops,
quad list, quad grid, triangle grid
and triangle list meshes.

Smart solid - Smart solids (solids created from
embedded Parasolid/ACIS data)
can be imported into Tekla
Structures as wireframe outlines.

Export to 3D DGN
You can export selected parts or the whole model to 3D DGN. You can use
either the older v7.0 export or the newer v8.0 export.

Export to 3D DGN v8
• 3D DGN export v8 uses Teigha libraries.

• The surface presentation of the parts is exported. Bolt holes are not
included in the export.

• You can export objects relative to the model origin, to the base point you
define, or to the work plane.

• You can export in layers by name, phase or any template attribute or user-
defined attribute.

• Colors can be exported by class or by stored object group representation.

• You can export all objects or selected objects. You can use the Select parts
and Select objects in components selection switches for selecting the
objects to export.

Create object group color representations

If you want to use object group color representations in the export, you need
to create the object groups first, set the colors for the object groups and save
the representation settings. Note that the transparency setting is not included
in the export.

Create base points

If you want to export objects relative to a base point, you need to create a
base point in your model. For more information, see Base points.

1. Open a Tekla Structures model.
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2. On the File menu, click Export --> 3D DGN v8 . 

3. In the File name box, enter the name of the export file.

4. In the Folder box, enter the export folder path, or browse to the folder.

5. In Location by, select one of the following: 

• Model origin exports the model relative to 0,0,0.

• Work plane exports the model relative to the current work plane
coordinate system.

• Base point <name of base point> exports the model relative to
the base point using coordinate system values East coordinate,
North coordinate, Elevation, Angle to North, Latitude and
Longitude from the base point definition.

6. In the Selection list, select All objects, or Selected objects. If you want to
export selected objects, select the objects with the appropriate selection
switches: 

• If you activate the Select parts and Select objects in components
selection switches, all the selected parts will be exported.

• If you activate the assembly or component selection, nothing will be
exported.

7. In Object color, select whether you want to export objects using object
class colors or object group colors.

8. In Layer names as, select Name or Phase from the list, or type the
template or user-defined attribute name in the box. You can use phases,
part names, or template attributes or user-defined attributes as layer
names for exported objects.
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9. When you are done, click Export to export the objects according to the
defined settings. 

Tekla Structures creates the <name>.dgn file in the specified folder.

Export to 3D DGN v7
• The 3D DGN v7 export supports parts only.

• In 3D DGN v7 export, you can only export to the model origin. Changing
the work plane has no effect to export.

1. Open a Tekla Structures model.

2. On the File menu, click Export --> 3D DGN . 

The 3D DGN Export dialog box opens.

3. In the Output file box, enter the name of the export file. 

If you want to replace an already existing file, click the ... button and
browse for the file.

4. In the Export list, select All objects, or Selected objects and select the
parts to export. 

It might be a good idea to filter out minor secondary parts, for example,
curved parts from railings, if you do not need them in the exported DGN
model. This decreases the export file size.

5. Click Create. 

Tekla Structures creates the <name>.dgn file in the current model folder.

You can use the following advanced options to control DGN exports:

XS_EXPORT_DGN_COORDINATE_SCALE

XS_EXPORT_DGN_FILENAME

XS_EXPORT_DGN_INCLUDE_CUTS

XS_EXPORT_DGN_INCLUDE_INNER_CONTOUR

XS_EXPORT_DGN_USE_CLASS_AS_COLOR

Advanced options related to 3D DGN export

If you have tubular parts in your model and you want to reduce the size of the
DGN files or the complex display in the rendered views, you can use the
following advanced options to control this:
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3.6 LandXML
You can insert LandXML reference models to Tekla Structures. The supported
contents of LandXML files are terrain models, line alignments of roads and
railways, and rain water systems.

You can export files in .xml format from applications like Bentley InRoads,
Autodesk Civil, and Trimble Business Center, and insert the .xml files in Tekla
Structures as reference models. The LandXML format extends the capabilities
of Tekla Structures to show merged models, including the infra models. Tekla
Structures supports LandXML 1.2 schema and single-precision floating-point
format.

A typical example of a building structure where LandXML can be used is the
surface of the bedrock to be utilized when pile lengths are to be considered.
LandXML can also be used when estimating the need of excavation. The
LandXML format is important also for bridge and for civil structures design
tasks.

An example of an imported LandXML reference model:

An example of layers in a LandXML reference model:
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Limitations

The LandXML feature does not support all the possible data in the format. It
supports the subset of the primitives defined in LandXML 1.2 schema, such as
alignments, terrain models and pipe networks.

• Surfaces are not shown correctly in drawings.

• Triangle type of surfaces are only supported.

• There is no warning if the LandXML file contains unsupported data.

See also

Insert a reference model (page 161)
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3.7 PDF
You can insert a PDF file as a reference model to your Tekla Structures model.
During import, Tekla Structures converts the PDF into the DXF format.

Insert a PDF file to a model

1. On the File menu, click Import --> Insert PDF . 

The Insert PDF Reference Model dialog box opens.

2. Click Browse...

3. Browse for the PDF file and click Open.

4. Set the scale for the reference model.

5. Enter the number of the pages that you want to insert.

6. Click OK.

7. Pick a point to place the reference model. 

Tekla Structures converts the PDF into the DXF format. The conversion
creates a DXF file for every inserted page. Tekla Structures saves the DXF
files to the same folder where the PDF is.

Limitations

Only vector graphics are converted, not raster graphics.

3.8 SketchUp
You can export a Tekla Structures model to SketchUp in the .skp format.

Trimble SketchUp is a modeling software used in, for example, architecture,
construction, engineering and landscape architecture. 3D Warehouse contains
lots of SketchUp models that you can import as reference models to Tekla
Structures.

You can insert Sketchup files as reference models to Tekla Structures. Tekla
Structures supports Sketchup version 2019 and earlier in import. For more
information about inserting reference models, see Insert a reference model
(page 161).

You can export Tekla Structures models as .skp files to be used in SketchUp.

Export a model to SketchUp

1. Select the model objects to export. 

If you want to export all, you do not have to select anything. We
recommend exporting large models in portions.

2. On the File menu, click Export --> SketchUp .

3. Browse for the Output file location and enter the file name.
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4. On the Advanced tab, select the objects that you want to export.

5. Click Create selected. 

If you want to export everything, click Create all.

3.9 Point clouds
Point clouds are groups of measured points on the surfaces of objects created
with 3D laser scanners, for example, Trimble 3D laser scanners. In
construction, the point clouds are mainly used in renovation projects to define
the building or structure that is to be renovated. They can also be used to get
the exact position of existing machinery, pipework or landscape that need to
be taken into consideration on the site. You can also use them to check
execution by importing them as build points into a model to be compared to
the design.

About point clouds in Tekla Structures

• When you attach a point cloud to a Tekla Structures model, you can place it
either by the model origin or a defined base point.

• The original point cloud file is processed and cache files are created in the
Potree format. The point cloud conversion occurs as a background process,
and you can continue working with Tekla Structures meanwhile.

• Point cloud data is stored in the folder defined by the advanced option 
XS_POINT_CLOUD_CACHE_FOLDER. By default, the folder is
%LocalAppData%\Trimble\Tekla Structures\PointClouds, for
example, C:\Users\<user>\AppData\Local\Trimble\Tekla
Structures\PointClouds. The XS_POINT_CLOUD_CACHE_FOLDER
advanced option is user-specific, and it is located in the File Locations
category in the Advanced Options dialog box.

• If the point cloud file is in the Potree format already, then the original file is
used without any conversion or copying to the ..\Pointclouds folder.

• If the same point cloud is used in several models, it will not be converted
again or duplicated when you attach it. If point clouds are identical, the
existing converted file is used, otherwise the file is converted.

• It may be useful to use a network drive for the potree file in a project. The
file will not be copied to the local computer.

• You can also use point clouds through internet. Point cloud web streaming
cache is a common cache with Trimble Connect for Windows. You can
define the cache folder using the advanced option 
XS_POINT_CLOUDS_WEB_CACHE in the File Locations category in the
Advanced Options dialog box. By default, the folder is %LocalAppData%
\Trimble\Trimble Connect\Import, for example, C:\Users\<user>
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\AppData\Local\Trimble\Trimble Connect\Import. The cache
usage improves the performance of the web streamed point clouds.

• In Tekla Structures, point clouds have colors if the original file format
supports colors.

• Point clouds can be seen in both the OpenGL model view and in the DX
model view. The DX model view with perspective projection may give better
visual result. Performance with bigger amount of data and/or larger
number of views may make DX usage impossible.

Compatible file formats

ASCII (.asc, .xyz)

E57 (.e57)

LAS (.las)

LAZ (.laz)

PTS (.pts)

PTX (.ptx)

Potree (.js)

Trimble scan format (.tzf)

Limitations

• Some basic Tekla Structures model handling functionalities are not
available, such as select, undo, move, rotate, copy, and pop-up menu on
right-click.

• Point clouds are not autosaved.

• You cannot delete a point cloud from the point clouds list using the
keyboard button Delete.

• Point clouds are not visible in drawings.

• Point clouds are not shared in Tekla Model Sharing or in multi-user mode.

• For the file formats ASCII, PTS: On each text line, the first three fields must
be: x y z. For colored point data, the last three fields must be: r g b

Attach a point cloud to the model
1. Click the Point clouds button in the side pane. 

2. If you want to place the point cloud inside the work area, select the Show
inside work area only check box.

3. Click Attach.
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4. Browse for the point cloud file, or enter the URL address of the point
cloud. 

Note that when you are using a URL, you need to create the HTTP
directory structure potree that you can create with Point Cloud Manager.
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5. Change the point cloud scale, if needed.

6. In Location by, select Model origin to place the point cloud in the model
origin, or select a base point to place the point cloud in the real world
coordinates. 

NOTE If you do not know the coordinate system of the point cloud,
select Auto-created base point to get the point cloud near the
model origin. Automatic base point with point cloud bounding
box min x, min y, and min z coordinates will be created in Tekla
Structures origin.

7. Click Attach point cloud.
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8. To show the point cloud in the model, select the model view where you

want to show it, and click the eye button  next to the point cloud in
the list. 

Note that when you select a model view, it has a yellow frame.

When the point cloud is set visible in the model view, you can see the min
x, min y, and min z coordinates of the point cloud bounding box on the
status bar.

To hide the point cloud, click  .

When you are modeling, you can snap to points for modeling and measuring
distances. You can use clip planes in point clouds to exactly show what you
want, for example, clip off the roof and some of the floors so that you can see
the bottom floor of the building, and everything there that needs your
attention in the planning phase. You can also use the Clipper tool in Tekla
Warehouse for handling several clip planes at a time, and split the model to
smaller pieces for visualization and modeling.

Modify point cloud properties and visualization settings
You can modify the point cloud properties and visualization settings when you
have attached a point cloud, and DirectX rendering is active.

Note that the point cloud Visualization settings are view specific and settings
are enabled for one view only, the name of which can be seen at the top of the
Point clouds side pane (if you have not selected multiple views). The
Properties settings are enabled only if the point cloud is selected from the list.

1. When you have attached the point cloud, select it from the point clouds
list in the side pane.

2. Adjust the point cloud location, scale and rotation. To modify the values,
you need to select the point cloud in the side pane. 
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Use the Reset button to return the values that we saved for the point
cloud the last time.

3. Click Modify.

4. In Visualization settings, use the EDL (Eye-dome lighting) effect to
improve the depth perception of the point cloud. Drag the sliders to
increase or decrease the outline thickness and strength of the point cloud.
You can deactivate the EDL effect by clicking the EDL button. 

5. In Visualization settings, adjust the size and density of the points by
dragging the sliders.

6. In Visualization settings, change the point cloud colors. Normally, the
default color values are in use. The visualization settings are view specific
and therefore you can use different settings in different views. 
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• You can color the point cloud by elevation by dragging the sliders.

• If the point cloud contains classifications, you can change the color of
the classification category points or hide them.

• Check clashes and deviations by using different colors for different
tolerances. You can detect points that are inside or within a distance
from the selected parts and selected reference model objects based
on the settings you define.

Note that rendered objects coloring may cause confusing results. It is
recommended to use Ctrl+1 and Shift+1 visibility modes to get
unambiguous results.
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7. Save the properties and visualization settings for future needs. 

Detach a point cloud from a model

• To detach a point cloud, click  Detach next to the point cloud name in
the Point clouds list. Then reopen the model or save the model.

Note that you cannot detach the point cloud by pressing Delete on the
keyboard.

The point clouds are cached to the default location or to the location
specified by the user. When a point cloud is no longer used in any Tekla
Structures model, it is cleaned from cache.

Set the default maximum point count in a view
You can use the advanced option XS_SET_MAX_POINT_CLOUD_POINT_COUNT
to set the default maximum value for the points in a view. The default value is
10 000 000 (10 million).

This advanced option is system specific, and it is located in the Model View
category of the Advanced Options dialog box. Restart Tekla Structures if you
change the value.

Clip point clouds and reference models only
Set the user-specific advanced option 
XS_DO_NOT_CLIP_NATIVE_OBJECTS_WITH_CLIP_PLANE to TRUE to only clip
point clouds and reference models with the Clip plane command. Native Tekla
Structures objects are not clipped. FALSE is the default value. This advanced
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option is located in the Model View category in the Advanced Options dialog
box.

Redraw the model views after changing the value.

Point cloud example
In the first image below, a point cloud has been attached to a model in a plan

view. Remember to select a model view and click the eye button ,
otherwise the point cloud will not be shown.

In the next image, the clip plane tool has been used to cut off floors and other
structures:
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In the next image, a section has been cut to be used in a section view:
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The last image shows the section view:
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Share point clouds with other users
Point clouds are normally so large in file size that it is not sensible to share the
point cloud as a part of the model data. Point cloud is not structural domain
data but project data that is not a part of the model, and therefore it is not
dependent on the model save. However, there is need for multiple persons to
use the same point cloud model efficiently. You can use the potree file for
sharing the point cloud. The best practices in sharing the point cloud potree
file among model users are explained below. You first need to create the
potree file and copy the potree file to a shared location, and then other users
can attach it to their Tekla Structures model.

Create a potree file

Option 1: With Tekla Structures

1. Create a potree file by attaching a point cloud model to a Tekla Structures
model.

The potree file is created to the folder defined by the advanced option 
XS_POINT_CLOUD_CACHE_FOLDER. The potree file is named as
<potree_name>.db, and it has a folder with the same name. For
example:
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2. Copy both the <potree_name>.db file and the related folder to a shared
location. You can rename the model if you want, in which case you also
need to rename the folder.

NOTE Do not replace existing potree data, especially if it is used by
other users.

Option 2: With Point cloud manager

You can download Point cloud manager from Tekla Warehouse.

For detailed instructions about using Point cloud manager, see the Point

cloud manager help. You can open the help by clicking the help button .

To use the Point cloud manager:

1. Install the application, and start it from the start menu or start screen,
depending on your Windows version.

2. Set the root folder for the project, for example C:\Trimble\PTRS.

3. Click the Add new project button to create a project with a given name.

This name will be the name of the potree database and potree folder.
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4. Import one or more point cloud models by clicking Add file, and
browsing for the point cloud file.

5. When the point cloud has been imported, create the potree by clicking

 .
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6. Copy the <potree_name>.db and the <potree_name> folder to a shared
location. Attaching a potree requires both the <potree_name>.db and
the <potree_name> folder.

NOTE Do not replace existing potree data, especially if it is used by other
users.

Attach a potree from a shared location

1. Open Tekla Structures and the Point clouds pane from the side pane.

2. Browse to the point cloud folder (mypotree in the example above) and
select the point cloud .js file. Then follow the instructions above for
attaching the point cloud.

3.10 Layout manager
Use Layout manager to import and export layout data between Tekla
Structures and a field layout device, such as Trimble® LM80. Layout manager
enables you to use accurate model data on the construction site.

When you wish to import and export layout data, we recommend that you first
set up groups in Layout manager, then model the layout points and layout
lines, and organize them in the groups. The points and lines are used in a
layout device on the construction site to position parts correctly.

Once you have defined and organized the layout data, you can export the data
from Layout manager to a field layout device in three different export
formats: point file (.txt), job file (.cnx), and Trimble Field Link file (.tfl).

You can check and measure the positions of the exported layout points
(design points) on the site using a field layout device. The layout device helps
you to position the parts correctly on the site, because then the points along
the part boundaries can be placed to the correct locations. To place the part
boundaries correctly, measure the as-built positions of the parts on the site
and create measured points along the part boundaries.

When you have measured the as-built positions and created measured points,
you can import the points to Tekla Structures. You can first preview the points
in Layout manager. Finally, you can view the measured points in the model.

To import and export directly with a handheld mobile device, such as
Trimble® LM80, you need to connect your computer to the device. Your
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computer needs to have software that enables it to communicate with a
mobile device. For information on how to connect your computer to Trimble
layout devices, see the Trimble website.

See also

Set up groups in Layout manager (page 287)

Create a layout point (page 292)

Create a layout line (page 293)

Export layout data from Layout manager (page 294)

Import layout data to Layout manager (page 297)

Example: Base point use in Layout manager (page 302)

Set up groups in Layout manager
You can create groups in Layout manager to organize layout points and
layout lines suitably.

Base points in Layout manager
You can use base points in Layout manager when defining the location of
layout points. You can use the base points that have already been defined in
the model, and you can define new base points in File --> Project properties
--> Base points. Layout manager uses the Location in the model
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coordinates that you define for base points, and the East coordinate, North
coordinate, and Elevation coordinates.

When you add, modify, or delete base points in File --> Project properties -->
Base points, reopen or refresh Layout manager to ensure that the base
point data is up to date in Layout manager.

• The base points that you add are shown in the Group local coordinate
system list for the groups in Layout manager.

• If you delete a base point that is linked to a group in Layout manager,
Tekla Structures recreates that base point so that it can still be used in
Layout manager.

• If you modify a base point that is used in Layout manager, Tekla
Structures shows a message about the base point use in Layout manager.
You can either use the modified coordinates in Layout manager, or you
can select not to use them. If you select not to use them, the coordinates of
the base point will then be different in Tekla Structures and in Layout
manager.

When you open an existing model in a Tekla Structures version where Layout
manager uses the base point functionality, Layout manager creates base
points based on the group local coordinate systems that are not in the model
origin [(0,0,0) & no rotation]. The created base points are added to the groups
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in Layout manager and shown in the Group local coordinate system list.
The base points are also shown in the list of base points in File --> Project
properties --> Base points. The description text in the Base point dialog box
shows that the base point has been created by Layout manager.

Define a default coordinate system for groups
You can define a default base point to set the default coordinate system for all
the new groups that you create in Layout manager. You can use the groups
in Layout manager to organize layout points and layout lines.

1. On the Manage tab, click Layout manager.

2. In Layout manager, select Layout Manager Object Group to show the
available Group local coordinate system for new groups list.

3. Select from the list the base point that you want to use, the model origin,
or the current work plane. 

The base points that have been defined in the model are available in the list. If
you have added new base points to the model since you opened Layout
manager, reopen or refresh Layout manager to make the new base points
available in the list.

You can change the group default coordinate system at any time by selecting
another option from the list. Note that the default coordinate system only
applies to new groups. The existing groups are not changed.

Define numbering settings for groups
You can define that all groups in Layout manager have the same numbering
settings. When you change the settings, the changed settings are used in all
the groups that you create after the change. The settings in the existing
groups are not changed.

1. On the Manage tab, click Layout manager.

2. Click  to open the settings and then click Group.

3. Define the numbering settings.

a. Enter the prefix in the Prefix box.

b. Enter the starting number in the Starting number box.
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c. Enter the maximum length of the number in the Number max
length box.

d. Enter a delimiter to separate the prefix and the number in the
Delimiter box: a hyphen or an empty space.

e. Select from the Fill leading space list whether the leading space in
front of the number is filled with zeroes or not, for example, PFX
00001 or PFX 1.

4. Click OK.

5. To apply the numbering settings to the points and lines in a group, right-
click the group and select Auto Naming.

NOTE You can modify the numbering settings of an individual group if you do not
want to use the default settings. Select the group and change the settings. To
restore the default settings, click Reset.

Create a group in Layout manager
1. On the Manage tab, click Layout manager.

2. Right-click Layout Manager Object Group and select Add Group. 

You may want to set up several groups so that you can organize the
points and lines into groups as they are modeled. You can have a
maximum of 255 groups in Layout manager.

3. If needed, click the group to rename it. 

A group name can have 18 characters.

4. Define the numbering settings for the group.

5. Select the Group local coordinate system. 

The coordinates are immediately applied when selected.

If you do not want to use the default base point, you can select some
other suitable base point, the model origin, or the current work plane.
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When you have selected a coordinate system for the group and added layout
points to it, you can view the location coordinates of the points in Layout
manager. Select the point in Layout manager to show the coordinates of the
point in Layout manager.

• Location in the model shows the point location compared to the model
origin.

• Location in the group shows the point location compared to the group
local coordinate system.

• East, North, Elevation shows the coordinates that represent the
corresponding X, Y and Z coordinates.

TIP Set XS_IMPERIAL to TRUE to display imperial units in Layout manager,
otherwise metric units are used. You can modify the distance accuracy setting
for imperial units in Layout manager settings  when XS_IMPERIAL is set to 
TRUE.
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NOTE Layout manager may show an Unassigned group in the tree structure. The
Unassigned group shows layout points and layout lines that have inadequate
group information. Such points and lines have usually been created in an
earlier Layout manager version.

Create a layout point
Use the Layout Point tool in the Applications & components catalog to
create layout points. The layout points that you create in the model are design
points that you can export to a layout device, such as Trimble® LM80.

Before you start, ensure that the Select components  selection switch is
activated.

1. In the Applications & components catalog, double-click the Layout
Point tool.

2. Define the layout point properties on the Parameters tab:

a. Enter a name and a description for the layout point. 

You can use the following special characters in layout point names:_
~ % ! @ # & . = + - and space.

Note that the maximum length of the name is 16 characters if you
export layout data to .cnx and .tfl formats. When exporting to a
text file, there is no limitation in the number of characters in the
name. The maximum length of the description is 24 characters.

b. Enter the diameter of the layout point in the Size box. 

Layout manager uses the XS_IMPERIAL advanced option to
determine the units. Set XS_IMPERIAL to TRUE to show imperial
units.

c. Select whether the layout point is a reference point or not. 

A reference point is a mapping point to another coordinate system,
such as a geo-spatial coordinate system or a municipal monument.

d. Select a color for the layout point.

e. Select a shape for the layout point.

f. Select a group from the list or create a new group by entering a
name.

For imported points, Is Stakeout Point shows if the point is a measured
point as staked in the Trimble® LM80 device if it deviates from the
corresponding layout point created in the model. Is Field Point shows if a
point is a field point that has been measured on the construction site and
imported to Tekla Structures.
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3. Select a location for the layout point in the model. 

The layout point is created when you select the location.

4. On the Manage tab, click Layout manager.

5. Click Refresh  to show the added point.

TIP You can also add a layout point to a group in Layout manager. First select a
group, then select the point in the model. Right-click the group and select Add

Selected. Click Refresh  to show the point.

TIP To zoom to a layout point in the model, right-click the point in Layout manager
and select Zoom Selected.

To highlight a layout point in Layout manager, click  in Layout manager
and select Highlight selected model point. Select Redraw to remove the
highlighting.

See also

Set up groups in Layout manager (page 287)

Create a layout line
Use the Layout Line tool in the Applications & components catalog to create
layout lines. Layout lines are created between layout points.

Before you start, ensure that the Select components  selection switch is
activated. Create layout points in your model.

1. In the Applications & components catalog, double-click the Layout Line
tool.

2. Define the properties of the layout line:

a. Enter a name and a description for the layout line.

b. Enter the diameter of the layout line in the Size box. 

Layout manager uses the XS_IMPERIAL advanced option to
determine the units. Set XS_IMPERIAL to TRUE to show imperial
units.

c. Select a color for the layout line.

d. Select a group from the list or create a new group by entering a
name.

Is Field Line shows if a line is a field line that has been measured on the
construction site and imported to Tekla Structures.
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3. Pick the first layout point.

4. Pick the second layout point. 

The start point and the end point cannot be in the same location.

The layout line is created.

5. On the Manage tab, click Layout manager.

6. Click Refresh  to show the added line.

TIP You can also add a layout line to a group in Layout manager. First select a
group, then select the line in the model. Right-click the group and select Add

Selected. Click Refresh  to show the line.

TIP To zoom to a layout line in the model, right-click the line in Layout manager and
select Zoom Selected.

To highlight a layout line in Layout manager, click  in Layout manager and
select Highlight selected model point. Select Redraw to remove the
highlighting.

See also

Set up groups in Layout manager (page 287)

Create a layout point (page 292)

Export layout data from Layout manager
You can use Layout manager to export layout data from your model to a
layout device, such as Trimble® LM80.

Export layout data
You have two options when exporting:

• Export the layout data from Layout manager to a file and move the file
later to a layout device.

• Export a file directly to a layout device. You can do this if you connect the
layout device to your computer using a USB, or a Bluetooth connection.

Before you export, you can define the default export settings in Layout
manager settings .

1. On the Manage tab, click Layout manager.

2. Check from the settings  that the default export settings are as
intended.
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3. Select the group (page 287) that you want to export. 

The points in the group are exported according to the group local
coordinate system. The local coordinates of the points are shown in the
export dialog box.

4. Click  and select the appropriate file type for the export. 

• Export point file (.txt) to export layout points (page 292).

• Export job file (.cnx) to export all layout data in the model to
Trimble® LM80.

• Export Field Link file (.tfl) to export all layout data in the model to a
Trimble Field Link device.

Note that in addition to Trimble devices, other layout devices can also
read in the .txt and .cnx file types.

NOTE The layout points that you create in the model are design points
that you can export to a layout device.

The maximum length of the layout point name is 16 characters if
you export layout data to .cnx and .tfl formats. When
exporting to a text file, there is no limitation in the number of
characters in the name. The maximum length of the description is
24 characters.

5. Select the destination folder and enter a name for the export file.

6. Select the coordinate system for the export from the Export local
coordinate system list. 

• If you are exporting one group, the Export local coordinate system
list shows the base point of the group. You can change the coordinates
by selecting another option from the list.

• If you are exporting more than one group and the groups do not have
the same local coordinate system, the Export local coordinate
system list shows the text: Local coordinate systems of groups. If
you use this option in the export, each group uses the base point that
has been defined for it.

You can also use one base point for all the groups in the export by
selecting the coordinate system from the Export local coordinate
system list.

7. If needed, select a drawing in Map file (.dxf). 

You can attach a layout drawing when exporting a job file (.cnx) and a
Trimble Field Link file (.tfl). You can use the layout drawing with the
layout point data in the layout device. To ensure that the drawing is
exported correctly, you need to define the drawing scale.

8. Click Export to export.
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Define default export settings
You can define the default export settings for each export file type: point file
(.txt), Trimble LM80 job file (.cnx), and Trimble Field Link (.tfl). The units
depend on the settings in File menu --> Settings --> Options --> Units and
decimals .

1. On the Manage tab, click Layout manager.

2. Click  to open the settings.

3. Click Point File to define the export settings for point files (.txt):

a. Select the unit.

b. Select the delimiter.

c. Define the order of column headers in point files. Right-click a header
in the list and select Move Up or Move Down.

4. Click Trimble LM80 to define the export settings for Trimble® LM80 job
files (.cnx):

a. Select the Default directory.

b. Select the default Length unit. 

You can select to export as meters, feet-inches, or survey feet.

c. Select the plane Angle unit. 

The default angle unit is Degree.

d. Select the Version of the Trimble® LM80 device. 

The default version is V4. Ensure that the setting matches the version
of your layout device.

5. Click Trimble Field Link to define the Trimble Field Link file default
directory (.tfl).

6. Click OK.

Define the drawing scale
You can include a drawing when exporting all layout data in a job file or a field
link file from Layout manager by adding the drawing to the Map file (.dxf)
box in the export dialog box. The drawing is exported in the .dxf or .dwg
format. To ensure that the drawing is exported correctly, you need to define
the drawing scale.

1. Create a general arrangement (GA) drawing of your model. 

We recommend that you make the drawing as simple as possible, only
include parts and grids to show the drawing correctly in a layout device.
You might want to create a drawing layout especially intended to be used
in Layout manager export.
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2. Open the drawing that you are going to use as a drawing layout.

3. Double-click the drawing view frame to open View Properties.

4. Copy the drawing scale.

5. Close the drawing.

6. On the Manage tab in the model view, click Layout manager.

7. Click Drawing Scale Calculator .

8. Enter the drawing scale in the Scale Denominator (e.g. 48, 128) box.

9. Click Calculate. 

The drawing scale is shown in the Scale box.

10. Copy the drawing scale from the Scale box and close the Drawing Scale
Calculator dialog box.

11. On the File menu, click Export --> Drawings . 

Tekla Structures opens the Document manager dialog box and the
Export drawings to DWG/DXF dialog box.

12. In the Document manager dialog box, select the drawing that you want
to export.

13. In the Export drawings to DWG/DXF, do the following:

a. In File location, select the export folder.

b. Select the Drawing as snapshot to CAD model space check box. 

The Scale box is shown.

c. Enter the drawing scale in the Scale box.

14. Click Export.

Import layout data to Layout manager
You can use Layout manager to import layout data to your model from a
layout device, such as Trimble® LM80, to verify the as-built conditions.

Import layout data
You have two options when importing:

• Copy the file that contains the layout data from the layout device to your
computer and import the file later to Layout manager.

• Import the file directly to Layout manager. You can do this if you connect
the layout device to your computer using a USB, or a Bluetooth connection.

1. On the Manage tab, click Layout manager.
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2. In Layout manager, click Import .

3. Select the appropriate import file option. 

• Import point file (.txt) to import layout points (page 292).

Point files (.txt) are always imported to the Design Points tab,
regardless of whether they have been measured on the site or not.

• Import job file (.cnx) to import all layout data in a Trimble® LM80 job
file.

Job files (.cnx) are imported to the Measured Points tab.

• Import Field Link file (.tfl) to import all layout data in a Trimble Field
Link file.

Trimble Field Link files (.tfl) import both design points that have
been exported from Tekla Structures originally and measured points
that have been measured on the site. In the import dialog box, a
design point is flagged  if the point name and therefore, the point
already exists. We recommend that you do not import an existing
design point. Clear the check box next to the flag to exclude an existing
point from the import .

4. Select the file to import. 

When you select a file, a new group that is named with the file name is
created. You can have a maximum of 255 groups in Layout manager.

5. Select the group (page 287) to which the layout data is imported, or click
New to create a new group. 

Job files (.cnx) and Trimble Field Link files (.tfl) may contain layout point
groups. If there are groups in these files, the groups are shown in the list
of groups that you can select in the Group list.

6. Check the group coordinate system. 

The Group local coordinate system shows the group coordinate option
that you have selected. You can change the coordinates by selecting
another option from the list.

If you select the group that has the import file name, the default
coordinate system for groups defined in Layout Manager Object Group
is used.

7. Click Show to show the contents of the import file.

8. If needed, define the point file columns in the Text File Import - Column
Headers Mapping dialog box, and save the changes.

9. Click OK to close the Text File Import - Column Headers Mapping dialog
box. 

The points are now shown in the import dialog box.
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10. Click Import. 

The imported points are created in the model and displayed in the Layout
manager dialog box in the group that you selected in the import dialog
box.

NOTE Design points are layout points that have been created in the Tekla Structures
model. Measured points are layout points that have been measured on the
construction site.

Define point file columns
You can import layout points to your model in a point file that lists the layout
point names and the point coordinates. If the point file does not have a
header, or if Layout manager does not recognize the header, the Text File
Import - Column Headers Mapping dialog box is displayed when you click
Show to show the file contents in the import dialog box.

Example of a point file without a header:

In the Text File Import - Column Headers Mapping dialog box, the content
of the point file is shown at the bottom and the column headings are shown at
the top.

1. Check that the point file content is shown under the correct column
headings: 

• Name Column shows the layout point name.

• X Column shows the x coordinates.

• Y Column shows the y coordinates.

• Z Column shows the z coordinates.
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2. If needed, change the columns at the top of the dialog box by selecting
the correct column from the list.

3. Select a measuring unit.

4. Select in the Process first line setting whether the first line in the point
file is a header row or not. 

• Yes means that the first line has layout point data and that it is not a
header line.

• No means that the first line is a header line.

5. Click OK.

Measured points in Layout manager
Measured points are points that are measured on the construction site using a
layout device and imported to Tekla Structures. You can view the properties of
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measured points in Layout manager or in the Layout Point tool dialog box.
In addition to the general point properties, such as name, diameter, and
shape, the measured points have measured point properties that cannot be
modified in Tekla Structures.

To view the measured point properties, select the point in Layout manager or
double-click the point in the model.

The measured point properties are as follows:

Property Description
Is Stakeout Point You can label a measured point as

staked in the Trimble® LM80 device if
it deviates from the corresponding
layout point created in the model.

The property is shown in the Layout
Point tool dialog box.

Is Field Point A field point has been measured on
the construction site and imported to
Tekla Structures.

Is Field Line is the corresponding
property for layout lines.

The property is shown in the Layout
Point tool dialog box.

HR Height of rod is the height of the
prism on the pole. It is used to
determine instrument height, and
therefore the actual elevation of the
measured point.

HA Horizontal angle is the angle that was
measured from the back sight, or 0
angle.

VA Vertical angle is the difference in
angle measurement from the
horizontal position of the instrument
scope.

SD Slope distance is the actual distance
regardless of elevation change.
Horizontal angle is the distance along
a horizontal plane.

PPM Parts per million is a factor used to
determine measurements that take
into account the air conditions and
how they affect the ability of light to
travel through the air. This property is
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Property Description
important in the measurement
calculation and accuracy.

Benchmark offset Benchmark offset is a measurement
that defines a benchmark that
elevation measurements are
calculated from.

Example: Base point use in Layout manager
This example shows different model views that contain a layout point, control
point, and civil origin in the model. The civil origin is the datum point, or the
fundamental benchmark point of the national land survey network.

1. Create a control point in File --> Project properties --> Base points. 

2. Create a layout point (page 292) by using the Layout Point tool, and add
the layout point to the model. 
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The image below shows the point locations in a 3D model view.

• The green point in the bottom-left corner is the civil origin.

Note that the East coordinate and North coordinate are not in scale
here.

• The blue point is the control point, that is, the base point that you
created.

• The red cone is the layout point, in the image framed with a yellow
square.

• The green box is the model origin at the grid intersection A-1.

3. In Layout manager, add the layout point to a group (page 287). Select the
base point that you created, Control point 1, to be used as the Group
local coordinate system of the group. 

4. Check the coordinates of the layout point. 

• Location in the model: the distance to the model origin.

• Location in the group: the distance to the base point selected for the
layout point group.

• East, North, Elevation: the distance to the civil origin.
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The images below show different views and measurements of the points
in the model.

Elevation view

Plan view
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Plan view zoomed

5. Export the layout point (page 294). 

The X, Y and Z coordinates in the export dialog box are the East, North,
Elevation (X, Y, Z) coordinates that you can view in Layout manager
point properties. These coordinates are exported.
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3.11 Analysis and design systems
Analysis and design systems are used to design and analyze the frame or
components within a structure. These applications calculate the loading,
stresses and strains on the elements. They also calculate the moments, shears
and deflections on objects under various loading conditions.

These types of applications make use of various forms of analysis from the
traditional first order static, second order p-delta, geometric non-linear or
buckling analysis. They can also make use of various forms of dynamic analysis
from modal extraction to time history and response spectrum analysis along
with the sizing of steel, concrete and timber elements to the relevant national
and international design codes.

Some examples of these systems are Tekla Structural Designer, ETABS,
STAAD.Pro, SAP2000, Robot, ISM, S-Frame, MIDAS, Dlubal, SCIA, Powerframe,
GTStrudl, Strusoft, and AxisVM.

See also

Analysis and design direct links (page 306)

Tekla Structural Designer (page 307)

STAAD.Pro (page 316)

SAP2000 (page 315)

Robot (page 315)

ISM (page 316)

S-Frame (page 317)

FEM (page 318)

Analysis and design direct links

When you have a direct link to an analysis and design application, and you
export the analysis model from Tekla Structures using that particular analysis
application, the model is opened in the application. Tekla Structures and the
analysis and design application need to be installed on the same computer.

The analysis and design direct links are created either using the Tekla Open
API or the older COM link (Common Object Model transfer technology). A
number of direct links are available including AxisVM, Diamonds, Dlubal,
ETABS, GTStrudl, ModeSt, MIDAS, NISA, Powerframe, ISM, Robot, SAP2000,
SCIA, S-Frame, STAAD.Pro, STRUDS, and Strusoft.

Many of the direct links are available for downloading in Tekla Warehouse. For
the applications that are not available in Tekla Warehouse, the links can be
downloaded from the vendor web sites or by contacting the vendor.
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Tekla Structural Designer
Tekla Structural Designer is a software that allows you to design reinforced
concrete buildings and steel buildings. It works with real physical objects such
as beams, columns and slabs. The information transferred is the physical
information such as geometry, section sizes and grade as well as attributed
data. In Tekla Structures, you can import from and export to Tekla Structural
Designer.

Tekla Structural Designer is a code-based modeling tool, which enables
structural engineers to establish a code compliance design of the structure,
and perform calculations and schema design, for example. All the design/code
data is held within Tekla Structural Designer at all times.

Tekla Structural Designer will analyze and design structures to a range of
International codes of practice.

The initial model can be started in either Tekla Structures or Tekla Structural
Designer, depending on the project needs. You can import and export many
times, and make use of the effective change management functionality.

The integration process allows you to pass models between Tekla Structural
Designer and Tekla Structures, allowing the updates in the model at both
ends. As the model is integrated between software applications, the changes
are updated, and modifications performed since the last integration operation
are maintained within the model.

Tekla Structural Designer and Tekla Structures accept and produce files in
the .cxl neutral file format. The .cxl file format is an XML based neutral file
format that allows applications to link Tekla Structural Designer. To import
rebars, you need to have compatible versions of Tekla Structures and Tekla
Structural Designer installed on the same computer and access to the original
Tekla Structures Designer file (.tsmd).
Tekla Structures supports files created in Tekla Structural Designer 2016 or 
later.

This section only contains instructions regarding import (page 309) and re-
import (page 312) from Tekla Structural Designer, and export (page 313) to
Tekla Structural Designer. For more information about Tekla Structural
Designer and the integration between Tekla Structural Designer and Tekla
Structures, see Guidance notes for Integration between Tekla Structural
Designer and Tekla Structures. This page contains a link to "Integration with
Tekla Structures" guide in .pdf format.

Also take a look at other related information in Tekla User Assistance for Tekla
Structural Designer:

Getting started guides

Product guides
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Knowledge base articles

Videos

Example workflow of integration between Tekla Structures and Tekla
Structural Designer
Integration between Tekla Structures and Tekla Structural Designer has been
developed to ensure that the initial model can be started in either tool without
any detriment to the design process. This added flexibility enables companies
to align their software solutions closely to their own workflows. (i.e. The initial
model can be created in Tekla Structural Designer by the engineer or in Tekla
Structures by the technician.)

It is recommended that Tekla Structures model is used as the "master model"
for geometrical changes as this model also is linked to the BIM
documentation. Alterations made to the model geometry are best handled by
altering the Tekla Structures model and transferring the changes through to
Tekla Structural Designer for redesign.

A typical workflow and the decision making process through the different
stages of a project could be as follows:

Initial scheme stage

• The initial model may be started in Tekla Structures or Tekla Structural
Designer without any detriment to the process.

• A number of factors may determine which software is used for starting the
modeling process, such as availability of staff, or deliverable requirements.

• Unless there are external drivers, Tekla Structures may prove to be the
best starting point for the model as it can provide most of the deliverable
items at the initial stage.

• The model does not need to cover the complete building, it might be a
typical bay or floor, for example.

• The generated structure can be designed in Tekla Structural Designer for
initial section sizing at the initial stage and synchronized back to Tekla
Structures for initial drawings or material list creation.

• Simple drawings can be created at this stage, this can be done in Tekla
Structures or Tekla Structural Designer.

• Initial material lists for cost estimates can be generated at this stage.

Detailed design stage

• It is not always appropriate to carry models forward from the Initial
scheme stage to the Detailed design stage as changes to the overall
scheme may have been made, which will not be reflected in the initial
scheme model. It is sometimes better to begin the model again.
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• Models can be started in Tekla Structures or Tekla Structural Designer to
suit the user. The models can then be transferred to the other modeling
system.

• Importantly, the two models can be worked on at the same time, with
synchronization of the two models taking place to suit the workflow.

• Tekla Structural Designer can be used for a full gravity and lateral design of
the structure.

• Within Tekla Structures, drawings can be generated to a tender stage level
and general arrangements submitted to building control for approval.

Construction stage

• Using the model from the Detailed design stage, much of the
Construction stage process will take place in Tekla Structures so that the
integration with other disciplines can be accounted for.

• The design is not revisited unless the client drives the requirement for
change.

• If a re-design of the structure is required, the same synchronization of
Tekla Structures or Tekla Structural Designer models can be carried out to
suit the user.

• The model will be completed within Tekla Structures and fully detailed
drawings for parts can be created along with construction level
arrangement drawings of the structure.

• Detail integration checks with other disciplines (e.g. mechanical and
electrical engineers) can be carried out at this stage.

Import from Tekla Structural Designer
Import from Tekla Structural Designer creates Tekla Structures parts, such as
beams, columns, slabs, and shear walls based on the contents of the
imported .cxl neutral file. To import rebars, you need to have compatible
versions of Tekla Structures and Tekla Structural Designer installed on the
same computer and access to the original Tekla Structures Designer file
(.tsmd).

Before importing, open Tekla Structures and the model where you want to
import.

1. On the File menu, click Import --> Tekla Structural Designer .

2. In the import dialog box, enter the path of the import .cxl ile or the 
original.tsmd file in the Import file box, or click the ... button next to 
the box to browse for the ile.

3. Once you have selected a valid file, the import buttons and the Preview
Conversions button will be enabled. To read the import file and display
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all the proposed profile and material grade conversions to be used, click
the Preview Conversions button. 

The import uses an internal conversion list containing the standard
profiles and grades. Any member with profile or material that cannot be
converted using the internal conversion will be flagged in red and the
Tekla Structures name will be replaced with the text *** NO MATCH ***.

4. If the text *** NO MATCH *** is displayed, you can convert the profiles
and materials manually in the following way:

a. Create a profile and/or material conversion file in a text editor using
the file name extension .cnv.

The conversion files can also be used to override the standard
conversion.

b. In the text ile, enter the .cxl/.tsmd profile or material name, the 
equal sign (=) and then the corresponding Tekla Structures name, for 
example:

STB 229x305x70=TEE229*305*70 for profile

S275JR=S275 for material

If the conversion files are not used, the members with profiles or
materials that cannot be converted will still be created but they will use
the import file profile or material, which may be invalid in Tekla
Structures, and the members may be drawn as lines in the model, but can
then be edited manually in Tekla Structures

5. Select the among the following grid options:

• Delete Tekla Structures' grids: Import will remove all grid lines/
planes from the current Tekla Structures model.

• Import grids from import file: The grid lines from the import file will
be imported into the Tekla Structures model. A grid line pattern will be
created, and all the imported grid lines will be attached as individual
grid planes to this pattern.

6. If you want to remove slab and wall openings in the Tekla Structures
model that were previously imported from Tekla Structural Designer,
select Remove previously imported openings.

7. On the Rebars tab, define whether the reinforcing bars are imported, and
how they are imported. Note that the options on the Rebars tab will
become available only when you have selected a .tsmd file as the 
import ile.

Option Description
Import rebars Enable or disable rebar import.
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Option Description
Delete old rebars Delete any reinforcement previously

imported using Tekla Structural
Designer import.

Grade conversion file A text file that contains conversion
information for the rebar grade and
size.

First create a text file with the
extension .cnv. In the text file, enter
the Tekla Structural Designer grade
name, an equal sign (=) and then the
corresponding Tekla Structures name.
List the size mappings for the grade
on the rows underneath the grade
name in the same way, indented by a
tab.

Create rebars as Native bars: Create the rebars as
standard Tekla Structures bars.

Reference bars: Create the rebars as
a reference model that will be saved
in the model folder.

Creation options Single bars only: Do not group the
rebars. If you do not select this
option,the rebars will be imported as
rebar groups where possible.

Simplify bars: The rebars will be
imported without any hooks or
curtailments, and longitudinal bars in
beams will be cut off before they
enter the columns at the end points.

Once per design group: Rebars in
parts belonging to the same design
group (for example column or beam)
will be added only to one of the
groups (for example column or
beam).
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Option Description
Import rebars for Select the objects for which you want

to import rebars: Beams, Columns,
Walls, or Slabs.

8. Import by pressing one of the following buttons:

• Import at Origin: Import the model using the global X, Y and Z
coordinates with the global origin as the 0,0,0 point for the import
model’s coordinate system.

• Import at Location: Select a point in the model to use as 0,0,0 and
select a second point to define the X axis to use.

When a Tekla Structural Designer .cxl or .tsmd file is imported into Tekla
Structures, the model is checked for existing items. If none of the items in the 
import file have previously been imported into the current model, Tekla 
Structures imports the contents of the selected import file and creates all the 
required objects in the Tekla Structures model. If the Tekla Structures model is 
empty, the project properties from the import file will be written into the
model's project properties. If the model contains members, the .cxl/.tsmd 
model data will be ignored leaving existing project properties intact.

NOTE You can find more information on exporting models and objects from
Tekla Structural Designer in the Tekla Structural Designer product
guides.

Limitations

• For the best results, ensure that XS_ENABLE_POUR_MANAGEMENT in
Advanced Options --> Concrete Detailing is set to TRUE.

• For beams, columns and walls, rebars are created at their correct physical
location inside the solids, but the rebars are not dynamic, which means
that they do not respond to changes in cover values.

• Clashes are not resolved.

• Laps cannot be modeled.

• Rebars in walls are not cut by wall openings.

• Mapping of sizes and grades only works for standard settings with UK and
USA models.

Limitations See also

Re-import from Tekla Structural Designer (page 312)

Re-import from Tekla Structural Designer
When you import from Tekla Structural Designer, you can control which
changes will be made in the Tekla Structures model. If none of the objects in
the import file have been previously imported in Tekla Structures, the import

Import to and export from Tekla Structures 312 Analysis and design systems

https://teklastructuraldesigner.support.tekla.com/product-guides
https://teklastructuraldesigner.support.tekla.com/product-guides


will complete after Tekla Structures has created the required objects. If objects
already exist, then the new members will be listed as new, but if no objects
exist, then the import will just take place.

1. Follow the steps in Import from Tekla Structural Designer (page 309).

2. To display the properties of an object, select the object from the list on
the left in the import verification dialog box. 

If you select more than one object, only the properties for the first object
on the list are displayed, but all the objects that you selected are
highlighted in the model.

3. If any object in the import file has previously been imported into the Tekla
Structures model, the Model Comparison Tool dialog box is displayed
showing the changes and allowing you to control which changes will be
made in the Tekla Structures model. You can do one of the following: 

• Ignore deleted list: The .cxl file may contain a list of objects deleted
in Tekla Structural Designer. If objects in this list still exist in the Tekla
Structures model, they will be deleted unless this check box is
selected.

• Ignore new items: Objects that did not previously exist in the Tekla
Structures model that are in the import file are excluded from the
import if you select this check box.

4. To append the Tekla Structures object ID to the object type string in the
comparison tool list, select Display part IDs.

5. If updating the positions of objects is not required, selecting Profile and
material updates only will only update the object profiles and materials,
and ignore other changes.

6. To reduce the amount of information displayed about the objects that
have been updated, select Only display changed fields. 

Only the values that have been changed are displayed instead of all the
object properties.

7. Click Accept to use the current settings and complete the import. 

Once the import is complete you can view the changes in the model using
Tekla Structural Designer_Integration Status object group color and
transparency settings ( View tab --> Representation --> Object
Representation ).

Export to Tekla Structural Designer
Export to Tekla Structural Designer allows you to export the entire Tekla
Structures model or a selected subset of the model. The exported .cxl file
can be uploaded to Tekla Structural Designer to update the model, or to create
a new Tekla Structural Designer model based on the Tekla Structures model.
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NOTE To export to Tekla Structural Designer using a Tekla Structures
analysis model, see Export an analysis model to Tekla Structural
Designer.

Before exporting, open Tekla Structures and the model from which you want
to export.

1. On the File menu, click Export --> Tekla Structural Designer .

2. In the export dialog box, either enter the path of the export file in the
Export file box or click the ... button at the end to browse to a folder and
enter a name for the file.

3. Once you have selected a valid file, the export buttons and the Preview
Conversions button will be enabled. To process the model and display all
the proposed profile and material grade conversions to be used, click the
Preview Conversions button. 

The export uses an internal conversion list containing the standard
profiles and grades. Any member with profile or material that cannot be
converted using the internal conversion will be flagged in red and the
export name will be replaced with the text *** NO MATCH ***.

4. If the text *** NO MATCH *** is displayed, you can convert the profiles
and materials in the following way:

a. Create a profile and/or material conversion file in a text editor using
the file name extension .cnv. 

The conversion files can also be used to override the standard
conversion.

b. In the text file, enter the .cxl profile or material name, the equal sign
(=) and then the corresponding Tekla Structures name, for example: 

STB 229x305x70=TEE229*305*70 for profile

S275JR=S275 for material

If the conversion files are not used, the objects with profiles or
materials that cannot be converted will still be created but they will
use the export file profile or material that may be invalid.

5. You can export the whole Tekla Structures model or only the objects that
you select. Do one of the following to create the neutral file: 

• To export the whole model, click Export Model.

• To export only the selected parts, select the parts from the model and
click Export selected.

The use of select and view filters is recommended to ensure that only
structural part of the model or elements requiring design are
exported.

The Quick report section will show you the result of the export.
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Robot
The Robot Millennium A&D application is owned by Autodesk Inc. Full product
details can be found on the Robot Millennium web site.

• This application is suitable for basic interoperability, and it can export and
import cis/2 files.

• If you install Tekla Structures and Robot Millennium on the same
computer, then a direct link can be used.

• Currently only the EC3, LRFD, CM66, E32 and ANS design codes are
available in Robot when using the direct link.

• If you are upgrading to Robot 2012, you will need to uninstall Robot 2011
along with the Autodesk Robot Structural Analysis link. Then install Robot
2012 and the link again. This way you make Tekla Structures point to the
Robot 2012 application.

To get more information and to download, go to Tekla Warehouse

See also

Linking Tekla Structures with Robot

Analysis and design direct links (page 306)

SAP2000

The SAP2000 analysis & design application is written by Computers &
Structures, Inc. Full product details can be found on their website.

• The SAP2000 analysis & design application can export and import cis/2 and
ifc files, and export SDNF files.

• If Tekla Structures and SAP2000 are installed on the same computer, then a
direct link can be used.

• It is important that you run SAP2000 for the first time as a standalone
application before your load the link. Just start SAP2000 and create a new
model, save it and close SAP2000. This will then update your registry which
is needed by the link.

To get more information and to download, go to Tekla Warehouse.

See also

Linking Tekla Structures with SAP2000

Analysis and design direct links (page 306)
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STAAD.Pro
The STAAD.Pro analysis and design application is owned by Bentley Systems,
Incorporated. Full product details can be found on their website.

• STAAD.Pro can export and import CIS/2 files, along with their std format. It
has become a semi-industrial standard especially in the plant and heavy
engineering segments.

• If Tekla Structures and STAAD.Pro are installed on the same computer,
then a direct link can be used.

• Profile mapping for different installation environments is achieved by
mapping the profiles used by Tekla Structures and Bentley in files called
ProfileExportMapping.cnv and ProfileImportMapping.cnv located
in the TeklaStructures\TS_STAAD folder. Currently these files are only
used in import.

To get more information and to download, go to Tekla Warehouse.

See also

Linking Tekla Structures with STAAD.Pro

Analysis and design direct links (page 306)

ISM
Bentley’s Integrated Structural Modeling (ISM) is a technology for sharing
structural engineering project information among structural modeling,
analysis, design, drafting and detailing applications.

ISM is similar to Building Information Modeling (BIM), but focuses on the
information that is important in the design, construction and modification of
the load bearing components of buildings, bridges and other structures. Full
product details can be found on their website.

The ISM link is different form the other analysis and design links in that the
physical model is also transferred at the same time as the analysis and design
model and the ISM model can be imported into an empty Tekla Structures
model. The round-trip of model information is also controlled by a
synchronizer.

If Tekla Structures and an ISM enabled Analysis & Design application or
Bentley Viewer v8i are installed on the same computer then a direct link can
be used.

In order to use the link, the ISM Structural Synchronizer version 3.0 needs to
be loaded before the link.

For more information and to download, go to Tekla Warehouse.
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See also

Linking Tekla Structures with an ISM enabled Analysis & Design application

Analysis and design direct links (page 306)

S-Frame

S-Frame Analysis is owned and developed by S-FRAME Software Inc. It is a
complete 4D structural modeling, analysis and design solution for steel,
concrete, linear and non-linear structural models.

• The Tekla API link allows you to write code to connect to an open model in
Tekla and query or manipulate the model. The link was established by
using both the S-Frame and Tekla APIs. It uses a library database to
manage items between Tekla Structures and S-Frame.

• S-Frame can export and import .dxf files. If Tekla Structures and S-Frame
are installed on the same computer, then a direct link can be used. A copy
of the link and instructions on using the link can be requested from
https://s-frame.com. Descriptions regarding the link can be found here:
Building information modeling (BIM) links.

• In some areas S-Frame used to be distributed by CSC, in which case the
installation points to different folders. The model name must not include
spaces as this currently is an issue as the analysis and design frame is not
created if spaces are included.

The whole process involves the following steps: importing to S-Frame,
displaying imported items, and exporting from S-Frame. This process is
described below.

Importing objects to S-Frame and displaying the objects

1. The S-Frame software checks to see if there is an open model in Tekla
Structures using the Tekla API.

2. If a connection can be established, the Tekla Structures model is queried
for a list of model objects, such as modeled members or panels.

3. The returned objects are iterated through, recognized types are
processed, and equivalent S-Frame objects are added or updated to a
library database.

4. The IDs from Tekla Structures are stored so that items can be mapped
back and forth between Tekla Structures and S-Frame.

5. Once the objects have been iterated through, the library database is
queried, and the updated or created objects referenced in the library are
displayed in S-Frame display window.

Exporting from S-Frame
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1. The S-Frame is queried for objects that are displayed in the S-Frame
display window.

2. The library is iterated through for types of known objects (members and
panels) that can be mapped back and forth between Tekla Structures and
S-Frame.

3. Using the unique IDs stored in the import, the Tekla Structures model is
queried to see if items exist. If they do not, they will need to be created,
and the library will be updated.

4. Items can then be added or updated to Tekla Structures to match what is
in S-Frame.

FEM
Tekla Structures FEM import and export tool support several formats and
provide several options for importing and exporting models.

FEM (Finite Element Method) is an analysis and calculation method used in
structural engineering. In this element method, the target is divided into
appropriate finite elements interconnected at points called nodes.

You can import the following formats into Tekla Structures using the FEM
import tool.

Option Software
DSTV DSTV format data (Deutsche Stahlbau-Verband).

Several different systems, for example, RSTAB static
software and Masterseries Analysis & Design system.

DSTV manufacturing format is the standard format
used for manufacturing steel components on
numerically controlled (NC) machines. It also has an
Analysis & Design format that is used for transferring
Analysis & Design models to the physical 3D model.

Different programs produce different DSTV files. For
example, the DSTV file produced by RSTAB static
software only contains a static model. Tekla Structures
exports either the static model (CROSS_SECTION), or
the CAD model (MEMBER_LOCATION).

SACS SACS modeling and analysis software
S-Frame Analysis software, for example, FASTSOLVE.
Monorail Monorail system
STAAD STAAD format data (Structural Analysis And Design).

STAAD modeling and analysis system.

FEM import is an old way to import STAAD data. We
recommend that you use a direct link to ISM or
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Option Software
STAAD.Pro, which are available in Tekla Warehouse. If
Tekla Structures and STAAD.Pro or ISM are loaded
onto the same machine then direct links can be used.

To make a STAAD input file compatible with the Tekla
Structures STAAD import, use the option Joint
coordinate format (Single) to save the input file in
STAAD. This creates a line for each coordinate in the
input file.

Stan 3d Stan 3d analysis software
Bus BUS 2.5 analysis software

Import FEM
1. On the File menu, click Import --> FEM .

2. In the New Import Model dialog box, select Import FEM.

3. Select import model (default) from the list or enter a new name.

4. Click OK.

5. Click Properties... to open a dialog box where you can define the settings
for the import file: 

Setting Description
Conversion tab
Profile conversion file

Material conversion
file

Twin profile
conversion file

Define the conversion files you want to use.

Conversion files map Tekla Structures profile and
material names with names used in other
software.

For more information about conversion files, see
Conversion files (page 155).

Parts tab
Part Pos_No

Assembly Pos_No

Enter a prefix and a start position number.

Parameters tab
Input file The name of the file you want to import. You can

also browse for the file.
Type Select the input file type: DSTV, SACS, Monorail,

Staad, Stan 3d, Bus
Origin X, Origin Y,
Origin Z

Define the origin coordinates to place the file in a
specific location.
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Setting Description
Default yield stress
limit

Default material when
yield stress >= limit

Default material when
yield stress < limit

The Default material when yield stress < limit
setting is used for SACS import file. Define the
material to use if yield stress is less than the limit.

The setting Default material when yield stress
>= limit is used for SACS or DSTV import files. For
SACS, this field defines the material to use if yield
stress is greater than or equal to the limit. For
DSTV you can enter the material grade here, if it is
not included in the import file.

Combine members

Max length for
combining

To combine several elements in the FEM model
into one part in Tekla Structures, set Combine
members to Yes.

For example, if a beam in a file consist of more
than one element, and you select Yes, the
elements are combined to form one beam in the
Tekla Structures model.

If you use the value No, Tekla Structures creates a
beam for each element in the FEM model.

Max length for combining is only applied if you
set Combine members to Yes. Use this setting to
define the maximum length for combining parts.
Tekla Structures combines elements into one part
only if their combined length is less than the value
you enter here.

Staad tab
Material Select the material grade.
Report tab
Create report Set to Yes to create a report.
Display report Set to Yes to display the report.
Report template Select the report template. Your can also browse

for the template.
Report file name Enter the report file name or browse for a report

file.

If you do not give the report any other name, the
report is saved with the name
import_revision_report.rpt in the model folder.

DSTV tab
Version Select the DSTV version.
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Setting Description
Import static elements

Import other elements

If the DSTV file to be imported contains a static and
a CAD model, you can choose which one to import.

Answering Yes to Import static elements imports
the static model.

Answering Yes to Import other elements imports
the CAD model.

Stan 3d tab
Scale Specify the scale of the import model. You can

import Stan 3d without specifying the scale as long
as both the Tekla Structures model and the import
model are in millimeters. If the Stan 3d file is in
millimeters, use the scale 1. If the Stan 3d file is in
meters, use the scale 1000.

Material Enter the material for the parts to import.
Bus tab
Pos_No Indicate the Pos_No of the girders, columns,

braces and cantilevers you import.
Material Enter the material for the parts to import.
Name Enter the name of the parts to import.
Class Enter the class of the parts to import.
Beams behind plane The value Yes aligns the tops of all beams at the

floor level.
Advanced tab  
Action when objects
status is (compared to)

Previous plan lists the objects in your model,
compared with the objects in the file to be
imported. They can be New, Modified, Deleted, or
Same.

Tekla Structures compares the state of imported
objects with those in your model. They can be Not
in model, Different, or Same.

Use the options under Not in model, Different,
and Same to specify the actions when importing
changed objects. The options are No action, Copy,
Modify, or Delete.

Usually there is no need to change the defaults.

6. Click OK to go to the Import Models dialog box.

7. Select the model to import.

8. Click Import. 

Tekla Structures displays the Import model info dialog box.
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9. Select which version of parts to import.

10. Click Accept all. 

If you have changed the model and want to re-import it, you can also
reject all changes by clicking Reject all, or accept or reject individual
changes by clicking Select individual...

11. Tekla Structures displays the message Do you want to save the import
model\nfor subsequent imports? Click Yes. 

Tekla Structures displays the import model in a model view.

12. Right-click the model view and select Fit Work Area to Entire Model to
ensure that the imported model is completely visible.

13. If parts are missing, check the Depth up and Depth down values in the
View Properties dialog box and change them if necessary.

Export FEM
1. Open a Tekla Structures model.

2. On the File menu, click Export --> FEM . 

The Export FEM dialog box opens.

3. Go to the Conversion tab and enter the names of the conversion files
(page 155), or browse for the files.

4. Go to the Parameters tab, and enter the name of the output file, or
browse for the file.

5. Select the output file type: DSTV, MicroSAS or Staad.

6. Set Split members to Yes to split a part in the Tekla Structures model into
several elements in the exported model.

7. If you are exporting to MicroSAS, set Combine segmented members
(MicroSAS) to Yes to combine multiple parts to form one part in the
exported model. 

For example, if you have divided a beam into several elements and select
the Yes option, Tekla Structures combines the elements so that they form
one beam in the exported model. With the option No every element of the
beam in the model forms individual beams.

8. If you are exporting to Staad, go to the Staad tab: 

• Select an option from Profile table list.

• Use the setting Parametric shapes when possible to define how
Tekla Structures exports the profiles PL, P, D, PD, SPD to Staad. Yes
exports the profiles as parametric shapes so that STAAD can identify
them correctly. No exports all profiles as standard STAAD shapes.

Example of a plate PL10*200 when exported as parametric shape
(Yes):
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13 PRI YD 200.000000 ZD 10.000000.

Example of the same plate exported as a standard shape (No):

13 TABLE ST PL10*200

9. If you are exporting to DSTV, go to the DSTV tab: 

• Select the DSTV version from the version list.

• In Element reference with, select whether you want to export into a
static model (CROSS_SECTION), or into a CAD model
(MEMBER_LOCATION).

10. Select the parts in the model to export.

11. Click Apply and Create. 

Tekla Structures creates the export file in the current model folder.

Supported DSTV entities

The DSTV entities are listed below. Tekla Structures supports those marked
with an asterisk (*). See the DSTV standard "Stahlbau - Teil 1. März 2000" for
more information.

Static data:

vertex (*)

polyline

substructure (*)

node (*)

element (*)

element_eccentricity (*)

raster

boundary_condition

elastic_support

nodal_reaction

element_reaction

General data:

material (*)

cross_section (*)

CAD data:

member (*)

member_location (*)

construction-data
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cutout

hole

STAAD table type specifications
Tekla Structures supports the following STAAD table type specifications:

• ST (single section from the standard built-in tables)

• ST PIPE (parametric)

• ST TUBE (parametric)

• RA (single angle with reverse Y_Z axes)

• D (double channel)

• LD (long leg, double angle)

• SD (short leg, double angle)

• TC (beams with top cover plates)

• BC (beams with bottom cover plates)

• TB (beams with top and bottom cover plates)

You can import the types CM and T, user-provided steel table types (UPT), and
other non-standard profiles, if you have defined them in the profile conversion
file. You must use the underscore character in the STAAD name, for example,
UPT_1_W10X49. Tekla Structures automatically converts twin profiles in this
import routine.

3.12 Steel fabrication
Fabrication applies to the building of structures by cutting, shaping and
assembling components made from steel. Steel fabrication shops generally
concentrate on the preparation, welding and assembly aspect with a much
greater use of the multi functioning machines.

Fabrication (cutting and drilling features) of structural steel elements has
always been performed using manually operated techniques, and these
remain today as fabrication methods. The emergence of CNC (computer
numerical control) technology brought automation and greater accuracy to
these techniques, resulting in families of special purpose machines dedicated
to performing individual fabrication tasks.

The following tools are included for steel fabrication purposes in Tekla
Structures installation:

NC/DSTV (page 325)

CIS and CIMSteel (page 361)

MIS (page 360)
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Fabtrol XML (page 368)

ASCII (page 369)

There are also some steel tools that you can download from Tekla Warehouse.

NC files
Tekla Structures produces NC files in DSTV format. You can select the
information to be included in NC files and NC file headers, and define the
desired pop-mark and contour mark settings. You can also produce MIS
(Manufacturing Information System) list files according to the DSTV standard.

NC (Numerical Control) refers to a method where machine tool operations are
controlled with a computer. The NC data controls the motion of CNC
(computer numerical control) machine tools. During the manufacturing
process a machine tool or machining center drills, cuts, punches or shapes the
piece of material.

After you have finished detailing a Tekla Structures model, you can export the
NC data as NC files from Tekla Structures to be used by CNC machine tools.
Tekla Structures transforms the part length, hole positions, bevels, notches,
and cuts into sets of coordinates that the machine tools can use to create the
part in a shop. In addition to the CNC machine tools, the NC files can also be
used by MIS and ERP software solutions.

The data for the NC files comes from the Tekla Structures model. We
recommend that you complete detailing and create drawings before
producing the NC files.

Tekla Structures produces NC files in DSTV format (Deutscher Stahlbau-
Verband) in the current model folder. In most cases each part has its own NC
file. You can also produce NC files in DXF format by converting DSTV files to
DXF files.

DSTV is a standard interface for geometrical description of steel structure
pieces for the post-processors with numerical control. The essential aim of this
interface is to be neutral, which means that with only one standard description
you can manage several different NC machines. The interface standardizes the
link between a CAD-program or a graphical system via a CAM file for the NC
machines. The geometry of the piece is introduced completely neutrally, and
after knowing the parameters of the NC machine, the post-processor is able to
translate this neutral language to the NC machine language. For more
information, visit http://www.deutscherstahlbau.de/dstv/der-verband.

Notes and limitations:

• Duplicate bolts on a part (bolts in the same location as another bolt) are by
default ignored in NC DSTV export. The tolerated distance for bolts to be
considered duplicates can be adjusted with the
XS_BOLT_DUPLICATE_TOLERANCE advanced option.
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• The DSTV standard does not support curved beams, and therefore Tekla
Structures does not create NC files for curved beams. Use polybeams
instead of curved beams.

Create NC files in DSTV format
1. On the File menu, click Export --> NC files .

2. If you have some predefined settings that you want to use, select the
settings from the settings file list at the top and click Load.

3. In the NC files dialog box, select the check box in the Create column next
to DSTV for plates and/or DSTV for profiles.

4. To modify the NC file settings, select an NC file settings row, and click
Edit... 

In the NC file settings dialog box, modify the settings on the Files and
part selection, Holes and cuts, Hard stamp and Advanced Options
tabs. Click OK to save your NC file settings and to close the NC file
settings dialog box.

Hard stamps can be created for both the main part and the secondary
parts. By default, Tekla Structures creates hard stamps only for the main
part. Set the advanced option to TRUE to also create hard stamps for
secondary parts.

You can select to create only DSTV files, MIS files, both, or DSTV files
embedded in MIS files.

If you want to add new NC file settings, click Add... This will add a new row
in the NC file settings list, and the NC file settings dialog box is
displayed, where you can give the settings a new name.

You can enter a unique name for the settings using Save as. Tekla
Structures saves the settings in the ..\attributes folder under the
current model folder.

For more information about the NC file settings, see the "NC file settings"
section below.

5. You can customize the order in which information is displayed in an NC
file, and add additional information on individual parts in the NC file
header. To select the information to be included in the NC file header,
click Header..., modify the information, and click OK: 

• In the NC File Header Information dialog box, include in the Selected
elements list the header information options that you want, and
arrange the options in the desired order by selecting the option and
using the Move up and Move down buttons.
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• If needed, add additional information on individual parts.

You can enter text in the Text info on piece 1 - Text info on piece 4
boxes, and enter desired template attributes in double angle brackets,
for example <<WEIGHT>> to display the weight of the part

• If you want to restore the default file header information, click the
Default button in the NC File Header Information dialog box.

6. To create pop-marks and modify the pop-mark settings, click Pop-
marks... 

For more information about creating pop-marks and about the pop-mark
settings, see the section "Create pop-marks in NC files" below.

7. To create contour marks, and modify contour mark settings, click Contour
marking. 

For more information about creating contour marking and about the
contour marking settings, see the section "Create contour marking in NC
files" below.

For more information on contour marking, see the support article How to
create contour marking for steel beams.

8. To save the settings that you have modified with another name for later
use, click enter a new name next to Save as and click Save as.
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9. In the NC files dialog box, use the All parts or Selected parts options to
select whether to create the NC files for all parts or only for the selected
parts. 

If you use the Selected parts option, you need to select the parts in the
model.

10. Click Create. 

Tekla Structures creates .nc1 files for the parts using the defined NC file
settings. By default, the NC files are created in the current model folder.
The filename consists of a position number and the extension .nc1.

11. Click Show NC log to create and show the log file dstv_nc.log that lists
the exported parts and the parts that were not exported. 

If all expected parts are not exported, check that the parts which were not
exported pass all the profile type, size, hole and other limits set in the NC
file settings.

NC file settings

Files and part selection tab

Setting Description
File format DSTV is the only available value.
File location The default folder is \DSTV_Profiles or

DSTV_Plates under the current model folder.

You can define another destination folder for NC
files in one of the following ways:

• You can enter the folder path in the File
location box. You can also browse for the path.

For example, enter C:\NC.

• If you leave the field empty, the NC files will be
created in the current model folder.

• To create the NC file in a specific folder under
the current model folder,
enter .\<folder_name>.

For example, enter .\MyNCFiles.

• You can use the model-specific advanced
option XS_MIS_FILE_DIRECTORY to define the
destination folder for NC and MIS files. Go to
the CNC category in the Advanced Options
dialog box, and enter the desired folder path
for the advanced option 
XS_MIS_FILE_DIRECTORY. The NC files will be
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Setting Description
created in the specified folder under a folder
that has the name of the current model.

For example, if you define C:\NC, and the name
of the current model is MyModel, the NC files
will be created in the folder C:\NC\MyModel.

File extension .nc1 is the default value.
Include revision mark
to file name

Add a revision mark to the NC file name.

The file name then includes a number indicating
the revision of the file,P176.nc1 becomes
P176_1.nc1, for example.

Create what Select the type of files to create:

NC files creates only DSTV files.

Part list creates only a MIS list file ( .xsr ).

If you create an MIS list file, enter a name for the
list in the Part list file name box. Also, you need
to click the Browse... button next to the Part list
file location box and browse for the location
where you want to save the list .

NC files and part list creates both the DSTV files
and an MIS list file.

Combined NC files and part list embeds DSTV
files in an MIS list file ( .xsr ).

Maximum size The options define the maximum length, width,
and height of the parts the machine tool can
handle. Larger parts are sent to other machines.

Profile type All profiles that are set to Yes in the Profile type
list can be handled by the machine tool. Profile
types are named according to the DSTV standard.

I: I profiles

U: U and C profiles

L: L profiles

M: Rectangular tubes

R: Round bars and tubes

B: Plate profiles

CC: CC profiles

T: T profiles
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Setting Description
SO: Z profiles and all the other types of profiles

By default, Tekla Structures unwraps round tubes
as plate profiles and uses the plate profile type B in
the NC file header data. To change this, use the
advanced option XS_TUBE_UNWRAP_USE_PLATE_
PROFILE_TYPE_IN_NC.

Maximum size of holes The Maximum size of holes options define how
large holes the machine tool is able to drill. The NC
file is not created if a part contains larger holes or
its material is thicker than the specified values. The
hole size is connected to material thickness or
plate thickness.

Each row contains the maximum hole diameter
and the material thickness. Both conditions have to
be met for the NC file to be created. For example, a
row with the values 60 45 means that when the
material thickness is 45 mm or smaller, and the
hole diameter is 60 mm or smaller, the NC file is
created. You can add as many rows as needed.

The following example shows how the Maximum
size of holes can be defined. In this example, we
have the following situation:

• Three plates of different thickness.

• Two bolt groups with equal sizes, and one bolt
group with a larger size.

Maximum size of holes are defined as follows:

Test1 creates a folder under the model folder for
the plates that meet the following criteria:

• Hole diameter: 22
• Plate thickness: 10
Test2 creates a folder under the model folder for
the plates that meet the following criteria:

• Hole diameter: 22
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Setting Description
• Plate thickness: 20
When you create NC files for the plates, the folder
Test1 includes the plate PL350*10 and the folder
Test2 includes the plate PL350*20. The plate 
PL350*15 is not included in any folder, because
the hole size criterion is not met.

The order in which you enter the criteria is
important: enter the most exclusive criteria first. If
you define the criteria in a different order, the
results will also be different.

Holes and cuts tab

See also XS_DSTV_CREATE_NOTCH_ONLY_ON_BEAM_CORNERS.

Setting Description
Inner corners shape The Inner corners shape option

defines the shape of, for example,
web notches or flange cuts at the
beam end.

The Inner corners shape option also
affects cuts on the flange:

The Inner corners shape option
does not apply to rectangular
openings that are located in the
middle of a part:
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Setting Description

The Inner corners shape option
does not apply to those inner
contours that are already rounded in
the model. The model values remain
intact.

The examples in the below show how
the different inner corner shape
options affect the part in the NC file.
The original part in the model has
flanges cut entirely and the web is
notched.

Option 0: Radius

The inner corners are shaped like
holes with a given radius. A separate 
BO block is not written to the NC file.

Option 1: Tangential

The inner corner is rounded
according to the value in the Radius
box.

Option 2: Square
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Setting Description

The corner is as it is in the model.

Option 3: Drilled hole

A drilled hole is added to the inner
corner. The hole radius is the same as
the value in the Radius box. Holes are
written as a separate BO block to the
NC file.

Option 4: Tangential drilled hole

A drilled hole is added tangentially to
the inner corner. The hole radius is
the same as the value in the Radius
box. Holes are written as a separate 
BO block to the NC file.

Distance from flange within which
web is not cut

The Distance from flange within
which web is not cut option defines
the height of the flange clearance
area. The clearance check only affects
the I, U, C, and L DSTV profile types.

If a cut in a part is located closer to
the flange than the clearance in the
model, the cut points inside that
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Setting Description
clearance are moved to the border of
the clearance area when the NC file is
written.

The part how it is modeled. The cut
goes closer to the top flange than the
defined flange clearance in the NC file
settings:

The part how it is written in the NC
files. The dimension shows the
clearance. The top of the original cut
is moved so that the clearance area is
left free. The bottom of the cut is not
moved.

Machine slots as The Machine slots as option defines
how slotted holes are created:

Ignore slots: Slotted holes are not
created in the NC file.

A single hole in the center of the
slot: Drills a single hole in the center
of the slotted hole.

Four small holes, one at each
corner: Drills four smaller holes, one
at each corner.

Internal contours: Flame-cuts the
slots as internal contours.

Slots: Leaves slots as they are.
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Setting Description
Maximum diameter for holes to be
drilled

The Maximum diameter for holes
to be drilled option defines the
maximum hole diameter. Holes and
slotted holes that are larger than the
maximum hole diameter are
manufactured as internal contours.

Maximum diameter for circular
cuts to be drilled

Maximum diameter for circular
cuts to be drilled defines the
maximum circular part cuts. They are
written as holes if the diameter of the
cut is less than the value defined for
the setting. Smaller internal circular
cuts are converted to holes.

Hard stamp tab

Setting Description
Create hard stamp When selected, creates hard stamps.
Hard stamp content The Elements list defines which

elements are included in hard stamps
and the order in which the elements
appear in the hard stamp. You can
also define the Text height and Case.

Project number: Adds the project
number to the hard stamp.

Lot number: Adds the lot number to
the hard stamp.

Phase: Adds the phase number to the
hard stamp.

Part position: Prefix and position
number of the part.

Assembly position: Prefix and
position number of the assembly.

Material: The material of the part.

Finish: The type of finish.

User-defined attribute: Adds a user-
defined attribute (user fields 1-4) to
the mark.

Text: Opens a dialog box where you
can add user-defined text to the hard
stamp.
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Setting Description
Including part position and/or
assembly position in the hard stamp
affects the NC filename:

• Part position: P1.nc1, P2.nc1
• Assembly position: A1.nc1,

A2.nc1
• Assembly and part position: A1-

P1.nc1, A2-P2.nc1
The following example shows a hard
stamp that contains the elements
Phase, Part position, Material, and
Text.

Hard stamp placing If you set the option By orientation
mark to Yes, the default face is
changed from bottom (u) to top (o)
for L profiles, rectangular tubes and
round bars.

The Side option defines the side of
the part on which the hard stamp is
placed.

The Position along the part and
Position in depth of part options
define the position of hard stamps on
parts.

These options move the hard stamp
on the same face it is created, but
they cannot move the stamp to a
different face. If the face is, for
example, the bottom flange, you can
move the stamp to a different place
on bottom flange, but not to the top
flange.

Default faces for different profiles:

I profile: Bottom flange (u)

U and C profiles: Back side of web (h)

L profiles: Back (h) or Bottom (u)

Rectangular tubes: Bottom flange (u)

Round bars: Bottom flange (u)
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Setting Description
Circular tubes: Front (v)

T profiles: Back side of web (h)

Plate profiles: Front (v)

See also XS_SECONDARY_PART_
HARDSTAMP.

Advanced Options tab

Setting Description
Number of decimals Define the number of decimals shown

in NC files.
Change external contour (AK block)
radius sign

Change the AK block curve radius
signs on top (o) and back (h) faces.
This change only affects on top (o)
and back (h) faces.

Below is an example, where the Change external contour (AK block) radius
sign is not selected.

Below is an example, where the Change external contour (AK block) radius
sign is selected.

Change internal contour (IK block)
radius sign

Change the IK block curve radius
signs for top (o) and back (h) faces.
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Setting Description
This change only affects top (o) and
back (h) faces.

Curve detection

Chord tolerance

Curve detection controls whether
three points should be read as a
curve instead of two straight lines.
When Curve detection is set to Yes,
Tekla Structures checks the edges of a
solid against a virtual curve described
by the edges to see if the edges are
curved or straight based on the
Chord tolerance value. Enter the
Chord tolerance value in millimeters.
Curve detection is on by default.

The image below describes the chord
tolerance.

Convert I profile to T profile when
flange is missing

Select whether to convert I profiles to
T profiles when a flange is missing.
You can select either Yes or No.

Skip unnecessary points Select whether to keep or skip the
points that are almost collinear.

If the creation points of a contour
plate differ less than 0.3 mm from a
straight line, they are skipped in the
NC file when this setting is selected.
When the setting is not selected,
every creation point of a plate is
written to the NC file.

Skip unnecessary points not
selected:
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Setting Description

Skip unnecessary points selected:

Create KA block for Select the following options to show
bent line information for bent plates
and polybeam plates in the NC file KA
block: Unfolded bent plates and
Unfolded polybeam plates.

See also XS_DSTV_DO_NOT_UNFOLD_
POLYBEAM_PLATES.

Create pop-marks in NC files
Pop-marks are small holes that help the shop assemble individual parts to
form an assembly. Tekla Structures is able to write the pop-mark information
in NC files to help position parts that will be manually welded to the assembly
main part. Pop-marks are usually made using a drilling machine that drills a
small hole in the surface of the material.

Limitation: Tekla Structures pop-marking does not work with polybeams.

Tekla Structures only creates pop-marks for parts for which you have defined
pop-mark settings. You can save the pop-mark settings in a .ncp file, which
Tekla Structures saves by default in the ..\attributes folder under the
current model folder.
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NOTE Pop-marking affects numbering. For example, if two parts have
different pop-marks, or one part has pop-marks and the other one
does not, Tekla Structures gives the parts different numbers.

1. In the NC files dialog box, select the parts for which you want to create
the pop-marks by selecting the corresponding check boxes in the Pop-
marks column.

2. Click the Pop-marks... button.

3. In the Pop-Mark Settings, click Add to add a new row.

4. To define which parts are pop-marked and where the pop-marks are
created, enter or select information for each item on a row. 

The order of the rows in the Pop-Mark Settings dialog box is important.
Enter the most limiting definition first, and the most generic one last.

First define the pop-mark settings on the Parts to pop-mark tab:

Option Description
Main part profile type Select the main part

profile type that is pop-
marked. The list contains
profiles according to the
DSTV standard.

Main part name Enter the names of the
main part profiles. You
can enter several part
names separated by
commas, for example,
COLUMN, BEAM.

You can use wildcards
(* ? [ ] ). For example,
HE* matches all parts
with a profile name that
begins with the
characters "HE".

Part name can contain
more names separated
by comma.

Sec part profile type Select the secondary
part profile type.

Secondary part name Enter the names of the
secondary part profiles.
You can enter several
part names separated by
commas.
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Option Description
You can use wildcards
(* ? [ ] ).

Part name can contain
more names separated
by comma

Pop-mark location Select how the
secondary part is
projected onto the main
part.

• Left side: The left
side of the secondary
part is marked on the
main part. The left
side is the side of the
secondary part that
is closest to the start
point of the main
part.

• Right side: The right
side of the secondary
part is marked on the
main part.

• Both sides:
Combines Left side
and Right side.

• Center: Center of the
secondary part.

• Left side holes:
Marks the main part
with the position of
holes in the
secondary part, on
the left side of the
secondary part.

• Right side holes:
Marks the main part
with the position of
holes in the
secondary part, on
the right side of the
secondary part.

• Both side holes:
Combines Left side
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Option Description
holes and Right side
holes.

• Middle line: Marks
two points on the
middle line of the
secondary part x
axis.

Move to flange Select to which part of
the main part flange the
pop-marks are moved.
The options are None,
Both flanges, Top
flange, and Bottom
flange.

Edge distance Enter the minimum
distance from a pop-
mark to the edge of the
main part. Tekla
Structures does not
create pop-marks inside
this distance.

If a pop-mark is inside
the defined edge
distance, Tekla
Structures moves it,
unless you have set Pop-
mark location to
Center.

Secondary pop-marks Select whether pop-
marks are created to the
secondary parts.

Add pop-mark to parts
welded on site

Select whether pop-
marks are created for
parts that are welded on
site.

Then define the pop-mark settings on the Pop-marking options tab:

Option Description
Rotate part if pop-marks or other
items only on the back

First select the Pop-marks on the
back check box and then one of the
options.

Also set the Hole diameter.
Rotate part and drill through pop-
marks on the back if other items or
more pop-marks only on the back
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Option Description
Drill through pop-marks on the
back if no other items on the back
No pop-marks on overlapping holes Select if you do not want to have pop-

marks on overlapping holes.
Add pop-marks to centers of studs Select to have pop-marks in the stud

centers.
Show pop-marks in the model Select to show pop-marks in the

model.
Consider zero diameter holes as
pop-marks

Write zero diameter bolt holes as a
pop-marks.

5. Click OK.

6. Select the parts in the model and create the NC files.

Pop-marks are written in the BO block in the DSTV file as 0 mm diameter holes.

If needed, pop-marks can also be displayed in drawings. In drawings, select
the Pop-marks: on/off check box in the part properties to display the pop-
marks.

The default symbol for pop-marks is xsteel@0. You can change the symbol
with the advanced option XS_POP_MARK_SYMBOL .

Tekla Structures displays thick red lines for each pop-mark pair in the model
view which was last updated.
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Examples

Tekla Structures marks the center point of all round secondary profiles on a
main part, and does not create pop-marks closer than 10 mm to the main part
edge.

Tekla Structures projects the hole location in the secondary plates onto a main
part.

Create contour marking in NC files
Tekla Structures is able to generate contour marking in NC files. This means
that information on the layout and the parts that are welded or bolted
together can be added to the NC files and passed on to the machine tool.

Limitation:Tekla Structures contour marking on polybeams does not work in
all cases. The visual placement of contour marking on polybeams has been
improved.

Tekla Structures only creates contour markings for parts for which you have
defined contour marking settings. You can save the contour marking settings
in a .ncs file, which Tekla Structures saves by default in the ..\attributes
folder under the current model folder.

You can add contour marking to both the main and the secondary parts.

NOTE Contour marking affects numbering. For example, if two parts have
different contour markings, or one part has contour markings and the
other one does not, Tekla Structures gives the parts different
numbers.

1. In the NC files dialog box, select the parts for which you want to create
the contour marks by selecting the corresponding check boxes in the
Contour marking column.

2. Click the Contour marking... button in the NC files dialog box.

3. In the Contour marking settings dialog box, click Add to add a new row.

4. To define which parts are contour marked and how they are contour
marked, enter or select information for each item on a row: 

Import to and export from Tekla Structures 344 Steel fabrication



Option Description
Main part profile type Select the main part profile type that

is contour marked. The list contains
profiles according to the DSTV
standard.

Main part name Enter the name for the main part
profiles. You can enter several part
names separated by commas, for
example, COLUMN, BEAM.

You can use wildcards (* ? [ ] ). For
example, HE* matches all parts with a
profile name that begins with the
characters "HE".

Part name can contain more names
separated by comma.

Sec part profile type Select the secondary part profile type.
The list contains profiles according to
the DSTV standard.

Secondary part name Enter the name for the secondary
part profiles. You can enter several
part names separated by commas.

You can use wildcards (* ? [ ] ).

Part name can contain more names
separated by comma.

Secondary contour marking Select whether the secondary parts
are contour marked.

Punch or powder In the list, select how the part is
contour marked:

• Punch: The part is punched.

• Powder: The part is marked with
powder.

• Both: Both techniques are used.
Hard stamp Select whether hard stamps are

created.
Mark parts welded on site Select whether you want to mark

parts that are welded on site.
Edge distance Define the minimum distance from a

contour mark to the edge of the main
part. Tekla Structures not create
contour marks inside this distance.

5. Click OK and create the NC files.

Import to and export from Tekla Structures 345 Steel fabrication



Contour marking is written in the PU and KO blocks in the DSTV file.

Tekla Structures displays contour marking as thick magenta lines in the model
view.

Fittings and line cuts in NC files
When creating NC files in DSTV format, the method you use to cut the end of
the beam affects the beam length in the NC file.

• Fittings affect the length of the beam in the NC file.

• Line cuts do not affect the length of the beam in the NC file.

When you cut the beam end, use the fitting method to make sure that the
beam length is correct in the NC file.

The overall length of a beam will be the fitted net length of the beam. This
means that Tekla Structures always takes the fitting into account when
calculating the beam length.

For lines, polygons, or part cuts, the cut does not affect beam length, but the
overall length in the NC file will be the gross (initially modeled) length of the
beam.
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1. Fitting

2. Line cut

3. Polygon or line cut

4. Fitting

Shortest length

If you want to use the shortest possible length in an NC file, use the advanced
option .

Net and gross length

If you want to include both net and gross length into NC file header data, use
the advanced option .

DSTV file description
Tekla Structures produces NC files in DSTV format. DSTV format is an
industrial standard defined by the German Steel Construction Association
(Deutsche Stahlbau-Verband). A DSTV file is a text file in ASCII format. In most
cases each part has its own DSTV file.

To learn more about the DTSV syntax, see Standard Description for Steel
Structure Pieces for the Numerical Controls.

Blocks

The DSTV file is divided into blocks that describe the content of the file.

DSTV block Description
ST Start of the file
EN End of the file
BO Hole
SI Hardstamp
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DSTV block Description
AK External contour
IK Internal contour
PU Powder
KO Mark
KA Bending

Profile types

Profile types are named according to the DSTV standard.

DSTV profile type Description
I I profiles
U U and C profiles
L L profiles
M Rectangular tubes
RO Round bars
RU Round tubes
B Plate profiles
CC CC profiles
T T profiles
SO Z profiles and all the other types of

profile

Part faces

Single letters in the DSTV file describe the part faces.

Letter Part face
v front
o top
u bottom
h behind

Create NC files in DXF format using Convert DSTV files to DXF macro
You can convert the created NC files in DXF format by using the Convert DSTV
files to DXF macro

Limitation: The macro has been designed for simple plates. Therefore it may
not give correct conversion results for beams, columns and bent polybeams.

1. Create the NC files in the DSTV format.
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2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. Click the arrow next to Applications to open the applications list.

4. If Convert DSTV files to DXF is not visible in the Applications list, select
the Show hidden items check box at the bottom of the Applications &
components catalog.

5. Double-click Convert DSTV files to DXF to open the Convert DSTV files
to DXF dialog box.

6. Browse for the folder that contains the NC files you want to convert to
DXF files.

7. Select the NC files and click Open. 

Tekla Structures automatically creates an NC_dxf folder in the model
folder and the DXF files are created there.

Create NC files in DXF format using tekla_dstv2dxf.exe
You can use a separate Tekla Structures program tekla_dstv2dxf.exe to
convert the DSTV files to DXF format. Only one side of a part (front, top, back
or bottom) is written to the file, and therefore this export format is most
suited to plates.

The program is located in the ..\Tekla Structures\<version>\nt
\dstv2dxf folder.

1. Create a folder for the NC files, for example c:\dstv2dxf. 

Do not use spaces is the folder path. You should not save the files, for
example, in the Tekla Structures folder under the \Program Files
folder, because the folder path contains spaces.

2. Copy all files from C:\Program Files\Tekla Structures\<version>
\nt\dstv2dxf to the folder you created (C:\dstv2dxf).

3. Create DSTV files and save the files in the in the folder you created
(C:\dstv2dxf).

4. Double-click a suitable dstv2dxf_conversion.bat file. 

The program converts the files to DXF format in the same folder.

If you need to adjust the conversion settings, modify the settings in an
appropriate tekla_dstv2dxf_<env>.def file and restart the
conversion. For more information, see the tekla_dstv2dxf_<env>.def
file description below.

The conversion file description PDF files can be found in the same folder
as the tekla_dstv2dxf.exe program.
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tekla_dstv2dxf_<env>.def file description
The tekla_dstv2dxf_<env>.def file is used when converting from the DSTV
to the DXF format using the tekla_dstv2dxf.exe. It contains all the
necessary conversion settings. The .def file is located in the ..\Tekla
Structures\<version>\nt\dstv2dxf folder.

The DSTV to DXF conversion settings are described below.

Environment settings [ENVIRONMENT]

INCLUDE_SHOP_DATA_SECTION=FALSE

Specify whether to include a special data section in the DXF file to allow the
DXF file to be better imported into CNC software written by Shop Data
Systems. Including this special data section in the DXF file makes the DXF file
unreadable by AutoCAD.

Options: TRUE, FALSE
NO_INFILE_EXT_IN_OUTFILE=TRUE

Use to add the input file extension to the output file.

Options:

TRUE: p1001.dxf

FALSE: p1001.nc1.dxf

DRAW_CROSSHAIRS=HOLES
Draw crosshair for holes and slotted holes.

Options: HOLES, LONG_HOLES, BOTH, NONE
HOLES:

LONG_HOLES:

BOTH:
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NONE:

SIDE_TO_CONVERT=FRONT

Define which side of the member to convert.

Options: FRONT, TOP, BACK, BELOW
Defines which part face is shown in the DXF file. This setting is originally
designed for plates.

FRONT is the most typical option. Sometimes you may need another rotation
for a plate, and then you can try if changing this setting to BACK would help. In
addition to the SIDE_TO_CONVERT setting, it requires that the NC files are
created with the advanced option 
XS_DSTV_WRITE_BEHIND_FACE_FOR_PLATE set to TRUE, which will include
the back side data of a plate in the NC file.

OUTPUT_CONTOURS_AS=POLYLINES

Convert contours as polylines or lines and arcs.

Options: POLYLINES, LINES_ARCS

NOTE If you set OUTPUT_CONTOURS_AS=LINES_ARCS:

• Slotted holes may sometimes have a gap/offset between a straight
line and an arc.

• Sometimes a 3D DXF is produced instead of a 2D DXF.

If you set OUTPUT_CONTOURS_AS=POLYLINES, the DXF file may not be
correct if the NC is created with the Inner corner=0 setting.

CONTOUR_DIRECTION=REVERSE

Define the contour direction. This option changes the coordinates of the
vertices, and the order they are written. You can see the difference if you open
the DXF file in a text editor: "reverse" is clockwise and "forward" is counter-
clockwise.

Options: REVERSE, FORWARD
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CONTOUR_DIRECTION only works if you have set 
OUTPUT_CONTOURS_AS=POLYLINES. If you have set it to use LINES_ARCS, the
output is always FORWARD (counter-clockwise).

CONVERT_HOLES_TO_POLYLINES=TRUE

Convert holes to polylines.

Options: TRUE, FALSE
MAX_HOLE_DIAMETER_TO_POINTS=10.0

Convert small holes to points in the DXF file.

When you set MAX_HOLE_DIAMETER_TO_POINTS to a value, the holes with a
diameter smaller than this value will follow the HOLE_POINT_SIZE and 
HOLE_POINT_STYLE settings. With this kind of point visualization, the hole
symbols will no longer show if a hole is bigger or smaller than the other one,
but they will all have the same size.

HOLE_POINT_STYLE=33 and HOLE_POINT_SIZE=5

Point style and size for holes.

1 is a circle, but this setting is not in use

2 is +

3 is X
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4 is short line

33 is circle

34 is a circle with +

35 is a circle with X

36 is a circle with short line

SCALE_DSTV_BY=0.03937

Use 0.03937 to scale to imperial units.

Use 1.0 to scale to metric units.

ADD_OUTER_CONTOUR_ROUNDINGS=FALSE

Add holes to roundings. This only affects the roundings that are created using
the Inner corners shape: 1 setting in the NC file settings dialog box on the
Holes and cuts tab. The hole size information is coming to the DSTV file from
the Radius value in the NC file settings dialog box, and you cannot adjust the
hole size in the dstv2dxf converter.

Options: TRUE, FALSE
ADD_OUTER_CONTOUR_ROUNDINGS=FALSE:

ADD_OUTER_CONTOUR_ROUNDINGS=TRUE:

MIN_MATL_BETWEEN_HOLES=2.0

Define how close the holes can be to each other in slotted hole conversion.

INPUT_FILE_DIR= and OUTPUT_FILE_DIR=
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Folders for input and output files.

DEBUG=FALSE

Show data processing in the DOS window.

Options: TRUE or FALSE

Text specifications [TEXT_SPECS]

TEXT_OPTIONS=PQDG

Define the text options that you want to use in the DXF file:

S adds a side mark (Side: v)

P adds a part mark (Part: P/1)

B adds a part mark and side mark (Part: P/1 Side: v)

Q adds the quantity (Quantity: 5)

G adds the steel grade (Material: A36)

T adds the thickness (Thickness: 3)

D adds the profile description (Desc: FL5/8X7)

TEXT_POSITION_X=30.0 and TEXT_POSITION_Y=30.0

The X/Y location of lower-left corner of first line of text from the origin point
<0,0> of the DXF file.

TEXT_HEIGHT=0.0

TEXT_HEIGHT is not used, the text height is always 10.0, also in text layers.

Text item prefixes

You can define several different prefixes for text items. The prefix is only
written in the file if the option CONCATENATE_TEXT is set to 0.

You can use the following prefix definitions:

PART_MARK_PREFIX=Part:
SIDE_MARK_PREFIX=Side:
STEEL_QUALITY_PREFIX=Material:
QUANTITY_PREFIX=Quantity:
THICKNESS_PREFIX=Thickness:
DESCRIPTION_PREFIX=Desc:
CONCATENATE_TEXT=1

Combine text items (part mark, quantity, profile, grade) into one or two lines.

Options:

0: Text lines are not combined. Prefixes work only with this option.

1: Part mark text on one line, other texts combined on another line.
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2: All text on one line.

CONCATENATE_CHAR=+

Define a separator of max 19 characters for the text items.

Examples of different text specifications

The following settings are used the example below:

TEXT_OPTIONS=PQDG
TEXT_POSITION_X=30.0
TEXT_POSITION_Y=30.0
TEXT_HEIGHT=0.0
PART_MARK_PREFIX=Part:
SIDE_MARK_PREFIX=Side:
STEEL_QUALITY_PREFIX=Material:
QUANTITY_PREFIX=Quantity:
THICKNESS_PREFIX=Thickness:
DESCRIPTION_PREFIX=Desc:
CONCATENATE_TEXT=1
CONCATENATE_CHAR=+

The following settings are used for the example below: TEXT_OPTIONS=B,
CONCATENATE_TEXT=0:
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Miscellaneous layers [MISC_LAYERS]

Entity Layer Name Col
or

Text Height Output as

TEXT TEXT 7 Not used,
always the
same as the
general text
height
definition 10.0.

 

OUTER_CONTOUR CUT 7   
INNER_CONTOUR CUTOUT 4   
PART_MARK SCRIBE 3 Do not set a

value for this
option. If you
set one, the
DXF file will not
be created.

 

PHANTOM LAYOUT 4   
NS_POP_PMARK NS_POP_MAR

K
5  POP_CIRCLE

2.0
(POP_CIRCLE
or POP_POINT
followed by
size)

FS_POP_PMARK FS_POP_MAR
K

6 1.0

This ‘1.0’ is the
diameter of the
hole used for
far side pop
marks. It must
match the
value in the
“drill thru”
option in the
machinex.ini
file

POP_CIRCLE
2.0
(POP_CIRCLE
or POP_POINT
followed by
size)

Color table

1 = red

2 = yellow

3 = green

4 = cyan

5 = blue
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6 = magenta

7 = white

8 = dark grey

9 = light grey

Hole layers [HOLE_LAYERS]

Layer Name Min Diam Max Diam Color
P1 8.0 10.31 7
P2 10.32 11.90 7
P3 11.91 14.0 7

Slot layers [SLOT_LAYERS]

The type and color affect the symbol, but the color of the slot outline or arrow
(phantom) is defined by the PHANTOM layer definition in the MISC_LAYERS
definition.

Layer
Name

Min
Dia
m

Max
Dia
m

Min
‘b’

Max
‘b’

Min
‘h’

Max
‘h’

Typ
e

Colo
r

Phantom

13_16x1 20.6
2

20.6
5

4.75 4.78 0.0 0.02 3 3 PHANTOM_O
UTLINE

13_16x1-7_
8

20.6
2

20.6
5

26.9
7

26.9
9

0.0 0.02 3 3 PHANTOM_O
UTLINE

Below there are three examples with different phantom types. The other
settings used are Slot type=1, HOLE_POINT_STYLE=33 and 
HOLE_POINT_SIZE=1
PHANTOM_ARROW:

PHANTOM_BOTH:

PHANTOM_OUTLINE:
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PHANTOM_NONE:

For an explanation of the “b” and “h” dimensions, see the image below:

Examples of slot types

These example use different slot types, but the other setting are the same:

• Slot layer color is 3 (green).

• Hole layer color is 6 (magenta).

• Phantom layer color is 1 (red).

• Slot layer phantom type: PHANTOM_OUTLINE
• Hole point settings: HOLE_POINT_STYLE=35, HOLE_POINT_SIZE=10

Slot type Description
SLOT_TYPE_1 One hole symbol to the center of slot. The hole symbol

follows the HOLE_POINT_STYLE and HOLE_POINT_SIZE
settings. The slot symbol is created according to the
selected phantom setting (PHANTOM_OUTLINE in this
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Slot type Description
example). The circle color follows the slot layer color, and
the slot color follows the phantom layer color.

SLOT_TYPE_2 Two hole symbols to the slot. The hole symbol follows the 
HOLE_POINT_STYLE and HOLE_POINT_SIZE settings.
The slot symbol is created according to the selected
phantom setting (PHANTOM_OUTLINE in this example).
The hole symbol color follows the hole layer color, and
the slot color follows the phantom layer color.

SLOT_TYPE_3 One circle to the center of slot. The size of the circle
corresponds to the real hole size. The circle color follows
the slot layer color, and the slot color follows the
phantom layer color. The slot symbol is created according
to the selected phantom setting (PHANTOM_OUTLINE in
this example).

SLOT_TYPE_4 Two circles to the slot. The size of the circle corresponds
to the real hole size. If the circles would be touching each
other, only one circle in the middle of slot is created. The
slot symbol is created according to the selected phantom
setting (PHANTOM_OUTLINE in this example). The circle
color follows the hole layer color, and the slot color
follows the phantom layer color.

SLOT_TYPE_5 Hole symbol to the first slot center point. The hole
symbol follows the HOLE_POINT_STYLE and 
HOLE_POINT_SIZE settings. The slot symbol is created
according to the selected phantom setting
(PHANTOM_OUTLINE in this example). The hole symbol
color follows the hole layer color, and the slot symbol
color follows the phantom layer.

SLOT_TYPE_6 One circle to the first slot center point. The slot symbol is
created according to the selected phantom setting
(PHANTOM_OUTLINE in this example). The circle color
follows the hole layer color, and the slot symbol color
follows the phantom layer color.

SLOT_TYPE_7 No hole symbol is created. The slot symbol is created
according to the selected phantom setting
(PHANTOM_OUTLINE in this example). The slot color
follows the slot layer color.
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Create tube NC files
You can create NC files for tubular hollow sections. You first need to use
specific tube components to create the connections.

Create the following tube-to-tube and tube-to-plate connections:

•

•

•

•

•

After using the components, you can create an NC file for data export. The
tube NC file creation results into an XML file which includes the model data.

Limitations:

To get the correct tube NC export results, note the following limitations:

• Line cuts and fittings created manually or by other components will be
exported as simple chamfers.

• Holes created by bolts are not supported, and they will not be exported.

• Curved beams are not supported.

1. On the File menu, click Export --> Tube NC files .

2. In the Create Tube NC Files dialog box, enter a name for the export file,
and browse for the location where you want to save the file. 

By default, the file is saved in the model folder.

3. Select whether you want to create the file for selected parts or for all
parts.

4. Click Create. 

Tekla Structures creates an XML file and a log file in the location you
defined.

MIS lists
You can export an MIS list to a file.

You can export model data to Manufacturing Information Systems (MIS). The
MIS export supports the following formats:

• DSTV - The exported file contains the MIS information written in the DSTV
format.

• KISS - We recommend using the FabTrol reports instead of the MIS export
for exporting FabTrol data. The FabTrol reports are available for the Steel
Detailing role in the US environment. If you do not use a suitable
environment you may also contact your local support for the FabTrol files.
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• EJE - US environment, Imperial role only. Structural Material Manager
internally stores all dimensions in sixteenths. Its External Data Interface
writes all dimensions, such as widths and lengths, except for Beam and
Channel descriptions, in sixteenths of an inch. As an example the length
12'-8 7/8 is equivalent to 2446 sixteenths, which is calculated as (feet * 192)
+ (inches * 16) + (eighths * 2) = (12 * 192 + 8 * 16 + 7 *2).

• EPC - The EPC (Estimating and Production Control) module of SDS/2
requires multinumbering to be active.

• Steel 2000

Export a MIS list

1. On the File menu, click Export --> MIS. 

The Export MIS dialog box opens.

2. Select the file type from the MIS type list.

3. If you selected KISS or Steel 2000, define the additional options: 

• KISS

Enter the customer name in the Customer name box.

Select the Full material list check box to add labor-related
information to the list (for example, holes, welds, cambers, preliminary
marks).

• Steel 2000

Select the Export only shop bolts check box to include only workshop
bolts in the list file.

4. Enter a name for the list file in the MIS list file box. 

By default, the list file is saved in the model folder.

You can select the folder where you want to save the list file by clicking
Browse....

5. Ensure that you have the selection switch Select objects in components
selected. If you have the switch Select assemblies selected, Tekla
Structures will create empty files.

6. Click Create all or Create selected to export the MIS list file.

CIS and CIMSteel models
The CIS (CIMsteel Integration Standards) is one of the results of the Eureka
CIMsteel project. The current version CIS/2 is an extended and enhanced
second generation release of the CIS. It was developed to facilitate a more
integrated method of working through the sharing and management of
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information within, and between, companies involved in the planning, design,
analysis, and construction of steel framed buildings and structures.

There is one limitation: multi-material objects cannot be defined, because the
standard concentrates on steel objects.

Import a CIMSteel model
1. On the File menu, click Import --> CIMSteel. 

The New Import Model dialog box opens.

2. Select Import CIS Model from the Type list.

3. Use the default name import model or enter a new name.

4. Click OK.

5. Select the model from the list.

6. Click Properties... to open a dialog box where you can define the settings
for the import file type you selected. 

Setting Description
Parameters tab  
Model type Select the model type: Design, Analysis, SP3D.
CIS Version Select CIS/1 or CIS/2:

• CIS/1 imports files compatible with the CIMsteel
LPM4DEP1 schema declaration.

• CIS/2 imports files compatible with the CIMsteel
CIS/2 (STRUCTURAL_FRAME_SCHEMA) schema
declaration.

Input file The name of the file you want to import. You can
also browse for the file.

Origin X, Origin Y,
Origin Z

Define the origin coordinates to place the file in a
specific location.

Combine members

Max length for
combining

To combine several elements in the CIS model into
one part in Tekla Structures, set Combine
members to Yes.

For example, if a beam in a file consist of more than
one element, and you select Yes, the elements are
combined to form one beam in the Tekla Structures
model.

If you use the value No, Tekla Structures creates a
beam for each element in the CIS model.

Max length for combining is only applied if you
set Combine members to Yes. Use this setting to
define the maximum length for combining parts.
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Setting Description
Tekla Structures combines elements into one part
only if their combined length is less than the value
you enter here.

Ignore offset CIS/1 and CIS/2 analysis models can include
member offsets, which means that nodes are not
exactly at the beam’s end points. With the default
Yes, Tekla Structures uses these offsets to locate
the physical members. With No, Tekla Structures
determines the location using the node locations.

Ignore forces Use to define how forces are imported. With No,
Tekla Structures imports absolute values of
maximum forces to parts’ user-defined attributes
Shear, Tension and Moment. With Yes, Tekla
Structures does not import forces.

Import GUID (design
model)

Select Yes to include the part GUID in the import.

Conversion tab  
Profile conversion file

Material conversion
file

Twin profile
conversion file

Define the conversion files you want to use.

Conversion files map Tekla Structures profile and
material names with names used in other software.

For more information about conversion files, see
Conversion files (page 155).

Advanced tab
Action when objects
status is (compared
to)

Previous plan lists the objects in your model,
compared with the objects in the file to be
imported. They can be New, Modified, Deleted, or
Same.

Tekla Structures compares the state of imported
objects with those in your model. They can be Not
in model, Different, or Same.

Use the options under Not in model, Different,
and Same to specify the actions when importing
changed objects. The options are No action, Copy,
Modify, or Delete.

Usually there is no need to change the defaults.

7. Click OK to go to the New Import Model dialog box.

8. Click Import. 

Tekla Structures displays the Import model info dialog box.

9. Select which version of parts to import.
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10. Click Accept all. 

If you have changed the model and want to re-import it, you can also
reject all changes by clicking Reject all, or accept or reject individual
changes by clicking Select individual....

11. Tekla Structures displays the message Do you want to save the import
model\nfor subsequent imports? Click Yes. 

Tekla Structures displays the import model in a model view.

12. Right-click the model view and select Fit Work Area to Entire Model to
ensure that the imported model is completely visible.

13. If parts are missing, check the View depth Up and Down values in the
View Properties dialog box and change them if necessary.

Export to a CIMSteel analysis model
1. Open a Tekla Structures model that you want to export.

2. Select the objects to export using the appropriate selection switches or
filters.

3. On the File menu, click Export --> CIMsteel: Analysis model.

4. Select the CIS version from the CIS Version list. 

• CIS/1 generates a file that is compatible with the CIMsteel LPM4DEP1
schema declaration.

• CIS/2 generates a file compatible with the CIMSteel CIS/2
(STRUCTURAL_FRAME_SCHEMA) schema declaration.

5. Enter a name for the export file in the Step file box or accept the default. 

You can enter the path or browse for it. If you do not enter a path, Tekla
Structures creates the export file in the current model folder.

6. If required, enter the a name and organization to identify who created the
export file.

7. From the Flavor list, select one of the following standards to apply to the
export: UK, EUROPEAN, or US.

8. Set units to metric or imperial in the Linear units (CIS/2 only) box. 

Imperial is only available for CIS/2. CIS/1 is always exported in metric
units.

9. Enter coordinate values in Origin X, Origin Y, and Origin Z boxes if you
want to export the model to a specific location. 

The origin comes from the origin in Tekla Structures.
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10. To split a part in the Tekla Structures model into several elements in the
CIMsteel model, set Split members to Yes. 

For example, three columns may be connected to a beam in a model, so
that one column is in the middle and the others are at each end of the
beam. With the Yes option the beam is split into two equal elements in
the CIMsteel model. With the No option there will be one beam, a single
linear element, and two nodes (a node at each end) in the CIMsteel model.

11. Click Apply and Create. 

Tekla Structures exports the CIMSteel analysis model to the current model
folder, or to another folder you specified, using the name you specified.

Export to a CIMSteel design/manufacturing model
1. Open a Tekla Structures model that you want to export.

2. Select the parts that you want to export.

3. On the File menu, click Export --> CIMsteel: Design/manufacturing
model .

4. Go to the Parameters tab and specify the required information: 

• Select the LPM version: LPM5 or LPM6.

• Enter name for the export file in the Output file box or accept the
default.

You can enter the path or browse for it. If you do not enter a path,
Tekla Structures creates the export file in the current model folder.

• Select the model type from the CIS/2 Model Type list. The options are
manufacturing, design, and SP3D.

• Set units to metric or imperial in the Linear units (CIS/2 only) box.

With Imperial units Tekla Structures writes all of the designations for
nuts, bolts, and washers in fractional inches.

• Enter a name for the structure in the Structure name field.

• Enter the path to the profile and material conversion files or browse
for them.

If you leave the profile and material conversion file paths empty, Tekla
Structures uses the conversion files in the current profile folder for the
conversion.

• To export globally unique IDs instead of internal ID numbers, set
Export Globally Unique IDs to Yes.

• If you want to export concrete parts, set Export concrete to Yes.
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5. Go to the Standards tab, and enter the appropriate profile, material, and
bolt standard organization, name and year. 

Tekla Structures populates the export file with the information you enter
here. If you do not enter the standard organization or the name, Tekla
Structures places an empty entry ("") in the export file. If you do not give
the year, Tekla Structures uses 1999 as the default value.

6. If you are exporting to a manufacturing model, go to the Manufacturing
model tab, and specify the required information: 

• Set Include NC files to Yes to include information on NC files in the
export.

• In NC file directory, specify the path (relative to the current model
folder) to the folder where the NC files are located.

7. If you are exporting to a design model, go to the Design model tab, and
set Export design connections to Yes to export design connections.

8. Click Apply and Create. 

Tekla Structures exports the CIMSteel design or manufacturing model to
the current model folder, or to another folder you specified, using the
name you specified.

CIMSteel conversion files

Here are examples of the contents of the conversion files used in CIMSteel
conversion.

Example 1

This example shows part of the profile conversion file prfexp_cis.cnv:

! US Imperial Flavor
! Profile name conversion Tekla Structures -> CIS
!
! If Converted-name does not exist, it will be
! the same as Tekla Structures-name.
! Tekla Structures-name Converted-name
!
!American Sections - Imperial
!W - Wide Flange Beams
W44X335 S\SECT\US\W44X335\ASTM_A6\1994
W44X290 S\SECT\US\W44X290\ASTM_A6\1994
W44X262 S\SECT\US\W44X262\ASTM_A6\1994
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Converted-name contains the following information, and items are separated
by a backslash (\):

• S (fixed value)

• SECT (fixed value)

• Name of the standardization organization

• Standard name of the profile shape

• Name of the standard

• Year of the standard

If the conversion file does not contain the relevant profile type, the Tekla
Structures name of the profile is used. Tekla Structures also uses the
standardization organization, standard name and year of standard defaults
given on the Standards tab.

Example 2

This example shows part of the material conversion file matexp_cis.cnv:

! US Imperial Flavor
! Material name conversion Tekla Structures -> CIS
!
! If Converted-name does not exist, it will be
! the same as Tekla Structures-name.
! Tekla Structures-name Converted-name

# Carbon Structural Steel (ASTM_A36\1994)
GRADE32 S\MAT\US\GRADE32\ASTM_A36-94\1994
GRADE36 S\MAT\US\GRADE36\ASTM_A36-94\1994
#High Strength Carbon Manganese Steel (ASTM_A529\1994
GRADE42 S\MAT\US\GRADE42\ASTM_A529-94A\1994)
Converted-name contains the following information, and items are separated
by a backslash (\):

• S (fixed value)

• MAT (fixed value)

• Name of the standardization organization

• Standard name of the material

• Name of the standard

• Year of the standard
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Converted-name contains the following information about bolts, nuts, and
washers, separated by two colon characters (::):

• Name of the standards organization

• Name of the standard

• Year of the standard

• Standard name of the bolt, washer, or nut

Tekla Structures names for bolts, washers, and nuts are constructed from their
fastener standard, fastener type and size.

If the conversion file does not contain an equivalent profile name, Tekla
Structures uses the name of the material.

FabTrol XML files
You can import fabrication status information for parts to a Tekla Structures
model from an XML file written by FabTrol.

FabTrol is a Material Resource and Planning (MRP) system commonly used by
steel fabricators to manage estimating, inventory and production. Data can be
written to FabTrol via a KISS format export or directly via the text based
reports from Tekla Structures for tracking of the assembly status through the
project lifecycle. The tracking information entered in FabTrol can then be re-
imported back to Tekla Structures via the FabTrol XML import for colorization
of the model. This is performed by storing the data in a preset collection of
user-defined attributes (UDAs). Import of the FabTrol XML is possible in all
configurations of Tekla Structures (including Project Viewer) but data can only
be saved into the UDAs in modeling or management configurations.

You need to have the XMLTrans.trn file in the system folder defined by the
advanced option XS_SYSTEM. This file maps the FabTrol XML names to Tekla
Structures UDA names.

Import Fabtrik XML

1. On the File menu, click Import --> FabTrol XML .

2. Click the ... button next to the Input file box to browse for the XML file.

3. Select an appropriate option from the Create log file list: 

• Select Create to write a new log file and delete the previous log file
each time you import the XML file.

• Select Append to add the log file information at the end of the existing
log file.

• If you do not need a log file, select No.

4. Select an appropriate option from the Display log file list: 

• If you do not want to display the log file, select No.
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• To display the log file, select On dialog.

5. Click Create to import the status information.

PDMS/E3D
You have the following tools available for download in Tekla Warehouse:

PDMS/E3D and Tekla Structures Interoperability: Export to PDMS/E3D

PDMS/E3D and Tekla Structures Interoperability: PDMS/E3D extension

BIM Publisher

Tekla User Assistance contains the following articles about PDMS/E3D:

PDMS/E3D and Tekla Structures Interoperability: Q&A, collected 7 th March
2017

AVEVA PDMS/E3D and Tekla Structures Interoperability: PDMS/E3D extension

PDMS

ASCII files
ASCII stands for American Standard Code for Information Interchange. Some
plant design systems export ASCII files, for example, ModelDraft, PDS and
PDMS.

You can import and export profiles and plates created as beams using the
ASCII format. Contour plates cannot be imported.

Import a model in the ASCII format
1. Create a new model in Tekla Structures.

2. Create a new 3D view.

3. Copy the ASCII file to the model folder.

4. Name the file import.asc.

5. On the File menu, click Import --> ASCII . 

Tekla Structures displays the main parts created from the ASCII file in the
model.

Export a model to the ASCII format
1. Open the Tekla Structures model you want to export.

2. Select the parts in the model you want to export.
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3. On the File menu, click Export --> ASCII . 

Tekla Structures creates a model.asc file in the current model folder.

ASCII file description

In an import.asc file each part is described by 8 lines. These lines are
repeated for each part to be transferred. Units are always in millimeters,
blanks are used as separators.

Below is an example of a beam part description:

Line Description
Line 1 4169 HEA300 1 = ID profile type

• ID 4169: Unique ID (integer).

• PROFILE HEA300: Profile name (string).

• TYPE 1: Profile type (integer)

The available profile types are:

0 = free cross section (can be used for special profiles which are not in
the database)

1 = I profiles

2 = Welded hollow core profiles (HK, HQ)

3 = U profiles

4 = L profiles

5 = Round bars

6 = Round tubes

7 = Rectangular hollow core sections (RHS, P)

8 = T profiles

9 = Rectangular bars (FL, PL)

10 = Z profiles

11 = C profiles
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Line Description
12 = Omega profiles

13 = Sigma profiles

14 = Rail profile

16 = Reinforcement bars (DH)
Line 2 The contents of line 2 depend on the part profile.

• Polygon plates:

N_POINTS COORDINATES

N_POINTS: For profiles of type 0.

COORDINATES: Number of the corner points (integer).

The X and Y coordinates of the plate corners (floating). Rotation
direction is clockwise. Coordinates follow the global coordinate
system. Z coordinates are taken from the center line in the plate
thickness direction.

Note that the line 2 can be divided into several rows in the file.

• Profiles:

For profile types 1-16, the line includes the physical dimensions of
the cross section.

HEIGHT S W1 T1 W2 T2: 290.000000 8.500000 300.000000
14.000000 300.000000 14.000000
• HEIGHT 290.000000: Height of the cross section

• S 8.500000: Web thickness.

• W1 300.000000: Width of the upper flange.

• T1 14.000000: Thickness of the upper flange.

• W2 300.000000: Width of the lower flange.

• T2 14.000000: Thickness of the lower flange.
Line 3 A/6 BEAM = mark name

• MARK A/6: Position mark of the part (string).

• NAME BEAM: Part name (string).
Line 4 S235JR S235JR = material

Material of the part (string).
Line 5 0.000000 = rotation

Rotation angle (in degrees) around the local x-axis of the beam.
Line 6 16.500000 24000.000000 4855.000000 = X1 Y1 Z1

Coordinates of the beam start point. Z coordinates are center-line
coordinates.
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Line Description
Line 7 6000.000000 24000.000000 4855.000000 = X2 Y2 Z2

Coordinates of the beam end point. Z-coordinates are center-line
coordinates.

Line 8 16.500000 24000.000000 5855.000000 = X3 Y3 Z3

Direction vector showing the direction of the local z-axis.

3.13 Automated precast fabrication
With Tekla Structures you can efficiently deliver all types of precast concrete
elements at the right time to the right place by integrating design and detailing
with manufacturing, project management and efficient information sharing.

For the precast fabricators, the target is to offer functionalities to help to
optimize the whole precast construction process from modeling to fabrication
to site operations, minimize errors and waste in all stages and improve
collaboration between project parties in design, production and site.

The offering consist of several product listed below.

Unitechnik

Unitechnik (from the company Unitechnik) is the most common format for
exporting precast and mesh geometry as well as production data. Unitechnik
is for precast panels and slabs and other products that are manufactured in a
pallet circulation as well as for reinforcement meshes.

The Unitechnik format is not used only by UniCAM but also by other industry
solutions such as Leit2000.

Export to Unitechnik (page 373) versions 5.0c - 6.1 are available in Tekla
Structures core installation in the most extensive precast-related
configurations.

EliPLAN

EliPLAN is an ERP software from machinery provider Elematic. The file
format .eli also contains production data and geometry for CAM-operated
hollow-core slab production.

Both EliPLAN export from and import to (page 455) Tekla Structures are
available in the Tekla Structures installation in the most extensive precast-
related configurations.

HMS

HMS is a CAM software for hollow-core production.

The export to HMS (page 471) software is included in the Tekla Structures
installation in the most extensive precast-related configurations.

BVBS
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Reinforcement geometry can be exported to German BVBS
(Bundesvereinigung Bausoftware) format. The result is a text file in ASCII
format.

You can export cut and bent reinforcing bars, reinforcing bar groups and
reinforcement meshes, which can be rectangular, polygonal, non-bent or bent,
and may include cuts. The export of hooks is also supported.

The supported version of the BVBS format is 2.0 from year 2000.

BVBS export (page 444) is available in Tekla Structures installation in the most
extensive configurations.

UXML

UXML (from the company Unitechnik) is for precast panels and slabs and other
products that are manufactured in a pallet circulation as well as for
reinforcement meshes.

Tekla Structures supports exporting both to Unitechnik and UXML formats.

Precast Production Export for UXML can be found as an extension in Tekla
Warehouse. For instruction on how to use the export, see Precast Production
Export.

PXML

The data format of progressXML also known as PXML has been developed by
Progress Software Development, which is part of precast solution provider
Progress Group. Data format is based on hierarchically structured XML for the
generation of data and production control and scheduling at precast or rebar
prefabrication factories. PXML contains both the product geometry to be used
in production and the attribute data for managing the related processes (ERP
data). In particular, there are two different areas of application:

• interface between systems of different manufacturers

• internal (proprietary) storage of data of CAD/CAM systems

PXML is the main data format to bring design geometry between detailer's
Tekla Structures and factory's Progress software such as ebos, erpbos, ProFit
and AviCAD.

Precast Production Export for PXML can be found as an extension in Tekla
Warehouse. For instruction on how to use the export, see Precast Production
Export.

Unitechnik
You can export the 3D geometry of the cast units to the Unitechnik format.
The result is a text file in ASCII format.

Supported versions of the Unitechnik format are:

• 6.1.0 17.9.2009
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• 6.0.0 14.6.2005

• 5.2b 11.9.2000

• 5.0c 30.10.1997

Unitechnik format is intended for the production of the geometry of pallet- or
table-produced precast elements such as solid, sandwich or double walls as
well as panel slabs and half-slabs. You can export cast units consisting of
concrete, steel and surface materials. Exporting of reinforcing bars (bent and
not-bent), reinforcing bar groups and meshes with hooks is also supported.

Example

Exported cast unit:

(1) Hole

(2) Steel embed

(3) Reinforcing bars, cages also supported (UT version 6.1.0)

(4) Insulation plate (green)

For details about exporting to the UXML and PXML formats, see Precast
Production Export. You can download Precast Production Export from Tekla
Warehouse.
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Limitations in Unitechnik export
The Unitechnik format is for flat panels and slabs for production in pallet
circulation plants. It is an open format used by many different production
system master computers, and therefore the specifications are quite strict,
and field character lengths are limited, for example. The different master
computers from different solution providers also have different
interpretations of the Unitechnik data. The original format is from early 2000's,
and it is a bit outdated in many aspects. As a result, the Unitechnik format has
certain limitations:

• Cast units with cast unit type cast-in-place are not exported.

• All Unitechnik fields have a maximum character length, both for geometry
and attribute information.

• While Tekla Structures supports input of longer strings, the data has to
be cut and simplified, or the export may be prevented completely. The
log will notify if this happens.

• Negative values in certain geometry fields (negative pallet X, Y, and Z
coordinates, for example) will cause errors in production systems, even
though the geometry comes correctly from the model.

• Also the number of fields per hierarchy object is limited, although each
has also unspecified reserve fields for customer-specific cases.

• 3D shapes are not supported.

• 3D concrete shapes are not supported (except for edge shapes in line
attributes)

• 3D embed shapes are not supported

• 3D bent rebar shapes are not supported

• When using terminal hook flection forms, the rebars and meshes can be
bent only in one direction (hooks up or hooks down, for example).

• One Unitechnik file may only have one HEADER block, but it may have
several SLABDATE blocks.

• Double wall elements are an exception. They should be exported in one
file, with each shell having its own HEADER information.

Export to Unitechnik format
1. Go to the part properties of the parts that you plan to export, and edit the

user-defined attributes on the Unitechnik tab (or Unitechnik Mountpart
tab for steel parts) as required. The user-defined attributes are
environment specific,
so you may not have all the settings below available: 

Product type Product type is important for
identifying the object type in CAM
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software. Undefined product type will
result in error notification while
importing the production data file.
You can define the product type by
selecting one of the options, or by
defining a user-defined text.

User-defined product type Optional field for product type.
Product group Optional field for product group. The

product group is used in the
SLABDATE block.

Product addition This attribute is exported with
Unitechnik export (79) to object's
SLABDATE block as a representative
number 00-03. The available options
are Standard element, Balcony,
Roof, and Plastered element.

Storey Optional field used for planning the
transport and erection processes.

Transport unit number

Transport sequence number

Optional fields used for planning the
transport and erection processes.
These can be defined in the export
settings to be included as part of
SLABDATE block.

Transport pile level Optional field that specifies the
transport pile level number. If there
are elements in the stack that need to
be layered on the same level, then the
pile level is used if the transport
sequence number is the same for the
pile. This can be defined in the export
settings to be included as part of
SLABDATE block.

For example, you may have a pile of 6
slabs, and they each have sequential
pile level numbers 1, 2, 3.. 6.

Unloading type Specify the unloading type.
Concreting identification (LOT
block)

You can select No special treatment
or Shovel concrete, or leave the field
empty.

Layer split thickness Manually define the layers with
names and thicknesses.

Layer not to export Specify the layer that you do not want
to export.
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Mountpart data from UDA Select whether you want to export
mountpart data from the user-
defined attributes.

Exlude from export Select whether you want to exclude
mountparts from export.

Identification of installation Select one of the following options:

Installed (0)

Only plotted (1)

Only installed (2)

Not installed, not plotted (3)

Installed in reinforcement (4)

Installed automatically (5)
Type of mounting part Define the type of mounting part by

entering a user-defined attribute.
Reference number Define the reference number of a

mounting part by entering a user-
defined attribute.

Mountpart name Enter the mountpart name.
Info 1 text (UT 6.0) Specify more information, if

necessary.
Info 2 text (UT 6.0) Specify more information, if

necessary.

2. We recommend that you define the top-in-form face. Do this before
creating any drawings. 

For more information, see Define the casting direction of the part.

3. Update numbering. 

Export Unitechnik reads and exports data from the numbering series of
parts. It is important that all exported parts are numbered correctly.
Incorrectly numbered parts are not exported.

4. On the File menu, click Export --> Unitechnik . 

The Export Unitechnik dialog box is displayed.

5. Define the Unitechnik export properties on the various tabs.

6. Select objects using Select assemblies (recommended) or Select objects
in assemblies depending on the option that you selected for Create
from on the Main tab. You can also enter the cast unit positions to be
exported manually.

7. Click Create. 

By default, .uni output files are created in the \UT_Files folder under
the current model folder. The number of output files depends on the
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options selected from the Create from list on the Main tab, and on the
total number of selected parts, cast units, or assemblies.

The export log is displayed. See the Log files tab for additional log
options.

The maximum number of exported elements or layers is limited to 99. If
the limitation is exceeded, you will be notified by a console and log file
message.

Unitechnik export: Main tab

Option Description
Unitechnik version Select the Unitechnik version.
Create from Select which parts or cast units are exported.

• Selected cast units

Only cast units that have one or more parts
selected in the model are exported. Each cast
unit has one output file. Select By cast unit Id
or By cast unit position.

• All parts

All cast units are exported. Each cast unit has
one output file. Select By cast unit Id or By
cast unit position.

• Selected parts (separately)

Only the selected concrete parts (also embeds
and insulation parts belonging to the selected
part) are exported. Each part has one output
file.
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• Selected parts (cast united)

Selected parts belonging to one cast unit are
grouped and exported together in one output
file. Select By cast unit Id or By cast unit
position.

• Selected assemblies

This option is recommended in most cases. All
selected assemblies are exported. One
assembly equals one cast unit and has one
output file. Selection of subassemblies is also
allowed.

• Cast units in list

Select the cast units for export from the Cast
unit position list you enter.

• By cast unit Id

Each cast unit has its own output file.

• By cast unit position

Identical cast units share an output file.
Export using filter Use a selection filter to select the parts for export.

You can use the selection filter for including or
excluding the parts from the export.

Parts excluded from
export (class or name)

If you do not want to export some parts, enter the
classes or names of the parts. You can also filter
out rebars with this setting. Parts with classes in
this list will not be exported.

Directory path Define where the export files are saved. The
default folder is .\UT_Files under the current
model folder.

File name

Extension

Select the name of the output file from the lists
and file name extension.

You can use up to 5 strings to generate the export
file names. Select options from the lists, definition
values or attributes, and an optional string length
limiter. You can leave the box empty if you do not
need all 5 strings. You can use the delimiter period
( .), dash (-), or underscore (_) between the strings.
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• Proj. nr is the number of the project.

• Proj. name is the name of the project.

• CU nr is the assembly position number of the
main part of the cast unit.

• Phase is the current phase.

• CU pos is the assembly position of the main
part of the cast unit.

• ACN is the assembly control number. To
generate the assembly control numbers, go to
the Drawings & reports tab and click
Numbering --> Assign control numbers .

• Part ID is the ID number, which is 10 characters
long. If the ID number is not 10 characters long,
zeros are added in front of the ID number to
make it 10 characters long. For example, id
number 456999 will be 0000456999.

• Counter adds a running number at the end of
the file name, if the name already exists.

• Other options are Date, Time, Date-Time,
UDA, Text, Template, and Project UDA.

Date, Date-Time and Time use the format
yyyy-mm-dd-hh-mm.

Template means a template attribute. UDA
and Template are always read from the main
part.

Also define the file name extension. By default it is
Text and uni. You can select another option from
the list.

File name mask The format (length) of the output file name and file
name extension. Numbers represent the length of
the output string. If the name is longer than the
selected option, it is cut.

Open folder after
export

Select whether the folder where the output file is
saved is opened after the export.
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Output file structure Structure of the exported file (slab date and layer

part).

In most cases, you do not need to use this setting.

• Multiple layers

One SLABDATE block with N layers. Each cast
unit has its own LAYER block. Embeds,
reinforcement and insulations belong to one
concrete part, and they are exported to the
related LAYER block.

If the layers are not defined correctly, it will
result in error.

• Single layer, 1 slabdate, 1 part

Each cast unit has its own SLABDATE block, no 
LAYER blocks.

• Single layer, n slabdate, n parts

Cast units with equal geometry are collected in
one SLABDATE block. No LAYER or LOT blocks
are defined. Embeds, reinforcement and
insulation belonging to a cast unit with the
same geometry are collected and exported in
one SLABDATE block.
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• Single layer, 1 slabdate, n parts

All similar wall shells are defined within one 
SLABDATE block instead of being defined in a
separate SLABDATE block per wall shell. The
option is useful when exporting special
embeds.

• Combined, n slabdate, 1 part

Combined export that can contain more than
one cast unit. The exported cast units are
placed side by side according to the sequential
logic defined on the Pallet tab.

• Single layer, 1 slabdate, n steelmats

Only exports the main part of the cast unit as
slabdate and meshes and embeds from whole
cast unit in one row in export X axis direction
with a 1 mm gap between them.

1st exported layer Select which part is exported in the first LAYER.
This option allows to define which wall shell is
positioned on the pallet first.

The options are:

• Main part (of cast unit)

• Biggest part

• Heaviest part
Consider layer split
thicknesses

Select how the layers of the cast unit are exported.
These options are available when you have set
Output file structure to Multiple layers.

• No

The cast unit is exported as one volume.

• Yes

The manual layers set on the Unitechnik tab in
the user-defined attributes of a part are used,
and the cast unit is exported in two or three
layers.
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Blank symbol in
exported file

Select the blank symbol to be used in the export
file.

An example with "_" symbol:

An example with " " symbol:

Unitechnik export: TS configuration tab

Option Description
Rotation Select the scanning direction, which defines which

main part face is towards the pallet base.
Unitechnik export uses scanning layers to obtain
the geometry of all parts in a cast unit.

The scanning direction depends on the plane of
the cast unit main part. A floor panel is scanned
from bottom to top side. A wall panel and a
column are scanned from one side to the other
side. The position and direction of a basic shape of
the exported cast unit depends on the rotation.

Note that you can use the surface object user-
defined attribute Use surface as pallet base to
orient the object without changing the top-in-form
face or the rotation in export settings.
No

Floor: Bottom to top

Wall: Front to rear side (according to the modeling
direction)

Column: Side to side
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180

Floor: Top to bottom

Wall: Rear to front side

Column: From one side to the opposite side

 +90 around X

Floor: Left to right side

Wall: Top to bottom

Column: Side to side

 -90 around X

Floor: Right to left side

Wall: Bottom to top

Column: From one side to the opposite side

Import to and export from Tekla Structures 384 Automated precast fabrication



Option Description

-90 around Y

Floor: Rear to front side

Wall: Right to left side

Column: Top to bottom

 With the Top in form face option, the scanning
direction depends on the defined top-in-form face,
so that the opposite face will be towards the pallet.

Import to and export from Tekla Structures 385 Automated precast fabrication



Option Description
 Examples of rotation:

• Wrong scanning plane (from the right side to
the left side):
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• Correct scanning plane (from back to front

side):

Extra rotation Select the rotation around the z axis, and thereby
the rotation of the pallet. The z axis has the same
direction, but the x and y directions are changed.

To show the actual coordinate system, set Draw
pallet axis to Yes on the Pallet tab.

• No

No extra rotation.

• Swap X/Y

Swap x and y axis.

• X=max(X_dim,Y_dim) main part

X axis goes through the longer side of the main
part.

• X=min(X_dim,Y_dim) main part

X axis goes through the shorter side of the
main part.
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• X=max(X_dim,Y_dim) cast unit

X axis goes through the longer side of the cast
unit.

• X=min(X_dim,Y_dim) cast unit

X axis goes through the shorter side of the cast
unit.

• +90 around Z

Rotates x and y axis around the z axis by 90
degrees.

• - 90 around Z

Rotates x and y axis around the z axis by -90
degrees.

• 180 around Z

Rotates x and y axis around the z axis by 180
degrees.

The following example shows the coordinate
system with no rotation and no extra rotation
settings. Panel 1 has the z axis set parallel to the
shorter side. It is incorrect in the Unitechnik
format, so the coordinate system has to be
rotated. Panel 2 shows a rotation by 90 degrees
around the z axis.

Auto-rotate on pallet Select whether to auto-rotate the coordinate
system for export +90° or -90° when the element
width exceeds the pallet width, or when the
element width exceeds the element length.

Rotate geometry This option applies the rotation angle calculated
with the settings Extra rotation and Auto-rotate
on pallet.
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With SLABDATE
rotation angle

Rotates the element and exports the rotation angle
as a value in the respective SLABDATE field.

Export CONTOUR Select how to export the element contour. The
options are Scanned, Bounding box, and
Simplified.

The Scanned option inquires the modeled 3D
geometry using 2D scanning planes, see the Scan
position setting description below.

The Bounding box option defines the contour as 4
perpendicular lines between the minimum and
maximum values of (x, y) coordinates.

The Simplified option exports a simplified contour
using 4 x, y corner points of the element. Similarly
as the bounding box, but accounts for diagonal
lines at the edges.

Scan position The element contour, cutouts and line attributes
are defined by scanning the cast unit in the scan
direction defined by rotation settings above. A
scanning plane works like a section with no view
depth. The export application uses 1 or 2 scanning
planes for each part included in the exported cast
unit (regardless of the output file structure setting).

The offset is towards the middle of panel from the
scanning plane, but can be negative or positive
value.

The number of the scanning layers depends on the
selected scan position. Each object of the cast unit
is scanned in one direction.

Select the position in which all parts are scanned.
Each part is scanned separately. Scanning plane is
parallel to the basic shape plane.

• Bottom and top

Two scanning planes at the top and bottom of
the scanned part.

Import to and export from Tekla Structures 389 Automated precast fabrication



Option Description
• Bottom only

One scanning plane at the bottom face.

• Top only

One scanning plane at the top face.

• Middle only

One scanning plane at the middle point of the
scanned part.
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• Top, bottom and middle

Three scanning planes: one at the top face, one
at the bottom face and one at the middle point
of the scanned part.

To move the position of the exact scanning plane,
use the Scan position offset boxes below to
define start offset and end offset.

Merge CONTOUR
layers

You can export one scanned layer only. With two
scanned layers, they have to be merged into one
layer.

• Intersection

Creates polygon intersection of two contour
geometries.

1. First scanned layer

2. Second scanned layer

3. Layer

• Union

Creates polygon union of two contour
geometries.
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Export CUTOUTs To prevent cutout export, select No.

Exclude selected excludes from the export the
modeled cut parts that you define by class or
name.

Selected only includes in the export the cut parts
that you define by class or name.

Merge CUTOUT layers The same as Contour export, but for holes only.
Merge CUTOUTs Select how to merge overlapping cutouts. You can

select to export a big cutout which is created by
smaller cuts as separate cutouts. The options are:

1. Merged as one cutout

2. Unmerged, overlapping cutouts

3. Unmerged cutouts with no overlapping

Extend contour and
add formwork

Select whether to extend the contour according to
protruding reinforcement or embeds. This setting
extends the contour and adds additional formwork
mountparts to the extended area.

Formwork is not added if there already is an
embed with the same geometry.

The contour is not extended for electric tube
embeds.

Name for additional
formwork (embed)

Define a name for the embed.

Geometry export Select whether the geometry of the exported part
(concrete contour, cutout, mountpart) is
represented as polygons or lines.

Polygons exported:
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 Lines exported:

Export rounded holes
as circle (K)

Select whether you want to export rounded holes
as circles (K) or polygons/lines.

Double wall turned Select whether the first shell of a double wall on
the pallet is turned. This requirement depends on
the receiving master computer system. The
options are:

No, one coordinate system: Exported as in
model, shell1 is in front, shell2 in background.

Yes, turn shell1: The shell 1 is offset by the pallet
width in y direction (defined on the Validation tab)
and flipped around x axis

Yes, turn shell1 - fixed edge up: This is meant for
special machines.

No, shell-specific coordinate systems: Use to
export the second shell in the Z direction from the
bottom of the pallet upwards.
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Unitechnik export: Embeds tab

Option Description
Normal embeds Select which parts are considered as embeds.

Embedded parts are exported in the MOUNPART
block.

If the embed block consists of several parts, it is
useful to combine all embed parts into one sub-
assembly block and then add as sub-assembly to a
cast unit or concrete shell sub-assembly. Single
part embeds can be simply added to cast unit.

• Selected + steel

All classes listed in the Embeds classes box are
considered as embeds. All steel parts are also
considered as embeds, unless excluded from
export.

• Selected

Classes listed in the Embeds classes box are
only considered as embeds.

• No export

Ignores the Embeds classes box and exports
all steel parts as standard parts.

• Selected (also reinforcement) + steel

All parts and reinforcing bars listed in the
Embed classes or names box are considered
as embeds and plotted as lines. Also bounding
box can be used. All steel parts are also
considered as embeds.

Embed classes or
names

Enter the classes or names of the embeds.

Export assemblies Select how the 2D geometry of embeds and steel
blocks are exported.

Embeds are exported as parts. All embedded
welds and assembly relations are ignored.
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Welded embeds and the assembly block are
exported as one part with the bounding box
geometry of the complete sub-assembly.

Only the main part of the embedded block or
embedded assembly is exported.

The main part of the embedded block extended in
the x direction to cover all the parts of the
embedded block is exported.

Only the bounding box around the main part of
the embedded block or embedded assembly is
exported.

Export the corner symbols of the main part
bounding box.
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Export the corner symbols of the embed sub-
assembly bounding box.

Corner symbol width /
height

Enter the width and height of the corner symbol.

Def export code Define how the insertion point and the direction
for embeds is calculated. Possible values are 0, 1,
2, 3, 11, 12, 21, 22, 23, 31 and 32, 41, 42, 43.

In most cases, the insertion middle point refers to
the center of gravity of the embed sub-assembly or
main part depending on the Export assemblies
setting.

0 = Ignores the symbol and uses the sub-assembly
bounding box setting according to the insertion
COG setting (1 - 5), for example, PLATE 0 0 4.

1 = The insertion point is the middle point of
embed and the direction is parallel to the longest
side of the exported mountpart geometry. 1 is the
default.

2 = The insertion point is the middle point of
embed and the direction is parallel to the shortest
side of the exported mountpart geometry.

3 = The insertion point is the middle point of
embed, and if the mainpart is symmetrical,
calculate the direction of the mountpart along the
line from mainpart COG to sub-assembly COG.

11 = The insertion point is the point of embed in
the middle of shorted side and the direction is
along the longest side.

12 = The insertion point is the point of embed in
the middle of longest side and the direction is
along the shortest side.

21 = The insertion point is in the contour's top
edge point closest to the embed and the direction
is parallel to the longest side of the exported
mountpart geometry.

22 = The insertion point is in the contour's top
edge point closest to the embed and the direction
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is parallel to the shortest side of the exported
mountpart geometry.

23 = The insertion point is in the contour's top
edge point closest to the embed and if the
mainpart is symmetrical, calculate the direction of
the mountpart along the line from mainpart COG
to sub-assembly COG.

31 = The insertion point is the point of the closest
vertex on concrete part, between embeds and
concrete part side and the direction is along the
longest side.

32 = The insertion point is the point of the closest
vertex on concrete part, between embeds and
concrete part side and the direction is along the
shortest side.

41 = Insertion point embed assembly COG and
orients towards the start to end point axis.

42 = Insertion point embed part start point and
orients towards the end point.

43 = Insertion point embed assembly COG and
orients towards the axis of the longest edge.

Cut outer assemblies Select how the embedded parts that are outside
the concrete element are exported.

All parts in the embed are exported.

Only the embedded parts that are inside of the
concrete element are exported. Embedded parts
that are outside the concrete element are ignored.
If an embedded part is partly inside a concrete
element, the exported geometry of the embedded
part is changed to cut.

Same as the previous option, but only embedded
parts with class defined in Cut outer only classes
are taken into account.
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Cut outer only classes Enter the classes of parts whose geometry is

changed to cut when you have selected the last
option in the Cut outer assemblies list.

Special assemblies
export

Special export
assembly file name

The options are No, Yes,
(spec_assemblies_def.txt), and Yes, no rotation
on pallet.

The options affect the exported geometry of the
embeds. The real geometry is replaced by the
geometry defined in text files. The default name of
the text file is spec_assemblies_def.txt and is
searched for in the model folder. Use Special
export assembly file name to define the name
and the location of the text file.

Special assembly symbol definition file supports
embed template properties and its values or
embed names that have blank spaces. Embed
template property values or embed names have to
be enclosed in quotation marks.

By default, the symbol definitions are mapped
according to the exported embed designations.
Designation can be any part property, which is
controlled on the MOUNPART block data tab with
the Mountpart name setting.

The required structure of the text file is:

• Designation(text)
Number_of_lines_defined(number)

• S(representing single line)
Start_coors-X,Y (number number)
End_coors-X,Y(number number)

• S(representing single line)
Start_coors-X,Y(number number)
End_coors-X,Y(number number)

Example of the file:
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Embeds in special assembly symbol definition file
can also be designated by template property and
its value in format [TEMPLATE:VALUE] instead of
the exported embed designation.

Example of using template property:

The geometry of all embeds (from example with
designations Quicky, QuickyS, E-Doze) are replaced
by geometry defined in the text file. In the
following example, the part number 1 (the name is
Beam) was not found in the text file so the
geometry is exported according to default settings
from export dialog. On the opposite side the part
number 2 (the name is Quicky) was found, so the
geometry is replaced.
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You can also define the def export code, insertion
point logic and embed z-positioning on the first
definition row:

Designation(text)
Number_of_lines_defined(number)
Def_export_code(number, see above)
Insertion_position(number 1-5) z-
position (PALLET / BOTTOM / MIDDLE)
To specify the insertion point position of embeds
in using the spec_assemblies_def.txt file:

1 = Subassembly center of gravity

2 = Subassembly bounding box center of gravity

3 = Main part center of gravity

4 = Extended main part center of gravity

5 = Main part bounding box center of gravity

If you select Yes, no rotation on pallet, the
embed symbols are placed according to the panel
rotation, but the symbols themselves are not
rotated.

Embed Z position Select the embed z position. The options are
Minimum to pallet, Start point and Z=0. When
you select Z=0, all exported mountparts will be
plotted on the level of the pallet.

You can use the spec_assemblies_def.txt file
to set the position of the embeds, see above.

If unassigned, the setting chosen in the dialog box
is used by default.

For example:

Import to and export from Tekla Structures 401 Automated precast fabrication



Option Description

On the first line of the example above you have
additional options for positioning the embed
symbol:

Quicky is the name of the embed.

4 is the number of lines following.

1 is the embed installation type: 1 2 3 11 12 21 22
23 31 32 (see above).

1 defines the geometry for which the center-of-
gravity is calculated, choices being 1 - 5, see above.
1 means that the symbol location is defined by the
entire mountpart sub-assembly bounding box
center of gravity.

The special assembly symbol plotting for Z=0 is 
pallet, for Minimum to pallet bottom and for
Start point middle.

Insulation Define the insulation classes or names. The
corresponding parts will be exported as insulation
parts. All parts considered insulation are exported
in the MOUNPART block. Default mountpart type for
insulation is 03 unless overwritten.

Electric tubes Define the electric tubes classes or names. The
corresponding parts will be exported as MOUNPART
with lines geometry. Default mountpart type for
electric installation is 07 unless overwritten.

Opening embed Define the opening embed classes or names. The
corresponding parts will be exported as normal
embeds in the MOUNPART block. The geometry will
not be considered in the CONTOUR and CUTOUT
blocks of the concrete part.

Opening cutout Define the opening cutout classes or names. The
corresponding parts will be exported only in
regard to their geometry in the CUTOUT block of
the concrete part. They will not be exported in the 
MOUNPART block.

Cutpart former Export cuts that have been specified with a class or
name in the MOUNPART block. Default mountpart
type for cutout box is 21 unless overwritten.
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Opening with corner
symbols

Specify classes or names of embeds for openings
that will be exported with corner symbols instead
of mountpart symbols.

All cutouts as corner
symbols

Export rectangular cutouts as 4 corner symbol
mount parts by defining the classes or names. You
can define the size of the symbol in the dialog box.

Export insulation Select whether insulation parts are exported in the 
MOUNPART block as embeds or in the SLABDATE
block as concrete panels.

Export surface Select whether surface treatment is exported in
the MOUNPART block as embeds or in the SLABDATE
block as concrete panels. You can also use the
option No, which does not export surface
treatment.

Install identification Select the installation identification for the 
MOUNPART block.

The options are Installed (0), Only plotted (1),
Only installed (2), Not installed, not plotted (3),
Installed in reinforcement (4), Installed
automatically (5)

Unitechnik export: Reinforcement tab

You can export single reinforcing bars, groups of straight and bent reinforcing
bars, and rectangular or polygonal or bent meshes. The reinforcing bar group,
or rectangular or polygonal mesh is divided into several single reinforcing
bars. All reinforcing bars are exported in the RODSTOCK block.

Option Description
Rebars export -
Straight

Note that the hooked bars are controlled by the
Straight setting, not by the Bent setting.

All including hooked - Straight reinforcing bars
are exported. Hooks are supported.

All without hooks - Exports straight rebars
without hooks only.

Collected - Uncollected reinforcement is excluded
from the export.

Rebars export - Bent All - Bent reinforcing bars are exported.

Collected - Uncollected reinforcement is excluded
from the export.
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Meshes export When set to Yes, polygonal or rectangular meshes

are exported. Hooks are supported. You can define
the setting separately for straight or bent meshes.

You can also select whether to unfold along
longest line or parallel to pallet.

Bent reinf. as unfolded When set to Yes, bent reinforcement is exported
as unfolded.

Hooks are also supported for unfolded
reinforcement, and you can select Yes, with end
hooks. Hooks form 0, 2 and 5 are detected.

Bent meshes with end hooks exports end hook
shapes L, S and U (flection form 1, 4 and 5) as
terminal hooks according to the Unitechnik
specification. Other shapes are exported as free
flection forms like before.

Using the option Only meshes, you can export
bent meshes as unfolded, while other bent
reinforcement is exported as bent.

You can select between two reinforcement starting
points: Origin in unfolded rebar or Origin in
start rebar point. Origin in unfolded rebar uses
the first point of the main leg of rebar or mesh
wire depending on the rebar orientation in export.
The option also affects the z level of the
reinforcement in the resulting Unitechnik file. The
start points are unaffected by unfolding options.

Export meshes as Set the rotation of the mesh plane in the export
file. The options are:

Standard

Embeds: Exported as mountparts.

Turned to pallet: All meshes will be individually
rotated in line with the pallet axes.

Braced girder classes
or names

Enter the class or name of reinforcing bars, steel
rods or profiles representing braced girders. For
example, 15 17 5 means that parts with class 15,
17, or 5 are considered braced girders. If the
Braced girder export and Braced girder classes
or names boxes are not used, the braced girders
will be exported incorrectly as reinforcement or
embeds.

You can export braced girders within the
STEELMAT block using the option Within the
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STEELMAT block. You can also export braced
girders Z coordinate as 0 using the option Without
concrete cover. By default, the braced girders are
exported outside of the STEELMAT block.

Braced girders are represented as a single line,
placed according to your selection:

• As braced girder top chord (default): The
geometry of the main chord (top chord) with all
information is included in the export.

• As braced girder bottom chords: The braced
girder is exported as one object but with the
quantity number 2 with the spacing included.

• As braced girder all chords: One object like
above but with the quantity number 3.

• As top chord with end symbols: 2 Mountpart
symbols are placed at the top chord end points
towards the braced girder direction, line 20 mm
long. In addition, the above-mentioned
BRGIRDER information.

• As bottom chords with end symbols: 4
Mountpart symbols are placed at the bottom
chord end points towards the braced girder
direction, line 20 mm long. In addition, the
above-mentioned BRGIRDER information.

• Only top chord end symbols: 2 Mountpart
symbols are placed at the top chord end points
towards the braced girder direction, line 20 mm
long. No BRGIRDER.

• Only bottom chord end symbols: 4 Mountpart
symbols are placed at the bottom chord end
points towards the braced girder direction, line
20 mm long. No BRGIRDER.

Reinforcement export
type

Define the structure of the exported file for
reinforcement.
Plant with lying robot only

All reinforcement including mesh objects will be
exported as individual rodstocks within slabdate.
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Fabrication of welded rebars

If Export type is set to Fabrication of welded
rebars, bar groups are exported as individual
rodstocks, mesh objects are exported as rodstocks
within STEELMAT blocks.

The structure of the output file (one SLABDATE is
shown only):

 Collect reinforcement

The structure of the output file is the same as for
Fabrication of welded rebars. This option allows
you to collect mesh, single reinforcing bars and
reinforcing bar groups into groups exported in one 
STEELMAT block. The groups are collected based
on the Collect based on field. You can also collect
meshes which belong to different cast units.
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1 (orange color): The mesh belongs to the bottom
panel of the cast unit, mesh name is MESH1.

2 (blue color): Two single bars, the name is MESH1.

3 (green color): One reinforcing bar group belongs
to the top panel, the name is MESH1.

If Reinforcement export type is set to Collect
reinforcement and Collect based on is set to
Name, all three different reinforcement types are
collected into one mesh, which is exported in one 
STEELMAT block.

Other non-designated rebar groups are exported
as individual rodstocks. If the collected mesh has
only one rebar, it is exported as an individual
rodstock without a STEELMAT.

Collect based on Select how meshes are collected. Meshes with one
bar are exported as a single reinforcing bar.

• Name

Meshes, single reinforcing bars and reinforcing
bar groups with the same name are collected
into meshes. Meshes, single reinforcing bars
and reinforcing bar groups with the same name
equals one mesh in the exported file.
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• Class

Meshes, single reinforcing bars and reinforcing
bar groups with the same class number are
collected into meshes. Meshes, single
reinforcing bars and reinforcing bar groups
with one class number equal one mesh in the
exported file.

• Grade

Meshes, single reinforcing bars and reinforcing
bar groups with the same grade are collected
into meshes.

• UDA

Meshes, single reinforcing bars and reinforcing
bar groups with the same user-defined
attribute are collected into meshes.

The value you enter in the box next to this
option is the UDA value.

Collect if distance is
lower then

Define the maximum distance between the mesh
rebars to be collected together into one STEELMAT.

Rebar grouping Group similar rebars with equal spacing. Similar
rebars are exported using one RODSTOCK row
with correct quantity and spacing. The options are
Yes and No (default).

The rebar grouping is primarily intended to be
used in the production of simple mesh and
reinforcement.

Import to and export from Tekla Structures 408 Automated precast fabrication



Option Description
Reinforcing bars length Select how the reinforcing bar length is calculated.

• Lines in the middle
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• Lines at the edge (total length only)

• Lines at the edge (all leg lengths) calculates
the lengths of the reinforcing bar legs at the
edge of the bars.
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• GetValue(Length) (total length only)

Reinforcing bars
diameter

Select how the reinforcing bar diameter is
exported. The options are:

• Actual or nominal
(XS_USE_ONLY_NOMINAL_REBAR_DIAMETER)

For more information, see XS_USE_ONLY_
NOMINAL_REBAR_DIAMETER.

• Size

• Actual

• Nominal

This selection affects the results of the Rebar
length option.

Rebar direction angle
limit

Select whether the reinforcing bars starting
direction in XY plane is limited, as required in some
production interfaces.

• No

The reinforcing bars exported as they're
modeled in Tekla Structures.
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• From 0 to 180

The reinforcing bars are exported so that they
have a start angle limit to be under 180
degrees, and therefore always oriented to start
in positive pallet y direction.

In this case the rebar start point will be always
be the rebar end with smallest Y-coordinate

• From 0 to 180 ordered

Same as above but the reinforcing bars are
sorted according to the direction angle of the
reinforcing bar: the reinforcing bars with lower
angles are first.

• From 180 to 0 ordered

The reinforcing bars are sorted according to the
direction angle of the reinforcing bar: the
reinforcing bars with higher angles are first.

First bending angle Allows setting the first bending angle of free-
flection rodstock to be positive or negative (as
required by certain interfaces). The options are:

• Always positive

• Allow positive or negative

Reinforcement types Select the reinforcing bar type in a mesh to be
exported.

1 and 2 are for the rods in the bottom face
longitudinal and cross bars.

5 and 6 are for the rods in the top face longitudinal
and cross bars.

4 is for other rebars placed in the element
reinforcement.

8 is for loose bars welded into prefabricated
meshes.

Classes for loose
rebars type 8

Enter the classes of loose reinforcing bars to be
collected. The bars are a part of a mesh and are
exported as reinforcing bar type 8.

Classes for non-
automated rebars

Enter the classes of reinforcing bars to be tagged
for non-automated production.

Spacer type You can add spacer type information to the first
layer of the reinforcement (Unitechnik
reinforcement type 1). The spacer type is added to
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Option Description
the respective spacer type block in the rodstock
within the Unitechnik file. The options are:

Automatic, rebar type 1: Calculates the spacer
type automatically according to the cover
thickness. When the reinforcement type is 1 and
element is thinner that 100 mm, the spacer type is
exported.

Automatic, all rebars: Spacer type is always
calculated for each rebar.

User defined spacer type: Enter the spacer type
to be input in all first layer rebars.

No: Leaves 0 as spacer type.
Spacer start position Enter the first spacer start position from the start

point of the rebar, for example, 500 (mm).
Spacer pitch Enter the spacer pitch information from start point

onwards, for example, 1000 (mm).
Add mesh stabilizing
wires

Select whether to extend reinforcement mesh
wires through openings to stabilize the mesh. Use
for meshes with large openings.

Stabilization wire max
spacing

Enter a value to define the maximum spacing of
the wires that stabilize the reinforcement mesh. As
a result, the minimum amount of extra wires will
be extended within this spacing value from the
closest full wire near opening.

Meshes sort Select whether meshes are sorted.
Meshes offset Select whether the mesh has an offset defined in

the STEELMAT block. If the option is set to Yes, the
value for X and Y direction is set to zero. If the
option is set to No, the X and Y values are exported
according to modeled situation.

Unitechnik export: Validation tab

Option Description
Draw scanned
geometry

The exported geometry can be shown with Draw
scanned geometry.

Select whether you want to check if the geometry
of the exported parts is correct. It shows the lines
representing the exported rectangle of the basic
shape, the exported geometry of parts, cuts,
embeds, and reinforcement. Embeds are projected
to the plane of the basic shape. The reinforcement
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lines are positioned inside each reinforcing bar in
bent or in unfolded state depending on the option
selected for the settin Bent reinf. as unfolded on
the Reinforcement tab.

1. Projected area on the pallet

2. Geometry of the main element and the
position of the scanning planes

3. Cut geometry

4. Embed geometry and the reference insertion
point with the rotation direction

Note that this setting might have significant effect
on export processing speed.

Draw pallet axis Select whether to show the coordinate system. The
axes are displayed with dotted lines.

Wall to pallet checking Select whether the export checks the wall size
against the pallet size. If you select the Yes, if
exceeded, do not export option, the Pallet width
Pallet length, and Max. cast unit thickness
options cannot be empty.

Pallet width Define the pallet width.

On the basis of the pallet width and length, the
Wall to pallet checking option is able to check if a
wall element is too big to fit to a pallet. If the wall
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element does not fit to a pallet, the wall element is
turned.

Pallet length Define the pallet length.
Max cast unit
thickness

Define the maximum cast unit thickness.

To avoid collision with the drying chamber, the
maximum thickness of a cast unit should be
smaller than the maximum opening of the drying
chamber.

Rebar diameter
limitation

Minimum and maximum diameter for the
reinforcing bars to be exported.

Rebar length limitation Minimum and maximum length for the reinforcing
bars to be exported.

Rebar leg length
limitation

Minimum and maximum length for individual leg
section within a bent rebar to be exported.

Mesh wire length
limitation
(Longitudinal)

Minimum and maximum diameter for longitudinal
reinforcing bars to be exported.

Mesh wire length
limitation (Cross)

Minimum and maximum length for cross
reinforcing bars inside a mesh to be exported.

Mesh wire leg length
limitation

Minimum and maximum length for individual leg
section within a bent mesh wire to be exported.

Mesh wire overhang
limitation

Minimum and maximum length for mesh wire
overhang section before the first cross-wire
welding point and after the last cross-wire welding
point to be exported.

Mesh wire spacing
limitation

Allowed spacing values for mesh wires separated
by blank space to be exported. If no value added,
there is no limitation for spacing.

Export others These operations are intended for objects that fail
the validation:

• Remove invalid mesh wires: Only exclude
invalid mesh wires and not the whole mesh
when some of the mesh wires fail the
validation.

• Yes, as loose (type 4 or 8): Export invalid
rebars as loose rebars of type 4 or 8.

• Yes, ignore limitation: The diameter and
length limitations are ignored.

• Yes, as non-automated: Export non-valid
rebars as non-automated.

• Prevent export
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• Exclude all: Exclude the whole mesh from the

export if any of the wires fail the validation.

When a rebar fails the validation, you are notified
by a log message.

Unitechnik export: Reinf. data specification tab

In the column on the right, enter the custom or UDA string when applicable.
On this tab, you can add data attributes only, no geometric attributes. The
information you add controls the reinforcement unit data (single
reinforcement, mesh, braced girder, or cage). The attributes are either
optional or obligatory. The length of some of the fields may be limited in the
UT format, so keep the strings short.

Depending on the setting, the following attributes can be added: Name,
Grade, Class, Rebar ID, Mesh ID, Mesh position,UDA, UDA (main part), UDA
(rebar), Part UDA, Main part UDA, Phase, User-defined text, User-defined
text + class, Template, and Text[Template]#Counter.

Text[Template]#Counter:

• Text can be any text including punctuation marks.

• Write templates in brackets [].

• # adds a running number if the data content is the same in several entries.

• You can enter several templates and use text delimiters, for example,
[ASSEMBLY_POS]-[REBAR_POS].

• If you start the Text[Template]#Counter with a template, add a space as
the first character before the bracket.

• Template attributes are read from the single reinforcement, mesh, braced
girder, or cage.

• You can also use attributes that refer to another hierarchy level, for
example, the assembly UDA of the rebar.

• You can use <VALUE> to inquire a part UDA and {VALUE} to inquire an
assembly UDA. This makes it possible to use a shorter string instead of
having to use a template property to designate UDAs.

Option Description
Rebars: Article number
rebar

Select which property you want to export as a
reinforcing bar article number for rebars.

Rebars: Article number
mesh

Select which property you want to export as a
mesh article number for rebars.

Meshes: Article
number rebar

Select which property you want to export as a
reinforcing bar article number for meshes.
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Meshes: Article
number mesh

Select which property you want to export as a
mesh article number for meshes.

Meshes: Meshes
designation

Select the information that you want to export
about the meshes.

Meshes: Info 1 text (UT
6.0)

Information field is filled with the selected data.

Meshes: Info 2 text (UT
6.0)

Information field is filled with the selected data.

Welded leg designation Designate the welded leg in bent mesh bars if
there is only one leg that is welded to cross-wires..
When you select Yes, information about welded
leg designation is exported.

Strands (UT 6.0): Pull
force (KN)

You can now use main part UDA (UDA (main part))
or rebar UDA (UDA (rebar)) to include strand pull
force information in the Unitechnik export.

Selecting Empty does not export the strand pull
force information.

This setting only works for rebars that are set to
type 9 in the Unitechnik reinforcement type box
on the Unitechnik tab in the user-defined
properties of the rebars.

BRGIRDER block:
Braced girder type

Select the string value of girder type field in the 
BRGIRDER block in the exported file.

• Empty

No string is exported.

• Name

The name of the braced girder type is exported.
If the name of the top part of a braced girder is
empty, the names of the rods are checked.

• UDA

You can export the user-defined attribute
values for a braced girder type (type), braced
girder article number (art_number), or braced
girder fabricator name (fabricator).

The UDAs can be added to the braced girder if
the parts have been created using the system
component Braced girder (88) or Braced
girder (89) and you have entered the needed
values on the dialog boxes of the components.
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• User defined text

The value you enter in the box next to this
option is exported.

CAGE BLOCK: Cage
designation

Select the information that you want to export
about the the cage in the CAGE block (UT 6.1).

CAGE BLOCK: Base cage
shape

Select the information that you want to show as
base cage shape.

CAGE BLOCK: Info 1
text

Information field is filled with the selected data.

CAGE BLOCK: Info 2
text

Information field is filled with the selected data.

Unitechnik export: HEADER block data specification tab

In the column on the right, enter the custom or UDA string, when applicable.
On this tab, you can add data attributes only, no geometric attributes. The
attributes are either optional or obligatory. The length of some of the fields
may be limited in the UT format, so keep the strings short.

Depending on the setting, the following attributes can be added: Project
number, Project name, Cast unit position, Cast unit position
code,Assembly control number (ACN), Cast unit ID, Cast unit prefix (2
digits), Cast unit drawing revision mark, Project properties - name,
Project properties - address, File name with extension, File name without
extension, Tekla Structures version, Main part ID, Project UDA, Main part
UDA, Main part UDA (UT_product_code), Phase, User-defined text, User
name, Main part template, Template and Text[Template]#Counter.

Text[Template]#Counter:

• Text can be any text including punctuation marks.

• Write templates in brackets [].

• # adds a running number if the data content is the same in several entries.

• You can enter several templates and use text delimiters.

• If you start the Text[Template]#Counter with a template, add a space as
the first character before the bracket.

• Template attributes are read from the main part.

• You can also use attributes that refer to another hierarchy level.

• You can use <VALUE> to inquire a part UDA and {VALUE} to inquire an
assembly UDA. This makes it possible to use a shorter string instead of
having to use a template property to designate UDAs.
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Name of order Order fields in the HEADER block are filled with the

selected data.

File name sections: Specify a string consisting of
numbers referring to the 6 sections of the
exported file name mask that are specified on the
Main tab. You can type numbers 1 to 6, and
delimiters , . _ and - in the free input field to export
any combination of strings used in the file name, in
any order. For example, 1-2-3, or 2_5_6.

Name of component Component fields in the HEADER block are filled
with the selected data.

Drawing number Drawing number fields in the HEADER block are
filled with the selected data.

File name sections: Specify a string consisting of
numbers referring to the 6 sections of the
exported file name mask that are specified on the
Main tab. You can type numbers 1 to 6, and
delimiters , . _ and - in the free input field to export
any combination of strings used in the file name, in
any order. For example, 1-2-3, or 2_5_6.

Drawing revision Drawing revision fields in the HEADER block are
filled with the selected data and drawing revision
mark is exported.

Product code Product code fields in the HEADER block are filled
with the selected data.

Project line3 text -
Project line4 text

Project information fields (3rd line) in the HEADER
block are filled with the selected data.

File creator (UT 6.0) You can select to export the Tekla Structures
version information, use name or user-defined text
in the HEADER block.

Free field (UT 5.2) Only for Unitechnik 5.2. You can select to export
the following information to theHEADER block: user
name, user-defined text, file name with extension,
file name without extension, or model name.

Building site - name Name of the building site.
Building site - street Street address of the building site.
Building site - post
code

Postal code of the building site.

Building site - place City or town where the building site is located.
Building owner - name Name of the building owner.
Building owner - street Street address of the building owner.
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Building owner - post
code

Postal code of the building owner.

Building owner - place City or town where the building owner street
address is located.

Data field template
units: No. of units after
the decimal point

Specify the number of decimals after the decimal
separator in data field template units.

Unitechnik export: SLABDATE block data specification

In the column on the right, enter the custom or UDA string, when applicable.
On this tab, you can add data attributes only, no geometric attributes. The
attributes are either optional or obligatory. The length of some of the fields
may be limited in the UT format, so keep the strings short.

Depending on the setting, the following attributes can be added: Counter,
Cast unit number, Cast unit position, Part position, Part number, Part
name, Cast unit position code, Cast unit nameCast unit GUID, Assembly
control number (ACN), Cast unit ID, Cast unit prefix, Cast unit thickness,
Concrete part thickness, Cast unit width, Concrete part width, Main part
thickness,Main part ID, Main part GUID, Main part UDA, Material, Name,
UDA, User-defined text, Phase, Total quantity of part, Main part template,
Part weight, Unit weight, Cast unit weight, Yes, with swapped X axis and
Y axis, Template and Text[Template]#Counter.

Text[Template]#Counter:

• Text can be any text including punctuation marks.

• Write templates in brackets [].

• # adds a running number if the data content is the same in several entries.

• You can enter several templates and use text delimiters.

• If you start the Text[Template]#Counter with a template, add a space as
the first character before the bracket.

• Template attributes are read from the main part.

• You can also use attributes that refer to another hierarchy level.

• You can use <VALUE> to inquire a part UDA and {VALUE} to inquire an
assembly UDA. This makes it possible to use a shorter string instead of
having to use a template property to designate UDAs.

Option Description
Slab number Slab number field in the SLABDATE blocks is filled

with the selected data.

File name sections: Specify a string consisting of
numbers referring to the 6 sections of the
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exported file name mask that are specified on the
Main tab. You can type numbers 1 to 6, and
delimiters , . _ and - in the free input field to export
any combination of strings used in the file name, in
any order. For example, 1-2-3, or 2_5_6.

Unloading type Specify the unloading type. The options are:

• Lying

• Tilting table

• Main part UDA

You can override this setting on the Unitechnik
tab for precast concrete parts, which overrides the
export dialog box setting.

Transport type Export the means of transportation information.

You can override this setting on the Unitechnik
tab for precast concrete parts, which overrides the
export dialog box setting.

Transport unit
number, Transport
sequence number

Define a value for the transport unit and sequence
numbers in the SLABDATE blocks.

This can be defined in the part UDAs.
Transport pile level
number

Specify the transport pile level number in the 
SLABDATE blocks. If there are elements in the stack
that need to be layered on the same level, then the
pile level is used.

For example, you may have a pile of 6 slabs, and
they each have sequential pile level numbers 1, 2,
3.. 6.

This can be defined in the part UDAs.
Exposure class Export exposition class. You can select to read

from part UDAs or use another option.
Total thickness Select which value will be exported as total

thickness. The options are Cast unit thickness,
Concrete part thickness, Main part thickness,
Template, and Double wall width.

Double wall width is the same as the Cast unit
thickness but it is always inquired from the main
cast unit, regardless of how it is modeled. Then the
2nd shell will also receive total cast unit width.
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Production thickness Calculates the production thickness in SLABDATE

block based on cast unit width, concrete part width
or double wall width.

Double wall width is the same as the Cast unit
width but it is always inquired from the main cast
unit, regardless of how it is modeled. Then the 2nd
shell will also receive total cast unit width.

When you export double walls: With the option
Cast unit width the cast unit thickness is exported
for both shells.

Production weight Set the type of the SLABDATE weight. The options
are Part weight, Unit weight, Cast unit weight,
and Template.

Concrete volume Set the type of the volume. You can select concrete
part or specify a user-defined concrete volume
template property.

Quality of layer Set the quality of the slabdate. The options are
material and UDA.

Item designation Designate data about the exported element.
Info 1 text (60) - Info 4
text (60)

Information fields (1-4) in the SLABDATE and 
MOUNPART blocks are filled with the selected data.

Export project
coordinates

Select whether you want to swap X and Y axis of
the exported project coordinates. Use the Yes,
special variant A option to export Unitechnik files
that are compatible with the IDAT stacker software.
This is only available for the 5.2b version of
Unitechnik.

Unitechnik export: MOUNPART block data tab

On this tab, you can add data attributes only, no geometric attributes. The
attributes are either optional or obligatory. The length of some of the fields
may be limited in the UT format, so keep the strings short.

How to use Text[Template]#Counter:

• Text can be any text including punctuation marks.

• Write templates in brackets [].

• # adds a running number if the data content is the same in several entries.

• You can enter several templates and use text delimiters.

• If you start the Text[Template]#Counter with a template, add a space as
the first character before the bracket.

• Template attributes are read from the main part of the embed assembly.
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• You can also use attributes that refer to another hierarchy level.

Note that steel parts have a tab Unitechnik Mountpart, where you can
specify data which then overwrites the settings defined on the MOUNPART
block data tab in the Export Unitechnik (79) dialog box.

Option Description
Type of mounting part You can define the type of mounting

part in the MOUNTPART block by UDA,
class or name.

Reference number You can define the reference number
of a mounting part in the MOUNTPART
block by UDA.

Mountpart name Enter the MOUNTPART name.
Info 1 text (UT 6.0) Information field is filled with the

selected data.
Info 2 text (UT 6.0) Information field is filled with the

selected data.

Unitechnik export: Line attributes tab

Line attributes are exported automatically according to the element and
opening edge shape. If the factory does not use Unitechnik standard line
attribute codes, you can override these exported codes. Sometimes line
attribute values that are exported in the Unitechnik files are not suitable for
the particular situation. For example, to preserve lightness in the model or
extensive product standardization, you might have fewer chamfers in the
model than there will be in the actual structure. For this reason, you might
want to override some line attributes in the export so that the model remains
light, but the exported Unitechnik files are correct. You can do this by using
the options on the Line attributes tab.

Option Description
Export line attributes
for contour

Select whether the line attribute values are used
for contours (Export line attributes for contour)
or for holes (Export line attributes for cutouts) in
the export.

• None

Line attribute values are not used.

• All lines

Line attribute values are used for all lines.

• Outmost lines only

Line attribute values are used only for the
outermost lines in the part:

Import to and export from Tekla Structures 423 Automated precast fabrication



Option Description

This option is available only for contours.
Border line overriding You can enter up to six border line modifications in

the line attribute export.

No border lines are overridden.

Vertical outermost border lines at the start are
overridden.

Horizontal outermost border lines at the bottom
are overridden.

Vertical outermost border lines at the end are
overridden.

Horizontal outermost border lines at the top are
overridden.
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Vertical outermost border lines are overridden.

Horizontal outermost border lines are overridden.

Horizontal and vertical outermost border lines are
overridden.

 

All inclined outermost border lines are overridden.

All outermost border lines are overridden.

All vertical border lines, except the outermost
border lines are overridden.

All horizontal border lines, except the outermost
border lines are overridden.
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All vertical and horizontal border lines except the
outermost border lines are overridden.

All border lines except outermost border lines are
overridden.

All border lines except the horizontal and vertical
outermost border lines are overridden.

All border lines are overridden.
Orig. attr, New attr. Define the original attribute (Orig. attr) and the

attribute that will be used in the export (New
attr.).

In the example below the horizontal outermost
border line at the top would get a line attribute
value 0033 originally, but the value will be
overridden, and the line attribute value in the
Unitechnik file will be 0040.

Export line attributes
for cutouts

Select whether all line attributes are exported for
openings.
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Export angle of 1st and
last vertical border

Select whether you want to export the angle of cut
at the first and last vertical border.

Max, Min The width of the chamfer is max 30 mm and the
depth of the tongue and groove max 30 mm. If not
within the tolerance, they are handled as special
formwork 0002.

Unitechnik export: Pallet tab

Option Description
Placing on pallet Define if the placing is checked from the start or

end of the pallet.
X offset at start or end Define if the X offset at start or end of the pallet is

checked.
Y offset from
alignment

Specify the Y offset of elements on the pallet.

Align in Y axis Align elements in Y direction. You can select
whether to align

• element upper edge to pallet upper edge

• element upper edge to pallet center line

• element center line to pallet center line

• element lower edge to pallet center line

• element lower edge to pallet lower edge

• element to the center of the pallet in Y direction
Clearance between
cast units

Define if the clearance between the cast units is
checked.

Same cast unit
thickness needed

Define if the cast unit thickness is checked.

Sequence in pallet

Sequence order

When you have selected Combined, n slabdate, 1
part as the output file structure on the Main tab,
you can select the logic of sequencing panels on
pallet using main part or cast unit ACN or number,
main part UDA or main part template, or
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Unitechnik transport UDAs. You can set the
sequence as Ascending or Descending.

Unitechnik export: Log files tab

Option Description
Log file directory path Define the path for a log file. If the path is empty,

then the log file is saved in the same location as
the export files.

Create main Log file Select whether to create a one main log file.
Create Log file for each
file

Select whether a log file is created separately for
each export file.

Write history to log file
and UDA

Create a log file containing the history of the
exported parts. You can also select to write the
information to the UDA UT_export_history of
the main part. The following data is gathered:
export time, part information, export path and file,
and who has performed the export.

Show error dialog
boxes

Select whether an error message is shown, for
example, when exported parts are not numbered
correctly or when the embedded parts have no
parent part.

Write file name to UDA Select to write the full export file name (File name
with extension) or the export file name without
the file name extension (File name without
extension) to hidden main part UDA 
UT_FILE_NAME.

Best practices in modeling, validating and exporting for Unitechnik

Pre-research

Before you start modeling, find out the following:

• What are the fabrication requirements and constraints?

• What is the complexity level of the products?

• What information is desired from the model?

• Production geometry for reinforcement mesh, loose rebars, embeds

• Project and product attributes

• What Unitechnik versions does the CAM system support?

Before your first project:
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• Model a test model with each of the typical products.

• Choose your modeling components and modeling settings.

• Test the Unitechnik export with each of the typical products and draft
suitable settings.

• Draft a company modeling guideline for collecting the information about
modeling, drawing creation, export and other practices in one place.

Modeling

General

Designers should aim to model with good precision taking into account the
fabrication requirements of the products. The required level of accuracy varies
from product to product, and some details need to have exactly correct
geometry whereas others can be included as attributes that will be sufficient
for production purposes.

As production only needs certain amount of information, some data needs to
be in drawings that will not be used within the export files and vice versa. The
goal is to have an error free model, which is modeled in a disciplined and
structured fashion so that it will be easy to include or exclude information in
both drawing and export file creation. All information will be used by
production, and therefore it is very important to have correct information,
because also export might be prevented if data is missing (such as material
data or other). Any mistakes are hard to notice until the actual production
stage.

Additional information can be brought to both the drawing and production file
using user-defined attributes (UDAs), which can be within each object, or on
the project level. UDAs are defined on the HEADER block data specification,
SLABDATE block data specification, Mounting part data specification and
Reinf. data specification tabs in the export dialog box. Some mandatory
fields have to filled as agreed, such as project number, product type and
drawing number, otherwise import is prevented. For more information about
the different tabs, see Unitechnik (page 373).

The best practice is to:

1. Finalize the detailing of a product.

2. Do a test export of the product with ready-made setting (for that product
type) and inspect the resulting file and make any adjustments if
necessary.

3. Create the drawing and edit it.

4. Finalize the drawing and send the drawing and a production file to a team
member for approval.

5. Later on a designated person will send the production files in suitable
sets.
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6. Control the design status on object-level within the model to keep track of
design, approval and changes, as well as the export files sets.

Object geometry will be used for plotting and shuttering as well as fabricating
the mesh, and cutting and bending the reinforcement. Each object type should
have a distinct NAME and CLASS setting, to later control the export content.

In the model objects are represented hierarchically. This means that the object
to be exported is a cast unit and within the cast unit there is the concrete main
part. Other parts or reinforcement can be attached to the main part directly,
or by first formulating a sub-assembly, which will have its own hierarchy and
main part.

Unitechnik geometric objects

The 3D Tekla Structures objects are translated to suit the Unitechnik format.
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(1) Contour

(2) Cutout

(3) Mountpart (embed)

(4) Rodstock (rebar)

(5) Steelmat (mesh)

(6) BGrinder (braced girder)

Contour and openings

Each object should have unified contour. There may be openings through the
element.

More than one contour causes problems for plotting the contour and placing
the shuttering. Having more than one contour is usually unintended, and
caused by either having a concrete part that has not been designated as an
embed, or the contour scanning resulting in two separate objects due to a cut
or recess.

The orientation of the object and contour is controlled by the modeling
direction, using the top-in-form setting within the model and the various
settings within the export dialog box. Setting the top-in-form in the model is
important because that is how Tekla Structures understands how the object
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will be produced, which affects both the export file and the drawings. As a rule
of thumb, slabs and panels should be laid out on their wide face, with no
extending parts or rebars towards the pallet, and any embeds and gaps that
require additional filler pieces against the pallet. These filler embeds should
have 0 weight and should be excluded from drawings and volume calculations.

If the edge has a shape that needs to be identified for a shuttering robot, this
is indicated by using line attribute codes (for chamfers, recesses or teeth).
These should be modeled using ready-made components, chamfers or cuts.
These will always be in the geometrical object's contour and cutout. In export,
they can be mapped automatically according to the Unitechnik standard, or
you can set an automatic override in the export.

In the usual case, CUTOUT represents a full-depth opening, while recesses in
the face are represented by embeds, MOUNPART.

For elements with standardized shape, such as pre-stressed slabs, the profile
can be included as attribute information.

Controlling the contour in the model is done by having an object profile, which
will be extruded to create the main part geometry. This basic geometry can
then be adjusted by using cuts within the model. Each cut should have a
distinct class or part set, so including and excluding them in export geometry
can be adjusted later. We recommend that you model any cuts or filler
embeds with systematic orientation, and for example, start and end handles
should also be modeled in the panel length direction.

The initial cut parts are to be added to the cast unit, knowing that they will be
listed on reports and shown on drawings. To exclude these purely production
related elements from reports and drawings use filters and rules.

In the example below the initial cut parts were kept and added to the cast unit.
The cut part name is set to "FORMWORK", the class is 111 (orange), and the
material name is Zero_weight.
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The following example shows exactly the same wall panel, but without the
formwork parts – they have been filtered out.
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Example chart of classes for modeling cuts (Cut included = as CUTOUT,
mountpart included = as MOUNPART):

Type of cut Modeled Exported
Window opening Cut with class 601

(component)
Cut included

Door opening Cut with class 601
(component)

Cut included

Other opening through
the element

Cut with class 601
(component)

Cut included

Rectangular recess in
the middle of element

Cut with class 602, filler
embed part with class

Cut excluded, filler
mounpart included

Rectangular recess on
the contour

Cut with class 602, filler
embed part with class

Cut excluded, filler
mounpart included

Non-rectangular recess Cut with class 602, filler
embed part with class

Cut excluded, filler
mounpart included

Cuts around embed
components

Cut with class 602 Cut excluded

Chamfer on the edge Chamfer or cut with
class 603

As line attribute
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Type of cut Modeled Exported
Groove or tongue shape
on the edge

Cut with class 603
(component)

As line attribute

Embeds

Embeds are presented as mountparts. Steel plates for connections, lifting
embeds, electric boxes or grout tubes are examples of mountparts. Each
embed should be added as a sub-assembly to the main cast unit. Embeds are
usually modeled with ready-made components, and it is important to check
that the tools have correct materials and attributes, and that the embed
hierarchy is correct. Embeds should be classified by a distinct class
(recommended 100 - 109 , other steel parts as 99). Steel parts can also be
recognized automatically.

• There are various options available for presenting the embeds: exact
geometry, a bounding box or a symbol.

• Embeds modeled as rebars can be turned into mountparts.

• Small cuts within the embed modeling components should usually be
excluded, which can be done by separately identifying them with class.

• Insulation layers can be added as mountpart identified by class.

• Surface treatment can be exported as mountparts. Surface objects are not
supported.

• Additional attributes can be added to each mountpart.

Remember the following:

• Apply meaningful names or identification codes to embeds, such as the
component main part.

• Embed parts and sub-assemblies added to the cast unit must fully be
added to the cast unit of Tekla Structures. Embeds or other connection
entities not assigned to a cast unit of Tekla Structures will not be taken into
account when exporting to UT file.

• Use logical hierarchical structure, and select a sensible main part for an
embed sub-assembly.

• Check sub-assembly hierarchies. Only 2 levels within the sub-assembly is
recommended.

• Check placing, classes, positioning, naming.

• Embed UDA tab settings for tailoring embed representation
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• Keep a list of all embeds and reinforcement in the project including their
names and classes.

Cut and bent reinforcement and reinforcement mesh

Cut and bent reinforcement can be modeled by using standard rebar modeling
functionalities or components. Rebars should be correctly attached to correct
main parts, but this is rarely an issue if modeling carefully.

Usually the elements have a very high number of reinforcement but not
necessarily all have to be brought into the export file, only the ones that need
to be produced according to correct geometry or need to be quantified. In
some cases, it is good idea to exclude the protruding rebars from cast units for
better export. Bent rebar shapes will be presented as unfolded and in the xy
plane in most of the viewers. 3D bent rebars are not supported by the format.

Reinforcement has automatically assigned reinforcement type to designate it
in the production system. You can override this logic by manually adding
reinforcement type in rebar UDAs for desired groups.

The mesh bars are automatically assigned to reinforcement types 1 and 2 or 5
and 6. The types 1, 2, 5 and 6 represent the installation layer in the form. 1 and
2 for mesh in bottom face, 5 and 6 on the top face.

Rebars can also be grouped and classified as cage objects by using rebar
UDAs. It is very important to ensure that rebars are not accidentally grouped
into mesh or cage.

Additional attributes can be added to each bar group as well as to each bar.

Import to and export from Tekla Structures 436 Automated precast fabrication



Unitechnik supports both planar mesh and bent mesh. Mesh can be modeled
as mesh objects or as crossing bar groups. If modeled as bar groups, the bars
need to be identified using class (recommended a double digit class, e.g. 13 -
19) or name in the export dialog. If there are no bar groups to be designated
as mesh, it is important to not use this setting

The modeled cuts are also used for cutting meshes and bars within the Tekla
Structures object.

Tekla Structures has several tools for creating mesh for precast objects, such
as Mesh Bars, Mesh Array and Wall Panel Reinforcement.

Additional attributes can be added to each mesh object as well as to each bar
within the mesh.

Remember the following:

• Model according to production constraints.

• Check placing, classes, positioning, naming.

• A mesh can be designed or created in the Tekla Structures model with
mesh objects but also using bar groups. If mesh is bent in two directions, it
can only be modeled as bar groups. The UT file export has several options
to influence the mesh creation towards the end result.

• A mesh in the Tekla Structures cast unit, consisting of longitudinal and
cross wire, should be defined either by

• the same class (color)

• the same name

• Do a differentiation of name and class per mesh having for instance
bottom and top mesh within one wall shell.

• Furthermore, it is a good practice to apply loose or additional rebar to a
dedicated class. Depending on the factory equipment and the processes
involved it might be necessary to exclude certain rebars from a cast unit
when exporting to the UT file. This can easily be achieved by excluding such
rebars by class in question from the export. Class can also be used to
distinguish rebars for non-automated production.

• There are advanced functions to validate mesh, or to add additional wires
for stabilizing if the mesh has openings. Check the dialog box settings on
the Reinforcement (page 373) tab.

In the example below the wall panel reinforcement rebar and mesh are
created based on the suggested logic.

The mesh color has been set to red, class 79, its additional reinforcement to
blue, class 88. Other reinforcement, also being added to the mesh manually
later on in the production process, is set to yellow, class 6, and green, class 87.
Reinforcement belonging to embeds are set to purple, class 7. With such a
structure it is very easy to exclude rebar from automated mesh production
and declare the UT file content as per factory or MC requirement.
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Braced girders

Braced girders for half-cast or layered structures are identified by having a
sub-assembly consisting of rebar groups and designating them with a specific
class that is defined in export dialog box (recommended class 105 ). The top
chord should be the main part of the sub-assembly.

Girders modeled from steel parts or rebars are both supported but rebars are
recommended.

The best way to model braced girders is using modeling components such as
the Braced Girders tool from Tekla Warehouse.
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Strands

Strands should be modeled as rebar groups. Strand rebar groups are typically
reinforcement type 9. The best way to model strands is the Hollow Core
Reinforcement Strands tool.

Strands should be quite standard so in the production file they can
represented with an identifier within the main part such as a Strand Code and
quantity of strands. With the Hollow Core Reinforcement Strands tool this
strand code can be automatically included in the slabdate data, otherwise it
has to be manually controlled using UDAs.

Product information

Product information besides the geometry can be added as textual or
numerical information. This data can be on any level of the hierarchy, but
most important product information will be included in the HEADER and
SLABDATE.

The following is automatically added:

• Names of the order and the element (but these have to be set in the export
dialog)

• Product maximum dimensions, length, width in slab-block and thickness in
product-block

• Total weight in the slabdate block

• Product material in the slabdate block in the layer data. Many layers can be
exported but in most cases using only 1 layer provides best results.

• Product coordinates within the project (model) in the header block

• Product type (this needs to be set within the main part UDA) in the header
block

• Reinforcement type in the rodstock block

• Reinforcement cage group numbers

• Transport information

Other recommended manual information:

• The name of the modeler

• The design status

• Bar and mountpart labeling

• The quantity of the strands (if applicable)

• Erection sequence (if applicable)

Other optional manual information:

• Project information

• Mountpart special instructions
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• Concreting special instructions

In addition, any UDA or manual text can be added to info fields.

Product type

As a mandatory setting, the UT product type must be set for each main part of
a cast unit.

The product type is not set by default. Select a product type for the element
selected from the model from the predefined list of option.

We recommend that you save the UT product type in modeling settings and
components.

The most commonly used types are:

• Solid wall

• Element slab

• Sandwich Element

• Double wall (1st stage)

• Double wall (2nd stage)

• Solid floor

Note that it is very important to define the double wall and sandwich wall
correctly for both shells.

You can also define product types of your own in addition to the predefined
types.

We also recommend that you systematically gather information about the
product and keep it up to date.

Company-specific modeling guidelines

• Use classes to control element geometry and part/rebar filtering.

• Included/excluded, automated/non-automated, mesh/loose bars

• Define UDA content to define the product

• Project UDAs
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• Unitechnik product types, location, additional info

• What to do with different types of element openings and recesses

• Shuttered, plotted or excluded

• Use standard edge shuttering shapes

• Define standard meshes, rebars and embeds according to factory
requirements

• Wire sizes, spacings, bendings, overhangs, maximum dimensions,
cutting

• Define top-in-form face for pallet orientation

• Create export settings for each product, and tailor them for each project

Attribute information

Project attributes

To streamline and obtain best possible results it is highly recommended to
have the Tekla Structures cast units to be exported and processed by the
Unitechnik file well structured. The modeling technique has a direct impact on
the outcome of the UT file.

The following instructions give a guideline on the mandatory and the most
needed settings to be set in the Tekla Structures model.

The UT file contains a dedicated header block with general information about
the project where the cast unit to be manufactured belongs to.

Within the UT file export dialog box the content of the UT file header block can
be defined by using the project settings of the Tekla Structures Structures
model. All relevant information should be set in the beginning of the project in
Project properties.
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User-defined attributes (UDAs)

Each main part of a cast unit in Tekla Structures to be exported to an UT file
requires additional information to be stored in the model. You can use user-
defined attributes (UDAs) for this purpose. The UDAs are defined in the Tekla
Structures objects.inp file which is present for each configuration but its
content can differ per Tekla Structures user role. In the Precast configuration
this file can be found in the ..\ProgramData\Tekla Structures
\<version>\environments\common folder.
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In UT file export the Unitechnik tab must be available for precast elements.

Element naming

The UT file contains geometric information of the cast unit to be manufactured
as well as its properties such as names and materials.

We recommend that you apply a meaningful naming to all elements of a cast
unit (main part, embed part, rebar), as this will improve the readability of a UT
file when being reviewed on the precast production control system. In most
systems, the PDF drawing name should match the Unitechnik export file
name.

Element numbering

Unique numbering is usually needed. ACN numbering is very handy for
making sure that the export separates each piece into its traceable own export
file and PDF drawing, rebar positions can be included into bar objects using a
logic that suits the production.

Element color coding

Tekla Structures elements, such as parts and reinforcements, can easily be
filtered by its class.
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Self-validating the export file

• Validate after the export.

• Go through the geometrical objects within the slab-blocks and visualize
them one by one.

• Investigate possible errors in notifications, logs and viewer.

• Check the date modified and naming of the files.

• Check the main attributes for HEADER and SLABDATE.

• Check orientation on pallet.

• Check contour and line attributes.

• Check the quantity of exported objects.

• Smoke test the rebar and mesh geometry. Check that the mesh production
constraints have been taken into account, and translated correctly.

• Check the resulting embed plotting.

• If there are any issues, fix those in Tekla Structures, re-export and re-
validate.

• Do not import to CAM unless you have checked the export files properly.

• Keep in separate folders (to be checked / faulty / checked and ready for
import).

BVBS
You can export reinforcement geometry to the BVBS format. The result is an
ASCII file with a file name extension .abs.

You can export reinforcement geometry to BVBS (Bundesvereinigung
Bausoftware) format. The result is a text file in ASCII format. The supported
version of the BVBS format is 2.0 year 2000.

You can export bent reinforcing bars, reinforcing bar groups and
reinforcement meshes, which can be rectangular, polygonal, non-bent or bent,
and may include cuts. The export of hooks is also supported.

Reinforcing bars that have bendings with two or more variable radius values
are exported fully conforming with the BVBS specification so that radius
element and leg elements are written separately. If this causes compatibility
issues within your own environment and other tools using the BVBS files, you
can still go back to the older way of exporting by setting the advanced option 
XS_BVBS_EXPORT_ARC_COMPATIBLE_TO_OLDER_METHOD to TRUE in an .ini
file, for example, in user.ini.
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Export to the BVBS format
1. Ensure that numbering is up to date.

2. Go to the properties of the cast units and reinforcement that you plan to
export, and edit the user-defined attributes on the BVBS tab as required.
The user-defined attributes are environment specific.

3. Select the cast units with the desired reinforcement content, or select the
reinforcement.

4. On the File menu, click Export --> BVBS. 

The BVBS Export dialog box is displayed.

5. Define the BVBS export settings:

a. On the Parameters tab, select: 

• which reinforcement to export

• how to export drawing data

• how and where to export the BVBS file or files

• which BVBS elements to export

You can use saved selection filters to exclude reinforcement bars or
meshes matching with the selected filter.

b. On the Advanced tab, select whether you want to: 

• round rebar lengths for 2D bent bars

• make meshes out of rebars

• include the detailed data of mesh bars in the exported data of the
mesh

• define the order of the items in the output file

• export the private data block and select the data items for this
additional block

You can also define which bending radius is used to calculate the arc
length: Bending radius to the rebar center line, which is the default
for most interfaces, or to the rebar inner edge, in which case the
bending radius is shortened with half of the rebar nominal diameter.

BVBS export uses arc geometry in two cases:

• For circular rebars such as spirals or hoops.

• When bent rebar has more than 1 bending radius, the bends with
the larger radius are exported as arc sections.

c. On the Checking tab, select whether you want to run additional
checks for the reinforcing bars.

6. Click Export.
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The BVBS file or files in .abs format are exported to the folder specified in the
Output file area. You can check the export report by clicking the report link
that appears at the bottom of the dialog box.

BVBS export settings
Use the BVBS Export dialog box to control the BVBS export settings.

Parameters tab

Option Description
Model objects to be
exported

Select which reinforcing bars or meshes are
exported.

• Reinforcement of all cast units in the model

Exports reinforcing bars or meshes in all cast
units in the model. If there are cast units that
do not have reinforcing bars or meshes, no
empty files are created.

• Reinforcement of selected cast units

Exports reinforcing bars or meshes in the cast
units you have selected in the model.

• Selected reinforcement only

Exports the reinforcing bars or meshes you
have selected in the model or in the drawing.
When you select this option, you can export
only to a single file.

• Reinforcement of selected cast units (totals
by all positions)

Exports reinforcing bars or meshes in all the
cast units that have the same cast unit position
as any of the selected cast unit positions.

For example, if a cast unit with the cast unit
position W-120 is selected, the reinforcing bars
or meshes in all the cast units that have
position W-120 are exported even though not
all of them were selected.

Excluding
reinforcement by filter

Exclude reinforcing bars or meshes by selecting
any of the selection filters. Reinforcing bars or
meshes that match the filter are excluded.

Single file Export all BVBS information into one .abs file.
Enter the file name in the box or click the ... button
to browse for the file. If you do not enter a path,
the file is saved in the model folder.

Import to and export from Tekla Structures 446 Automated precast fabrication



Option Description
One file per each cast
unit

Export each cast unit reinforcement content to its
own file.

The files are created under the folder that you
define in the Folder name box, or you can browse
for the folder using the ... button.

Use the File naming template list to select how
the created files are automatically named. You can
use multiple assembly template properties in the
file name. Type the template properties in the box
and separate them with spaces. The combination
will be separated by underscores in the exported
file name.

You can include revision into file name by selecting
the Include revision into file name check box.

BVBS elements to be
exported

Select which item types are exported. The options
are:

• 2D reinforcement bars (BF2D)

• 3D reinforcement bars (BF3D)

• Spiral reinforcement coils (BFWE)

• Reinforcement meshes (BFMA)

• Lattice girders (BFGT)

If you select Lattice girders (BFGT), enter the
class numbers used in the model for the lattice
girder bars in the Class numbers for girder
box. The lattice girder may contain two or three
chord bars and one or two diagonal zig-zag
bars. The lattice girder length and other
attributes are taken from the main chord
(usually top chord).

Settings tab

Option Description
Drawing name source In BVBS file each row/rebar has a

data field for Drawing number of
the respective drawing (drawing
name) and Index of the
respective drawing (drawing
revision). With the option Drawing
name source you can control how
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Option Description
the values for these data fields will be
set.

Cast unit position

Drawing Name

Drawing Mark

Drawing Title1

Drawing Title2

Drawing Title3

Fixed text: If you select this, enter
the text in User-defined drawing
name.

Reinforcement UDA

Reinforcement template

Assembly template

By selecting the option Fixed text
you can enter the values in the dialog
box and same ("fixed") values will be
written for every exported rebar.

If any of the other options is selected,
the drawing name and revision will
be taken from the cast unit or cast
unit drawing of the rebar.

Note that it depends on the receiving
system of the BVBS file how
important and for what purpose this
data will be used. From Tekla
Structures perspective, using this
data field is not obligatory.

User-defined drawing name Enter a text string to be used for the
drawing in the export.

This option is available only when you
have selected the Fixed text option
in Drawing name source.

Rev Drawing revision (index).

This option is available only when you
have selected the option Fixed text
in Drawing name source.

Position source Define the source of the position. The
options are Reinforcement position,
Reinforcement UDA and Fixed text.
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Option Description
User-defined reinforcement
position

Define the reinforcement UDA
position number. Exported item with
the same position number but
different UDA position number will
be exported to different rows.

Project number Define the project number. The
options are:

Project Properties: The export
fetches the project number
information from the project
properties set in Tekla Structures.

Project properties UDA: The export
uses the UDA name entered in the
User-defined reinforcement
position box.

Fixed text: The export uses the text
entered in theUser-defined
reinforcement position.

Advanced tab

Option Description
Round

Round lengths to

Round leg lengths to

Round rebar lengths for 2D bent bars.
Mesh and 3D rebars are not affected.

To round the lengths, first select an
option for the Round setting. The
options are:

YesUp - Uses the nearest rounding
value.

Up - Rounds the lengths up.

Down - Rounds the lengths down.

Round lengths to rounds the total
rebar lengths in the corresponding
BVBS field in the header block, and
the available values are 1, 5, 10, and
25.

Round leg lengths to rounds the leg
lengths in the geometry block, and
the available values are 1, 5, and 10.

1 is the default value for both options.
Bent leg arc radius This setting defines which bending

radius is used to calculate the arc
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Option Description
length: Bending radius to the rebar
center line (Center line), which is the
default for most interfaces, to the
rebar inner edge (Inner edge), or to
the rebar outer edge (Outer edge). If
you select Inner edge, the bending
radius is shortened with half of the
rebar nominal diameter.

The BVBS export uses arc geometry in
two cases:

• For circular rebars such as spirals
or hoops.

• When bent rebar has more than 1
bending radius, the bends with the
larger radius are exported as arc
sections.

Try to make meshes of rebars Select whether the export tries to
automatically form meshes of a single
reinforcing bar or of a group
reinforcing bars and export them as a
mesh instead of separate 2D bars.
The options are:

Yes, group rebars by class

Yes, group rebars by name

Yes, group rebars by grade

Yes, group rebars by UDA

In order to form a mesh the
reinforcing bars need to belong to the
same part, be straight, be on the
same plane, and have equal filtering
attribute values.

UDA name for grouping If you selected the value Yes, group
rebars by UDA for Try to make
meshes of rebars, enter the UDA
name for grouping.

Exporting of mesh bar data
(@X..@Y..)

Use this option to control whether the
detailed data on mesh bars is
included in the exported data of the
mesh. The appropriate option
depends on the needs and
capabilities of the receiving system.
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Option Description
The data is needed if it will be used,
for example, for mesh fabrication.

• Custom and cut catalog meshes
only

Detailed bar data is included only
for custom meshes and catalog
meshes that have additional cuts,
openings or skewed edges.

• All meshes

Detailed bar data is written for all
meshes.

• None meshes

Detailed bar data is not written to
any of the meshes.

Export stepped bars as separate
items

By default a stepped group is
exported as a single string with the
stepping length defined in a certain
data block.

If you select the value Yes for
Exporting of mesh bar data
(@X..@Y..), all tapered reinforcing bar
groups are exported as multiple
separate reinforcing bar items even if
they have regular spacing and could
be exported as one single stepped
reinforcing bar item.

If all the tapered bars within the
group have the same geometry and
length, they will be exported within a
single BVBS string as a regular group
would, regardless of this setting.

Sort items Use this option to define the order of
the items in the output files. The
options are:

No sorting

By diameter, smaller size first

By diameter, bigger size first

By position number
Private data block With Private data block you can

control whether the private data
block is exported (Export private
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Option Description
data block) and select the data items
for this additional block. The following
data types are available:

- Reinforcement report property
(integer, float or text)

- User-defined attribute (integer, float
or text)

- Open API object property

- Assembly report property (integer,
float or text)

Click the New... button to add new
predefined private data fields to the
list. Enter information about the data
item.

• Name in list

The text shown in the Private
data block list.

• Field identifier (one lower case
letter)

The field code which separates the
individual data fields in the private
data block. It can be any lower
case letter. Typically, it is a good
practice to use a different value
for each data item but this is not
required. The receiving system
may also be able to read only
certain data fields.

• Property or UDA name

The value defines which data will
be inquired from the
reinforcement object. Note that a
non-existing property will be not
exported.

• Property data type

The value has to match the actual
selected property. The options
are:

• Reinforcement report
property Integer/
Reinforcement report
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Option Description
property Float/
Reinforcement report
property Text

• User defined attribute -
Integer/User defined
attribute - Float/User defined
attribute - Text

• Open API object property

• Assembly report property
Integer/Assembly report
property Float/Assembly
report property Text

You can also edit and remove data
fields, and change their order.

Checking tab

Option Description
Check reinforcement Select whether you want to run

additional checks for the following:

Reinforcement
diameters(separated with spaces)

Minimum cutting length of
reinforcing bars

Maximum cutting length of the
reinforcing bars

Minimum leg length for straight
sections between the bends

Maximum weight of individual bars

When you select the Check
reinforcement check box, and the
values of the exported reinforcing bar
are less than the minimum or greater
than the maximum, a warning is
written to the export log file.

The log file entry contains the ID of
the reinforcing bar. You can locate the
reinforcing bar in the model by
selecting the appropriate row in the
log file. Note that the reinforcing bar
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Option Description
is still exported normally and only the
additional warning is given.

Note that when the check is activated,
the length of lattice girders is also
checked. A warning is added in the
log when the check fails. The length of
the main chord defines the exported
length of the lattice girder.

UDAs tab

On this tab you can define the UDA fields to be used, and the content to write
into reinforcement, part, cast unit and pour object UDAs. You can tag UDAs
based on release code, release status, release date and released by
information. You can also select whether existing UDAs are checked and
handled by using the setting Check existing UDAs. The options are No,
Prevent export, Report to log, Report to log and overwrite, and Overwrite
only.

Reinforcing bar length calculation in BVBS export

The length of the reinforcing bar is calculated according to the BVBS
specification. The length also depends on the bending angle. Lengths L1 and
L2 are exported.
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If you set the advanced option
XS_USE_USER_DEFINED_REBAR_LENGTH_AND_WEIGHT to TRUE, the user-
defined length value is exported as the overall length for the reinforcing bar.

Note that the BVBS format specifications define that the overall length of the
bar is ignored if the data contains actual geometry data. Some other software
applications may still use the overall length values in the BVBS file for
calculating quantities. The exported overall length in Tekla Structures is the
same length as shown in reports.

ELiPLAN
Elematic ELiPLAN is a software for resource planning, scheduling, and
management for precast concrete fabricators. ELiPLAN import and export
automate the data transfer between Tekla Structures and ELiPLAN.

The data transfer between Tekla Structures and ELiPLAN consists of four parts:

1. Exporting ELiPLAN data file from Tekla Structures.

2. Importing ELiPLAN data file into ELiPLAN.

3. Exporting ELiPLAN status data file from ELiPLAN.

4. Importing ELiPLAN status data file into Tekla Structures.

The import of an ELiPLAN data file into ELiPLAN supports the incremental
approach, which means that ELiPLAN is able to create, update, and delete
parts in its database. This means that precast detailers can export the most
up-to-date data files whenever the Tekla Structures model has been changed.

Similar incremental support is included in the import of an ELiPLAN status
data file to Tekla Structures. To keep the status and schedule data up to date
in a Tekla Structures model, we recommend you update the status data
regularly.

In the EliPLAN export, the part geometry (profile, cuts, openings, and notches)
is always automatically exported. You need to define the plotter data and the
necessary attributes. Every time you export, you need to export all the parts
that have been exported before to ensure proper change management in
EliPLAN. Same applies to the import. The export is based on part GUIDs, and
the import is based on the project name/number and part GUIDs.

NOTE The format and contents of the ELiPLAN status data file imported to Tekla
Structures differs from the data file that is exported from Tekla Structures to
ELiPLAN.

For more information about the best practices in EliPLAN export, see Best
practices in ELiPLAN export (page 470).
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Export an ELiPLAN data file
You need to export everything that is ready. If you are using a shared model,
first check the situation by checking the drawings, for example.

1. Add ELiPLAN information to ELiPLAN user-defined attributes of the parts. 

This is optional, the product types and product codes are defined
automatically. There are numerous ways to alter these for the export
besides the manual UDA handling. See later sections.

For more information about the UDAs, see ELiPLAN user-defined
attributes in this same article.

2. On the File menu, click Export --> EliPlan . 

The Export EliPlan file dialog box is displayed.

3. Define the ELiPLAN export properties on the Parameters, Plotter data
and Data content tabs. For more information about the export
properties on different tabs, see further down in this same article.

4. Set Scope of export to All or Selected. 

You should always bring every element that is ready to ELiPLAN with every
round to ensure that any design changes are taken into the system as
well. The model might have some non-relevant or not-ready cast units,
which is why it is recommended to use Selected to control which ones are
being exported. Conceptual cast units can be taken, but then you need to
keep track of these elements, for example, by using a UDA. You also need
to ensure their GUID stays the same in the later export rounds.

5. Click Create. 

By default, a file called eliplan.eli is created in the current model
folder, in a .\EP_files subfolder.

ELiPLAN export settings
Use the Export EliPlan file dialog box to control the ELiPLAN export
properties.

Parameters tab

Setting Description
Scope of export Select whether all parts or only

selected parts are exported. Because
of the incremental import of ELiPLAN,
you need to select the same parts,
and some additional parts again, if
needed, when exporting the next
time, to make sure that any design
changes are taken in to the system as
well. Otherwise ELiPLAN assumes that
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Setting Description
the parts missing from the
subsequent file have been deleted in
the Tekla Structures model.

We recommend you to always use the
All option. Use the Selected option
when you are exporting parts for the
first time, if you are exporting from
unfinished model or in special cases.
Use the filtering option to control the
product or phase scope.

Export using filter Specify a selection filter. The parts to
export are selected on the basis of
the specified selection filter.

Numbering must be up to date to
export

Set this setting to Yes to prevent
export when the numbering is not up
to date. This prevents the export of
unfinished cast units.

Export version number The elements need to have a unique
identifier. The options are GUID, ID,
ACN and FloorMES.

Use 2.0 (GUID), because IDs will
change when reopening the model,
resulting in duplicates in export.

1.01 (ID) should only be used when
the export is done only once, because
of the changing IDs.

Select 2.00 (ACN) to export elements
with ACN.

The 3.0 (FloorMES) version file format
is intended for interfacing with newer
Elematic FloorMES versions, and is
also based on GUID. The file format
has been extended with additional
data fields, and therefore it is not
backwards compatible.

Version 3.0 of the export supports the
export of accessory code to plotter
data, and the export of accessory
code for openings.

Output file name The name and location of the export
file created. The default name is
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Setting Description
eliplan.eli. You can import this
file into ELiPLAN.

The eliplan.eli file includes,
among other things, material
information. The accessory code,
which is the material description, is in
the #Materials block.

The accessory code is based on the
material type as follows:

• For concrete material the default
accessory code is same as the
material name.

• For mesh, reinforcing bars, or
strands the default accessory code
is grade|size.

• For embedded material the
default accessory code is name|
size|material.

Data conversion file With this file you can convert the
parametric profile names into the
ELiPLAN product codes, and the
material descriptions into the
ELiPLAN accessory codes. You need to
create the file yourself when
necessary.

The default file name is
eliplan_export.dat, and this file
can be located in any folder.

The data conversion file
eliplan_export.dat contains
string pairs separated with one or
more tabs. The string on the left side
is the profile name or Tekla
Structures material description and
the string on the right side is the
corresponding ELiPLAN data. Make
sure that you use matching case

Note that the ELiPLAN codes depend
on the fabricator, and the codes that
are valid for one fabricator are likely
to be not valid for other fabricators.

For an example of data conversion
file contents, see
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Setting Description
Sample_for_Eliplan_Data_Conversion.
dat.

Filter by part: Element data Enter a list of classes or to be
excluded from or included in the
export. This contains the class
numbers or names used for concrete
parts. Separate the classes or names
with a space.

You can also specify a selection filter
for filtering element data, materials or
secondary concrete elements.

Filter by part: Material quantities Enter a list of classes or to be
excluded from or included in the
export. This contains the class
numbers or names used for
materials. Separate the classes or
names with a space.

You can also specify a selection filter
for filtering materials.

Filter by part: Secondary concrete Enter a list of classes or names to be
excluded from or included in the
export. This contains the class
numbers or names used for
secondary concrete parts. Separate
the classes or names with a space.

You can also specify a selection filter
for filtering secondary concrete
elements.

Create log file Select whether a log file is created.
Creating a log file is recommended to
ensure that the exported file is
correct.

The log will notify you about the
number of exported cast units and,
for example, if:

• Export failed because numbering
not done.

• Some cast units could not be
exported.

• Some cast units were ignored by
filters, or they are CIP.

• Embeds or cuts to be plotted are
completely outside the parts.

Import to and export from Tekla Structures 459 Automated precast fabrication

https://teklastructures.support.tekla.com/system/files/manual/Sample_for_Eliplan_Data_Conversion.dat
https://teklastructures.support.tekla.com/system/files/manual/Sample_for_Eliplan_Data_Conversion.dat


Setting Description
• Some of the material or product

type data conversion mapping is
not recognized.

Log file name The name and location of the created
log file.

Plotter data tab

Option Description
Export of cutout data Select how to export cutout data. The

options are:

• All: Exports all data.

• Full depth cuts only: Exports data
only on the cuts that go through
the whole part. Does not export
recess data.

• None: Does not export any cutout
data.

It is recommended to use Full depth
cuts only, because otherwise small
recesses are included in the plotting
on both faces.

Overlapping cutouts are combined in
the export file.

This setting exists for hollowcore and
slab products, and for wall and
sandwich wall products.

Export of embed data Select whether to export data of
embeds. The options are:

• Yes: Exports data on embeds.

• No: Does not export any data on
embeds.

This setting exists for hollowcore and
slab products, and for wall and
sandwich wall products.

Export of weep holes Select whether to export data of weep
holes. The options are:

• Yes: Exports data on weep holes.

• No: Does not export any data on
weep holes.
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Option Description
Plot additional reinforcement Plot additional reinforcement as

bounding box.

The options are:

• None

• Class

• Name

• Grade
Plot cutout/embed as lines Export cutouts and embeds as lines.

The options are:

• None

• Class

• Name

• Material/Grade
Exclude cut parts by Use to exclude cut parts from export

based on the cut part properties.

The options are:

• None

• Class

• Name

• Material

This setting is a handy filter for
reducing amount of extra cuts in
plotting.

Exclude embeds by Use to exclude embeds from
exported plotting data embeds by:

• None

• Class

• Name

• Material

You can define one or more values
for the selected property.

Exclude above z position Select whether to exclude from
exported plotting data embeds or
cuts that are above the specified Z
position. The Z position is the depth
of the element on the pallet, that is
how many millimeters the lowest
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Option Description
point of the embed is above the pallet
surface.

You can define one or more values
for the selected property.

The options are:

• None

• Embeds

• Cuts

• Embeds and cuts

Data content tab

Option Description
Product code Select the default product code

mapping, which then should
correspond with any data conversion
strings.

Accessory code Specify the accessory code for
standard embeds such as steel parts.
This will be the code written to each
embed in the #Plotter (if applicable)
and #Materials blocks, and the
chosen option should be used as a
base for further data conversion
mapping. The default option is
NAME|PROFILE-LENGTH|
MATERIALGRADE.

Export material data Select whether to include or exclude
the detailed material data (receipt) of
parts.

If you have no use for material data in
ELiPLAN (you have no material
handling module in ELiPLAN), select
No to exclude the data from the file
and to reduce the file size.

Note that once you have transferred
the file with the material data (Yes)
you should never switch off (No) the
export of material data in subsequent
exports. If you do this, the receipt is
also cleared in the ELiPLAN database
and all modifications are lost.
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Option Description
Export rebar bending data Select whether to include or exclude

the detailed rebar bending
information.

If you do not need this data in
ELiPLAN, select No to exclude the
data from the file and to reduce the
file size.

Note that once you have transferred
the file with the rebar bending data
(Yes) you should never switch off (No)
the export of rebar bending data in
subsequent exports.

Export embed Z position Select whether to include or exclude
the Z level of embeds.

Notes Use UDA or template attribute to add
extra information to be viewed at the
factory, such as design status, change
status or general comment.

Select what type of notes you want to
export: UDA, a template attribute or
your own text. Then enter the UDA,
template attribute, or text.

Stack, Pile number, Pile level The export of stack results is
supported starting from EliPlan
export version 3.0. You can select if
the UDA is read from the main part or
from the cast unit.

The UDAs are pre-filled, but you can
change them manually.

Data settings tab

Option Description
Unit for rebar length Select the unit for the length of

reinforcing bars.
No. of digits after decimal point Select the number of digits after the

decimal separator (0 - 3).

The default is 1 digit after the decimal
separator.

Tag for lifters Use to identify lifting loops by their
name or class.

Also rebars can be specified as lifters
using a class or a name.You can also
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Option Description
specify how the lifters geometry
should be plotted - as outline or as
center point.

It is also possible to specify multiple
classes or names for the Tag for
lifters setting. If the name consists of
multiple words then it has to be
enclosed in quotation marks.

When lifting loops are identified, the
plotter instruction type is changed
from WPL to LL.

Prefix for ID Enter a prefix (letter) to use with the
ID number.

Position number type Select whether to export the cast unit
position number, assigned control
number (ACN), or cast unit position
number and ACN.

Remove numbering separator Select whether a position number
separator is used in numbering. The
default is No.

Tag special elements Set this option to Yes to set a special
tag for elements that have notch cuts.
This option marks hollow-cores with
notches with SK denominator (N for
uncut slabs).

Strand code Specify a UDA or a template attribute
to read the strand code. Default
reads the value from the UDA
TS_STRAND_CODE. You can also
specify a custom property using the
option Template.

Net area calculation Select Exclude all cuts to exclude all
cuts or Exclude full depth cuts only
to exclude full depth cuts only from
the net area calculation, or Gross
area to export gross area as net area.
The whole assembly is checked.

Weight calculation Select which weight will be exported.
Decimal mark Set period (.) or comma (.) as the

decimal mark depending on ELiPLAN
settings.
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ELiPLAN data conversion file

The data conversion file contains string pairs separated with one or more tabs.
The string on left side is the profile name or Tekla Structures material
description and the string on right side is the corresponding ELiPLAN data. The
mapping can also contain the unit for quantity for material codes.

You can combine several mappings in one, because the product and material
code conversion is based on tags separated with the pipe character ("|"). A
matching conversion is used when any tags are found in the source file.

Note that the ELiPLAN codes depend on the fabricator and the codes which
are valid for one fabricator are most probably not valid for other fabricators.

The product code and the material code can be defined separately: mappings
following the line #PRODUCT CODES are used for product code conversion
and mappings following the line #MATERIAL CODES are used for material
conversion.

Example of a data conversion file:

#PRODUCT CODES
//
// Hollow-core slabs
//
265X1200    HCS27
320X1200    HCS32
400X1200    HCS40
//
// Beams
//
BEAM|RCDL    B_LP2P
BEAM|RCL    B_LP
BEAM    B_SK

#MATERIAL CODES
//
// reinforcement
//
A500HW|6    TW6        kg
A500HW|8    TW8        kg
A500HW|10    TW10    kg
A500HW|12    TW12    kg
A500HW|16    TW16    kg
A500HW|20    TW20    kg
A500HW|25    TW25    kg
A500HW|32    TW32    kg
//
// Strands
//
1570/1770    1570/1770        m
//
// Meshes
//
B500K|8/8-200/200    B500K8-200            m2
B500K|10/10-250/400    B500K10-250/400        m2
//
// Embeds
//
HPKM39|50*110-110    HPKM39        pcs
Neoprene            NEO_10        m2
//
// Concrete materials
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//
C35/45        C35        m3
C40/50        C40        m3
C45/55        C45        m3

You can combine several mappings in one, because the product and material
code conversion is based on tags separated with the pipe character ("|"). Make
sure that you use matching case.

ELiPLAN export file (.eli)
The .eli file contents are described below.

Header data for file info

The geometry of the elements is reported in the #Pieces and #Plotter blocks:

#Pieces:

• Contains a unique data row for each slab.

• Has a unique data row for each slab.

• For hollowcore slabs, the outer measurements are reported in the #Pieces
block based on the min (x, y) and max (x, y) values of the slab. These
measurements describe a rectangle, parallelogram or trapezium. The
thickness, profile and additional information of the slab is reported.

• In the #Pieces block you can separately flag slabs that have cuts in the
edges.

#Plotter:

• Contains data for individual plotting operations by element, such as
embeds, recesses, and through-cuts.

• The #Plotter block also contains geometrical data that is arranged by the
slab position. The operations are performed on each slab on the basis of
the position number.

• Each plotting operation is on its own row (formwork accessories, recesses,
cross sections).

• In the export settings you can define the plotting data scope included in
the export.

• The shapes can be lines, rectangles or circles.

• The order of the rows is not important, they will be reorganized in ELiPLAN.

• If the geometry cannot be presented as a rectangle or a circle inside the
slab boundaries, it will be presented as a line.

• Overlapping plotting with the outer boundaries defined by the #Pieces
data has been minimized, and crossing the edges is prevented.

#Materials:

• Contains data for material quantities by element.
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#Bars:

• Contains data for rebar shapes by element.

Example of an export file:

2.00;1;;04.06.2019 11:49:15
# Pieces
56a109f8-562c-4aa5-882a-a45cc7be9b95;B_LP2P;B/
1;7200.00;0.00;0.00;500.00;600.00;0.00;3628.80;1.51;4.32;1.08;;;PHASE 
1;;N;0;
3dbe09b6-1b35-44e7-a18f-0c492a71b6a6;HCS32;HC/
1;6000.00;6000.00;0.00;700.00;0.00;320.00;1655.09;0.69;4.20;4.06;;;PHASE 
1;;N;0;
1d2c4018-daa3-4b5d-801a-4a1e491db41f;HCS32;HC/
2;6000.00;6000.00;0.00;1200.00;0.00;320.00;2765.20;1.15;7.20;6.93;;;PHASE 
1;;N;0;
0b003ef7-2c79-4e4d-844f-51616ad0584d;HCS32;HC/
3;6000.00;6000.00;0.00;1200.00;0.00;320.00;2747.86;1.14;7.20;6.89;;;PHASE 
1;;N;0;
e670a8ac-c034-4fa9-b5e3-0a17461502fb;HCS32;HC/
4;5750.00;4875.00;0.00;1200.00;0.00;320.00;2446.78;1.02;6.89;6.13;;;PHASE 
1;;N;0;
868229bf-36ed-4b87-9d2e-e7c36962b181;HCS32;HC/
5;4875.00;4000.00;0.00;1200.00;0.00;320.00;2044.57;0.85;5.85;5.12;;;PHASE 
1;;N;0;
# Plotter
HCS32;HC/3;LI;LI;5750.00;1200.00;6000.00;850.00;0.00;0.00;
# Materials
B_LP2P;B/1;C35;1.51;
HCS32;HC/1;C40;0.69;
HCS32;HC/1;1570/1770;18.00;
HCS32;HC/2;C40;1.15;
HCS32;HC/2;1570/1770;36.00;
HCS32;HC/3;C40;1.14;
HCS32;HC/3;1570/1770;34.69;
HCS32;HC/4;C40;1.02;
HCS32;HC/4;1570/1770;29.45;
HCS32;HC/5;C40;0.85;
HCS32;HC/5;1570/1770;24.22;
# Bars

Import an ELiPLAN status data file
If you have a status data file that has been created in ELiPLAN, you can import
the status and scheduling information to your Tekla Structures model.

1. On the File menu, click Import --> EliPlan. 

The Import Eliplan status data dialog box opens.

2. Click the ... button next to the Import file name box to browse for the file
to be imported.

3. Click Create. 

Tekla Structures updates the status and schedule data for parts in the
Tekla Structures model. When the data is read, a log file is displayed.

The log file shows the parts whose data is updated correctly. It also
provides information on possible problems that may have occurred.
When you select a row in the log file, Tekla Structures automatically
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selects the corresponding part in the model. The overall status
information is shown at the end of the log file.

Tekla Structures stores the actual status data in the user-defined attributes of
the parts. To view the data, open the part properties, click the User-defined
attributes button and go to the ELiPLAN tab.

ELiPLAN user-defined attributes
In addition to normal model data, you can add additional information in the
user-defined attributes of the parts. The additional information can be
transferred from Tekla Structures and used in ELiPLAN.

The product type and product code user-defined attributes override the
automatic product type and product code. Other user-defined attributes are
reserved for ELiPLAN import.

Product type

The product type affects how ELiPLAN considers the part dimensions length,
length2, deltaL, width, height, and thickness.

The product type user-defined attribute overrides the product type defined in
the ELiPLAN export dialog box.

To set the product type, select a suitable product type option from the list.
Normally you should be able to use the default Auto, but in some cases you
may need to override the default.

If needed, you can override the product type value set in the dialog box in the
following way:

• You can enter a value for the user-defined attribute EP_TYPE in the
objects.inp file.
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• You can enter a value for the user attribute EP_TYPE in the Profile
catalog.

In the Profile catalog, the attribute value is given as a number. The values
are as follows:

• Slab = 1

• Beam = 2

• Column = 3

• Wall = 4

• Sandwich wall = 5

• Stair = 6

Product code

The product code user-defined attribute overrides the product code defined in
the ELiPLAN export dialog box.

You have alternative ways to give the product code. The ELiPLAN export tries
to define the product code in the following order:

1. You can enter a value for the product code in the ELiPLAN user-defined
attributes dialog box.

2. You can enter a value for the user-defined attribute EP_CODE of the cast
unit main part in the objects.inp file.

3. You can enter a value for user attribute EP_CODE in the Profile catalog.

4. You can use the data conversion file to convert parametric profile names
to a product code.

5. The main part name is exported as the main part name if none of the
previous methods succeeded.

Erection sequence

Precast parts are erected in a certain sequence. Use the sequence to help the
scheduling of the production in ELiPLAN. You can give the estimated erection
sequence by giving the sequence number for parts.

Ready for production

Set this option to Yes when the designer or detailer has finished the part and
the part is ready for production. The default is No, which means that the data
is transferred to ELiPLAN for preliminary planning only, and the part is not
sent for production until the attribute is set to Yes and a new file is transferred
to ELiPLAN.
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ELiPLAN status data

The ELiPLAN status data is meant to be read-only information and used to
visualize the data in a Tekla Structures model.

Set up your UDAs in the model or profile catalog for mapping object
types, profiles and materials

For more information on how to set up your UDAs in the model or profile
catalog for mapping object types, profiles and materials to suit the ELiPLAN
export, see EliPLAN/ELiPOS export guide.

Examples of ELiPLAN files
Click the links below to see examples of ELiPLAN files. You can open the files
with a standard text editor.

• ELiPLAN data conversion file: Sample_for_Eliplan_Data_Conversion.dat.

• ELiPLAN export file: Sample_for_Export_Eliplan.eli

• ELiPLAN import file: Sample_for_Import_Eliplan.sql

Best practices in ELiPLAN export

Pre-research

Before you start, find out the following:

• Which elements are produced?

• What are the bed sizes and other fabrication requirements?

• What should be plotted?

• Are embed and rebar quantities desired?

• What kind of product and material codes are being used?

• What additional information is desired from the model?

• Is it needed to bring process information back to the model?

Before you start a project:

• Collect product codes and material article numbers.

• Create the data conversion file, include any necessary codes, and test with
sample products that the data conversion table works as intended.

• Use automatic settings or choose the most suitable input method.

• Numbering logic:

• For ELiPLAN, every element should be unique and traceable.

• Data scope: Geometry, attribute, materials

• Which products and materials to include?
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• Which plotter data to include?

• Draft a modeling guideline to categorize model objects with specific
class/name/other attribute

• Fabrication requirements: dimensions, profiles, maximum weight

• Document everything in the modeling guideline

Best practices in ELiPLAN export

Workflow

• Model according to modeling guideline, depending on fabrication
requirements.

• Model precast objects with their embedded content.

• If hollow-core geometry is used for plotting within ELiPOS, ensure that
recesses and embed positions are accurate.

• Set up profile and material catalogs according to fabrication requirements.

• Adjust the profile catalog and modeling settings so that the mapping to the
ELiPLAN system is done correctly.

• Ensure that you use the materials and profiles that you have mapped.

• Define standard export settings in line with the modeling guideline.

• In newer Tekla Structures versions, always use GUID or ACN as the element
identifier.

• Number the model. Use Tekla Structures numbering for creating drawings,
and automatic control numbering (ACN) to track unique elements.

• Use automatic data conversion and product types.

• Add design status information to precast objects and import the status to
ELiPLAN using additional UDAs to communicate the design status. Also
mark the objects that have been sent to production.

• Always check the resulting file and the export log:

• Ensure that there is no strange mapping in the product or material
codes.

• Validate the export files in the production software, as there is no
viewer available.
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HMS
You can export model data of hollow core slabs to a HMS format. The result is
a .sot file.

HMS stands for Hollowcore Manufacturing System and it is developed in the
Netherlands. You can export data of hollow core slabs from Tekla Structures
to HMS. HMS uses the data in manufacturing processes.

Export to the HMS format
1. Select the model objects that you want to include in the export.

2. On the File menu, click Export --> HMS . 

The HMS Export dialog box opens.

3. Define the export properties as required. For more information, see HMS
export settings below.

4. Click the ... button to browse for the folder where you want to save the
file. 

The \HMS folder under the model folder is the default.

5. Enter a name for the file. 

The file name extension is .sot.

6. Click Save.

7. Select the Add revision to file name check box and select the revision
number if required. 

The revision number is added to the HMS export file as follows:

hms_export_file<revision>.sot
8. Select the Open log file after export check box if you want to see the log

after export. 

HMS Export creates the log file in the file export folder.

9. Click Export to create the HMS export file.

HMS Export settings
You can include project data, slab data, and steel part information in the HMS
export.
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Project data tab

Option Description
Customer Name

Customer Number

Contractor Name

Site Address

Site City

Section Name

Project Status

Remark 1

Remark 2

Remark 3

You can include project data, such as
customer name and site address, in
the HMS export file.

The boxes have the following values
available:

• Empty

The item is not included in the
HMS export file.

• Text

Enter the text in the box next to
the item.

• Project UDA

The data comes from the project’s
user-defined attributes.

• Project Object, Project Address,
Project Info 1 - 2

The data comes from the project
information.

Export file Define a name and location for the
export file. The file name extension
is .sot. By default, the export file
goes to the \HMS folder under model
folder.

Add revision to file name Add the revision number to the HMS
export file:
hms_export_file<revision>.sot.

Open log file after export Open the log file after export. HMS
Export creates the log file in the file
export folder.

Slab data tab

Option Description
Position Number Assigned Control Number (ACN) is

the only option.
Slab Remarks

Element Type

End Label

The options are:

• Empty

The item is not included in the
HMS export file.
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Option Description
• Text

Enter the text in the box next to
the item.

• UDA

The data comes from the project’s
user-defined attributes

Slab Name The options are:

• Profile

Select to export the whole profile
name.

• Thickness

Select to export only the profile
height.

Slab Mark The options are:

• Assembly position

Select to export the complete cast
unit position.

• Assembly serial number

Select to export the cast unit serial
number only.

Bay number Select the default UDA or UDA of your
choice. The value type of the default
UDA is integer, and it must be type
integer for any other chosen UDA as
well.

Slab Weight Units Select the weight unit.
Live/dead load Enter the default live/dead load to be

exported.

For hollow core slab calculation, you
can define a default live load/ dead
load (KN/m2) for slabs.

If you do not define this data here,
you must enter the default values for
each slab in HMS software later.
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Slab scope tab

Option Description
Exclude parts Enter the class or the name of the

model object, text, UDA or a template
attribute to exclude the data.

Hook Points

Electric boxes

Weld plate

Solid fill

Filled area

Select the data that is exported.

• Empty

The item is not included in the
HMS export file.

• Name

Select to include the name.

• Text

Enter the text in the box next to
the item to include the text.

• Class

Enter the class of the model object
in the box to include the class.

• UDA

The data comes from the user-
defined attributes.

• Template

The data comes from a template
attribute.

Hook point name Select to include hook point name in
export.

• Name

Select to include the name.

• Text

Enter the text in the box next to
the item to include the text.

• UDA

The data comes from the user-
defined attributes.

• Template

The data comes from a template
attribute.

Import to and export from Tekla Structures 475 Automated precast fabrication



Option Description
Weld plate name Select to include weld plate name in

export.

• Name

Select to include the name.

• Text

Enter the text in the box next to
the item to include the text.

• UDA

The data comes from the user-
defined attributes.

• Template

The data comes from a template
attribute.

Reinforcement tab

Option Description
Export strand code Select to include strand code in

export.
Export strand pull force Select to export pull force data.
Custom top strands

Custom bottom strands

Enter the quantity, diameter, distance
and pull force for custom strands.

The custom strand settings are meant
to be used if no strands are modeled.
If there are modeled strands, the
custom strands will be included in
addition.

Additional strands Additional strands can be used to
designate any other specific rebar
object to be exported as strand, as
only strand objects are included in
the export by default.

• Name

Enter the strand name.

• Class

Enter the class in the box next to
the item to include the class.
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Option Description
• UDA

The data comes from the user-
defined attributes. Enter the name
and value of the UDA.

• Template

The data comes from a template
attribute. Enter the template
attribute and the value.

Reinforcement Reinforcement can be included in the
export as cross bars by specifying
them in the Reinforcement setting.

• Name

Enter the reinforcement name.

• Class

Enter the class in the box next to
the item to include the class.

• UDA

The data comes from the user-
defined attributes. Enter the name
and value of the UDA.

• Template

The data comes from a template
attribute. Enter the template
attribute and the value.

  

Options tab

Option Description
Boundary line Export the boundary line Along cut

side of the slab or Along uncut side
of the slab.

Export Hook Box Select to include hook data.
Export HP name Select to export hook point names. If

you do not select this option, only the
XY coordinates are exported.

Export inner cores Select to include detailed information
on hollow cores in export.

Include full cut to contour Select to include in export full cut in
the contour block (CO). If not selected,
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Option Description
the full cut is written as an individual
cut (SP).

Generate drain/weep holes Select to include drain holes and
weep holes in export. You can also
specify the offset.

3.14 CAD
The CAD import and export tools support several formats to import and
export models. You can import a maximum of 10,000 parts. If the number of
parts exceeds this, Tekla Structures displays a warning message, and does not
import the model.

CAD import and export formats
The table below lists the supported import and export file types.

Option Import Export Imports from/Exports to
SDNF ✔ ✔ SDNF (Steel Detailing Neutral File) is used in importing to and exporting from several

different CAD systems.
HLI ✔ ✔ HLI (High Level Interface). IEZ AG Speedikon software
Plantview ✔ Plantview design system
SDNF (PDMS) ✔ ✔ Plant Design Management System. Aveva 3D plant design software.

Data is exported to PDMS via SDNF link. Tekla Structures writes the information of finish
field in the member class attribute, whereas in SDNF export it omits the class information.

XML ✔ ✔ ArchiCAD modeling system.

There are some limitations in the export:

• Conversion files are not used.

• Holes, bolts and welds are not exported.
SCIA ✔ ✔ SCIA is used for SteelFab interface.

In addition to the CAD import tool, the import tools listed below are available
in the New Import Model dialog box. The steps for importing these types are
the same as for the CAD import.

• Import Steelfab/SCIA

• Import SFrame

• Import MicasPlus

• Import Eureka LPM
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• Import CIS2 status

• Import CIS model

• Import FEM

Import CAD files
1. On the File menu, click Import --> CAD . 

The New Import Model dialog box is displayed.

2. Use the default name import model or enter a new name for the import
file.

3. Select the import type Import CAD. 

This dialog box also contains the following import tools:

Import SteelFab/SCIA

Import Sframe (7)

Import MicasPlus (5)

Import Eureka LPM (4)

Import CIS2 status

Import CIS Model

Import FEM

4. Click the Properties... button to define the import settings, which depend
on the selected import type. 

For more information about the import-type-specific settings, see the
settings and their descriptions in sections below.

5. Click OK to return to the New Import Model dialog box.

6. Click OK to import.

7. Select the import model name from the list and click Import. 

You can also click the New... or Properties... buttons if you need to make
some changes.

8. In the Import Models dialog box, select which version of parts to import.

9. Click Accept all. 

The Accept all option is generally used if importing a new model over an
existing one. If you have changed the model and want to re-import it, you
can also reject all changes by clicking Reject all, or accept or reject
individual changes by clicking Select individual....
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10. Tekla Structures displays the message Do you want to save the import
model\nfor subsequent imports? Click Yes. 

Tekla Structures adds the import model in the model view.

11. Right-click the model view and select Fit Work Area to Entire Model to
ensure that the imported model is completely visible.

12. If parts are missing, check the Depth up and Depth down values in the
View Properties dialog box and change them if necessary.

NOTE In SDNF import, if you want to import information that Tekla Structures parts
do not have, you can use the SDNF extension line in the SDNF file to be
imported, and the REVISION_NUMBER user-defined attribute in Tekla
Structures.

Settings of the CAD import

Setting Description
Conversion tab
Profile conversion file

Material conversion
file

Twin profile
conversion file

Define the conversion files you want to use.

Conversion files map Tekla Structures profile and
material names with names used in other
software.

For more information about conversion files, see
Conversion files (page 155).

Parameters tab
Input file The file that you want to import. You can also

browse for the file. The default value is
import.lis.

Type Define the input file or model type:

SDNF, HLI, Plantview, SDNF (PDMS), XML
Origin X, Origin Y,
Origin Z

Define the origin coordinates to place the file in a
specific location.

SDNF tab
Pos_No Enter a prefix and a start position number for

parts.

This settings relates to the Position number type
setting.

SDNF version number Set the SDNF format type to 2.0 or 3.0.

SDNF 3.0 is generally the format to select.
However, with StruCAD it is better to share SDNF
2.0 files.
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Setting Description
Apply cuts and fittings Set to Yes (default) to apply cuts and fittings in the

import.

These will only be included if contained within the
SDNF file.

Consider offsets Set to Yes to create offsets. In most cases you
should select Yes. No (default) positions part
creation points at part end points.

In most cases you should select Yes. No (default)
positions part creation points at part end points.

Create log file Select Create to write a new log file and delete the
previous log file each time you import the model.

If the import fails, examine the log file to find out
why. Check the log file even if the import seems to
have succeeded.

Select Append (default) to add the log file
information is at the end of the existing log file.

If yo do not need a log file, select No.
Display log file Select With external viewer to display the log file

in a text editor.

Select On dialog to create a separate list dialog
box in which the file can only be viewed.

If you do not want to display the file, select No.
Log file name Enter the log file name or browse for an existing

log file.
Position number type The SDNF file contains identifiers that can be

included in a part’s user-defined attributes, or used
as part position numbers.

Select Part position if you want the identifier to
become the part’s position number. Do not use the
Pos_No option with this option.

Select Universal ID if you want the identifier to
become a user-defined attribute for the part.

For file imports from PDS or PDMS then the
Universal ID option is the normal case.

To make user-defined attributes visible in the
dialog boxes, you need to add them to the
objects.inp file.

Plantview tab
Material Select the material grade.
Report tab
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Setting Description
Create report Set to Yes to create a report.
Display report Set to Yes to display the report.
Report template Select the report template.
Report file name Enter the report file name or browse for a report

file.

If you do not give the report any other name, the
report is saved with the name
import_revision_report.rpt in the model
folder.

Advanced tab
Action when objects
status is (compared to)

Previous plan lists the objects in your model,
compared with the objects in the file to be
imported. They can be New, Modified, Deleted, or
Same.

Tekla Structures compares the state of imported
objects with those in your model. They can be Not
in model, Different, or Same.

Use the options under Not in model, Different,
and Same to specify the actions when importing
changed objects. The options are No action, Copy,
Modify, or Delete.

Usually there is no need to change the defaults.

Settings of the SteelFab/SCIA import

Setting Description
Parameters tab
Input file Enter the name of the file you want to import.
Profile conversion file

Material conversion
file

Define the conversion files you want to use.

Conversion files map Tekla Structures profile and
material names with names used in other
software.

For more information about conversion files, see
Conversion files (page 155).

Origin X, Origin Y,
Origin Z

Define the origin coordinates to place the file in a
specific location.

Import weldings Include weldings in the imported model.
Import bolt holes Include bolt holes in the imported model.
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Settings of the S-Frame, MicasPlus, and Eureka LPM import

Setting Description
Conversion tab  
Profile conversion file

Material conversion
file

Twin profile
conversion file

Define the conversion files you want to use.

Conversion files map Tekla Structures profile and
material names with names used in other
software.

For more information about conversion files, see
Conversion files (page 155).

Parameters tab
ASCII file name Enter the name of the file you want to import.
Part rotation Select Front or Top.

Available only in Import MicasPlus (5).
Origin X, Origin Y,
Origin Z

Define the origin coordinates to place the file in a
specific location.

Advanced tab  
Action when objects
status is (compared to)

Previous plan lists the objects in your model,
compared with the objects in the file to be
imported. They can be New, Modified, Deleted, or
Same.

Tekla Structures compares the state of imported
objects with those in your model. They can be Not
in model, Different, or Same.

Use the options under Not in model, Different,
and Same to specify the actions when importing
changed objects. The options are No action, Copy,
Modify, or Delete.

Usually there is no need to change the defaults.

Settings of the CIS2 status import

Setting Description
Parameters tab  
Input file The name of the file you want to import. You can

also browse for the file.
Input scope Import the Entire model or Selection only.
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Setting Description
Create log file Select Create to write a new log file and delete the

previous log file each time you import the model.

Select Append (default) to add the log file
information is at the end of the existing log file.

If yo do not need a log file, select No.
Display log file Select On dialog to create a separate list dialog

box in which the file can only be viewed.

If you do not want to display the file, select No.

Settings of the CIS Model import

Setting Description
Parameters tab  
Model type Select the model type: Design, Analysis, SP3D.
CIS Version Select CIS/1 or CIS/2:

• CIS/1 imports files compatible with the CIMsteel
LPM4DEP1 schema declaration.

• CIS/2 imports files compatible with the CIMsteel
CIS/2 (STRUCTURAL_FRAME_SCHEMA) schema
declaration.

Input file The name of the file you want to import. You can
also browse for the file.

Origin X, Origin Y,
Origin Z

Define the origin coordinates to place the file in a
specific location.

Combine members

Max length for
combining

To combine several elements in the CIS model into
one part in Tekla Structures, set Combine
members to Yes.

For example, if a beam in a file consist of more than
one element, and you select Yes, the elements are
combined to form one beam in the Tekla Structures
model.

If you use the value No, Tekla Structures creates a
beam for each element in the CIS model.

Max length for combining is only applied if you
set Combine members to Yes. Use this setting to
define the maximum length for combining parts.
Tekla Structures combines elements into one part
only if their combined length is less than the value
you enter here.
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Setting Description
Ignore offset CIS/1 and CIS/2 analysis models can include

member offsets, which means that nodes are not
exactly at the beam’s end points. With the default
Yes, Tekla Structures uses these offsets to locate
the physical members. With No, Tekla Structures
determines the location using the node locations.

Ignore forces Use to define how forces are imported. With No,
Tekla Structures imports absolute values of
maximum forces to parts’ user-defined attributes
Shear, Tension and Moment. With Yes, Tekla
Structures does not import forces.

Import GUID (design
model)

Select Yes to include the part GUID in the import.

Conversion tab  
Profile conversion file

Material conversion
file

Twin profile
conversion file

Define the conversion files you want to use.

Conversion files map Tekla Structures profile and
material names with names used in other software.

For more information about conversion files, see
Conversion files (page 155).

Advanced tab
Action when objects
status is (compared
to)

Previous plan lists the objects in your model,
compared with the objects in the file to be
imported. They can be New, Modified, Deleted, or
Same.

Tekla Structures compares the state of imported
objects with those in your model. They can be Not
in model, Different, or Same.

Use the options under Not in model, Different,
and Same to specify the actions when importing
changed objects. The options are No action, Copy,
Modify, or Delete.

Usually there is no need to change the defaults.

Settings of the FEM import

Setting Description
Conversion tab
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Setting Description
Profile conversion file

Material conversion
file

Twin profile
conversion file

Define the conversion files you want to use.

Conversion files map Tekla Structures profile and
material names with names used in other
software.

For more information about conversion files, see
Conversion files (page 155).

Parts tab
Part Pos_No

Assembly Pos_No

Enter a prefix and a start position number.

Parameters tab
Input file The name of the file you want to import. You can

also browse for the file.
Type Select the input file type: DSTV, SACS, Monorail,

Staad, Stan 3d, Bus
Origin X, Origin Y,
Origin Z

Define the origin coordinates to place the file in a
specific location.

Default yield stress
limit

Default material when
yield stress >= limit

Default material when
yield stress < limit

The Default material when yield stress < limit
setting is used for SACS import file. Define the
material to use if yield stress is less than the limit.

The setting Default material when yield stress
>= limit is used for SACS or DSTV import files. For
SACS, this field defines the material to use if yield
stress is greater than or equal to the limit. For
DSTV you can enter the material grade here, if it is
not included in the import file.

Combine members

Max length for
combining

To combine several elements in the FEM model
into one part in Tekla Structures, set Combine
members to Yes.

For example, if a beam in a file consist of more
than one element, and you select Yes, the
elements are combined to form one beam in the
Tekla Structures model.

If you use the value No, Tekla Structures creates a
beam for each element in the FEM model.

Max length for combining is only applied if you
set Combine members to Yes. Use this setting to
define the maximum length for combining parts.
Tekla Structures combines elements into one part
only if their combined length is less than the value
you enter here.

Staad tab
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Setting Description
Material Select the material grade.
Report tab
Create report Set to Yes to create a report.
Display report Set to Yes to display the report.
Report template Select the report template. Your can also browse

for the template.
Report file name Enter the report file name or browse for a report

file.

If you do not give the report any other name, the
report is saved with the name
import_revision_report.rpt in the model folder.

DSTV tab
Version Select the DSTV version.
Import static elements

Import other elements

If the DSTV file to be imported contains a static and
a CAD model, you can choose which one to import.

Answering Yes to Import static elements imports
the static model.

Answering Yes to Import other elements imports
the CAD model.

Stan 3d tab
Scale Specify the scale of the import model. You can

import Stan 3d without specifying the scale as long
as both the Tekla Structures model and the import
model are in millimeters. If the Stan 3d file is in
millimeters, use the scale 1. If the Stan 3d file is in
meters, use the scale 1000.

Material Enter the material for the parts to import.
Bus tab
Pos_No Indicate the Pos_No of the girders, columns,

braces and cantilevers you import.
Material Enter the material for the parts to import.
Name Enter the name of the parts to import.
Class Enter the class of the parts to import.
Beams behind plane The value Yes aligns the tops of all beams at the

floor level.
Advanced tab  
Action when objects
status is (compared to)

Previous plan lists the objects in your model,
compared with the objects in the file to be
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Setting Description
imported. They can be New, Modified, Deleted, or
Same.

Tekla Structures compares the state of imported
objects with those in your model. They can be Not
in model, Different, or Same.

Use the options under Not in model, Different,
and Same to specify the actions when importing
changed objects. The options are No action, Copy,
Modify, or Delete.

Usually there is no need to change the defaults.

Re-import a CAD model
Sometimes you have already imported a model, but because of some changes,
you need to re-import it.

The profile and material conversion files need to be the same as defined in the
original model import.

The following instructions also apply to CIMsteel (cis/2) models.

1. Open Tekla Structures and a model where you have already imported an
existing CAD model.

2. On the File menu, click Import --> CAD .

3. Select the import type in the Type list. 

For CAD models, this will generally be for SDNF format files only.

4. Enter a new name for the imported model in the Name box. 

The total path and filename cannot be longer than 80 characters. If the
total path is too long, a message is displayed saying "File name and path is
too long. Please, place the file into another directory." Also, if you use the
same name as in the original import, Tekla Structures gives the warning
message "Illegal name for import model."

5. Click the Properties... button and ensure that the profile material
conversion files on the Conversion tab are the same as adopted in the
original model import.

6. Go to the Advanced tab and define the actions Tekla Structures takes
when importing changed objects: 

• The left-hand column, Previous plan, lists the state of the objects in
your model, compared with the state of objects in the file to be
imported. They can be New, Modified, Deleted, or Same.

• The objects can be Not in model, Different, or Same.
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• Use the list boxes in the rows under Not in model, Different, or Same
to specify the actions to take when importing changed objects. The
options are No action, Copy, Modify, or Delete.

You can select Delete only for Deleted objects. You can only use
Delete to delete objects that have been deleted from your model, not
from the imported model.

• Normally, default settings would be used by most users.

7. Click OK or Apply.

8. Click Import in the Import Models dialog box to import the updated
model.

9. Create reports on the Report tab to compare the various imports.

Export to CAD
You can export a CAD model in several formats.

NOTE Before you start an SDNF export, check that the advanced option
XS_SDNF_CONVERT_PL_PROFILE_TO_PLATE has not been set on the
Export page of the Advanced Options dialog box.

1. Open a Tekla Structures model.

2. On the File menu, click Export --> CAD . 

The Export CAD dialog box opens.

3. Enter the paths to the required conversion files on the Conversion tab,
enter the parameters on the Parameters tab, and depending on the
export format, define the settings on the SDNF or XML tab. 

For more information about the export settings, see the CAD export
settings section below.

4. Select the parts in the model to export.

5. Click Apply and Create. 

Tekla Structures creates the export file in your current model folder.

CAD model export settings

Setting Description
Conversion tab
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Setting Description
Profile conversion file

Material conversion
file

Twin profile
conversion file

Define the conversion files you want to use.

Conversion files map Tekla Structures profile and
material names with names used in other
software.

For more information about conversion files, see
Conversion files (page 155).

Parameters tab
Output file The file name of the exported file. You can also

browse for the file.
Type Select the export format: HLI, SCIA, SDNF, PDMS,

SDNF (PDMS), XML
Origin X, Origin Y,
Origin Z

Define the origin coordinates to place the exported
model in a specific location.

PML tab: this format is no longer supported
SDNF tab
SDNF version number Select the SDNF version to be used in the export.

With StruCAD, use SDNF version 2.0.
Apply cuts and fittings Select Yes (default) applies cuts and fittings in the

export.
Position number type The SDNF file contains identifiers, which can be

included in a part’s user-defined attributes, or as
position numbers. You have the following options:

• Part position

The identifier becomes the part’s position
number. Do not use the Part Pos_No fields
with this option.

• Assembly position

The identifier becomes the assembly’s position
number.

• Universal ID

The identifier becomes a user-defined attribute
for the part.

To make user-defined attributes visible, you need
to add them to the objects.inp file.

Consider offsets To ignore the offset records during export, select
No, and to take them into account, select Yes.

This setting does not affect the actual start and
end point information, only the offset. Tekla
Structures writes the start and end points based
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Setting Description
on the actual solid object, not on the reference
line.

PDMS phase offset PDMS phase offset defines phase offset for
exported parts. For example, if the first phase in
Tekla Structures model is 1 and you enter 10 for
phase offset, Tekla Structures parts in another
software get the phase from 11 and up.

Engineering Firm Enter the name of the engineering company.
Client Enter the name of the client.
Structure ID Enter a unique identification number for the

exported model.
Project ID Enter a unique identification number for the

exported project.
Revision Number Enter an optional revision number. Tekla

Structures takes the revision number from the
user-defined attributes (REVISION_NUMBER) of the
model. If this field is blank, Tekla Structures uses a
revision number from the Export CADdialog box
(Revision Number).

Issue Code Tekla Structures writes an issue code in the header
section of the output file. For PDMS, this value
should always be "Tekla Structures".

Design Code Define the design code to be used in structural
design.

XML tab
Units Specify unit conversions (MM, M, IN, FT). For

example, for a Tekla Structures model created
using millimeters, select IN to convert all part
dimensions to inches in the output file.

XML structure ID Unique identification number for the exported
model. You must always enter the identification ID.
Tekla Structures uses this value to identify the
model if you re-export it.

XML structure name Unique name of the exported model.
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4 Tekla Warehouse

Tekla Warehouse is a service for collaboration, and for storing and sharing
Tekla Structures content.

Tekla Warehouse provides centralized access to a wide range of content that
you can use in your Tekla Structures models.

With Tekla Warehouse you can:

• Publish your content online.

• Use your company network or a commercial file storage and
synchronization service to share content.

• Save content locally for private use.

In Tekla Warehouse, content is organized into collections.

Tekla Structures collections contain official Tekla Structures content that you
can use in your models. The content is grouped by geographical area. There is
also a global folder for content that is not location specific.

Tekla Warehouse has the following content categories:

• Applications

• Custom components

• 3D products

• Profiles

• Materials

• Bolts

• Reinforcement

• Model setup files

• Drawing setup files

• Report templates
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Accessing Tekla Warehouse

To open Tekla Warehouse while using Tekla Structures, do one of the
following:

• On the File menu, click Extend --> Tekla Warehouse.

• Go to Quick Launch, and start typing Tekla Warehouse.

Tekla Warehouse Service

Tekla Warehouse consists of the Tekla Warehouse web site (https://
warehouse.tekla.com/) and the Tekla Warehouse Service.

You need Tekla Warehouse Service to benefit from all the features Tekla
Warehouse offers, for example, easy installation of content into a Tekla
Structures model, or local and network collections.

See also

For more information on Tekla Warehouse, go to Tekla Warehouse and click
About, or see Getting started with Tekla Warehouse.
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5 Disclaimer

© 2020 Trimble Solutions Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced
Software. Use of the Software, and use of this Software Manual are governed
by a License Agreement. Among other provisions, the License Agreement sets
certain warranties for the Software and this Manual, disclaims other
warranties, limits recoverable damages, defines permitted uses of the
Software, and determines whether you are an authorized user of the
Software. All information set forth in this manual is provided with the warranty
set forth in the License Agreement. Please refer to the License Agreement for
important obligations and applicable limitations and restrictions on your
rights. Trimble does not guarantee that the text is free of technical
inaccuracies or typographical errors. Trimble reserves the right to make
changes and additions to this manual due to changes in the software or
otherwise.

In addition, this Software Manual is protected by copyright law and by
international treaties. Unauthorized reproduction, display, modification, or
distribution of this Manual, or any portion of it, may result in severe civil and
criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla Structures, Tekla Model Sharing, Tekla PowerFab, Tekla Structural
Designer, Tekla Tedds, Tekla Civil, Tekla Campus, Tekla Downloads, Tekla User
Assistance, Tekla Discussion Forum, Tekla Warehouse and Tekla Developer
Center are either registered trademarks or trademarks of Trimble Solutions
Corporation in the European Union, the United States, and/or other countries.
More about Trimble Solutions trademarks: http://www.tekla.com/tekla-
trademarks. Trimble is a registered trademark or trademark of Trimble Inc. in
the European Union, in the United States and/or other countries. More about
Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product
and company names mentioned in this Manual are or may be trademarks of
their respective owners. By referring to a third-party product or brand, Trimble
does not intend to suggest an affiliation with or endorsement by such third
party and disclaims any such affiliation or endorsement, except where
otherwise expressly stated.

Portions of this software:

Disclaimer 494

http://www.tekla.com/tekla-trademarks
http://www.tekla.com/tekla-trademarks
http://www.trimble.com/trademarks.aspx


EPM toolkit © 1995-2006 Jotne EPM Technology a.s., Oslo, Norway. All rights
reserved.

Open Cascade Express Mesh © 2015 OPEN CASCADE S.A.S. All rights reserved.

PolyBoolean C++ Library © 2001-2012 Complex A5 Co. Ltd. All rights reserved.

FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved.

Teigha © 2002-2016 Open Design Alliance. All rights reserved.

CADhatch.com © 2017. All rights reserved.

FlexNet Publisher © 2014 Flexera Software LLC. All rights reserved.

This product contains proprietary and confidential technology, information
and creative works owned by Flexera Software LLC and its licensors, if any. Any
use, copying, publication, distribution, display, modification, or transmission of
such technology in whole or in part in any form or by any means without the
prior express written permission of Flexera Software LLC is strictly prohibited.
Except where expressly provided by Flexera Software LLC in writing,
possession of this technology shall not be construed to confer any license or
rights under any Flexera Software LLC intellectual property rights, whether by
estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures,
click File menu --> Help --> About Tekla Structures and then click the 3rd
party licenses option.

The elements of the software described in this Manual are protected by
several patents and possibly pending patent applications in the United States
and/or other countries. For more information go to page http://
www.tekla.com/tekla-patents.
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